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1 What�s New in This Release
What�s New in Siebel Assignment Manager Administration Guide, 
Version 7.8
Table 1 lists changes described in this version of the documentation to support release 7.8 of the 
software.

Table 1. New Product Features in Siebel Assignment Manager Administration Guide, Version 7.8

Topic Description

New assignment object types and 
hierarchy

See �About Assignment Manager 
Object Types� on page 46 and 
�About Assignment Manager 
Object Type Hierarchy and 
Relationships� on page 48.

New object types include:

■ Assignment Object Extension

■ Dynamic Candidate Component

■ Dynamic Candidate Component Col

Enhanced dynamic candidate 
capability

See Chapter 7, �Working with 
Dynamic Candidates.�

Added a new chapter to consolidate dynamic candidate 
functionality. The enhanced capability allows you to:

■ Create dynamic candidate teams

■ Configure team-based and composite team-based criteria

■ Specify n-level join specifications when creating the 
dynamic candidate definition

NOTE: Before version 7.8, you could only assign dynamic 
candidates two levels deep from the assignment object 
primary table.

Reporting Mode

See �About Running Assignment 
Manager in Reporting Mode� on 
page 235.

Allows for what-if scenarios for possible assignments before 
making actual assignments.

NOTE: Before version 7.8, only the production mode was 
available.
Siebel Assignment Manager Administration Guide Version 7.8 11



What�s New in This Release ■  
Additional Changes
This version of the documentation also contains the following general changes:

■ Most content in this guide was rewritten and reorganized to enhance usability.

■ The following terms were changed throughout the book: 

■ Siebel Business Applications replaces Siebel eBusiness Applications

■ Siebel Dedicated Web Client was renamed to Siebel Developer Web Client

■ Several new server component job parameters were added.

For a list of all server component parameters available for use with Assignment Manager, see 
�Modifying the Assignment Manager Server Component Parameters� on page 198.

■ The Dynamic Candidate assignment object type definitions and usage have changed. For 
example, as of version 7.8, the Dynamic Candidate Attribute object type is no longer used; use 
the Dynamic Candidate Component Col object type instead.

For information about the Dynamic Candidates object types, see �About Assignment Manager 
Object Types� on page 46.

■ The following Dynamic Candidate object type properties are no longer used: 

■ Attribute Id Column

■ Attribute Table

■ Object Id Column

■ Score Column

■ Team Table

■ Team Table Attribute Id Column

■ Team Table Candidate Id Column

However, these properties remain in the repository for upgrade purposes.

■ Added a new chapter for availability-based assignment topics; however, there are only minor 
content changes. See Chapter 11, �Availability-Based Assignment.�

Expanded rule group support

See �About Configuring 
Assignment Manager to Copy 
Columns� on page 261.

Allows you to retain position-specific data.

Assignment Load Splitter 
Configuration

See Chapter 12, �Assignment Load 
Splitter Configuration.�

Added a new chapter. A new view in the Assignment - 
Administration screen allows you to configure Assignment 
Manager to split objects for processing into separate batches 
and submit those batch requests to multiple servers.

Table 1. New Product Features in Siebel Assignment Manager Administration Guide, Version 7.8

Topic Description
Siebel Assignment Manager Administration Guide Version 7.812 



2 Finding and Using Assignment 
Manager Information
This chapter covers how to find and use information in the Siebel Assignment Manager 
Administration Guide and in other sources relevant to Assignment Manager. It includes the following 
topics:

■ �How to Use the Siebel Assignment Manager Administration Guide� on page 13

■ �Important Assignment Manager Resources� on page 14

■ �Information on Assignment Manager Seed Data� on page 16

How to Use the Siebel Assignment 
Manager Administration Guide
This guide provides information necessary to configure, administer, and implement Siebel 
Assignment Manager. Chapters are organized in a way that allows users to move throughout the 
guide for various tasks. Use Table 2 as a guideline to determine which chapters you should review 
and familiarize yourself with before using Assignment Manager.

Table 2. Siebel Assignment Manager Administration Guide Organization

Chapter or Appendix Administrator Developer

Chapter 1, �What�s New in This Release� X X

Chapter 2, �Finding and Using Assignment Manager Information� X X

Chapter 3, �Overview of Siebel Assignment Manager� X X

Chapter 4, �Planning Your Assignment Manager Implementation� X X

Chapter 5, �Basic Assignment Manager Configuration� X

Chapter 6, �Assignment Rule Administration� X

Chapter 7, �Working with Dynamic Candidates� X X

Chapter 8, �Assignment Rule Administration for Delegated 
Assignment�

X

Chapter 9, �Running Assignment Manager� X

Chapter 10, �Advanced Assignment Manager Configuration� X

Chapter 11, �Availability-Based Assignment� X X

Chapter 12, �Assignment Load Splitter Configuration� X

Appendix A, �Troubleshooting: Assignment Manager Error 
Messages�

X

Siebel Assignment Manager Administration Guide Version 7.8 13



Finding and Using Assignment Manager Information ■  Important Assignment Manager 
Resources
Important Assignment Manager 
Resources
Assignment Manager is just one of many server processes available in Siebel Business Applications. 
Several other server processes, not fully documented in this guide, contribute to Assignment 
Manager functionality. The resources described in this topic provide additional information relevant 
to Assignment Manager.

Technical Documentation
The following Siebel documentation should be used as additional references when using Assignment 
Manager with these processes:

■ Siebel Business Process Designer Administration Guide for information about business processes 
and workflows

■ Object Types Reference for descriptions of and usage comments for assignment object properties

■ Using Siebel Tools for information about how to modify standard Siebel objects and create new 
objects to meet your organization�s business requirements.

■ Siebel Deployment Documentation Suite, including:

■ Siebel System Administration Guide for details on how to administer, maintain, and expand 
your Siebel servers

■ Configuring Siebel Business Applications for information about configuring Siebel Business 
Applications using Siebel Tools

■ Deployment Planning Guide to familiarize yourself with the basics of the underlying Siebel 
application architecture

■ System Monitoring and Diagnostics Guide for Siebel eBusiness Applications

■ Going Live with Siebel Business Applications for information about how to migrate 
customizations from the development environment to the production environment 

■ Security Guide for Siebel Business Applications for information about built-in seed data in the 
enterprise database, such as employee, position, and organization records.

■ Performance Tuning Guide for information about tuning and monitoring specific areas of the 
Siebel applications architecture and infrastructure, such as the Siebel Server infrastructure 
and Siebel Workflow.

■ Siebel Data Model Reference for information about how data used by Siebel applications is stored 
in a standard third-party relational DBMS such as DB2, Microsoft SQL Server, or Oracle as well 
as defines some of the data integrity constraints validated by Siebel Business Applications. Plan 
to use this guide for data entry, running limited scope queries, and managing processes like call 
scripting. 

■ Siebel eScript Language Reference for information about writing scripts to extend Assignment 
Manager functionary.

■ Siebel SmartScript Administration Guide for information about one way of triggering 
assignments.
Siebel Assignment Manager Administration Guide Version 7.814 



Finding and Using Assignment Manager Information ■  Important Assignment Manager
Resources
Siebel SupportWeb 
This Siebel technical support Web site provides search-engine access to the Siebel Bookshelf, 
Technical Notes, Siebel Alerts, troubleshooting information, and other important information. 
SupportWeb is located at http://ebusiness.siebel.com/supportweb.

■ System Requirements and Supported Platforms on Siebel SupportWeb. This document contains 
a definitive list of system requirements and supported platforms for the release, including the 
following:

■ Information on supported third-party products 

■ A description of supported upgrade paths 

■ Lists of product and feature limitations; either unavailable in the release or in certain 
operating environments 

It is located on the SupportWeb Knowledge Base at Product Documentation > System 
Requirements and Supported Platforms & Miscellaneous Documentation. 

■ Release Notes on Siebel SupportWeb. The Release Notes document contains only the most 
current information on known product anomalies and workarounds and may contain late-
breaking information that the Siebel Assignment Manager Administration Guide may not yet 
contain. Release Notes are located on the SupportWeb Knowledge Base at Product 
Documentation > Release Notes. 

■ Maintenance Release Guides. Maintenance Release guides contain important information about 
updates to applications in maintenance releases. Maintenance release guides are located on 
SupportWeb at Product Documentation > Maintenance Release Guides. 

■ Technical Notes. Technical notes provide important information on specific Assignment Manager 
issues. Technical Notes related to Assignment Manager are located on SupportWeb at Technical 
Notes > Assignment Manager/Territory Assignment. Technical Notes of particular importance 
include: 

■ Technical Note 527 provides information about setting up the Activity assignment object for 
availability-based assignment.

■ Technical Note 436 provides information about troubleshooting issues for Dynamic 
Assignment.

■ Technical Note 27 provides information about how to configure Siebel Sales Enterprise to 
support additional territory assignment options.

■ FAQs. Frequently asked questions provide important information on various Assignment Manager 
topics. FAQs of particular importance include:

■ FAQ 2202 

■ FAQ 1629 

■ FAQ 1004 

■ FAQ 1762

■ Siebel Alerts. Alerts provide time-critical information on key product behaviors and issues. Siebel 
Alerts about Assignment Manager issues are located on SupportWeb at Siebel Alerts > Product 
Areas > Assignment Manager/Territory Assignment.
Siebel Assignment Manager Administration Guide Version 7.8 15



Finding and Using Assignment Manager Information ■  Information on Assignment 
Manager Seed Data
Information on Assignment Manager 
Seed Data
Siebel Business Applications include a sample database that contains example data of various kinds 
and that you can use in demonstrating, evaluating, or experimenting with the Siebel client and Siebel 
Tools. For more information about the sample database, see the Siebel Installation Guide for the 
operating system you are using.

The enterprise database of your default Siebel application contains some built-in seed data, such as 
employee, position, and organization records. You can use this seed data for training or testing, or 
as templates for the real data that you enter. For more information on seed data, including 
descriptions of seed data records, see Security Guide for Siebel Business Applications. 
Siebel Assignment Manager Administration Guide Version 7.816 



3 Overview of Siebel Assignment 
Manager
This chapter provides an overview of Siebel Assignment Manager concepts and functionality. It 
includes the following topics:

■ �Assignment Manager Terminology� on page 18

■ �Assignment Concepts� on page 21

■ �Essential Assignment Manager Building Blocks� on page 24

■ �Optional Assignment Manager Building Blocks� on page 30

■ �Assignment Manager Operating Modes� on page 32

■ �Specialized Assignment Manager Features� on page 34

■ �Modes for Processing Assignment Rules� on page 34
Siebel Assignment Manager Administration Guide Version 7.8 17



Overview of Siebel Assignment Manager ■  Assignment Manager Terminology
Assignment Manager Terminology
Siebel Assignment Manager uses different terminology than what you may be accustomed to in 
standard business terminology. Table 3 compares some of these terms and describes how they differ 
from standard business terminology and what they represent in the context of the Assignment 
Manager application. You should familiarize yourself with these terms before planning and creating 
your assignment rules.
Siebel Assignment Manager Administration Guide Version 7.818 



Overview of Siebel Assignment Manager ■  Assignment Manager Terminology
Table 3. Differences Between Siebel Assignment Manager and Standard Business Terminology

Business 
Term

Siebel 
Assignment 
Manager 
Term Description

Territories Assignment 
Rules

In standard business terminology, a territory is a collection of 
accounts, contacts, and or assets that are managed by a team of 
positions. Usually a territory is based on a geographic area: either a 
collection of postal codes or geographic zones. 

In Siebel Assignment Manager, an assignment rule is a collection of 
logical business boundaries. These business boundaries include:

■ Geographic. ZIP Code, Province, City, State, Country, and so on. 

■ Non-geographic. Named Accounts, Industries, Products and 
Product Lines, Revenue, Sales Stage, Lead Quality, Service 
Request Area, Service Request Subarea, and so on. 

You can also enforce additional business rules using assignment 
rules. For example, you can define a rule so that a specific account 
manager manages a particular account and the account�s related 
opportunities.

NOTE: The word territory is used other places in the UI, where it is 
not related to the assignment territory features described in this 
guide. For example, the terms described in this table are not the 
same as the terms used with the Siebel Territory Management 
application.

Territory 
Conditions

Assignment 
Criteria

In standard business terminology, territory conditions constrain the 
accounts, contacts, and assets that can be assigned. 

In Siebel Assignment Manager, assignment criteria enforce business 
conditions when applied to assignment rules. An assignment rule 
can have one or more assignment criteria.

For example, if a sales representative�s territory is Northern 
California, but excludes City Y and Z for Products A, B, and C, then 
there are three territory conditions (assignment criteria) that define 
the sales representative's territory. The three conditions are:

■ Province, City, or ZIP Code (to identify Northern California)

■ City Y and City Z (for exclusion)

■ Products A, B, and C
Siebel Assignment Manager Administration Guide Version 7.8 19



Overview of Siebel Assignment Manager ■  Assignment Manager Terminology
Territory 
Condition 
Values

Assignment 
Criteria 
Values

In standard business terminology, territory condition values are 
applied to territory conditions to further constrain the accounts, 
contacts, and assets that can be assigned. 

In Siebel Assignment Manager, assignment criteria values are applied 
to a specific assignment criterion for a particular business condition. 
For example:

■ A ZIP Code assignment criterion could have the following criteria 
values: 94401, 94402, 94403, or 94406.

■ A service request assignment criterion could have the following 
criteria values: CD-ROM, 401K Account, Billing, or so on.

Business 
Entity

Assignment 
Object

In standard business terminology, business entities can be 
Accounts, Opportunities, Contacts, Sales Leads, Orders, Campaigns, 
Service Requests, Trouble Tickets, Activities, eMail, and so on. The 
business representatives for these entities include field service 
agents, telesales representatives, account executives, and so on.

In Siebel Assignment Manager, business entities are known as 
assignment objects. An assignment rule is associated with one or 
more assignment objects.

Territory 
Managers 
and 
Territory 
Teams

Assignment 
Candidates

In standard business terminology, territory managers and territory 
teams are generic terms used mostly in sales organizations. For a 
given business boundary, territory managers and their teams 
manage accounts, opportunities, contacts, or other business entities 
(or a combination of any or all of these). They are associated with a 
particular sales business entity�Account, Opportunity, Contact, and 
Partner, and so on�because they satisfy or qualify for the business 
conditions enforced by their organizations.

In Siebel Assignment Manager, assignment candidates apply not 
only to sales entities but to service entities as well. Service objects 
(entities) include Service Request, Product Defect, and so on. For 
sales organizations, candidates are positions or organizations. For 
example, a territory for a sales representative might be Northern 
California, with the exclusion of City Y and City Z for Products A, B, 
and C. For service organizations, candidates are employees or 
organizations. For example, a territory for a field service installation 
technician might be City A and City B.

Table 3. Differences Between Siebel Assignment Manager and Standard Business Terminology

Business 
Term

Siebel 
Assignment 
Manager 
Term Description
Siebel Assignment Manager Administration Guide Version 7.820 



Overview of Siebel Assignment Manager ■  Assignment Concepts
Assignment Concepts
Siebel Assignment Manager routes business entities and work items to the most appropriate 
candidates by enforcing business rules set by sales, service, and marketing organizations. 
Assignment Manager accomplishes this function by matching candidates (that is, employees, 
positions, and organizations) to predefined and user-configurable assignment objects. To assign the 
most qualified candidate to each object, Assignment Manager applies assignment rules that you 
define to each candidate.

To define assignment rules, you select:

■ Objects to which each assignment rule applies

■ Rule groups to which each assignment rule belongs

■ Candidates�person (employee or position), organization, or both�for each assignment rule

■ Criteria for each assignment rule

■ (Optional) Values for assignment criteria

For rules that match attributes of an assignment object with attributes of candidates, you can 
optionally define:

■ Skills to match assignment rules to candidate attributes

A skill is a generic row-level attribute that qualifies a person, organization, or assignment object 
row. For example, if an employee speaks English and Spanish, language is the skill he or she 
possesses, and English and Spanish are the skill items. Employee, position, and organization 
skills are used to store skills possessed; the skill tables for objects are used to store skills 
required. Assignment Manager uses skill tables to do skill matching by comparing the skills on 
the object with the skills of an employee, position, or organization to determine who passes the 
rule.

■ Expertise levels to weigh skill scores (to measure competency in a certain area for each 
candidate) 

■ Scores for each assignment rule, criteria, and value and a personal score for each individual 
candidate 

For example:

■ In a sales organization, you can create an assignment rule that scores positions (candidates) 
based on territory definitions (criteria) for an opportunity (object).

■ In a service organization, you can create an assignment rule that scores employees 
(candidates) based on product expertise (criteria) for a service request or product defect 
(object).

Using the sum of scores at the assignment rule level, Assignment Manager assigns the best 
candidate for each rule and the best candidates for the object.

■ Defining workload distribution rules to balance work among the candidates 

Define workload distribution rules if you want to distribute the workload rules evenly between 
the candidates or if your business logic includes limits on the maximum amount of work that can 
be handled at one time.
Siebel Assignment Manager Administration Guide Version 7.8 21



Overview of Siebel Assignment Manager ■  Assignment Concepts
You can also customize the way Assignment Manager makes assignments by:

■ Defining how attributes are matched by:

■ Using different comparison methods

■ Making criteria required (compulsory) or optional

■ Using inclusion and exclusion methods

■ Using workload distribution rules

■ Using wildcard values

■ Defining how assignment rules are matched by using:

■ Assignment rule groups

■ Assignment rule sequencing

■ Defining how candidates are assigned based on person and organization relationships using 
multitiered assignment

■ Creating and configuring your own entities, including:

■ Assignment objects

■ Assignment criteria

■ Assignment attributes

■ Workload distribution rules to make assignments based on current workload

■ Dynamic candidates and candidate teams that are assigned dynamically depending on the 
object row assigned

■ Running Assignment Manager in different operating modes to process assignments:

■ Interactively in real time

■ Dynamically when object rows are created or attributes on object rows are changed by 
connected or mobile users

■ Periodically assigning objects in batches

■ Running Assignment Manager against reporting tables to test the desired behavior of assignment 
rules and rule groups before running against production tables

■ Checking availability before assigning employees to objects

■ Defining which servers are used to run selected groups of rules

■ Delegating the task of creating business logic through rules and criteria to others
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Summary of Assignment Manager Customization Tasks
Table 4 summarizes the Assignment Manager customization tasks and where you can find more 
information.

Table 4. Summary of Assignment Manager Customization Tasks

Task For More Information, See �

Define assignment rules �Process of Defining Assignment Rules� on page 86

Match attributes of an assignment object 
with attributes of candidates

■ �About Assignment Skills, Expertise Codes, and 
Weighting Factors� on page 112

■ �Process of Defining Criteria Values as Skills with 
Expertise Codes and Weighting Factors� on 
page 114

Defining workload distribution rules to 
balance work among the candidates

■ �How Assignment Manager Balances Workload 
Among Candidates� on page 125

■ �Process of Defining Assignment Workload� on 
page 127

Define how attributes are matched Chapter 6, �Assignment Rule Administration�

Define how assignment rules are matched 
using rule groups and rule sequencing

■ �Creating Assignment Rule Groups� on page 88 

■ �Adding a Sequence Number to Assignment Rules� 
on page 149

Define how candidates are assigned based 
on person and organization relationships 
using multitiered assignment

�Configuring Assignment Objects for Multitiered 
Assignment� on page 268

Create and configure your own entities ■ Chapter 5, �Basic Assignment Manager 
Configuration�

■ Chapter 6, �Assignment Rule Administration�

■ Chapter 7, �Working with Dynamic Candidates� 

■ Chapter 10, �Advanced Assignment Manager 
Configuration�

Run Assignment Manager in different 
operating modes to process assignments

Chapter 9, �Running Assignment Manager�

Running what-if analysis on possible 
assignments before making actual 
assignments

�About Running Assignment Manager in Reporting 
Mode� on page 235

Define which servers are used to run 
selected groups of rules

�How Assignment Manager Uses Server Key Maps to 
Load Rules to a Particular Siebel Server� on page 149
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Essential Assignment Manager Building 
Blocks
Siebel Assignment Manager consists of several essential building blocks. A brief description of each 
is provided in the following subtopics; each subtopic is described in greater detail in other chapters 
throughout this guide.

Assignment Rules
An assignment rule is a logical collection of business conditions, and Assignment Manager evaluates 
potential candidates based on these rules. For example, assume the US Western Sales 
Representative position is responsible for sales of Products A, B, and C in zip codes 944401, 94402, 
94403. In Siebel Assignment Manager, this example translates as follows:

■ An assignment rule exists for the US Western region.

■ The assignment rule candidate is the US Western Sales Representative.

■ One criteria for the assignment rule includes only those accounts with 94401, 94402, and 94403 
Zip Codes.

■ Another criteria for the assignment rule includes only products in the Product A, B, or C product 
line.

Siebel Assignment Manager uses assignment rules to match assignment objects to candidates. 
Multiple assignment rules can be active for each assignment object. An assignment rule can also 
apply to multiple objects.

Assignment rules use criteria and scores to rate candidates and select potential assignees. 
Candidates that qualify for an assignment rule have the assignment rule score added to their total 
score. For example, if you have an assignment rule with the Score field set to 20 points, each 
candidate that meets the rule's criteria has 20 points applied to his or her total score.

Each assignment rule also has a candidate passing score value. After the total score for a candidate 
is calculated, Assignment Manager compares this score with the candidate passing score for the 
assignment rule. If a candidate�s score is less than the candidate passing score, the candidate does 
not meet the criteria and is not assigned.

Delegate the task of creating business logic 
through rules and criteria to others

Chapter 8, �Assignment Rule Administration for 
Delegated Assignment�

Check availability before assigning 
employees to objects

Chapter 11, �Availability-Based Assignment�

Table 4. Summary of Assignment Manager Customization Tasks

Task For More Information, See �
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Assignment Objects
In Siebel Assignment Manager, assignment objects represent assignment entities to which 
candidates are matched based on assignment rules. The concept is analogous to business objects in 
Siebel Business Applications. You must associate every assignment rule with at least one assignment 
object. 

Assignment Criteria and Criteria Values
Assignment criteria are the fundamental building blocks for assignment rules. You translate the 
assignment business logic you determine into assignment criteria. Assignment rules use criteria to 
determine which candidates qualify as potential assignees. Criteria also determine which assignment 
rule should be evaluated in assigning an object. An assignment rule can include none (zero), one, or 
many criteria.

An assignment criterion is usually defined along with criteria values. For example, assume you want 
an assignment requirement that employees speak German. When you create your assignment rule, 
you select the predefined Language rule criterion and German (or DEU, which is the language code 
for German) as the criterion value. 

You can have several criteria values for the same criterion. For example, Figure 1 shows a Language 
rule criterion that uses four languages as criteria values: German, Spanish, Italian, and French. 
Assuming this assignment rule�s candidate passing score is 10 points, and each language is worth 5 
points, candidates for this assignment rule that possess expertise in at least two of these languages 
qualify for the assignment rule. 

Figure 1. Sample Assignment Criterion with Multiple Criteria Values
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Assignment Manager provides predefined criteria values that are available dynamically based upon 
the criterion you select, or you can create your own criteria values using Siebel Tools. For example, 
if you want activities of type Repair or Break-fix handled by a certain employee, create a rule criterion 
called Activity Type with two criteria values, Repair and Break-fix. For more information about 
creating new criteria with values, see �Process of Creating Assignment Criteria for Use in Assignment 
Rules� on page 56.

Assignment Rule Groups
Assignment Manager allows you to group assignment rules, splitting them up by business function 
or other categories. An assignment rule group can include multiple assignment rules, however, an 
assignment rule can belong to only one rule group. You must associate each assignment rule with a 
rule group. 

TIP: If you do not want to create your own rule groups, you can associate all assignment rules to 
the Default Rule Group. The Default Rule Group is provided in the Assignment Manager seed data. 
Rules upgraded from versions prior to version 7.7 and 7.8 Assignment Manager are automatically 
associated with the Default Rule Group, if you have not already assigned a specific rule group.

Before the introduction of rule groups, Assignment Manager processed all active rules, which 
required several administration tasks to execute Assignment Manager only on a subset of rules. For 
example, one of the tasks required was to expire all unwanted rules. With the introduction of rule 
groups in version 7.7, you can now split rules and execute a subset of rules at any time.

For example, you may have one set of business rules for assigning repair activities and another set 
of rules for assigning similar, but different, activities, such as appointment activities. In this 
situation, you could create two rule groups with five rules each. Then, when assigning a particular 
activity, you specify the rule group you want Assignment Manager to process. Only the five rules from 
the rule group you specified are processed during assignment of the activity, for example, the five 
repair activity rules.

NOTE: Typically, you want to split rules into rule groups based on business logic. 

Assignment Candidates
In Siebel Assignment Manager, candidates represent the people or organizations who are evaluated 
as potential assignees for objects. Depending on the assignment rule you use, and the object to 
which a candidate is assigned, candidates can be positions, employees, or organizations, and can be 
assigned as individuals or as members of a team. Alternatively, you can associate all people or all 
organizations defined in the database as candidates for a rule. You can also specify a particular 
candidate or one member of a team as the primary assignee on a specific assignment rule.

Static Versus Dynamic Candidates
When processing rules, Assignment Manager determines potential candidates either statically or 
dynamically. Assignment Manager determines candidates statically when:

■ Candidates are explicitly added to an assignment rule

■ The All People or All Organizations flags are checked on an assignment rule

■ When qualifying candidates based on their skills 
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Static candidates do not change as Assignment Manager processes rules (unless you intentionally 
associate other, different candidates) whereas dynamic candidates are identified during assignment. 

Dynamic candidates can come from different, but related business entities. For example, Assignment 
Manager can assign an activity related to an asset and then dynamically generate a candidate list 
from the asset team.

Assignment Manager determines dynamic candidates as potential assignees for objects from an 
attribute on the object row. For example, assume you have an activity that is associated to an asset. 
The asset, in turn, is associated with a list of employees. You may want Assignment Manager to treat 
the list of employees associated with the asset as potential candidates for assignment of that activity. 
In this situation, the potential candidates are dynamic candidates because they are not statically 
associated with an assignment rule; instead, they are identified during assignment. In addition, if 
the activity gets associated with a different asset that is associated with a different set of employees, 
the list of potential candidates for the same activity can change during the next assignment. 

In summary, the following points explain how static candidate assignment differs from dynamic 
candidate assignment:

■ For static candidate assignment, candidates for each assignment rule are loaded when the server 
processes start up.

■ For dynamic candidate assignment, candidates are retrieved from related business entities 
(attribute team table) with respect to the object row during an assignment.

Employee Candidates
Employees represent candidates distinguished by their skills and product expertise and are typically 
used as candidates in service organizations. For example, a service organization would want to 
assign employees with the proper skills and expertise to objects, because these employees possess 
specific skills that are related to the service request or activity. Assignment Manager can also take 
into account a specific employee�s work schedule, calendar, and regional schedule when determining 
assignments by creating rules based on an employee�s availability. For more information about 
availability-based assignment, see Chapter 11, �Availability-Based Assignment.�

Position Candidates
Positions represent candidates distinguished by their job functions and are typically used as 
candidates in sales organizations. For example, a sales organization would want to assign positions 
to objects, because these positions are responsible for a region or territory. 

By assigning objects to positions, you can have one sales representative inherit the opportunities, 
accounts, and contacts from another representative by reassigning the employee responsible for a 
specific position.

NOTE: An assignment object can be either position-based or employee-based, but not both. 
Assignment Manager does not support assignment of employees and positions to the same 
assignment object.
Siebel Assignment Manager Administration Guide Version 7.8 27



Overview of Siebel Assignment Manager ■  Essential Assignment Manager Building 
Blocks
Organization Candidates
An organization represents a group of positions that has limited visibility to particular application 
data. For example, your company can create separate and distinct organizations to distribute specific 
information to organizational groups both inside and outside of your enterprise. Both internal and 
external users are granted access only to the information that they should see (such as accounts, 
opportunities, and contacts) and data they need to see (such as price lists, products, and literature).

By assigning objects to organizations, you can maintain better security and promote proper business 
practices by controlling data access and visibility between different organizations. For example, you 
can limit your distributors� data access by giving them visibility to product information, but restricting 
their visibility to price lists for the products. To restrict price list visibility, you can create a separate 
organization for your distributors that does not have access to the price list data. In this case, the 
price lists are not available to your distributors even if they are assigned to the products.

Some objects allow the assignment of a single organization, whereas other objects allow the 
assignment of multiple organizations to the same object. For more information about which 
candidates can be assigned to each of the predefined assignment objects, see Table 5 on page 29. 

Teams Versus Individual Candidates
A team represents a group of employees or positions. Assigning a team allows you to assign a group 
of individuals that possess various skills or job functions to a particular object.

In sales organizations, teams are typically assigned to objects. For example, you can assign a sales 
representative and a sales consultant to an opportunity. Alternately, you can assign a team of sales 
professionals�such as two district representatives, a regional manager, and a sales engineer�to 
work a single, large sales opportunity.

An individual represents a single employee or a position. Assigning individuals allows you to assign 
exclusive ownership to an individual who possesses a specific skill or expertise for a particular object.

In service organizations, individuals are typically assigned to objects. For example, you can assign 
a customer service representative with expertise in disk drives to all service requests that are 
marked for this area.

Assignment objects can be team-based, individual-based, or both. That is, the same assignment 
object can be team-based for employees and individual-based for organizations.
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Table 5 shows which candidates can be assigned to some of the predefined assignment objects. This 
table also shows which assignment objects are restricted to a single assignee, and assignment 
objects that are capable of incorporating a team of assignees. S indicates the ability to allow only 
single owner assignments; M indicates the ability to allow multiple owners or team assignments.

NOTE: If you want to assign different candidates, such as assign accounts to employees or assign 
projects to positions, you must configure the assignment object using Siebel Tools. For more 
information about this, see �Creating Assignment Objects� on page 243.

Primary Assignees
A primary on an assignment rule represents the candidate (employee, position, or organization) that 
is assigned as the primary owner of an assignment object if the candidate passes the criteria for that 
object. The primary is the main owner, that is primary assignee, of an assignment object. This 
assigned primary is usually the highest-scoring assignee from the highest-scoring assignment rule. 

Alternatively, you can configure Assignment Manager to assign one member of a team as the primary 
assignee. In addition, you can manually assign a particular candidate as the primary assignee on a 
specific assignment rule.

NOTE: For assignments that allow only single assignees, the single assignee also becomes the 
primary assignee.

Table 5. Individual Versus Team Assignments Listed by Assignment Object

Assignment Object
Employee
Candidate

Position
Candidate

Organization
Candidate

Account M M

Activity M

Campaign M M

Campaign Contact S S

Contact M M

Opportunity M M

Product Defect S

Project M M

Project Team M

Service Request S M

TM Account M

TM Asset M

TM Contact M
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Optional Assignment Manager Building 
Blocks
Siebel Assignment Manager provides several optional building blocks you can use with your 
assignment rules. A brief description of each is provided in the following subtopics; each subtopic is 
described in greater detail in other chapters throughout this guide.

Assignment Rule Sequencing
When you assign sequence numbers to assignment rules, Assignment Manager evaluates those rules 
in ascending order of the sequence numbers. Assignment rule sequencing provides a means for you 
to prioritize the rules that apply to any given assignment object by order of importance, thereby 
limiting the number of rules that Assignment Manager processes for assignment. For example, you 
might want to run Assignment Manager only for your higher priority rules first, and then if those rules 
pass, stop processing additional rules because candidates are already successfully matched.

Assignment Workload
Assignment Manager allows you to apply predefined workload distribution rules, or you can create 
your own, to assignment rules to balance workload among candidates. Candidates that have 
workloads in excess of the maximum workload are eliminated from the assignment rule. This 
workload distribution prevents employees from being overloaded. Each assignment rule can include 
multiple workload criteria.

Assignment Scoring
You can add scores to assignment rules to rate candidates and select potential assignees. Candidates 
that qualify for an assignment rule have the assignment rule score added to their total score. For 
example, if you have an assignment rule with the Score field set to 20 points, each candidate that 
meets the rule's criteria has 20 points applied to his or her total score.

You can also assign a candidate passing score value to each assignment rule. After the total score 
for a candidate is calculated, Assignment Manager compares this score with the candidate passing 
score for the assignment rule. If a candidate�s score is less than the candidate passing score, the 
candidate does not meet the criteria and is not assigned.

Alternatively, you can add scores for the same candidate across multiple assignment rules.

Assignment Skills, Expertise Codes, and Weighting Factors
Skills are a special criteria type that you can use to minimize the number of assignment rules. One 
assignment rule can match different candidates to various objects based on the object characteristics 
and candidate skills. 

Skills are the type of criteria you use most frequently for implementing assignments in a customer 
service environment. For optimal assignment, you determine the criteria that you want to evaluate 
for each candidate to make sure that the candidate possesses the proper skills to handle the task. 
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The Siebel application provides predefined skills, and you enable and configure those skills at the 
criteria level using Siebel Tools. However, you can also create new skills using Siebel Tools. After you 
enable skills, Assignment Manager matches skills based on an assignment criteria comparison 
method in the same manner in which attributes are matched. Assignment Manager then applies 
scores and other filters to find the best candidate after a match has been made.

You can apply expertise codes that define an employee's expertise level for a particular skill with 
weighting factors to weigh skill scores to measure competency in a certain area for each candidate. 
Assignment Manager uses expertise codes to rank skills to find the most suitable candidate. For 
example, assume you do not want to assign a novice to a service request that requires an expert. 
By using expertise codes, you can prevent assigning objects to underqualified candidates.

Server Key Maps
Server key maps allow you to define multiple rule groups that you want a specific server to load and 
process, thus allowing you to use different servers for different business purposes. Server key maps 
use an internal key-based routing mechanism to route requests to a particular server; however, this 
routing is done in the background and is not apparent. You can also specify multiple servers to load 
the same rule group.

Assignment Policies
Assignment policies are specialized workflow policies used to create dynamic assignment triggers. 
Assignment policies allow you to define policies that can act as triggers to execute a workflow 
process, such as dynamic assignment. A policy consists of one or more policy conditions. When the 
policy conditions are met, the policy action is executed. Assignment Manager provides preconfigured 
policies for each of the predefined assignment objects. To use assignment policies, you must first 
activate them using Siebel Tools. 

Denormalization
Denormalization is an assignment mode in which Assignment Manager introduces duplicate data to 
facilitate specific visibility requirements. In Siebel Assignment Manager, you use the prebuilt contact 
denormalization and product denormalization features to denormalize positions or organizations. 

Email Activity Assignment
Assignment Manager can assign or route inbound emails created by Siebel eMail Response to an 
appropriate agent. The Communications Server, that is the Communications Inbound Manager server 
component, works in conjunction with Siebel eMail Response to create inbound emails as activities.

To assign inbound emails, the assignment administrator creates assignment rules and criteria for the 
Activity assignment object. For more information about routing inbound emails, see Siebel Email 
Response Administration Guide (Workflow section) and Siebel Communications Server 
Administration Guide.
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Multitiered Assignment
By default, Assignment Manager assigns people and organizations independently. Multitiered 
assignment allows Assignment Manager to consider the relationship between people and 
organizations when determining the proper assignment. This feature requires configuration of 
assignment objects using Siebel Tools before implementing.

Availability-Based Assignment
Assignment rules can be created for employee-based objects using availability-based assignment, 
which allows Assignment Manager to check an employee�s calendar and to consider the employee�s 
availability when determining assignment eligibility. This feature requires advanced configuration of 
assignment objects using Siebel Tools before implementing.

Assignment Manager Operating Modes
This topic explains the various operating modes available for running Assignment Manager. 
Depending on the operating mode, you invoke Assignment Manager using the server administration 
views, using the command-line interface to run server component jobs, or both. 

About the Assignment Manager Operating Modes
There are three assignment operating modes:

■ Batch Assignment

■ Dynamic Assignment

■ Interactive Assignment

Batch Assignment
You can use batch assignment to assign multiple records in a single batch. For example, you can 
assign orders that are created during the business day at the end of business using batch assignment 
so that the assignments are made before start of business the next morning. Another example of 
batch assignment is when you change assignment rule definitions�you can use batch assignment to 
reassign objects using the new assignment rules. Batch assignment is optimized to process a large 
number of items efficiently.

Dynamic Assignment
Dynamic assignment performs assignments automatically as other users and server programs create 
records or modify existing records. For example, if a user creates a new opportunity or changes the 
revenue amount or the address of an opportunity, dynamic assignment automatically detects the 
change and invokes Assignment Manager to reassign the opportunity to a different territory or sales 
team, as determined by the assignment rule.
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Interactive Assignment
Interactive assignment allows end users to invoke Assignment Manager by a click of a button or 
menu selection, review the list of assignees generated by Assignment Manager, and then accept or 
override the assignees. 

NOTE: Mobile users running Assignment Manager in interactive mode do not make real-time 
assignments, because interactive assignments made by mobile users are not applied to the server 
until they resynchronize.

About Different Modes of Running Assignment Manager
You can choose one of two ways�default mode or rule group mode�to run Assignment Manager 
depending on what rules you want processed.

■ Default mode. In this mode, all active rules for all rule groups are loaded and processed. By 
default, interactive and dynamic assignment run in default mode. However, you can configure 
interactive assignment to run in rule Group mode.

■ Rule group mode. In this mode, you can process rules of one particular rule group when you 
assign an object row. 

Table 6 shows the supported operating modes and server components used for running each mode.

Table 6. Operating Modes for Running Assignment Manager

Mode Server Component Used

Operating
Mode Description Default

Rule
Group AsgnSrvr AsgnBatch

GenTrig/
WorkMon

Batch Assigns a set of rows in a 
single request.

X X

Dynamic Uses database triggers to 
assigns objects as soon 
as they are created or 
when they are modified.

X X

Interactive Uses the Assignment 
Manager engine to filter 
out certain candidates (in 
the evaluation phase), 
outputs a list of potential 
candidates to the user, 
and then the user 
manually assigns.

X X X
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Specialized Assignment Manager 
Features
Assignment Manager provides several specialized features. A brief description of each is provided in 
the following subtopics; some features are also described in greater detail in other chapters of this 
guide.

Mobile Assignment
Mobile Assignment allows mobile users to make interactive and dynamic assignments. Changes to 
the mobile client�s database are queued and are applied to the server the next time the client 
synchronizes.

Assignment Manager automatically performs interactive assignments made by the mobile user after 
synchronization. Changes to assignment rules and objects are updated, and affected objects are 
reassigned dynamically.

NOTE: Mobile users running Assignment Manager in interactive mode do not make real-time 
assignments, because interactive assignments made by mobile users are not applied to the server 
until they resynchronize.

Delegated Assignment
Delegated assignment provides assignment administrators (AAs) the ability to delegate rule 
administration to other administrators and partners to route leads, activities, accounts (and other 
assignment objects) to employees or positions. These delegates are known as delegated 
administrators (DAs). A DA can, in turn, delegate assignment rule administration to others. 

This hierarchical assignment feature is well-suited to sales organizations and organizations that work 
closely with partners.

Assignment Load Splitter Configuration
The assignment load splitter configuration feature provides assignment administrators (AAs) a tool 
for performing batch assignment for a significant number of objects. It eliminates the need for AAs 
to plan and implement complex load distribution logic. 

You can configure Assignment Manager to automatically split objects for processing into separate 
batches and submit those batch requests to multiple servers. This balances the task load across 
multiple servers, which in turn, improves processing performance.

Modes for Processing Assignment Rules 
As of version 7.8, Assignment Manager supports two modes for processing assignment rules�the 
reporting mode and the production mode. By default, Assignment Manager processes assignment 
rules in the production mode.

NOTE: Before version 7.8, only the production mode was available.
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Reporting Mode
Assignment Manager provides a special mode for processing assignment rules that allows 
Assignment Administrators (AAs) to run and preview trial assignments for what-if analysis before 
making actual assignments. Reporting mode stages the simulated assignments into a set of 
temporary results tables, known as reporting tables, rather than into the actual database tables. 
After this staging process is complete, AAs review the results and when satisfied, apply those 
changes by executing Assignment Manager in production mode.

Production Mode
The production mode is the mode in which actual assignments are made. Assignments are written 
into the team tables (account/position or contact/position tables) in the Siebel Enterprise database. 

For example, an AA might want to perform trial runs to confirm new assignment rules in the reporting 
mode. After accomplishing satisfactory results, the AA can then apply the same changes in the 
production mode.

NOTE: Reporting assignment and regular assignment are mutually exclusive operations that you can 
perform in any combination, that is, in reporting mode alone, production mode alone, or both. 
Irrespective of whether reporting is turned on or off, Assignment Manager can write evaluation 
results to an actual assignment table.
Siebel Assignment Manager Administration Guide Version 7.8 35



Overview of Siebel Assignment Manager ■  Modes for Processing Assignment Rules
Siebel Assignment Manager Administration Guide Version 7.836 



4 Planning Your Assignment 
Manager Implementation
This chapter provides guidelines for planning your Siebel Assignment Manager deployment and 
scenarios for various types of implementation. It includes the following topics:

■ �Guidelines for Planning Your Assignment Manager Implementation� on page 37

■ �Planning Your Assignment Manager Deployment� on page 38

■ �Guidelines for Creating Assignment Rules� on page 39

■ �Planning Optimal Assignment Rules� on page 39

■ �Scenarios for Using Assignment Manager� on page 41

Guidelines for Planning Your 
Assignment Manager Implementation
This topic provides high-level guidelines for planning your Assignment Manager implementation. 

Your business or functional teams should verify and confirm the requirements before assignment 
administrators begin planning assignment rule creation. The requirements include:

■ Ensure all the current business requirements and data routing (by way of Assignment Manager) 
is captured for the deployment.

■ When applicable, define strategies to leverage the existing implementation when additional 
organizations decide to use Assignment Manager in the future. 

For example, your current deployment may only include telesales, marketing, and customer care 
users, but you should plan ahead in case sometime in the future you want to include other users, 
such as quality assurance, email response, and so on.

■ Identify the business requirements and map those requirements to Assignment Manager 
features, such as assignment rule groups, rule sequencing, exclusivity, scoring, multitiered 
assignment, workload distribution, dynamic candidates, delegated assignment, and so on.

■ Map Assignment Manager deployment modes.

For example, your deployment mapping might include assigning service requests interactively, 
assigning opportunities dynamically, assigning accounts and assets using batch mode, assigning 
contacts using batch contact denormalization, and so on.

Assignment administrators should develop operational plans based on business requirements and 
frequency of assignment using Assignment Manager features, such as load splitter configuration, 
Reporting Mode, and so on.
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Planning Your Assignment Manager 
Deployment
This topic provides a high-level overview for planning your Assignment Manager deployment. If 
appropriate time is invested in analyzing the incoming data and loading up appropriately for the first 
time, it can reduce performance and other problems moving forward. 

Use the following points to help plan your deployment:

■ Develop a migration path from an external source to Siebel Assignment Manager and, if using 
territory management, also carefully plan import of external alignment rules.

NOTE: This task is even more important if your implementation has mobile users.

■ Use assignment rule groups to manage large numbers of rules.

■ Use rule sequencing to prioritize rules by order of importance. 

This can be helpful for newly-imported assignment manager rules from an external system 
because you can execute batch assignment against just the newly imported rules.

■ Use server key mappings to run multiple instances of assignment manager with different groups 
of rules loaded.

■ Create custom criteria for date fields (called date criteria).

Date criteria allow you to specify additional selectivity while assigning particular objects, such as 
creation date, expiration date, and so on.

■ If your assignment rules are static�that is, less frequently changing�consider using dynamic 
assignment over batch assignment. 

■ Identify opportunities where you can reduce assignment rules, such as:

■ Reusing assignment rules across objects

■ Using skills

■ Setting up dynamic candidates

For more information about how to reduce assignment rules, see �Planning Optimal Assignment 
Rules� on page 39.
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Guidelines for Creating Assignment 
Rules
To use Assignment Manager effectively, assignment administrators (AAs) must develop and 
document a clear set of strategies that are consistently applied by Assignment Manager or system 
administrators.

For each assignment object, AAs should consider how to develop assignment rules that:

■ Optimally match the attributes of assignment objects to criteria values of the assignment rules.

This is commonly used for traditional territory assignment where territories are managed 
exclusively through assignment administration. Employees, positions, or organizations 
associated with these rules are potential assignees. Sales organizations typically use this 
method.

■ Optimally match the attributes of assignment objects to employee skills. 

Expertise is managed using employee, position, or organization skills. Service organizations 
typically use this method.

■ Reflect a blend of the attributes outlined in the two methods previously described. 

For example, sales organizations can benefit from assignment rules using employee skills as well 
as territory rules.

Planning Optimal Assignment Rules
In general, the fewer assignment rules, the better. When you use fewer assignment rules, you 
achieve the following long-term gains:

■ Reduce Maintenance. The assignment administrator (AA) has fewer rules to manage, thus 
reducing time spent on checking quality of assignment rules. 

■ Scalability. When new organizations or divisions require Assignment Manager capability, there 
is no need to rearchitect the existing rules to accommodate the new requirements.

■ Reduce System Resources. Assignment Manager, like other processing applications, is 
resource intensive. By reducing the number of assignment rules, the amount of system resources 
required are minimized including database, Siebel Server, and the time window for territory 
alignments.

■ Enhance Performance. Assignment processing and throughput is increased when there are 
fewer rules because the Assignment Manager engine has a limited dataset to work on.

For normalization purposes, use the following guidelines to optimize your assignment rules:

■ Avoid duplication of assignment rules across objects.

For example, an account rule and a professional rule might have the same position assigned 
(within the same ZIP Code). In this case, you can collapse these two assignment rules into a 
single rule.
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■ For custom assignment criteria with similar values across multiple objects, build a single criteria 
so that you can consolidate assignment rules.

■ Consolidate positions across multiple assignment rules. 

After assignment rules are created, determine the top 10 positions used in assignment rules. If 
one or more positions are used in more than 90% of the assignment rules, you might want to 
consider alternate paths.

With a skills model, consider using the built-in Assignment Manager skills feature. Although it is 
typically used within a Call Center implementation, this feature can also be leveraged for a sales 
implementation. 

NOTE: Although it is recommended that you keep your assignment rules to a minimum, you should 
continually weigh the advantages of ease of administration with loss of performance as they apply 
to your particular deployment.

Examples for Optimizing Assignment Rules
Use the following examples to assist you in determining the number of assignment rules for your 
implementation.

Sales Example
A telecommunications sales company is planning their Assignment Manager implementation based 
on the following data:

■ There are 1,200 potential territories for the geographic and product lines served.

■ There are 600 sales people working these territories.

Ideally, this company would define no more than 600 assignment rules, which is the lower of the two 
numbers. However, if this company plans to use additional Assignment Manager features, such as 
dynamic candidates, scoring, skills, and so on, the company should consider reducing their rule count 
even further.

Service Example
An appliance services company is planning their Assignment Manager implementation based on the 
following data:

■ There are 100 potential geographic territories for their product line and different service 
products. 

The product line includes refrigerators, washing machines, air conditioning units, and so on. The 
services the company provides include: preventive maintenance, extended warranty coverage, 
and so on.

■ There are 1,600 field technicians working with customers in these territories.

Ideally, this company would define no more than 100 assignment rules, which is the lower of the two 
numbers. However, if this company plans to use additional Assignment Manager features, such as 
dynamic candidates, scoring, skills, and so on, the company should consider reducing their rule count 
even further.
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In summary, when you create assignment rules, identify the logical territories, the people 
participating in these territories, and then determine how you can best optimize your Assignment 
Manager deployment.

Scenarios for Using Assignment 
Manager
Several scenarios are provided as examples of how you might use Assignment Manager. Your 
company may follow a different process according to its business requirements.

Scenario for Using Assignment Manager in Sales Organizations
This scenario gives one example of how you can use Assignment Manager in a sales organization. 
You may use Assignment Manager differently, depending on your business model.

Sales organizations typically need to distribute opportunities and accounts to the proper people 
within the organization. Assignment of sales opportunities must take place quickly so that sales 
representatives can respond to potential revenue-generating opportunities. Information must also 
be readily available to salespeople to close the maximum number of sales possible.

Assignments in sales organizations are commonly made to positions responsible for a territory. 
Mobile salespeople, who are not connected to a network, can share information and work as a 
collaborative sales force on sales opportunities. Sales organizations can therefore use the talents of 
their salespeople within their entire organization.

Siebel Assignment Manager allows you to create territories for positions using a wide variety of 
criteria. By assigning objects to positions, you can have one sales representative inherit the 
opportunities, accounts, and contacts from another sales representative by reassigning the employee 
responsible for a specific position.

After you have created the territories using assignment criteria, a major territory realignment can 
negatively affect your system resources. If the realignment is large, Assignment Manager may create 
a volume of transactions for mobile clients, which increases synchronization time drastically. To avoid 
this problem, you can run a database extract server task (DbXtract) again and have the mobile 
clients initialize their databases. Because the time required to run a database extract server task for 
multiple clients may be significant, try to coordinate territory realignments with database extracts 
to occur during a time of low system utilization. 

Because sales organizations typically distribute their accounts and opportunities based on territories, 
create sales assignment rules based on these territories.

For more information about:

■ Territory alignments, see Siebel Territory Management Guide.

■ Database extracts, see Siebel Remote and Replication Manager Administration Guide.

■ Running server tasks, see Siebel System Administration Guide.
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Scenario for Using Assignment Manager in Service Organizations
This scenario gives one example of how you can use Assignment Manager in a service organization. 
You may use Assignment Manager differently, depending on your business model.

In a service organization, service requests can often be resolved by the first customer service 
representative (CSR) who services the customer. However, when the request cannot be resolved, or 
when the service request is logged through the Internet, ownership must be transferred to a service 
representative who possesses the expertise to handle the request.

In this environment, it becomes critical to assign employees with the proper expertise and skills to 
service requests. Therefore, you should assign employees to objects because some employees 
possess specific skills that are different from those of other CSRs or field service engineers. When 
service representatives are on vacation, are promoted, or assume different responsibilities, work 
assigned to these employees must be reassigned based on the skills and workloads of other 
employees in the service organization.

Scenario for Using Assignment Manager in Marketing Organizations
This scenario gives one example of how you can use Assignment Manager in a marketing 
organization. You may use Assignment Manager differently, depending on your business model.

In a marketing organization, you want to route responses from a new product campaign 
appropriately to the telesales team responsible for handling the campaign. In this case, the 
assignment administrator creates assignment rules using the Campaign assignment object, with 
Product and Workload criteria, to make sure there is a fair distribution of leads to telesales personnel.
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Configuration 
This chapter describes basic Siebel Assignment Manager configuration.

NOTE: If you plan to use the predefined Assignment Manager components, skip this chapter and 
proceed to Chapter 6, �Assignment Rule Administration.�

This chapter includes the following topics:

■ �About Performing Basic Assignment Manager Configuration Tasks� on page 44

■ �About Assignment Manager Object Type Hierarchy and Relationships� on page 48

■ �About Assignment Objects� on page 50

■ �Configuring Assignment Object Properties� on page 51

■ �Configuring Assignment Objects for Interactive Assignment� on page 53

■ �Process of Creating Assignment Criteria for Use in Assignment Rules� on page 56

■ �Creating Assignment Attributes� on page 56

■ �Mapping Assignment Attribute Columns to an Assignment Object and a Workflow Policy Component 
Column� on page 61

■ �Creating Assignment Criteria� on page 63

■ �Creating Assignment Criteria Attributes for Assignment Criteria� on page 65

■ �Disabling Assignment Attributes� on page 73

■ �About Inactive Assignment Manager Workflow Policy Components� on page 74

■ �Process of Using a Single Criterion for Multiple Objects� on page 67

■ �Example of Using a Single Criterion for Two Objects� on page 69

■ �About the Relationship Between Attributes and Skills� on page 75

■ �Viewing Predefined Skills� on page 76

■ �Enabling Assignment Objects for Skills� on page 77

■ �Example of Enabling an Assignment Object for Skills� on page 79

■ �Updating Your Assignment Manager Deployment with New Configurations� on page 80

NOTE: Configuration tasks other than the basic topics are explained in a separate chapter. For those 
users already familiar with Assignment Manager basic features and who require further information 
on refining their Assignment Manager deployment, also see Chapter 10, �Advanced Assignment 
Manager Configuration.�
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About Performing Basic Assignment 
Manager Configuration Tasks
Using Siebel Tools, you can modify existing assignment object definitions or create new assignment 
object and assignment criteria definitions in the Siebel repository. After you compile the changes, 
these definitions appear as criteria in the Criteria view or as skills in the candidate skills picklists in 
your Siebel application for assignment object selection.

Assignment Manager features that you can custom configure using Siebel Tools include:

■ List of assignment objects that can be assigned to assignment rules

■ List of attributes that can be incorporated in assignment criteria

■ Behavior of each available assignment object, including whether certain features are activated 
for the assignment object

■ Table and column mappings of assignment objects and attributes

■ Workflow policy component and workflow policy component column mappings of attributes used 
in assignment criteria

■ List of dynamic candidate objects for each assignment object

■ List of dynamic candidate component objects for each dynamic candidate (for team-based 
criteria)

NOTE: Criteria values, skills, and workload conditions are specialized. Do not attempt to reconfigure 
them. 
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Table 7 lists the various configuration tasks you may need to perform before creating your 
assignment rules. The steps are presented in no particular order, and some may not be applicable 
for your needs.

NOTE: In addition to the basic configuration tasks, you might find you need additional configuration 
to meet your particular business needs. Configuration tasks other than the basic topics are explained 
in a separate chapter and may require you to have additional knowledge or skills to perform. For 
more information about advanced configuration tasks, see Chapter 10, �Advanced Assignment 
Manager Configuration.�

Requirements for Configuring Assignment Manager
Before you can successfully configure Assignment Manager, you need to have a thorough 
understanding of how to use Siebel Tools, Assignment Manager, and the Siebel data model. For 
information on Siebel Tools functionality, see Using Siebel Tools and Configuring Siebel Business 
Applications. You should also familiarize yourself with the basics of the underlying Siebel application 
architecture. For information on Siebel application architecture, see Deployment Planning Guide. 
Assignment Manager object types are related to Workflow Manager object types. For information on 
Workflow Manager functionality, see Siebel Business Process Designer Administration Guide. For 
information on the Siebel data model, see Siebel Data Model Reference. 

Table 7. Basic Assignment Configuration Tasks

Task Required

�Configuring Assignment Object Properties� on page 51 X

�Process of Creating Assignment Criteria for Use in Assignment Rules� on page 56

1 �Creating Assignment Attributes� on page 56

2 �Mapping Assignment Attribute Columns to an Assignment Object and a Workflow 
Policy Component Column� on page 61

3 �Creating Assignment Criteria� on page 63

4 �Creating Assignment Criteria Attributes for Assignment Criteria� on page 65

X

�Disabling Assignment Attributes� on page 73

�Process of Using a Single Criterion for Multiple Objects� on page 67

�Enabling Assignment Objects for Skills� on page 77

�Updating Your Assignment Manager Deployment with New Configurations� on page 80 X
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About Assignment Manager Object 
Types
Siebel applications provide predefined definitions in the Siebel repository for several objects. Using 
Siebel Tools, you configure assignment object property values in the repository to control and 
customize the way objects are assigned. Some properties specify the basic definition of an 
assignment object, such as the name of the primary table in which object rows for the assignment 
object are stored, the name of the employee team table, the name of the employee primary column, 
and so on. Other properties control the behavior of Assignment Manager when processing rules. For 
example, the Add Team Members property controls whether candidates who no longer qualify for an 
assignment rule or rules should be removed from the team. 

Table 8 provides the object types specific to Assignment Manager and that can be configured using 
Siebel Tools.

Table 8. Assignment Manager Object Types

Object Type Description

Assignment Object An assignment object specifies a business entity to which a candidate can 
be assigned, what is updated to accomplish that assignment, and other 
assignment behavior parameters. Assignment objects are assigned to 
assignment rules in the Objects to be Assigned field of assignment rule 
records.

NOTE: The Objects to be Assigned field is a required field for assignment 
rules.

Assignment User Prop Assignment user properties allow you to optionally specify additional run-
time characteristics for each assignment object. Each assignment object 
has its own set of user property values.

Assignment Object 
Extension

This is a child of the Assignment Object object type that you can use to 
perform configuration related to Reporting mode.

Assignment Attribute An assignment attribute object definition defines an attribute that can be 
referenced in assignment criteria records. It specifies a logical attribute 
that can be chosen from a picklist for defining comparisons.

Assignment Attribute 
Column

An assignment attribute column object definition assigns an assignment 
attribute to an assignment object and a workflow policy component 
column. These mappings set up value matching within the assignment 
object and workflow policy object.

Assignment Criteria An assignment criteria object definition comprises multiple assignment 
attributes. Assignment criteria appear in the picklist in the Criteria list 
column when you are editing an assignment rule record.

Assignment Criteria 
Locale

This object type is used to store translated versions of localizable 
properties on the parent object type. For more information about the 
Locale object types, see Using Siebel Tools.
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For descriptions of, usage comments, and property values for each of the predefined assignment 
objects, see Object Types Reference, and search for these object types.

Assignment Criteria 
Attribute

An assignment criteria attribute lists the assignment attributes that are 
part of an assignment criterion. Assignment criteria attributes make it 
possible for an assignment criteria to consist of multiple attributes, known 
as composite criteria.

Assignment Criteria 
Attribute Locale

This object type is used to store translated versions of localizable 
properties on the parent object type. For more information about the 
Locale object types, see Using Siebel Tools.

Dynamic Candidate This object type is used to store a collection of joins from the base table 
to the team table that allows Assignment Manager to select potential 
candidates dynamically based on the current record.

Dynamic Candidate 
Component

A dynamic candidate component defines the tables and columns in an 
n-th level join. The first level defines the primary table, and the last level 
identifies the candidate table.

Dynamic Candidate 
Component Col

The Dynamic Candidate Component Col definition references a column 
within a particular level of a join that is used to evaluate assignment 
criteria or used to copy columns.

Dynamic Candidate 
Locale

This object type is used to store translated versions of localizable 
properties on the parent object type. For more information about the 
Locale object types, see Using Siebel Tools.

Table 8. Assignment Manager Object Types

Object Type Description
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About Assignment Manager Object Type 
Hierarchy and Relationships
Figure 2 illustrates the hierarchical (parent-child) relationships of Assignment Manager object types 
as well as two related object types in Workflow Manager configuration. You use the Object Explorer 
in Siebel Tools to view these relationships.

Figure 2 shows the following relationships:

■ Assignment Object, Assignment Object Extension, and Workflow Policy Component are children 
of Workflow Policy Object.

■ Dynamic Candidate and Assignment User Prop are children of Assignment Object.

■ Dynamic Candidate Component and Dynamic Candidate Locale are children of Dynamic 
Candidate.

■ Dynamic Candidate Component Col is a child of Dynamic Candidate Component.

■ Assignment Attribute Column is a child of Assignment Attribute.

■ Assignment Criteria Attribute is a child of Assignment Criteria.

Figure 2. Parent-Child Relationships Between Assignment Manager Object Types
Siebel Assignment Manager Administration Guide Version 7.848 



Basic Assignment Manager Configuration ■  About Assignment Manager Object Type
Hierarchy and Relationships
In addition to the parent-child relationships between Assignment Manager object types, there are 
one-to-one and one-to-many relationships specified in property settings within the object definitions, 
as illustrated in Figure 3. 

Figure 3 on page 49 shows the following relationships:

■ The business component that holds assignment criteria is called Assignment Rule. The business 
component that holds assignment rules is called Assignment Group. Assignment rules have 
assignment criteria children. Assignment rules are actually records of the Assignment Group 
business component, and their child assignment criteria are records of the Assignment Rule 
business component.

■ Each assignment rule points to one or more assignment object definitions, stored in the Assignment 
Objects multivalue group field (MVG) in the assignment rule record.

NOTE: Assignment Object is a required field for all assignment rules; however, Assignment 
Manager excludes rules that have no objects specified when upgrading.

Figure 3. Field Value and Property Relationships Among Assignment Manager Object Types
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■ Dynamic Candidate is a child of Assignment Object and each assignment rule can point to one or 
more dynamic candidates.

■ Dynamic Candidate Component is a child of Dynamic Candidate. It maintains the relationship 
between different components from which dynamic candidates are derived.

■ Dynamic Candidate Component Col is a child of Dynamic Candidate Component and identifies 
component columns that need additional filtering.

■ Each assignment criteria record points to an assignment criteria object definition, by means of 
the value in the Criteria field.

■ Assignment attributes are attached to an assignment object through a property setting in each 
assignment attribute column object definition.

■ An assignment attribute column object definition is mapped to a workflow policy component 
column object definition by means of a pair of property settings.

■ If your rule has dynamic candidates, the Person Candidate Source, Organization Candidate 
Source fields, or both, point to a Dynamic Candidate object definition. 

About Assignment Objects
An assignment object is a repository representation of a data item type. In Siebel Assignment 
Manager, objects represent assignment entities to which candidates are matched based on 
assignment rules. The concept is analogous to business objects in Siebel Business Applications. You 
must associate every assignment rule with at least one assignment object. A number of predefined 
assignment objects are available for use by Assignment Manager for the most commonly used 
business entities in Siebel Business Applications. Some of the predefined assignment objects are: 

■ Account

■ Activity

■ Campaign

■ Campaign Contact

■ Contact

■ Opportunity

■ Order (Sales Credit Assignment)

■ Product Defect

■ Project

■ Project Team

■ Service Request

NOTE: The predefined assignment objects are intended for use as a guide and may not be applicable 
to your business needs. It is recommended that you review, and change if needed, the configuration 
of these objects before using them using Siebel Tools.
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Alternatively, if your deployment requires additional assignment objects, you can also create new 
objects using Siebel Tools. For information about creating new assignment objects, see Chapter 10, 
�Advanced Assignment Manager Configuration.�

CAUTION: It is recommended that you contact Siebel Technical Support for assignment object 
creation. If you create your own assignment objects, you run the risk of Assignment Manager 
assigning incorrect assignments.

Configuring Assignment Object 
Properties
Siebel Assignment Manager uses definitions in the Siebel repository to assign objects to assignment 
rules and candidates.

An assignment object specifies a business entity to which a candidate can be assigned and the 
entities that are updated to accomplish that assignment. For example, an employee or position can 
be assigned ownership of an opportunity or account or made a member of the opportunity�s or 
account�s sales team. Similarly, an employee can be assigned ownership of a service request or 
product defect. Each of the corresponding business components has one or more fields that specify 
the owner or team. An assignment rule includes one or more assignment objects. When the rule is 
satisfied, specific columns underlying these fields are updated with replaced or added employee IDs 
appropriate for the settings in the assignment object. 

As shown in Figure 2 on page 48, an assignment object is a child object type of the Workflow Policy 
Object object. The parent workflow policy object provides a set of available column mappings 
through its child workflow policy component and grandchild workflow policy component column 
object types. These can be specified in Assignment Attribute Column object definitions as columns 
to test for value matches and to monitor in dynamic assignment for value changes.

NOTE: Workflow policy objects have a one-to-one or a one-to-zero relationship with assignment 
objects (the Order and Quote workflow policy objects do not have predefined child assignment 
objects). You cannot add more assignment objects to workflow policy objects that already have a 
child assignment object.

Siebel applications provides predefined definitions in the Siebel repository for several objects. The 
predefined Workflow Policy Object and Workflow Policy Component Column definitions include 
mappings for the most commonly used attributes for each object.

CAUTION: Siebel Tools allows the creation or configuration of an assignment object with both 
position- and employee-based assignment, but Assignment Manager does not correctly assign 
objects with this type of configuration. Only create or configure assignment objects for either 
position-based or employee-based assignment, not both.
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To configure assignment object properties

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and select the object you want to 
configure.

Objects are listed alphabetically by parent name in the Workflow Policy Objects window.

TIP: Workflow policy objects are not included in the Object Explorer by default. Click View > 
Options > Object Explorer to add the workflow policy objects to the Object Explorer view.

3 With the assignment object selected, choose Tools > Lock Project (or Alt+L) to lock the project. 

4 In the Object Explorer, select Assignment Object.

The property values of the assignment object appear in the Properties window as well as the 
Assignment Objects list applet, although naming conventions for the same property may differ.

5 In the Properties window, configure the assignment object by setting the appropriate values for 
each property.

NOTE: The default values provided in the Siebel repository for assignment objects are provided 
as a guide and may not be applicable to your business requirements. Therefore, it is 
recommended you review the configuration of the predefined objects before using them. For 
detailed information about assignment objects and their default values, see Object Types 
Reference.

6 Update your deployment with the new configurations. 

For instructions, see Step 2 and Step 3 on page 81 in the procedure for �Updating Your Assignment 
Manager Deployment with New Configurations.�

NOTE: It is not necessary to recompile the siebel.srf file when configuring an assignment object. 
For more information on when to recompile, see �Updating Your Assignment Manager Deployment 
with New Configurations� on page 80 and Using Siebel Tools.

TIP: If you are modifying the Default Employee, Default Position, or Default Organization 
properties, then make sure that the values specified exist in the appropriate base table. For example, 
if you change the default organization to My Organization, there must be an entry in the 
Administration - Group > Organizations view called My Organization. 
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Configuring Assignment Objects for 
Interactive Assignment
Interactive assignment allows users to invoke Assignment Manager immediately, view the list of 
assignees generated by Assignment Manager, and then override or confirm the assignees in the list. 
Users can invoke interactive assignment by clicking the appropriate object�s form Menu button and 
choosing Assign as shown in Figure 4. 

For example, you could choose the Assign option from the Menu button in the All Service Requests 
view after navigating to the Service screen > Service Requests > Service Requests List view, then 
choosing All Service Requests from the view drop-down list. When you click on the Assign applet 
menu item in the Service Request form to assign the current service request, the Siebel client 
contacts the assignment server and creates a list of qualified employees sorted by descending 
scores. The list of qualified employees appears to the user in the Employees window. Then, you can 
select an employee from the list as the service request owner.

Alternatively, you can allow SmartScript to have Assignment Manager select the most qualified 
candidate from the list. In this case, a list of qualified employees does not appear in the Employees 
window, and the most qualified candidate is assigned.

The Service Request assignment object is configured for Interactive Assignment by default. However, 
you can use Siebel Tools to configure Interactive Assignment for other assignment objects.

To configure interactive assignment for an assignment object

1 Verify that Assignment Manager is configured to perform assignment of values in the desired 
field, including the presence of the necessary assignment object and assignment rules and 
values.

2 Verify that the displayed business component is of the CSSBCBase class or one of its subclasses 
and add the Assignment Object business component user property to the business component.

a In the Object Explorer, select Business Component.

Figure 4. Example of Invoking Interactive Assignment
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b In the Business Components window, select the business component.

c In the Class property for that business component, verify the value is CSSBCBase (such as in 
the Account business component).

NOTE: Business components based on other classes cannot be configured for interactive 
assignment. If the class is not CSSBCBase, note the class name and locate it in the Object 
Explorer for the Class object type. Note the value in the Super Class property for this class. 
If the Super Class is CSSBCBase, interactive assignment is permitted. If the Super Class is 
not CSSBCBase, check the Super Class property for that class.

d Set the Name property to Assignment Object.

e Set the Value property to the name of the assignment object that is to be used in the assignment 
process.

3 Verify that the appropriate applet is of the CSSFrameBase class or one of its subclasses.

a In the Object Explorer, select Applet.

b In the Applets window, select the applet you want to verify.

c In the Class property for that applet, verify the value is CSSFrameBase (such as Account Entry 
Applet).

NOTE: Applets based on other classes (including CSSFrameListBase) cannot be configured for 
Interactive Assignment. 

4 Add the Assignment Type business component user property to the business component.

a In the Object Explorer, select Business Component.

b In the Business Components window, select the business component, and then click Business 
Component User Prop.

c Set the Name property to Assignment Type.

d Set the Value property to:

❏ People if you are setting up an employee- or position-based assignment

❏ Organizations if you are setting up an organization-based assignment

5 (Optional) If you want to enable SmartScript, add the Assignment Interactive business 
component user property to the business component.

a Set the Name property to Assignment Interactive.

b Set the Value property to TRUE.

6 Add the Assign selection to the applet menu button.

a In the Object Explorer, select Applet.

b In the Applets window, select the applet to which you want to add the Assign functionality.

c In the Object Explorer, select Applet Method Menu Item.

d Select the Applet Method Menu Items window, choose Edit > New Record and set the following 
values:

❏ Command=Assign(SWE)
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❏ Menu Text=Assign

❏ Position number = 1 (or to the number corresponding to the preferred placement in the 
menu)

7 Add the business component that holds assignment results records to the business object of the 
view in which the reconfigured applet is used.

This business component already exists, and is either: 

■ Assignment Results (Position) or Assignment Results (Employee), if Assignment Type is set 
to People (depending on whether you are setting up an employee- or position-based 
assignment)

■ Assignment Results (Organizations), if Assignment Type is set to Organizations

8 In the Object Explorer, select Business Object.

a In the Business Objects window, select the Business Object for which you want to add a child 
business object component.

b In the Object Explorer, click Business Objects Components, and in the Business Objects 
Components window, choose Edit > New Record.

c In the new record, enter values in the appropriate fields with the BusComp name set to: 
Assignment Results (Position), Assignment Results (Employee), or Assignment Results 
(Organization).

9 (Optional) Define the business component user property called Assignment Results BusComp and 
the applet user property called Assignment Results Applet.

These user properties are desirable when you need to show additional information about the 
results. For example, the service request assignment results can be joined with the CTI tables, 
and query only qualified service people who are not currently using their telephone:

■ The name of the business component used to hold data for the additional fields would be 
specified in an Assignment Results BusComp user property in the business component being 
assigned. 

■ The name of the applet used to display the assignment results would be specified in an 
Assignment Results Applet user property in the applet from which assignment is invoked.

10 Add one of the following Business Components (depending on what is being assigned) to the 
relevant Business Object: Assignment Group Position, Assignment Group Employee, or 
Assignment Group Organization. 

11 Update your deployment with the new configurations. 

For instructions, see Step 1 on page 81 in �Updating Your Assignment Manager Deployment with 
New Configurations.�

NOTE: Other than recompiling the siebel.srf file, there are no additional administrative tasks 
required for this procedure. For more information on when to recompile, see �Updating Your 
Assignment Manager Deployment with New Configurations� on page 80 and Using Siebel Tools. 
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Process of Creating Assignment Criteria 
for Use in Assignment Rules
Assignment criteria are the conditions that the candidates must satisfy in order to qualify for 
assignment to a particular work item. You usually define assignment criteria along with criteria 
values in assignment rules. Criteria values are the details associated with a criterion. There may be 
several criteria values for the same criterion.

Assignment Manager provides several predefined assignment criteria and criteria values. You can, 
however, create your own criteria and criteria values using Siebel Tools. 

To create new assignment criteria for use in assignment rules, perform the following tasks in the 
order presented:

1 �Creating Assignment Attributes� on page 56

2 (Optional) �Enabling Assignment Attributes for MLOV� on page 60

3 �Mapping Assignment Attribute Columns to an Assignment Object and a Workflow Policy Component 
Column� on page 61

4 �Creating Assignment Criteria� on page 63

5 �Creating Assignment Criteria Attributes for Assignment Criteria� on page 65

Creating Assignment Attributes 
Assignment attributes are logical attributes of an object or candidate that can be used for matching. 
An assignment attribute allows you to associate a single attribute on an object or a person or an 
organization to multiple fields in the application. For example, you can define an assignment rule 
that matches candidates based on State. However, State is stored in a different field in the 
application for different objects. Assignment attributes map the places that State is defined into a 
single state attribute. 

This task is one step in �Process of Creating Assignment Criteria for Use in Assignment Rules� on 
page 56.

Assignment attributes can be either column-based or skill-based. Column-based attributes are 
stored as columns in the object (such as Opportunity). You can use existing columns in the object, 
or use Siebel Database Extensibility to add new extension columns to the object. Skills-based 
attributes are stored as rows in the object�s skill tables (if any). For more information about Database 
Extensibility, see Configuring Siebel Business Applications.
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Figure 5 shows a Product Line Wildcard assignment criterion that uses the Compare to Person 
comparison method. The assignment criterion also uses the Include All inclusion method and includes 
two criteria values, Monitors and Graphic Cards. Each criteria value includes two assignment 
attributes. In this example, only candidates that possess an Expert-level expertise in monitors and 
graphic cards qualify for the assignment criterion. Furthermore, 25 points are added to the qualifying 
candidates score.

If you are adding an assignment attribute to a new table, you need to modify the existing Workflow 
Manager definitions in the Siebel repository. For more information on making modifications to 
Workflow Manager, see Siebel Business Process Designer Administration Guide.

An assignment attribute object definition defines an attribute that can be referenced in assignment 
criteria records. It specifies a logical attribute that can be chosen from a picklist for defining 
comparisons; it does not directly specify a particular database column or combination of columns. 
Column mapping is accomplished through the child assignment attribute column object definitions, 
one for each assignment object that uses the parent assignment attribute.

Figure 5. Sample Assignment Attributes
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An assignment attribute also specifies the picklist that appears in the Values list in the Criteria 
subview when you are entering an attribute in a value record, as shown in Figure 6.

NOTE: Assignment criteria configured to include multiple assignment attributes cannot have these 
attributes based on columns in different tables. 

An assignment criteria attribute object definition implements each list column in the Values applet, 
as described in �Creating Assignment Criteria Attributes for Assignment Criteria� on page 65. The 
assignment criteria attribute is based on an assignment attribute, as specified in its assignment 
attribute property. The referenced assignment attribute identifies a picklist. This is the picklist that 
appears when you click the drop-down arrow to the right of the list column cell.

The Assignment Attribute object type functions as an intermediary between the assignment criteria 
on the one hand and the assignment objects on the other, as shown in Figure 6 on page 58.

An assignment criteria attribute references an assignment attribute through its assignment attribute 
property. In turn, each of the assignment attribute�s child assignment attribute columns specifies an 
assignment object and a workflow policy component and column combination. 

An assignment attribute is a logical grouping of similar mappings to different assignment objects that 
can use the same picklist for value selection. For example, the Account State assignment attribute 
has several child assignment attribute column object definitions. Each of these assignment attributes 
is used for selection of the state in which an account is located, but five of them are used for different 
assignment objects (Activity, Account, Campaign Contact, and Order), and the other five are used 
for different account state attributes in the Opportunity assignment object (such as Primary Account 
State and Indirect Account Primary State).

NOTE: To generate a trigger based on an assignment attribute, a corresponding assignment 
attribute column must be configured. See �Mapping Assignment Attribute Columns to an Assignment 
Object and a Workflow Policy Component Column� on page 60. 

To create an assignment attribute

1 Start Siebel Tools.

2 In the Object Explorer, select the Assignment Attribute object.

TIP: If the Assignment Attribute object is not visible in the Object Explorer, you can enable it in 
the Development Tools Options dialog box (View > Options > Object Explorer).

Figure 6. Picklist for Populating an Attribute in a Value Record

This list column is based on 
an assignment attribute �

� in whose definition 
this picklist is specified.
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3 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

4 In the Assignment Attributes window, choose Edit > New Record and configure the assignment 
attribute object by setting values in the appropriate fields.

a In the Name field, type the name of the new assignment attribute.

b In the Project field, select a project.

c (Optional) If the attribute supports a range of values (such as revenue), check the Use Range 
field.

d In the Data Type field, select a data type for the attribute.

e (Optional) If you want a picklist for the attribute to allow users to select values for the 
assignment attribute, enter a value in the Picklist field.

f (Optional), Pick a field for the attribute to allow users to select values for the assignment 
attribute, enter a value in the Pick Field field.

For a description of these properties, see Table 9 on page 59.

5 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see �Updating Your 
Assignment Manager Deployment with New Configurations� on page 80.

Table 9 shows some of the properties of the Assignment Attribute object type.

Table 9. Assignment Attribute Properties

Property Description

Bounded When checked, the picklist is bounded (you can select a value from the picklist). 
When unchecked, you can enter a value that does not appear in the list.

Data Type Data type for the assignment attribute. Number, UtcDateTime, and Varchar are 
supported.

Name Name of the assignment attribute. Must be unique within the repository.

Order By LOV 
Type

Not used.

Pick Field Name of the field to select from the picklist.

Pick List Name of the picklist that supplies the selection values for populating any list 
column in the Values list (in the Assignment Criteria view) that is based on this 
assignment attribute.
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Enabling Assignment Attributes for MLOV
Multilingual List of Values (MLOV) capability allows assignment attributes to be stored in a form that 
can be retrieved and displayed in a variety of supported client languages. To enable assignment 
attributes for MLOV, use the following procedure.

To enable an assignment attribute for MLOV

1 Start Siebel Tools.

2 In the Object Explorer, select the Assignment Attribute object.

3 In the Assignment Attributes list, select the assignment attribute for which you want to enable 
MLOV.

4 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

5 Locate the Translate property for this attribute, and set the value to TRUE.

6 Locate the Translate Pick Field for the assignment attribute, and select from the Translate Pick 
Field dialog box the field in the Pick List Business Component that stores the Language 
Independent Code (in most cases this is the Name field).

7 Locate the Pick Field for the assignment attribute, and select from the Pick Field dialog box the 
field in the Pick List Business Component that stores the Display Value (in most cases this is the 
Value field).

You can also configure the application to enable MLOV for workload criteria, criteria values, and skills. 
For more information on configuring MLOVs, see Configuring Siebel Business Applications.

Related Topics
�About the Relationship Between Attributes and Skills� on page 75

Use Range Specifies whether a single list column or a pair of list columns, indicating a 
range, appears for assignment criteria attributes based on this assignment 
attribute. For example, the Revenue assignment attribute, which has a TRUE 
value for Use Range, appears as two list columns, Revenue Low and Revenue 
High. You can enter 50000 in the former and 100000 in the latter in a value 
record to indicate the range $50,000�100,000.

Translate When checked, enables MLOV (multilingual list of values) capability for the 
attribute. For more information on enabling this feature, see �Enabling 
Assignment Attributes for MLOV� on page 60.

Table 9. Assignment Attribute Properties

Property Description
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Mapping Assignment Attribute Columns to an 
Assignment Object and a Workflow Policy Component 
Column 
An assignment attribute column is a child object type of the Assignment Attribute object in Siebel 
Tools as shown in Figure 2 on page 48. The parent assignment attribute is an abstract logical attribute 
to test for a value match, and attribute columns provide mapping of assignment attributes to 
workflow policy component columns. Workflow policy component columns define the column and the 
table name from where Assignment Manager retrieves the data for the attribute from the database. 
The same assignment attribute can be used for different assignment objects. For example, consider 
the Account State criterion. You can apply this criterion to many assignment objects. For account 
objects, it means the physical state in which the account resides. For opportunity objects, it might 
be the state value for the accounts associated with a specific opportunity. In these instances, you 
define multiple assignment attribute columns for the Account State attribute and define the 
assignment object and the workflow policy component column to indicate where to get the data. 

An assignment attribute can have multiple attribute columns for the same assignment object. For 
example, for the Opportunity assignment object, Account City could either mean the primary city 
associated with the opportunity itself or the primary city associated with the account associated to 
the opportunity. In this instance, the Account City assignment attribute has two attribute column 
records for the Opportunity assignment object. You should also define the Sequence property on the 
assignment attribute column object. The sequence determines the order in which the data is 
retrieved in the event there are multiple attribute columns for the same attribute for the same 
assignment object.

An assignment attribute column object definition maps an assignment attribute to an assignment 
object and a workflow policy component column, as shown in Figure 3 on page 49. These mappings 
set up value matching within the assignment object and workflow policy object for criteria that use 
the parent assignment attribute.

The parent assignment attribute is an abstract logical attribute to test for a value match, which you 
can specify in an assignment criteria. The child assignment attribute columns specify the actual 
mappings to assignment objects and workflow policy component columns. Each assignment attribute 
column can specify a different assignment object to search, or a different attribute within the same 
assignment object.

This task is one step in �Process of Creating Assignment Criteria for Use in Assignment Rules� on 
page 56.

To map assignment attributes to an existing assignment object 

1 Start Siebel Tools.

2 In the Object Explorer, expand the Assignment Attribute object, and select the Assignment 
Attribute Column object.

3 In the Assignment Attributes window, select the assignment attribute for which you want to map 
the logical location in the database schema.

4 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.
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5 In the Assignment Attribute Columns window, choose Edit > New Record.

6 Configure the assignment attribute object by setting values in the appropriate fields.

a In the Name field, type the name of the new assignment attribute column.

b In the Assignment Object field, select an assignment object to which the assignment attribute is 
applied.

c In the Workflow Policy Component field, select a workflow policy component to which the 
workflow policy object is applied.

d In the Workflow Policy Component field, select a workflow policy component column to which the 
workflow policy component is applied.

e In the Sequence field, type in a sequence value.

For descriptions of these properties, see Table 10 on page 62.

7 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see �Updating Your 
Assignment Manager Deployment with New Configurations� on page 80.

Table 10 shows some of the properties of the Assignment Attribute Column object type.

Table 10. Assignment Attribute Column Properties

Property Description

Assignment Object Assignment object that is checked for a value match with the parent 
assignment attribute.

Name Name of the assignment attribute column. The typical format for the name 
is:

assignment_object: workflow_component_column

For example: 

Service Request: Account Area Code 

Sequence A unique sequence number for the assignment attribute column within the 
assignment attribute. If an assignment attribute has multiple assignment 
attribute columns, Assignment Manager searches for attribute values in the 
order of the values in this property.

Workflow Policy 
Component

Name of the workflow policy component, within the specified workflow policy 
object, with which this assignment attribute column is associated.

Workflow Policy 
Component Column

Name of the workflow policy component column, within the specified 
workflow policy component, with which this assignment attribute column is 
associated.

Workflow Policy 
Object

Name of the workflow policy object with which the assignment attribute 
column is associated. When an assignment object is selected, the workflow 
policy object defaults to this selection.
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Creating Assignment Criteria 
Assignment criteria define an object and are used in assignment criteria records in assignment rules. 
After you create and recompile an assignment criteria object definition in Siebel Tools, it becomes 
available for selection from the Criteria list column picklist in assignment criteria records in Siebel 
applications.

For static assignment, you use the Assignment Criteria object properties to specify the criteria name 
(internally and as displayed) and to configure skill tables. However, most of the behavior of 
assignment criteria is configured in the assignment criteria attribute children. For dynamic 
assignment, you use special team-based criteria. For more information about criteria for dynamic 
assignment, see �Examples of Dynamic Candidate Assignment� on page 159.

An assignment criteria can consist of one or more assignment attributes, such as the criteria Account 
City, Account State, and Account Country. These assignment attributes are grouped as assignment 
criteria. In this case, a single criterion, called a composite criterion, includes three assignment 
attributes. To add or change drop-down fields that define assignment criteria in an assignment rule, 
you should define or modify assignment criteria. Assignment criteria attributes enumerate 
assignment attributes for the assignment criteria.

The Criteria list column in an assignment criteria record specifies the assignment criteria that is 
tested for a match against one or more attributes of the assignment object or candidate. For 
example, in an assignment criteria that determines whether the state is California, the assignment 
item would be State, Home State, or Account State, and the value California (CA) would be specified 
in a child value record.

When you click the drop-down arrow button in the Criteria list column for an assignment rule, a 
picklist appears for selection of an assignment criteria. The picklist lists the available assignment 
criteria (assignment criteria object definitions in the repository). When you select an assignment 
criteria, its name is stored in the Criteria Name field in the current Assignment Rule business 
component record.

This task is one step in �Process of Creating Assignment Criteria for Use in Assignment Rules� on 
page 56.

To create assignment criteria

1 Start Siebel Tools.

2 In the Object Explorer, select the Assignment Criteria object.

3 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

4 In the Assignment Criteria window, choose Edit > New Record, and set values in the appropriate 
fields.

a In the Name field, type the name of the new assignment criteria.

b In the Project field, select the Assignment project.

c In the Display Name field, type the name that appears for the assignment criteria.
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d (Optional) If you want the assignment criteria stored in the skill table, check the Employee Skill 
field.

For information about skill tables, see �Enabling Assignment Objects for Skills� on page 77.

e (Optional) If you want expertise codes stored for the skill, check the Use Expertise field.

If you check this field, Assignment Manager uses expertise codes to match objects to 
candidates.

f (Optional) If you do not want the assignment criteria to appear in the Criteria picklist, uncheck 
the Display Flag field.

g If this is a team-based criterion, check the Team flag. In this case, you define only one criteria 
attribute record and you do not define any attribute columns for the assignment attribute. 

For more information about team-based criteria, see �Examples of Dynamic Candidate 
Assignment� on page 159.

For descriptions of these properties, see Table 11 on page 64. 

5 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see �Updating Your 
Assignment Manager Deployment with New Configurations� on page 80.

The assignment criteria object definition has two properties to specify the name (internally and as 
displayed) and two properties that are used to configure skill tables (Employee Skill and Use 
Expertise). Most of the behavior of an assignment criteria is configured in the assignment criteria 
attribute children. Table 11 shows some of the properties of the assignment criteria object type.

Table 11. Assignment Criteria Properties

Property Description

Display Flag A check mark indicates the assignment criteria appears in the Criteria picklist.

Display 
Name

Name that appears for this assignment criteria in the picklist and the Criteria list 
column in the Criteria list in the Criteria view (Assignment Rule> Criteria). If not 
specified, the value in the Name property is used instead.

Employee 
Skill

A TRUE/FALSE property that specifies whether the attribute is actually stored in the 
skill and skill item tables for the candidate or object. For more information about 
skill tables, see �Enabling Assignment Objects for Skills� on page 77.

Name Name of the assignment criteria.

Use 
Expertise

A TRUE/FALSE property that applies to assignment criteria that are skills. It 
specifies whether expertise codes are stored for the skill. If so, Assignment Manager 
uses the expertise code to match the assignment object to people. 
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Creating Assignment Criteria Attributes for Assignment 
Criteria 
An assignment criterion includes one or more assignment criteria attributes, stored as child 
assignment criteria attribute object definitions. Assignment criteria attributes are implemented as 
object definitions of the assignment criteria attribute object type. Assignment Criteria Attribute is a 
child object type of Assignment Criteria as shown in Figure 3 on page 49.

The set of assignment criteria attributes in an assignment criterion determines the set of list columns 
that appear in the Values list. One list column appears in the Values list for each assignment criteria 
attribute in the assignment criteria. In Siebel Tools, as Figure 7 shows, the Account Wildcard 
assignment criteria (the Account Name assignment criteria with a display name of Account Wildcard) 
has an Account Name and a Site Name list column in the display of its child Value records. Both the 
Account Name and Site Name list columns correspond to the Account Name assignment criteria 
attribute. 

If there were more assignment criteria attributes for this assignment criterion, each would have a 
list column in the Values list. The Score list column is automatically provided, and the Expertise Code 
list column appears in this instance because the assignment criteria has a Use Expertise property 
setting of TRUE. 

Composite Criteria
Assignment criteria attributes make it possible for a single assignment criterion to consist of multiple 
attributes, known as composite criteria.

For composite criteria, all the attributes must have a 1:1 relationship and should refer to the same 
base table record. For example, the Account City-State-Country is a good composite criterion 
because San Mateo (city) resides in the state of California (state) and California resides in the USA 
(country). All of these attributes are stored on the same record in the same table.

NOTE: It is not possible to create composite criteria with attributes based on different tables.

Figure 7. Assignment Criterion with Child Assignment Criteria Attributes

Account Name 
assignment criterion

Account Name assignment 
criteria attribute
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This task is one step in �Process of Creating Assignment Criteria for Use in Assignment Rules� on 
page 56.

To create an assignment criteria attribute

1 Start Siebel Tools.

2 In the Object Explorer, expand the Assignment Criteria object, and select the Assignment Criteria 
Attribute object.

3 In the Assignment Criteria window, select the assignment criteria for which you want to 
enumerate assignment attributes.

4 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

5 Select the Assignment Criteria Attributes window, then choose Edit > New Record.

6 Configure the assignment criteria attribute by setting values in the appropriate fields.

a In the Name field, type the name of the new assignment criteria attribute.

b In the Assignment Attribute field, select the assignment attribute for this assignment criteria.

c In the Display Name field, type the name for the assignment criteria attribute.

d In the Store Column field, specify the column in the assignment factor items table where the 
value for the assignment criteria attribute is stored.

e In the Display Sequence field, specify the sequence in which the assignment criteria attribute 
appears.

f (Optional) In the Pick Applet field, choose a pick applet for the assignment criteria attribute to 
allow users to view or select values for the assignment criteria attribute.

NOTE: For composite criteria, repeat Step 5 and Step 6 as many times as is necessary.

For more information on these properties, see Table 12 on page 66.

You also need to update the siebel.srf file and run various server administration tasks using the 
procedures in �Updating Your Assignment Manager Deployment with New Configurations� on page 80.

Table 12 shows some of the properties of the assignment criteria attribute object type.

Table 12. Assignment Criteria Attribute Properties

Property Description

Assignment 
Attribute

Name of the assignment attribute that this assignment criteria attribute is based 
on. Selected from a drop-down list.

Display Name List column label that appears for this assignment criteria attribute in the Values 
list. If omitted, the Name is used in the list column label.

Display 
Sequence

Order in which the list column for this assignment criteria attribute appears in 
the list applet, relative to those of other assignment criteria attributes in the 
assignment item. A lower number places the list column further to the left.
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Process of Using a Single Criterion for 
Multiple Objects
In some cases, you can create an assignment rule that assigns candidates to two or more objects 
while using only one of the object�s criteria. For example, you may want the ability to assign both 
accounts and opportunities based on the criteria Opportunity Lead Quality. To configure Assignment 
Manager to assign accounts based on this criteria, you must first configure and expose the 
Opportunity Lead Quality column to the Account assignment object using Siebel Tools. 

NOTE: The triggers for dynamic assignment are based on the workflow policy components and 
workflow policy component columns.

TIP: Assignment is based on data values in database fields. Therefore, configuration of the 
Assignment Attribute Column requires Workflow Policy Component and Workflow Policy Component 
Column information, and a Workflow Policy Component Column references a database table column.

Use the following process to create assignment rules that use a single criterion for multiple objects. 

1 �Creating a Workflow Policy Component for Two Objects� on page 68.

2 �Mapping a Column to the Workflow Policy Component� on page 68.

3 �Mapping the Workflow Policy Component to the Assignment Attribute� on page 69.

4 Define an assignment rule for two objects using one object�s criteria.

See �Process of Defining Assignment Rules� on page 86. 

For procedures using a specific example, see �Example of Using a Single Criterion for Two Objects� on 
page 69.

Name Name of the assignment criteria attribute, for identification. This name must be 
unique within the parent assignment criteria.

Pick Applet If a picklist is defined for the associated assignment attribute, you specify the 
name of a pick applet to display the picklist for selection of a value in the 
attribute�s list column.

Store Column Specifies the column in the assignment factor items table (S_ASGN_RULE_ITEM) 
in which to store the value for the assignment criteria attribute. There are four 
columns of each data type (Number, UtcDateTime, and Varchar) provided for 
storage of assignment criteria attribute values in each assignment criteria. You 
must specify a unique value, between 1 and 4 inclusive, for each assignment 
criteria attribute of the same data type. The data type can be determined from 
the Data Type property in the referenced assignment attribute object definition.

NOTE: You can have up to four assignment criteria attributes for each 
assignment criterion (a composite criterion can have a maximum of four 
attributes).

Table 12. Assignment Criteria Attribute Properties

Property Description
Siebel Assignment Manager Administration Guide Version 7.8 67



Basic Assignment Manager Configuration ■  Process of Using a Single Criterion for 
Multiple Objects
For more information about workflows in general, see Siebel Business Process Designer 
Administration Guide.

Creating a Workflow Policy Component for Two Objects
Use the following procedure to create a workflow policy component for two assignment objects.

This task is a step in �Process of Using a Single Criterion for Multiple Objects� on page 67.

To create a workflow policy component for two objects

1 Start Siebel Tools.

2 Select the workflow policy object for which you want to create a workflow policy component.

a In the Object Explorer, select Workflow Policy Object.

b In the Workflow Policy Objects window, select the object.

3 With the workflow policy object selected, choose Tools > Lock Project (or Alt+L) to lock the project. 

4 Add a new workflow policy component record.

a In the Object Explorer, expand Workflow Policy Component.

b In the Workflow Policy Component window, choose Edit > New Record.

5 Enter information in the fields for the new record using the following substeps:

a In the Name field, type the name of the workflow policy component.

b In the Source Table Name field, select the source table for the workflow policy component.

c In the Source Column Name field, select the source column for the workflow policy component.

d In the Target Component Name field, select the target component for the workflow policy 
component.

e In the Target Column Name field, select the target column for the workflow policy component.

Mapping a Column to the Workflow Policy Component 
After you create the workflow policy components for both objects, you need to map the workflow 
policy component to the assignment criteria. You do this by mapping a column to one of the workflow 
policy components.

This task is a step in �Process of Using a Single Criterion for Multiple Objects� on page 67.

To map a column to the workflow policy component

1 With the new record still selected, expand the Workflow Policy Component object in the Object 
Explorer, and then select the Workflow Policy Component Col object.

2 In the Workflow Policy Component Columns window, choose Edit > New Record.

3 In the Workflow Column Name field, select the workflow column for the workflow policy 
component.
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Mapping the Workflow Policy Component to the Assignment Attribute
After you map a column to the workflow policy component, you map the workflow policy component 
to the assignment attribute.

This task is a step in �Process of Using a Single Criterion for Multiple Objects� on page 67.

To map the workflow policy component to the assignment attribute

1 In the Object Explorer, expand the Assignment Attribute object, and then select the Assignment 
Attribute Column object.

2 In the Assignment Attribute Columns window, choose Edit > New Record.

3 Enter information in the fields for the new record using the following substeps:

a In the Name field, type the name of the assignment attribute column.

b In the Assignment Object field, select the assignment object to which candidates are assigned 
for the assignment rule.

c In the Workflow Policy Component field, select the workflow policy component to map to this 
assignment attribute.

d In the Workflow Policy Component Column field, select the workflow policy component column 
to map to this assignment attribute.

e In the Sequence field, specify the sequence of this assignment attribute.

4 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see �Updating Your 
Assignment Manager Deployment with New Configurations� on page 80.

NOTE: You must recompile the siebel.srf file whenever you add, inactivate, or delete any 
assignment object types, assignment criteria, and assignment attributes. Make sure all projects 
are recompiled�not only the locked projects�if you inactivate or delete a top-level object type 
or assignment criteria. For more information on when to recompile the siebel.srf file, see 
�Updating Your Assignment Manager Deployment with New Configurations� on page 80.

Example of Using a Single Criterion for 
Two Objects
This topic gives one example of configuring Assignment Manager to assign candidates to two 
objects�Account and Opportunity� using only one of the object�s criteria, Opportunity Lead Quality. 
You may use this feature differently, depending on your business model.

The example is divided into the following procedures; perform each procedure in the order provided.

1 �Creating a Workflow Policy Component Using the Account and Opportunity Objects� on page 70

2 �Mapping the Opportunity Workflow Policy Component to the Opportunity Lead Contact Assignment 
Criteria� on page 71
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3 �Mapping the Account/Opportunity Workflow Policy Component to the Lead Quality Code Assignment 
Attribute� on page 71

Creating a Workflow Policy Component Using the Account and 
Opportunity Objects
Use the following procedure to create a workflow policy component for two assignment objects.

To create a workflow policy component using the Account and Opportunity objects

1 Start Siebel Tools.

2 Select the workflow policy object for which you want to create a workflow policy component.

a In the Object Explorer, select Workflow Policy Object.

b In the Workflow Policy Objects window, select the object.

For this example, select Account.

3 With the Account assignment object selected, choose Tools > Lock Project (or Alt+L) to lock the 
project. 

4 Add a new workflow policy component record.

a In the Object Explorer, expand Workflow Policy Component.

b In the Workflow Policy Component window, choose Edit > New Record.

5 Enter information in the fields for the new record using the following steps:

a In the Name field, type the name of the workflow policy component.

For this example, type Account/Opportunity.

b In the Source Table Name field, select the source table for the workflow policy component.

For this example, select S_OPTY.

c In the Source Column Name field, select the source column for the workflow policy component.

For this example, select PR_DEPT_OU_ID.

d In the Target Component Name field, select the target component for the workflow policy 
component.

For this example, select Account.

e In the Target Column Name field, select the target column for the workflow policy component.

For this example, select ROW_ID. 
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Mapping the Opportunity Workflow Policy Component to the 
Opportunity Lead Contact Assignment Criteria
After you create the workflow policy components for both objects, you need to map the workflow 
policy component to the assignment criteria. You do this by mapping a column to one of the workflow 
policy components. In this example, you map the Opportunity workflow policy component to the 
Opportunity Lead Contact assignment criteria.

To map a column to the workflow policy component

1 With the Account/Opportunity record still selected, expand the Workflow Policy Component 
object in the Object Explorer, and then select the Workflow Policy Component Col object.

2 In the Workflow Policy Component Columns window, choose Edit > New Record.

3 In the Workflow Column Name field, select the workflow column for the workflow policy 
component.

For this example, select Opportunity Lead Quality.

Mapping the Account/Opportunity Workflow Policy Component to the 
Lead Quality Code Assignment Attribute
After you map a column to the workflow policy component, you map the workflow policy component 
to the assignment attribute. In this example, you map the Account/Opportunity workflow policy 
component to the Lead Quality Code assignment attribute.

To map the workflow policy component to the assignment attribute

1 In the Object Explorer, select the Assignment Attribute object.

2 In the Assignment Attributes window, select Lead Quality Code.

3 In the Object Explorer, expand the Assignment Attribute object and select the Assignment 
Attribute Column object.

4 In the Assignment Attribute Columns window, choose Edit > New Record.

5 Enter information in the fields for the new record as described in the following substeps:

a In the Name field, type the name of the assignment attribute column.

For this example, type Account: Lead Quality.

b In the Assignment Object field, select the assignment object to which candidates are assigned 
for the assignment rule.

For this example, select Account.

c In the Workflow Policy Component field, select the workflow policy component to map to this 
assignment attribute.

For this example, select Account/Opportunity.
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d In the Workflow Policy Component Column field, select the workflow policy component column 
to map to this assignment attribute.

For this example, select Opportunity Lead Quality.

e In the Sequence field, specify the sequence of this assignment attribute.

For this example, type 2.

6 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see �Updating Your 
Assignment Manager Deployment with New Configurations� on page 80.

NOTE: You must recompile the siebel.srf file whenever you add, inactivate, or delete any 
assignment object types, assignment criteria, and assignment attributes. Make sure all projects 
are recompiled�not only the locked projects�if you inactivate or delete a top-level object type 
or assignment criteria. For more information on when to recompile the siebel.srf file, see 
�Updating Your Assignment Manager Deployment with New Configurations� on page 80.

Figure 8 shows an example of defining an assignment rule for the Account and Opportunity objects 
using only the Lead Quality Code assignment criteria. 

Figure 8 shows:

■ An Account Opportunity assignment rule using the Opportunity and Accounts objects and One, 
Best Fit assignee filter

NOTE: Only the Opportunity object appears in the Objects to be Assigned field even though the 
Accounts object is also assigned.

■ The Account Opportunity assignment rule has the Lead Quality Code rule criterion applied and 
uses the Compare to Person comparison method, the Include inclusion method, and is always 
required

Figure 8. Example of Defining an Assignment Rule for Two Objects Using One Assignment Criteria
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Disabling Assignment Attributes
In some cases, you may want to eliminate assignment criteria that appear in the Assignment Criteria 
view. To do so, you need to remove the unwanted criteria from the Assignment Criteria view. if you 
want to prevent the criteria from being used in any rule, you must use Siebel Tools to also disable 
the corresponding assignment attribute, assignment attribute column, assignment criteria, and 
assignment criteria attribute object definitions.

Use the following procedure to disable an assignment attribute and avoid further use.

To disable an assignment attribute

1 In the UI, delete criteria you want removed from any assignment rules.

For a procedure, see �Removing Assignment Criteria from Assignment Rules� on page 111.

2 Start Siebel Tools.

3 Disable the assignment attribute definition.

a In the Object Explorer, select the Assignment Attribute object.

b Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

c In the Assignment Attributes window, select the assignment attribute you want to disable.

d Check the Inactive field.

4 Disable the assignment attribute column definition.

a In the Object Explorer, expand the Assignment Attribute object, and then select the Assignment 
Attribute Column object.

b In the Assignment Attribute Columns window, select the assignment attribute column you want 
to disable.

c Check the Inactive field.

5 Disable the assignment criteria definition.

a In the Object Explorer, select the Assignment Criteria object.

b In the Assignment Criteria window, select the assignment criteria you want to disable.

c Check the Inactive field.

6 Disable the assignment criteria attribute definition.

a In the Object Explorer, expand the Assignment Criteria object, and then select the Assignment 
Criteria Attribute object.

b In the Assignment Criteria Attributes window, select the assignment criteria attribute you want 
to disable.

c Check the Inactive field.
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7 Recompile all projects (not just the locked projects) in the .srf file. 

For instructions, see Step 1 on page 81 of the �Updating Your Assignment Manager Deployment 
with New Configurations.�

About Inactive Assignment Manager 
Workflow Policy Components
Table 13 shows the Workflow Policy Components that are by default inactive for the Opportunity 
Workflow Policy Object for Assignment Manager.

If these Workflow Policy Components are required for your deployment, activate the components by 
following the procedures that describe defining a Workflow Policy Component in Siebel Business 
Process Designer Administration Guide.

Table 13. Inactive Assignment Manager Workflow Policy Components

Workflow Policy 
Object Workflow Policy Component

Opportunity Indirect Account

Opportunity Indirect Account Address

Opportunity Indirect Account Industry

Opportunity Indirect Account Primary Address

Opportunity Indirect Account Synonym

Opportunity Indirect Account/Industry

Opportunity Opportunity/Indirect Account

Opportunity Primary Account Address
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About the Relationship Between 
Attributes and Skills
When you define an assignment criterion, the data Assignment Manager uses for matching the object 
and candidate can come from two different types of sources, either attributes or skills. 

■ Attribute. An attribute is data that usually resides on a column on the base table. For example, 
Employee Salary resides on a column in the S_EMP_PER employee table and is an attribute. 
Similarly, Service Request Severity is an attribute on the Service Request object, because it is 
stored on the Service Request record.

Some attributes exist outside the base table. For example, Account Zip Code is an attribute on 
the account, but does not exist on the Account table itself. Instead, Account Zip Code exists on 
the common address table known as S_ADDR_ORG. It does not exist on the account table. 
However, there is a link between a given account record and all the addresses that belong to it.

■ Skill. Skills are row-level extension attributes to objects (Opportunities, Service Requests, and 
so on) and candidates (employees, positions and organizations). These are data stored in special 
child and grandchild tables of the base tables known as skill and skill item tables. For example, 
Language is an employee skill defined in the S_EMP_SKILL employee skill table and the 
S_EMP_SK_IT employee skill item table. The S_EMP_SK_IT table is actually a child table of the 
S_EMP_SKILL table. You can define skill and skill item tables for every assignment object through 
properties using Siebel Tools. 

Skills and skill items are defined in a similar manner to criteria and criteria values. If an employee 
has expertise for two products, Product A and Product B, you define one skill (Product) and define 
two skill items under the same skill (Product A and Product B). Skills provide a way to create new 
attributes for a candidate or an object without extending the database schema. 

Objects also have skill and skill items. For example, you can define a Product skill with a Product 
A skill item for an activity to indicate that candidates must have the same product skill for 
assignment to that activity.

■ Attribute and skill. Data could reside on an object or a candidate in the form of an attribute 
and a skill. For example, you can link an opportunity to a product using either of the following: 

■ Products subtab and associating the product to the opportunity

■ Skills subtab and creating a product skill and a skill item for the product you want to associate

When matching assignment criteria, Assignment Manager looks for column-based attributes first, 
and if they are not found, Assignment Manager looks for a skill value in designated skill tables.

For example, if you have an assignment rule using an Account State criteria and the Compare Object 
to Person comparison method, Assignment Manager processes the rule in the following order:

1 Assignment Manager checks the assignment object. 

If the object to be assigned is the Opportunity assignment object, Assignment Manager checks 
the value specified in Assignment Criteria > Assignment Criteria Attribute in Siebel Tools. Then, 
Assignment Manager checks the Assignment Attribute > Assignment Attribute Column value for 
the Opportunity object. In our case, this is Opportunity: Primary Account Primary State.
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2 Assignment Manager checks the criteria attributes.

Since Opportunity is a team- and position-based, Assignment Manager checks the value specified 
in Assignment Criteria > Attribute in Siebel Tools. From the Attribute, Assignment Manager then 
checks the Assignment Attribute Column for that assignee, which in our case is Position: State.

3 If no Assignment Attribute Column exists for the person chosen, then Assignment Manager 
checks the Skills table.

Assignment Manager evaluates criteria by comparing two strings, numbers, or dates using a 
comparison method. One of these literals sets the requirement, and the other literal must match the 
first literal for the criterion to pass. 

Table 9 shows an example of a sales assignment rule and how position, skills, and skill items relate 
to that rule. 

Viewing Predefined Skills
The Siebel application provides several predefined skills. The predefined skills for Assignment 
Manager are:

■ Language Code

■ Product Id

■ Product Line Id

■ Product Line Name

■ Product Name

Figure 9. Example of a Relationship Between Assignment Criteria and Skills for a Sales 
Implementation
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■ Revenue

For most deployments, the predefined skills are sufficient. However, you can create new skills using 
Siebel Tools. For more information about creating new skills, see �Creating New Skills� on page 244.

To view predefined skills

1 Start Siebel Tools.

2 In the Object Explorer, click to select the Assignment Criteria object.

3 In the Assignment Criteria applet, query for criteria with Employee Skill equal to TRUE.

The predefined skills appear as well as any new skills you have created.

Enabling Assignment Objects for Skills
Assignment Manager uses skills to compare an object being assigned directly to person or other 
assignee�s expertise when processing assignment rules. Assignment Manager criteria and skills are 
related transparently in the Siebel Data Model. Skills are extensions to attribute data stored in 
designated skill and skill item tables. At a very high level, you can think of an assignment criterion 
as a skill, and each criteria value as a skill item, as shown in Figure 10. 

The Skill Table and Skill Item Table properties are child and grandchild tables, respectively, of the 
assignment object used to store skills, and skill items for assignment objects that are not stored as 
columns in the parent table itself. The S_EMP_SKILL employee skill table is used to store skills 
possessed by employees, such as languages spoken, product expertise, and so on. For example, for 
an employee who speaks English and Spanish, there is one record in the employee skill table that 
specifies the skill name as Language. There are also two records in the child S_EMP_SK_IT employee 
skill item table that correspond to this skill record: one record for English, and another record for 
Spanish.

Figure 10. Assignment Criteria and Skills Comparison
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There are several objects preconfigured for skills�Account, Activity, Campaign, Employee, 
Opportunity (Revenue), Service Request, and so on. By default, sales objects do not use skills. Using 
Siebel Tools, you enable skills for other assignment objects by configuring the object�s Skill Table and 
Skill Item Table properties.

NOTE: Before enabling skills for an assignment object, make sure the Skill Table assignment object 
property exists in the Siebel data model.

To enable assignment objects for skills

1 Start Siebel Tools.

2 Select the assignment object for which you want to enable skills.

a In the Object Explorer, click Workflow Policy Object, and then in the Workflow Policy Objects list, 
query for an object.

b In the Object Explorer, click Assignment Object.

3 Lock the project for the assignment object by choosing Tools > Lock Project (Alt+L).

A pencil icon appears next to the Name field to indicate that the object�s project is locked.

4 In the Assignment Objects list (or Properties window), enter values for the fields in the following 
table.

NOTE: Choose the table name from the drop-down menu. This LOV (list of values) is derived 
from tables specified in the Siebel repository.

5 Set the Employee Skill assignment criteria property to TRUE.

a In the Object Explorer, select Assignment Criteria.

b In the Assignment Criteria list, select the object you selected in Step 2.

c Set the Employee Skill property to TRUE.

Field Description

Skill Item Table The name of the skill item table.

Skill Table The name of the skill table.
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Example of Enabling an Assignment 
Object for Skills
This topic gives one example of enabling skills for an assignment object. You may use this feature 
differently, depending on your business model.

The following procedure explains how to enable skills for the Service Request assignment object.

To enable skills for the Contact assignment object

1 Start Siebel Tools.

2 Select the assignment object for which you want to enable skills.

a In the Object Explorer, click Workflow Policy Object, and then in the Workflow Policy Objects list, 
query for Contact.

b In the Object Explorer, click Assignment Object.

3 Lock the project for the Contact assignment object by choosing Tools > Lock Project (Alt+L).

A pencil icon appears next to the Name field to indicate that the object�s project is locked.

4 In the Assignment Objects list (or Properties window), enter values for the fields in the following 
table.

Field Description

Skill Table S_CON_SKILL

Skill Item Table S_CON_SKILL_IT
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Updating Your Assignment Manager 
Deployment with New Configurations
After configuring Assignment Manager objects and attributes or altering assignment policies, it is 
often necessary to recompile the .srf file and restart various server components and tasks. Table 14 
required server tasks and components that must be restarted based on the type of configuration 
process.

NOTE: You must recompile the siebel.srf file whenever you add, inactivate, or delete any assignment 
object types, assignment criteria, and assignment attributes. Make sure all projects are recompiled�
not only the locked projects�if you inactivate or delete a top-level object type or assignment criteria. 

NOTE: For information about checking out and checking in objects, see Using Siebel Tools.

Use the following procedure to update your deployment with new configurations.

CAUTION: Some steps in the following procedure may not be required for your particular 
deployment. Follow the steps as they apply (or do not apply) to the configuration process performed 
as shown in Table 14 on page 80.

Table 14. Summarization of Server Administration After Configuring Assignment Manager

Configuration Process
Compile 
.srf File

Restart 
Assignment 
Manager

Regenerate 
Triggers

Restart 
Workflow 
Monitor Agent1

1. Only for dynamic assignment.

Add or inactivate assignment objects Yes Yes Yes Yes

Configure assignment objects No Yes Yes Yes

Add, configure, or inactivate 
assignment attributes

Yes Yes Yes Yes

Configure assignment attribute 
columns

No Yes Yes Yes

Add, configure, or inactivate 
assignment criteria

Yes Yes Yes Yes

Add, configure, or inactivate 
assignment criteria attributes

Yes Yes Yes Yes

Activate, inactivate, or modify 
assignment policies

No No Yes Yes
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Deployment with New Configurations
To update your deployment with new configurations

1 Compile changes to the siebel.srf file, if necessary, and deploy it to the server.

a Choose Tools > Compile Projects.

b In the Object Compiler dialog box, select the project (or projects) you want to compile.

c Select the Siebel client repository file (default is siebel.srf) located in the Objects subdirectory 
within the Siebel client root directory.

d Click Compile.

For more information on when to recompile the siebel.srf file, see Table 14 on page 80 and Using 
Siebel Tools. For information on distributing the siebel.srf file, see Siebel Anywhere 
Administration Guide.

NOTE: It is not necessary to recompile the siebel.srf file whenever you configure an assignment 
object or an assignment attribute column, but you must recompile the siebel.srf file whenever 
you add, inactivate, or delete any assignment object types, assignment criteria, or assignment 
attributes.

Make sure all projects are recompiled�not only the locked projects�if you inactivate or delete 
a top-level object type or assignment criteria. 

2 If you are running dynamic assignment, perform the following steps:

a Stop the Workflow Monitor Agent server component.

b Regenerate triggers by running the Generate Triggers server component.

c Release assignment rules (if rules have changed) by clicking Release in the Assignment Rules 
view.

For more information on releasing assignment rules, see �Releasing Assignment Rules� on 
page 153.

d Restart the Workflow Monitor Agent server component. 

For more information on stopping and restarting server components, see Siebel System 
Administration Guide.

3 If your are running dynamic assignment, stop and restart the Assignment Manager server 
component for the changes to take effect.

a Stop the Workflow Monitor Agent server component.

b Stop the Assignment Manager server component.

c Start the Assignment Manager server component.

d Start the Workflow Monitor Agent server component.

For more information on stopping and restarting server components, see Siebel System 
Administration Guide.

You must stop and restart the Assignment Manager server component whenever you add, inactivate, 
or delete any assignment object types, assignment criteria, or assignment attributes.
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6 Assignment Rule Administration
This chapter explains how to define assignment rules for Siebel Assignment Manager. The tasks 
explained in this chapter are for Assignment Administrators (AAs), and as such, the procedures are 
documented using the Administration - Assignment screen and views.

NOTE: Even if you intend to use predefined assignment objects, you must define assignment rules 
by completing the tasks in this chapter. 

This chapter includes the following topics:

■ �About the Assignment Manager Administration Views� on page 84

■ �Before Defining Assignment Rules� on page 85

■ �Process of Defining Assignment Rules� on page 86

■ �Creating Assignment Rule Groups� on page 88

■ �About Some of the Assignment Rule Fields� on page 90

■ �Creating Assignment Rules� on page 94

■ �About Assignment Criteria� on page 98

■ �Assignment Criteria Comparison Methods� on page 98

■ �Assignment Criteria Inclusion Methods� on page 99

■ �About Assignment Scoring� on page 101

■ �About the Required Field for Assignment Criteria� on page 102

■ �Process of Adding Criteria and Values to Assignment Rules� on page 104

■ �Defining Assignment Rules to Use a Single Criterion for Multiple Objects� on page 110

■ �Removing Assignment Criteria from Assignment Rules� on page 111

■ �About Assignment Skills, Expertise Codes, and Weighting Factors� on page 112

■ �Process of Defining Criteria Values as Skills with Expertise Codes and Weighting Factors� on 
page 114

■ �Example of Using Assignment Skills in Assignment Rules� on page 119

■ �Adding Employees, Positions, and Organizations to Assignment Rules� on page 120

■ �Choosing a Candidate as the Primary Assignee� on page 123

■ �Associating Skills with Employees, Positions, and Organizations� on page 124

■ �How Assignment Manager Balances Workload Among Candidates� on page 125

■ �Process of Defining Assignment Workload� on page 127

■ �Assignment Methodology and Examples for Creating Assignment Rules� on page 133
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■ �About Assignment Policies� on page 143

■ �Process of Defining Assignment Policies for Dynamic Assignment� on page 144

■ �Deactivating Assignment Policies to Disable Dynamic Assignment� on page 146

■ �How Assignment Manager Determines the Sequence in Which Rules Are Evaluated� on page 147

■ �Adding a Sequence Number to Assignment Rules� on page 149

■ �How Assignment Manager Uses Server Key Maps to Load Rules to a Particular Siebel Server� on 
page 149

■ �Defining Server Key Maps for Assignment Rule Groups� on page 151

■ �Generating Assignment Reports� on page 152

■ �Preparing to Release Assignment Rules� on page 153

■ �Releasing Assignment Rules� on page 153

■ �About Migrating Assignment Rules� on page 154

About the Assignment Manager 
Administration Views
Assignment Manager functionality is administered with two administration screens, Administration - 
Assignment and Administration - Delegated Assignment. 

Administration - Assignment Screen
Assignment administrators (AAs) uses the assignment administration views (Navigate > Site Map > 
Administration - Assignment) to create and administer assignment rules and perform the following 
tasks:

■ Create assignment rules 

■ Associate assignment rules to appropriate rule groups (or the Default Rule Group)

■ Apply criteria to assignment rules

■ Apply business-defined candidates to assignment rules 
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Territories List View
Within the Administration - Assignment screen, there is Territories List view, which was originally 
designed for sales organizations. However, this view functions exactly as the Assignment Rule List 
and Assignment Criteria views. The Territory List view has been simplified to allow users to define 
their sales territories. For this reason, some of the assignment options covered in this guide do not 
appear in the Territory List view. 

NOTE: The Territory List view may eventually be phased out from the assignment administration 
screens. If your current configuration uses these views, they can migrate to the existing assignment 
views with no loss of functionality or data. For further information about Territory views, contact 
Siebel Technical Support. 

TIP: The Territories List view has no relationship with the Territory Management screen and views. 
The data shown for each differs and how the data is used differs.

Administration � Delegated Assignment Screen
Delegated administrators (DAs) use the delegated assignment administration views (Navigate > Site 
Map > Administration - Delegated Assignment) to inherit and refine assignment rules and perform 
the following tasks:

■ Inherit assignment rules and further specify assignment rule behavior and candidates

■ Choose to delegate rule responsibility by creating child rule groups and making rules inheritable 
to the owners of those child rule groups

■ DAs lower in the hierarchy can then inherit the refined rules, modify them, or choose to further 
delegate. 

NOTE: Delegation and inheritance can go many levels deep within a single hierarchy.

In the Administration � Delegated Assignment screen, rule group owners have visibility for their rule 
groups (and subtrees). AAs also have visibility for rules only in their organizations but have 
unrestricted access to rule administration within those organizations.

For more information about delegated assignment, see Chapter 8, �Assignment Rule Administration 
for Delegated Assignment.�

Before Defining Assignment Rules
There are several preparatory tasks you should perform before using Assignment Manager and 
creating your assignment rules.

Before defining your assignment rules, you should:

1 Review the Assignment Manager planning guidelines and best practice information. See 
Chapter 4, �Planning Your Assignment Manager Implementation.�

2 Have a good understanding of how Assignment Manager assigns candidates to assignment 
objects. See �Assignment Methodology and Examples for Creating Assignment Rules� on page 133.

3 Modify assignment object property settings to suit your business requirements using Siebel 
Tools. See �Configuring Assignment Object Properties� on page 51.
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Process of Defining Assignment Rules
The process of defining assignment rules varies depending on how much you reconfigure or 
customize Assignment Manager. This section provides a typical process flow for defining and 
releasing assignment rules that you can use as a guide. Your process may differ, depending on your 
business model.

Figure 11 provides a sample process flow for defining and releasing assignment rules.

Figure 11. Sample Process Flow for Defining and Releasing Assignment Rules
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Table 15 lists the various tasks you perform when defining new assignment rules. The steps represent 
a typical order of execution when defining a new assignment rule, however, many tasks are optional 
and may not be applicable for your deployment.

Table 15. Administrative Tasks for Defining Assignment Rules

Task Required

1 �Creating Assignment Rule Groups� on page 88

NOTE: You must apply a rule group to each assignment rule. If you do not want 
to define your own rule groups, you can use the predefined rule groups or the 
Default Rule Group.

X

2 �Creating Assignment Rules� on page 94 X

3 �Adding Assignment Criteria to Assignment Rules� on page 104 

4 �Adding Criteria Values to Assignment Criteria� on page 108
or
�Adding Criteria Values as Skills to Assignment Rules Using Expertise Codes� on 
page 116

5 �Adding Employees, Positions, and Organizations to Assignment Rules� on page 120

6 �Adding Dynamic Candidate Teams to Assignment Rules� on page 170

NOTE: The assignment seed data provides two dynamic candidate teams: Activity 
Account Team and Activity Asset Team. There is no organization dynamic team 
seed data provided. You may need to configure your own teams according to your 
business needs.

7 �Choosing a Candidate as the Primary Assignee� on page 123

8 �Associating Skills with Employees, Positions, and Organizations� on page 124

9 �Creating Assignment Workload Distribution Rules� on page 128

10 �Applying Assignment Workload Distribution to Employees, Positions, and 
Organizations� on page 130

11 (Optional) �Process of Defining Assignment Policies for Dynamic Assignment� on 
page 144
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Creating Assignment Rule Groups
This topic explains how to create new assignment rule groups using the assignment administration 
views. 

This task is a step in �Process of Defining Assignment Rules� on page 86.

About Assignment Rule Groups
An assignment rule group is a logical grouping of assignment rules, and assignment rules are logical 
business boundaries associated with individuals or a team of people to achieve a business goal. 
Assigning rule groups to assignment rules allows you to partition rules based on organizational or 
corporate goals, or some other grouping, such as email response. Table 16 provides sample rule 
groups and their descriptions.

You can set up Assignment Manager to process only specific assignment rule groups and not others. 
See �How Assignment Manager Uses Server Key Maps to Load Rules to a Particular Siebel Server� on 
page 149.

Prerequisites
Before applying rule groups to your assignment rules based on your particular business needs, you 
should:

■ Decide whether you want to use rule groups.

Create rule groups if you want a separate set of assignment rules that you can apply to different 
business scenarios. Alternatively, you do not need to create rule groups if you want all rules 
processed every time you run Assignment Manager. In this case, use the Default Rule Group that 
is provided as part of the Assignment Manager seed data. 

■ Decide whether you need rule group hierarchies 

If you plan to use delegated assignment, you need rule group hierarchies.

Table 16. Sample Rule Groups

Assignment Rule 
Group Name Description

North America-USA Assignment rules related to USA are associated with the North America-USA 
rule group.

Service Products Assignment rules related to service products are associated with a single rule 
group.

Email Response 
Group

Assignment rules related to email response are associated with a single rule 
group.
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For more information about the Default Rule Group, see the description for assignment rule groups 
in �Essential Assignment Manager Building Blocks� on page 24. For more information about delegated 
assignment and rule group hierarchies, see Chapter 8, �Assignment Rule Administration for Delegated 
Assignment.�

To create an assignment rule group

1 From the application-level menu, choose Navigate > Site Map > Administration - Assignment > 
Rule Groups List.

2 In the Rule Groups List list, click New.

3 In the new record, click in the available fields to enter relevant information.

The new rule group appears in the Rule Group List as well as in the Rule Group Explorer.

Table 17 shows the predefined fields.

TIP: All fields may not be visible in the initial view. Use the Columns Displayed feature to make 
fields visible (right-click, select Columns Displayed, use the arrows to move a field from Available 
Columns to Selected Columns, and then click Save).

Table 17. Assignment Rule Group Fields

Field Description

Name Name of the assignment rule group.

Parent Rule 
Group

A rule group that appears directly above another rule group in the hierarchy.

Owner Position The owner of the rule group. Each rule group has an owner (and potentially 
designees who also have owner rights). 

For more information about owners and designees as it relates to delegated 
assignment, see �About Assignment Rule Group Hierarchy� on page 176.

Owner Login The login of the owner position. The owner position has visibility from the 
delegated administration views for rule groups and each of the child rule groups.

Activation Start date of the assignment rule group. 

By default, rules within a group inherit the activation date from the group date. 
However, if you specify an activation date for a particular rule, it overrides that 
date.

NOTE: By default, Siebel applications use the Universal Time Coordinated (UTC) 
standard. For more information about UTC, see Global Deployment Guide. 
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If you plan to use delegated assignment, see also �Creating Child Assignment Rule Groups� on 
page 180.

About Some of the Assignment Rule 
Fields
The subtopics in this section provide detailed descriptions of the following assignment rule fields:

■ �Assignee Filter Field� on page 91

■ �Candidates Source Fields� on page 91

■ �Check Employee Calendar Field� on page 93

■ �Exclusive Field� on page 94

Expiration End date of the assignment rule group. 

By default, rules within a group inherit the expiration date from the group date. 
However, if you specify an activation date for a particular rule, it overrides that 
date.

NOTE: By default, Siebel applications use the Universal Time Coordinated (UTC) 
standard. For more information about UTC, see Global Deployment Guide. 

Key Based Indicates the rule group is intended for key-based routing and usually has a 
corresponding server key mapping.

By checking this flag, even if there is no server key mapping defined for the rule 
group, this makes sure that the rules that belong to this rule group are not 
processed when running the assignment server in default mode.

NOTE: The Key Based field may be a hidden column on the Assignment Rule 
Groups list. You can enable the Key Based field by selecting it through the 
Columns Displayed feature.

For more information about key-based routing and server key maps, see �How 
Assignment Manager Uses Server Key Maps to Load Rules to a Particular Siebel 
Server� on page 149.

Organization The organization in which this rule group belongs.

Table 17. Assignment Rule Group Fields

Field Description
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Assignee Filter Field
The value in the Assignee Filter field of an assignment rule determines how candidates are evaluated 
as potential assignees to the object. Table 18 shows the filters used by Assignment Manager to 
determine which potential assignees are assigned to the object for each assignment rule.

NOTE: If you do not use scores, the candidate passing score on the assignment rule and all 
qualifying candidate scores are treated as zero. Therefore, every qualifying candidate (every 
candidate that passes all required criteria) is assigned depending on the assignee filter.

Candidates Source Fields
For each assignment rule, the administrator determines whether Assignment Manager takes 
candidates directly from the assignment rule (statically) or dynamically from the object row by 
indicating the candidate source. 

There are two candidate source fields:

■ �Person Candidates Source Field� on page 91

■ �Organization Candidates Source Field� on page 92

Person Candidates Source Field

■ From Rule. The candidates are the people (positions and employees) defined for an assignment 
rule and are statically assigned. This is the default value for person candidates.

■ All People. The candidates are all the people (positions and employees) in the database and are 
statically assigned.

Table 18. Assignee Filter Field Values

Assignee Filter Description

All, Above Minimum Use assignees with an assignment score greater than or equal to the 
assignment rule�s candidate passing score. Assigns one or more 
assignees.

All, Must Assign Same as the All, Above Minimum value, except that the highest-scoring 
candidate is a potential assignee even if all candidates fail to meet the 
candidate passing score. Assigns one or more assignees.

One, Best Fit Use the highest-scoring assignee with an assignment score greater than 
or equal to the candidate passing score. Assigns one assignee.

One, Random Choose a random assignee whose score is greater than or equal to the 
candidate passing score required for this assignment rule. Assigns one 
assignee.
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■ Teams. The candidates are the person dynamic candidate teams (positions and employees) you 
define in Siebel Tools. In Siebel Tools, you choose either positions or employees as the value of 
the Team Type property in the Dynamic Candidate object to indicate that the person candidates 
for the assignment rule should come dynamically from the relevant attribute on the object row. 
Two teams�Activity Account Team and Activity Asset Team�are provided as seed data, but you 
can add your own teams using Siebel Tools. In addition, several teams are predefined for use 
with territory management.

Organization Candidates Source Field
■ From Rule. The candidates are the organizations defined for an assignment rule and are 

statically assigned. This is the default value for organization candidates.

■ All Organizations. The candidates are all the organizations in the database and are statically 
assigned.

■ Teams. The candidates are the organization dynamic candidates teams you define in Siebel 
Tools. In Siebel Tools, you choose organization as the value of the Team Type property in the 
Dynamic Candidate object to indicate that organization candidates for the assignment rule should 
come dynamically from the relevant attribute on the object row. There is no organization dynamic 
team seed data provided; you need to configure your own teams according to your business 
needs.
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For dynamic candidates teams, the value (employee, position, or organization) of the Team Type 
property of the Dynamic Candidate object in Siebel Tools determines what appears in the candidates 
source LOV fields in the assignment rule as shown in Figure 12.

Check Employee Calendar Field
For each assignment rule, the administrator can designate whether Assignment Manager checks the 
employees� calendars when determining assignment eligibility. By checking the Check Employee 
Calendar field in the Assignment Rules List view, Assignment Manager checks for employee 
availability.

This feature is used only for employee-based assignment objects, and requires the installation of the 
Siebel Field Service application as it depends on a field service component, the Appointment Booking 
System. You must first configure the Activity and Service Request assignment objects using Siebel 
Tools before this feature is available. For more information about the Check Employee Calendar 
feature, see �About Availability-Based Assignment� on page 277.

Figure 12. Relationship of Candidates Source Assignment Rule Fields to Team Type Property in 
Siebel Tools

The value in the Team Type assignment 
object property determines what appears in 
the Person Candidates Source and 
Organization Candidates Source fields.
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Exclusive Field
For each assignment rule, the administrator can designate whether that rule is exclusive.

If a rule is exclusive and has assignees, then all assignees from other rules are discarded. If there 
are no exclusive rules, then the primary rule is the rule with the highest-scoring assignee and the 
primary assignee is the highest-scoring assignee. In this case, no assignees from the other rules are 
discarded; however, if the assignment object does not allow for more than one assignee, then only 
the primary assignee is assigned.

If there are multiple exclusive rules, the exclusive rule with the highest-scoring assignee is chosen 
as the only exclusive rule. However, if multiple exclusive rules with equal scores qualify, the default 
default employee, default position, or default organization is assigned because Assignment Manager 
is unable to determine the winning rule. For more information about assigning a default employee, 
default position, or default organization, see Step 7 on page 136 in �Assignment Methodology.�

You make an assignment rule exclusive by checking the Exclusive flag for the assignment rule.

Related Topic
�Creating Assignment Rules� on page 94

Creating Assignment Rules
Each assignment rule has an activation and an expiration date that you can use to denote a range 
of dates for when the rule should be active. If you specify an activation date and no expiration date, 
the rule is active from the date denoted by the activation date onwards. If you specify an expiration 
date and no activation date, the rule is active until the date denoted by the expiration date. If you 
do not specify neither the activation date or the expiration date, the rule is always active.

NOTE: Assignment Manager uses the database time to determine whether a rule is active or not.

Use the following procedure to create your assignment rules. 

This task is a step in �Process of Defining Assignment Rules� on page 86.

To create an assignment rule

1 Navigate to the Administration - Assignment screen > Assignment Rules List view.

2 In the Assignment Rules list, click New. 

3 In the new record, click in the available fields to enter relevant information for the new rule.
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Table 19 shows the predefined fields.

TIP: All assignment rule fields may not be visible in the initial view; use the Columns Displayed 
feature to make fields visible (right-click, select Columns Displayed, use the arrows to move a field 
from Available Columns to Selected Columns, and then click Save).

Table 19. Assignment Rule Fields

Field Description

Name Name of the assignment rule.

Objects to be 
Assigned

A multivalue group (MVG) field that allows you to select one or more assignment 
objects to apply to the rule. 

NOTE: These objects are the business entities chosen by the assignment 
administrator, such as accounts, contacts, and so on. 

Rule Group Assignment rule groups applied to this rule. Each rule must be associated to an 
assignment rule group.

Sequence Sequence number for this rule. Assignment Manager uses this number to 
prioritize the execution of a set of rules. By default, assignment rules do not have 
a sequence number�one must be assigned by the administrator, if needed. 

For more information on rule sequencing, see �How Assignment Manager 
Determines the Sequence in Which Rules Are Evaluated� on page 147.

Activation Start date of the assignment rule.

NOTE: By default, Siebel applications use the Universal Time Coordinated (UTC) 
standard. For more information about UTC, see Global Deployment Guide. 

Expiration End date of the assignment rule.

NOTE: By default, Siebel applications use the Universal Time Coordinated (UTC) 
standard. For more information about UTC, see Global Deployment Guide. 

Score Score eligible for the assignment rule if qualifications are met.

For more information on scoring, see �About Assignment Scoring� on page 101.

Exclusive If selected, candidates for this assignment rule supersede candidates that qualify 
for any other nonexclusive assignment rules. 

For more information on the exclusive feature, see �About Some of the Assignment 
Rule Fields� on page 90.

Person 
Candidates 
Source

Determines whether the employee or position candidates for this rule are 
specified on the assignment rule (statically) or are chosen dynamically using 
predefined dynamic candidate object definitions.

The choices are From Rule, All People, and whatever other dynamic person 
candidate team records you defined in the Dynamic Candidate object using Siebel 
Tools.

For more information about this field, see �Candidates Source Fields� on page 91.
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Organization 
Candidates 
Source

Determines whether the organization candidates for this rule are specified on the 
assignment rule (statically) or are chosen dynamically using predefined dynamic 
candidate object definitions. 

The choices are From Rule, All Organizations, and whatever other dynamic 
candidate team records you defined in the Dynamic Candidate object using Siebel 
Tools.

For more information about this field, see �Candidates Source Fields� on page 91.

Assignee Filter Filters used by Assignment Manager to determine which potential assignees are 
assigned. Choices for assignee filters are:

■ All, Above Minimum

■ All, Must Assign

■ One, Best Fit

■ One, Random

Defaults to All, Above Minimum when creating new assignment rules.

For more information this field, see �About Some of the Assignment Rule Fields� on 
page 90.

Candidate 
Passing Score

Minimum score required for candidates to qualify for this assignment rule. 
Defaults to 0 (zero) when creating new assignment rules.

Check 
Employee 
Calendar

If selected, activates Assignment Manager to check employees� calendars when 
determining assignment eligibility. Used only for employee-based objects.

For more information about this field, see �About Some of the Assignment Rule 
Fields� on page 90.

Primary 
Employee

Primary employee for this assignment rule if the rule passes and is the highest 
scoring rule for that object. Typically used for service-related assignments. 
Applicable only if this employee qualifies from the assignment rule (either from 
the rule itself or from dynamic candidates). 

However, if the AddScores server component parameter is set to TRUE, the 
primary employee is ignored. This parameter overrides primaries on the rule, 
merges scores for each candidate across the rules, and then calculates the 
primary based on highest total scoring employee that passes for that object.

NOTE: If the assignee filter type is One, Best Fit, then do not select a primary 
employee, because the highest-scoring employee is still selected and the primary 
employee is excluded.

For information about assigning a particular employee as the primary assignee on 
a specific assignment rule, see �Choosing a Candidate as the Primary Assignee� on 
page 123.

Table 19. Assignment Rule Fields

Field Description
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Related Topics
�About Some of the Assignment Rule Fields� on page 90

�Assignment Methodology and Examples for Creating Assignment Rules� on page 133

Primary 
Organization

Primary organization for this assignment rule if the rule passes and is the highest 
scoring rule for that object. Applicable only if this organization qualifies from the 
assignment rule (either from the rule itself or from dynamic candidates). 

However, if the AddScores server component parameter is set to TRUE, the 
primary organization is ignored. This parameter overrides primaries on the rule, 
merges scores for each candidate across the rules, and then calculates the 
primary based on highest total scoring organization that passes for that object.

NOTE: If the assignee filter type is One, Best Fit, then do not select a primary 
organization, because the highest-scoring organization is still selected and the 
primary organization is excluded.

For information about assigning a particular organization as the primary assignee 
on a specific assignment rule, see �Choosing a Candidate as the Primary Assignee� 
on page 123.

Primary 
Position

Primary position for this assignment rule if the rule passes and is the highest 
scoring rule for that object. Typically used for sales-related assignments. 
Applicable only if this position qualifies from the assignment rule (either from the 
rule itself or from dynamic candidates). 

However, if the AddScores server component parameter is set to TRUE, the 
primary position is ignored. This parameter overrides primaries on the rule, 
merges scores for each candidate across the rules, and then calculates the 
primary based on highest total scoring position that passes for that object.

NOTE: If the Assignee Filter type is One, Best Fit, then do not select a primary 
position, because the highest-scoring position is still selected and the primary 
position is excluded.

For information about assigning a particular position as the primary assignee on 
a specific assignment rule, see �Choosing a Candidate as the Primary Assignee� on 
page 123.

Table 19. Assignment Rule Fields

Field Description
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About Assignment Criteria
Assignment criteria are sets of conditions describing the attributes of objects or candidates, or both, 
that are evaluated to determine optimal assignment. Assignment rules use criteria to determine 
which candidates qualify as potential assignees. Criteria also determine which assignment rule 
should be evaluated in assigning an object. An assignment rule can include none, one, or many 
criteria.

Assignment criteria define attributes that can be used in assignment criteria records. Assignment 
criteria appear in the picklist that is displayed when you click in the Criteria list column (in the Criteria 
subview) when editing an assignment criterion record in Siebel applications.

Assignment Criteria Comparison 
Methods
Assignment Manager uses criteria comparison methods to qualify objects or candidates, or both, for 
an assignment rule. Attributes (object or candidate) can be either attributes or skills depending on 
the criterion value.

Table 20 lists the different requirements for each comparison method.

Table 20. Assignment Criteria Comparison Methods

Comparison 
Method Description

Compare to 
Object

Compares criteria values to object attributes. The criterion passes if the objects 
possess the criteria values. 

For example, Account Zip Code = 94040.

Compare to 
Person

Compares criteria values to skills of person candidates (employees or positions). 
Person candidates that possess the skills required by the criterion qualify for this 
criterion.

For example, Language = ENU.

Compare 
Object to 
Person

Compares object attributes to skills of person candidates (employees or 
positions). Person candidates that possess the skills required by the object qualify 
for this criterion. 

For example, product means compare the product of the opportunity and the 
product skills of the person or position.
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Depending on the comparison method, candidates that meet the criteria have the criteria score 
added to their total score as follows:

■ The total score from all criteria of the Compare to Object type that pass is added to all qualifying 
person and organization candidates.

■ The person candidates get the score from the Compare to Person and Compare Object to Person 
criteria and values they pass.

■ The organization candidates get the score from the Compare to Organization and Compare 
Object to Organization criteria and values they pass.

NOTE: Assignment rules can be created with no criteria. A rule of this nature functions to make sure 
all data items of a particular object type are assigned, that is, all objects of the defined type pass. 
Use these rules carefully as a rule defined with no criteria can make assignments that are not 
required.

You should be especially careful creating rules with no criteria using batch assignment. This mode 
can produce a very large number of assignments, because all objects in the database that have rules 
with no criteria pass and are assigned in this mode. Such an increase can result in a backlog of 
requests that may cause the whole environment to stop working if the database or file system runs 
out of space. Therefore, assignment rules with no criteria should be used sparingly with batch 
assignment.

Assignment Criteria Inclusion Methods
You specify criteria inclusion methods for assignment rules to determine how criteria values and 
candidates will be matched.

Assignment criteria use inclusion methods to: 

■ Determine how many criteria values must be met to pass the criterion

■ Determine how the score of the criterion values are added to the candidate�s score

Compare to 
Organization

Compares criteria values to organization skills. Organizations that possess the 
skills required by the criterion qualify for this criterion. 

For example, type = gold-level partner.

Compare 
Object to 
Organization

Compares object attributes to organization skills. Organizations that possess the 
skills required by the object qualify for this criterion.

For example, ZIP Code means compare the ZIP Code of the service request and 
the ZIP Code of the organization.

Table 20. Assignment Criteria Comparison Methods

Comparison 
Method Description
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Table 21 shows the types of assignment criteria inclusion methods.

Table 21. Assignment Criteria Inclusion Methods

Inclusion 
Method Comments

Include At least one value needs to match:

■ For Compare to Object, the object attribute must match at least one listed 
criteria value.

■ For Compare to Person, the person attribute must match at least one listed 
criteria value.

■ For Compare Object to Person, at least one value of the person attribute must 
match one value of the object attributes.

■ For Compare to Organization, the organization attribute must match at least one 
listed criteria value.

■ For Compare Object to Organization, at least one value of the organization 
attribute must match one value of the object attributes.

Assignment Manager stops processing criteria when one value is matched and the 
score of the matching criterion value is added to the candidate's score.

Include All All values must match:

■ For Compare to Object, the object attribute must match all listed criteria values.

■ For Compare to Person, the person attribute must match all listed criteria values.

■ For Compare Object to Person, all values of the person attribute must match all 
values of the object attribute.

■ For Compare to Organization, the organization attribute must match all listed 
criteria values.

■ For Compare Object to Organization, all values of the object attribute must 
match all values of the organization attribute.

If the criterion is met, all the criteria value scores are added to the candidate's score. 
However, if just one of the criteria are not met, then Assignment Manager stops 
processing the rule.
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About Assignment Scoring
Siebel Assignment Manager determines which candidates are assigned to objects by applying scores 
to potential candidates. Assignment Manager then ranks the candidates based on their scores and 
selects assignees based on the assignee filter.

Assignment Manager calculates the total score for each candidate from each assignment rule from 
the:

■ Assignment rule score

■ Assignment criteria score

■ Assignment criteria values score (according to the appropriate inclusion method)

■ Workload criteria score

Include All 
Matching

This inclusion method matches in the same manner as the Include inclusion method, 
that is, at least one value needs to match.

However, unlike the Include method, Assignment Manager continues to process this 
criterion until all criterion values are exhausted. As a result, the scores from all 
passing criterion values are added to the candidate's score.

TIP: The Include All Matching inclusion method matches like the Include inclusion 
method but scores like the Include All inclusion method.

Exclude None of the values must match:

■ For Compare to Object, the object attribute must not match any of the listed 
criteria values.

■ For Compare to Person, the person attribute must not match any of the listed 
criteria values.

■ For Compare Object to Person, no values of the person attribute can match any 
values of the object attribute.

■ For Compare to Organization, the organization attribute must not match any of 
the listed criteria values.

■ For Compare Object to Organization, no values of the organization attribute can 
match any values of the object attribute.

NOTE: This inclusion method excludes criterion value scores. If the criterion is met, 
only the criterion score is added to the candidate's score.

Table 21. Assignment Criteria Inclusion Methods

Inclusion 
Method Comments
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■ Employee, position, or organization score (depending on the candidate)

NOTE: Before implementing Assignment Manager, you should carefully consider the value for each 
score. Use scores to assign weights to your criteria. If there are multiple criteria, assign a higher 
score to the more important attributes. This is especially useful for finding the best match when not 
all criteria are required.

Using Siebel Tools, you can configure Assignment Manager to save the scores of candidates who are 
assigned to an object. Other Siebel application modules can then access the saved candidate scores 
for various purposes. For example, you might want to produce analysis reports for employee 
utilization. Alternately, you can expose the scores to users for review and sorting.

The scores of each candidate are stored in the appropriate team table by specifying the Employee 
Team Score Column, Position Team Score Column, and Organization Team Score Column for the 
assignment object. Team member scores are written independently for each type of candidate 
(employees, positions, and organizations).

You can also configure Assignment Manager to add scores across assignment rules. For more 
information about this, see the Add Scores across Rules (AddScores) parameter in �Configuring 
Assignment Manager to Add Scores Across Rules� on page 273.

NOTE: Typically, you plan your scoring methodology during the design phase. However, you can add 
scores to assignment rules at any time, but you must release the rules in order for the changes to 
take affect.

About the Required Field for Assignment 
Criteria
The Required field on an assignment criterion gives you the ability to make certain criterion 
mandatory for the assignment rule. If candidates meet this criterion, the candidate�s score is 
increased, providing that candidate a better chance of being assigned. You make assignment criteria 
required or not required by selecting one of the following choices from the picklist in the Required 
field in the Criteria list for the assignment rule: Always, Never, or When Available.

Required Assignment Criteria
A required criterion means that the criterion must be met. For the Compare To Object type criteria, 
if the object does not have the attribute to satisfy the criterion, the rule fails and none of the 
candidates from that rule qualify for assignment. For person-based criteria (criteria with either a 
Compare To Person or a Compare Object to Person comparison method), if the criterion is not met, 
that person candidate fails and does not qualify for that assignment rule. Therefore, further person-
based criteria are not evaluated for that person candidate. 

For organization-based criterion (criterion with a Compare To Organization or a Compare Object to 
Organization comparison method), if the criterion is not met, that organization candidate fails and 
does not qualify for that assignment rule. Therefore, further organization-based criteria is not 
evaluated for that Organization candidate.
Siebel Assignment Manager Administration Guide Version 7.8102 



Assignment Rule Administration ■  About the Required Field for Assignment Criteria
For example, an assignment rule can have a required Service Request Severity assignment criterion 
with a Compare to Object comparison method and a criteria value of 1-Critical. In this case, if the 
object to be assigned has a service request severity of 1-Critical, the object qualifies for the 
assignment rule. An object without a service request severity value or one that has a different service 
request severity value does not qualify for the assignment rule. 

Required When Available Assignment Criteria
In some cases, you may want to use Required When Available as the required property on the 
assignment criterion. Your requirements may dictate that a particular criterion should be applied only 
if the object or the candidate has the attribute available. If the attribute is available, the criterion 
should be satisfied mandatorily. It is in these instances you use Required When Available. You can 
make criteria required when available by selecting When Available from the picklist in the Required 
field.

For example, an assignment rule can have a required when available Service Request Severity 
assignment criteria with a Compare to Object comparison method and a criteria value of 1-Critical. 
In this case, if the object assigned has a service request severity of 1-Critical, the object qualifies 
for the assignment rule. An object that has a lower service request severity value does not qualify 
for the assignment rule. However, an object without a service request severity value qualifies for the 
assignment rule (because the criteria value is null, or not available).

NOTE: If an assignment criterion uses a Compare Object to Person or a Compare Object to 
Organization comparison method, and the attribute value is not found on person, the criterion fails.

Nonrequired Assignment Criteria
Use nonrequired assignment criteria to further determine a suitable match between candidates and 
assignment rules. You can make criteria nonrequired by selecting Never from the picklist in the 
Required field. Use nonrequired criteria that include scores to apply scores to candidates. These 
scores are added to the total scores of the candidates for this assignment rule if they pass the 
criteria. By using nonrequired criteria with scores, you can add a higher score to candidates that 
satisfy this criteria, while keeping candidates that do not satisfy the criteria.

If a candidate fails a nonrequired criterion, no score is added to the candidate; however, the 
candidate does not fail. Person candidates are evaluated for rest of the person-based criteria and 
organization candidates are evaluated for the rest of the organization-based criteria.

For example, you should use service-related criteria (such as Service Request Priority) for an 
assignment rule that are applied to service-related objects (such as Service Request). If you create 
an assignment rule with Server Request Priority as nonrequired criteria, Assignment Manager does 
not qualify any accounts for the criteria because Service Request Priority does not apply to accounts.

If an assignment rule uses only nonrequired assignment criteria, then the assignment rule passes 
even if the minimum score for the rule is not satisfied, because the assignment criteria are not 
required. To avoid this behavior, you can alter Assignment Manager so that assignment rules pass 
only when the minimum score for the rule is satisfied, even if the assignment criteria are not 
required.
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To require that an assignment rule satisfies the minimum score for the rule to pass, you can use the 
UseRuleMinScore server parameter. If you set this parameter to TRUE, each assignment rule score 
must be equal to or greater than the rule minimum score to pass. Also, candidates must have a total 
score from the rule greater than or equal to the rule minimum score in order to qualify for that rule 
as well.

When using the AsgnSrvr and AsgnBatch commands from the command-line interface when running 
Assignment Manager, you can change the value for the UseRuleMinScore server parameter. For 
dynamic assignment, you change the default value of the UseRuleMinScore parameter in the 
Assignment Request (In Process) workflow policy program. 

Process of Adding Criteria and Values to 
Assignment Rules
You can add criteria and criteria values to your assignment rules to evaluate and assign candidates.

CAUTION: Assignment rules can be created with no criteria. However, it is recommended that you 
use this type of rule carefully as a rule defined with no criteria can make unnecessary assignments. 

To add criteria and criteria values to assignment rules, perform the following tasks:

1 �Adding Assignment Criteria to Assignment Rules� on page 104

2 �Adding Criteria Values to Assignment Criteria� on page 108

or

�Adding Criteria Values as Skills to Assignment Rules Using Expertise Codes� on page 116

Adding Assignment Criteria to Assignment Rules
This topic explains how to add assignment criteria to assignment rules.

This task is a step in �Process of Defining Criteria Values as Skills with Expertise Codes and Weighting 
Factors� on page 114 as well as �Process of Defining Assignment Rules� on page 86.

Criteria are sets of conditions describing the attributes of objects or candidates, or both, that are 
evaluated to determine optimal assignment. Criteria are the fundamental building blocks for 
assignment rules. An assignment rule can contain none, one, or many criteria. Assignment rules use 
criteria to determine which candidates qualify as potential assignees. Criteria also determine which 
assignment rule should be evaluated in assigning an object. 

CAUTION: Assignment rules can be created with no criteria. A rule of this nature functions to make 
sure data items of a particular type are assigned, that is, objects of the defined type pass. Use these 
rules carefully as a rule defined with no criteria can make assignments that are not required. 

To add an assignment criterion to an assignment rule

1 Navigate to the Administration - Assignment screen > Assignment Rules List view.
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2 In the Assignment Rules List list, drill down on the assignment rule for which you want to create 
an assignment criterion, and then click the Criteria view tab (if not already active).

3 In the Criteria list, click New.

4 In the new criterion record, click in the available fields to enter the relevant information.

NOTE: If you want to query for an assignment criterion, you must use the name of the 
assignment criterion, not the display name for the assignment criterion object you configured 
using Siebel Tools. For example, if the name of the Account assignment criteria is ACCOUNT_ID, 
then you must use this name for your query, although the display name is Account. The queries 
for seed assignment criteria must also be made with their English names, that is, these queries 
do not accept non-English characters.

Table 22 shows the predefined fields.

Table 22. Assignment Criteria Predefined Fields

Field Description Example 

Rule 
Criterion

The criteria evaluated for the assignment rule. Product Defect 
Priority

Comparison
Method

Methods used by Assignment Manager to determine how objects 
and candidates are matched. Choices are:

■ Compare to Object

■ Compare to Person

■ Compare Object to Person

■ Compare to Organization

■ Compare Object to Organization

For explanations of each method, see �Assignment Criteria 
Comparison Methods� on page 98.

NOTE: For assignment criteria that use the Compare to Object, 
Compare to Person, or Compare to Organization comparison 
method, each criteria includes one or more values.

Compare to 
Object

Inclusion Methods used by Assignment Manager to determine how criteria 
values and candidates are matched. Choices are: Include, Include 
All Matching, Include All, and Exclude.

For more information about each inclusion method, see 
�Assignment Criteria Inclusion Methods� on page 99.

NOTE: Depending on the Inclusion method, candidates that meet 
the criteria value have the criteria value score added to their total 
score. Criteria values can be defined as constants or can use 
wildcard characters to include a wider selection of potential 
matches between assignment rule and object.

Include
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Required Determines whether the criteria is required. Choices are:

■ Always

■ Never

■ When Available

For detailed information about the required field, see �Adding 
Assignment Criteria to Assignment Rules� on page 104.

Always

Score Score for this criteria. Candidates that satisfy this criteria have this 
score added to their total score.

For more information how you can use the criteria score, see 
�Assignment Criteria Comparison Methods� on page 98.

Minimum 
Score

Minimum score required to qualify for this criterion. This field can 
be left blank.

If the total score from all matching criterion values (calculated 
based on the inclusion method for the rule) is greater than or equal 
to the minimum score specified for the criterion, then the criterion 
passes.

Inherited If selected, indicates the criterion was inherited from a parent rule. 
This is a read-only field.

NOTE: If the Inherited flag for a criterion is true in the 
Administration - Assignment view, the Read Only flag is true in the 
Administration - Delegated Assignment views.

TIP: If the Inherited field is not visible, use the Columns Displayed 
feature to make it visible (right-click, select Inherited, use the 
arrows to move Inherited from Available Columns to Selected 
Columns, and then click Save).

Table 22. Assignment Criteria Predefined Fields

Field Description Example 
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DA Read 
Only

If selected, makes a criterion read-only for delegated 
administrators. By checking this field, the assignment 
administrator (AA) makes sure the criterion is read-only to all users 
who view the rule from the delegated assignment views, including 
the owner of that child rule group.

For example, if the AA creates Rule A in a rule group and that rule 
gets inherited as Rule B in a child rule group, the AA can add a 
criterion to Rule B and make it read-only. The owner of the child 
rule group cannot change this setting. Without this flag, the owner 
of the child rule group could delete that criterion because it was not 
inherited from the parent rule.

NOTE: If the DA Read Only field for a criterion is true in the 
Administration - Assignment view, the Read Only flag is true in the 
Administration - Delegated Assignment view.

TIP: If the DA Read Only field is not visible, use the Columns 
Displayed feature to make it visible (right-click, select Columns 
Displayed, use the arrows to move DA Read Only from Available 
Columns to Selected Columns, and then click Save).

Template If selected, Assignment Manager excludes the criterion when 
processing rules. 

Assignment Manager does not process criteria templates until an 
inheritor chooses to apply a template to an assignment rule. For 
more information about applying criteria templates, see �Adding 
Criteria Templates to Assignment Rules� on page 182.

NOTE: When a rule with a criterion using a template is inherited, 
the criterion is not automatically inherited with the other criteria. 
You must explicitly apply the criterion to the inherited rule. After 
the criterion is applied to the inherited rule, you can modify the 
criterion as you would any other criteria.

TIP: If the Template field is not visible, use the Columns Displayed 
feature to make it visible (right-click, select Columns Displayed, 
use the arrows to move Template from Available Columns to 
Selected Columns, and then click Save).

Table 22. Assignment Criteria Predefined Fields

Field Description Example 
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Figure 13 shows an example of an assignment criterion using the values from Table 22. This example 
shows a required always Product Defect Priority rule criterion for an assignment rule that is compared 
to service objects using the Include inclusion method.

Adding Criteria Values to Assignment Criteria 
This topic explains how to add criteria values to assignment criteria. Each assignment criterion has 
one or more criteria attributes (values) that are shown as columns in the Values list applet.

This task is a step in �Process of Defining Criteria Values as Skills with Expertise Codes and Weighting 
Factors� on page 114 as well as a step in �Process of Defining Assignment Rules� on page 86.

About Criteria Values
Criteria values are details associated with criteria that are compared to an object or candidate. For 
assignment criteria that use the Compare to Object, Compare to Person, or Compare to Organization 
comparison method, each criterion includes one or more criteria values. A value represents the 
actual string, number, or date that is used in matching. Criteria values can be based on MLOVs, 
picklists (a pop-up pick applet from where you can choose a record), or simple free text fields. 
Depending on the inclusion method, candidates that meet the criteria value have the criteria value 
score added to their total score. Criteria values can be defined as constants or can use wildcard 
characters to include a wider selection of potential matches between assignment rule and object.

There are predefined criteria values available dynamically based upon the criterion you select, or you 
can create your own criteria values using Siebel Tools. Each criteria value can include one or more 
attributes. For example, the Account City State Country criterion has three attributes: one each for 
City, State, and Country. This type of criterion is known as a composite criterion. Each of the 
assignment attributes appear as list columns in the criteria value applet.

For more information about assignment attributes, see �Creating Assignment Attributes� on page 56.

To add criteria values to an assignment criterion

1 With the appropriate assignment criterion selected in the Criteria list (Navigate > Site Map > 
Administration - Assignment > Assignment Rules List > Criteria), scroll down to the Values 
subview.

2 In the Values list, click New. 

3 In the new record, click in the available fields to enter the relevant information. 

NOTE: The assignment attributes for criteria values that are available differ depending on the 
assignment criterion you select in Step 1.

Figure 13. Example of an Assignment Criterion
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You define different types of criteria values depending on the assignment attribute. Some criteria 
values appear as list of value (LOV) fields from which you choose a value (such as Account State), 
some criteria values show a pick dialog box from which you choose a value (such as Account), and 
some criteria values are numbers which you choose using the calculator button, while other values 
are dates which you choose using the calendar select button.

Table 23 shows examples of assignment attributes for the assignment criterion created in �Adding 
Assignment Criteria to Assignment Rules� on page 104.

Avoiding Duplicate Assignment Criteria Values
It is possible to create duplicate criteria values for an assignment criterion. If both criteria values 
use scores in this case, then both scores are added to the assignment criterion if the criteria value 
passes. This can happen when you create criteria values that use ranges, such as criteria values for 
the Revenue assignment criterion. 

CAUTION: It is recommended that you do not create duplicate criteria values for the same 
assignment criterion, even though Assignment Manager allows this. If both criteria values use scores 
and you use the Include inclusion method, the score added to the passing candidate may be 
inconsistent. If you use the Include All or Include All Matching inclusion method, both the scores are 
added to the passing candidate.

Using Wildcard Characters When Defining Criteria Values
Wildcard characters can also be used when defining specific criteria values. This option allows for a 
greater range of assignment object matches. For example, if you create an assignment rule for 
Account objects with the Account City as assignment criteria, the corresponding criteria value City 
can be defined as A*. This setting matches Accounts in cities beginning with the letter A. 

If a criteria value includes the special characters "?�, �*�, and �\� that are used as literals, the escape 
identifier character (\) must be added before each special character in the value field. For example, 
the criteria value Tri*Laptop is entered into the Values field as �Tri\*Laptop�.

Criteria values that include alphanumeric entries are stored as string values. These values are sorted 
lexicographically, that is, in dictionary order, when determining specific ranges for assignment rules. 
For example, the value AB10 is sorted between AB1 and AB9 even though you may require AB10 
placed greater than AB9. 

Table 23. Available Assignment Attributes

Criteria Value Example

Score 10
6 

Product Defect Priority 1�Very High
2�High
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Figure 14 shows an example of creating Product Defect Priority criteria values using the procedure 
in �Adding Criteria Values to Assignment Criteria� on page 108 and the values in Table 23 on page 109.

Defining Assignment Rules to Use a 
Single Criterion for Multiple Objects
In some cases, you may want to create an assignment rule that assigns candidates to two or more 
objects while using only one object�s criteria. This topic uses a specific scenario as an example in 
which you create an assignment rule to use only an Opportunity criteria to assign candidates to both 
the Opportunity and Account objects. This rule can be used to assign candidates to opportunities and 
their associated accounts.

To create assignment rules that assign two objects using only one object criteria, you need to create 
and map workflow policy components using Siebel Tools after defining the assignment rule.

To define an assignment rule to use a single criterion for multiple objects

1 Create an assignment rule and specify the assignment objects that are assigned using this rule.

For this example, create an assignment rule called Account/Opportunity and add the Account and 
Opportunity objects to this rule. For more information about creating assignment rules, see 
�Creating Assignment Rules� on page 94. 

2 Create an assignment criteria that applies to only one of the assignment objects in this 
assignment rule.

For this example, configure the Lead Quality Code assignment criteria (an Opportunity object 
criteria). For more information on creating assignment criteria, see �Creating Assignment Rules� 
on page 94.

Figure 14. Example of Adding Criteria Values to an Assignment Criterion
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3 After the assignment rule is defined, create a workflow policy component that maps to both 
objects.

For information on creating a workflow policy component, see �Process of Using a Single Criterion 
for Multiple Objects� on page 67.

4 Map the workflow policy component you created with the column.

For information on mapping a workflow policy column, see �Mapping Assignment Attribute 
Columns to an Assignment Object and a Workflow Policy Component Column� on page 61.

5 Map the workflow policy component you created to the assignment attribute.

For information on mapping a workflow policy component to assignment attributes, see �Mapping 
Assignment Attribute Columns to an Assignment Object and a Workflow Policy Component Column� 
on page 61.

Figure 8 on page 72 shows an example of defining an assignment rule for the Account and 
Opportunity objects using only the Lead Quality Code assignment criteria.

Removing Assignment Criteria from 
Assignment Rules
In some cases, you may want to eliminate assignment criteria that appear in the Assignment Criteria 
view. To do so, you need to remove the unwanted criteria from the Assignment Criteria view as well 
as use Siebel Tools to disable the corresponding assignment attribute, assignment attribute column, 
assignment criteria, and assignment criteria attribute object definitions.

Use the following procedure to remove unwanted criteria from the Assignment Criteria view.

To remove unwanted criteria from an assignment rule

1 Navigate to the Administration - Assignment screen > Assignment Rules List view.

2 Select the assignment rule for which you want to remove criteria.

3 Click the Criteria subview.

4 In the Criteria list, delete any criteria you want removed.

5 Perform the tasks described in �Disabling Assignment Attributes� on page 73.

NOTE: If you want to remove criteria from the list of values (LOV) field, you must use Siebel 
Tools to perform Step 5. However, removing the criteria from the rule itself is often sufficient to 
make certain the criteria is no longer used for the rule.
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About Assignment Skills, Expertise 
Codes, and Weighting Factors
Assignment Manager provides predefined skills, expertise codes, and weighting factors. These 
optional building blocks allow you to determine the criteria that you want to evaluate for each 
candidate to make sure potential candidates possess the proper skillset to handle the task.

Assignment Skills
A skill is an attribute associated with a person, organization, or base table row. Assignment Manager 
can perform assignments based on skills by associating the skills with employee, position, and 
organization candidates. For example, if an employee speaks English and Spanish, language is the 
skill he or she possesses, and English and Spanish are the skill items. Employee, position, and 
organization skills are used to store skills possessed; the skill tables for objects are used to store 
skills required. Assignment Manager uses skill tables to do skill matching by comparing the skills on 
the object with the skills of an employee, position, or organization to determine who passes the rule.

The Siebel application provides predefined skills, however, you can create new skills using Siebel 
Tools. You enable and configure skills at the criteria level using Siebel Tools. After skills are enabled, 
Assignment Manager matches skills based on the assignment criteria comparison method in the 
same manner in which other attributes are matched. Assignment Manager applies scores and other 
filters to find the best candidate after a match is made.

Expertise Codes
Expertise codes define an employee's expertise level for a particular skill item. For example, an 
employee might have an Expert level expertise in networking products but only a Novice level 
expertise in printer products. You apply expertise codes to skills to eliminate underqualified 
candidates. Assignment Manager uses expertise codes to match an assignment object to people. 
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After you select an expertise code for a skill, Assignment Manager matches assignment rules based 
on the assignment criteria comparison method. Table 24 shows the different results based on those 
methods.

For more information about assignment criteria comparison methods, see �Assignment Criteria 
Comparison Methods� on page 98.

Weighting Factors
Optionally, you can apply weighting factors to expertise codes. While you can use expertise codes to 
eliminate underqualified candidates, using weighted expertise codes allows you to weigh skill scores 
to find the most suitable candidate by further eliminating overqualified candidates. For example, you 
may not want to assign an expert to a service request that can be handled by a novice.

Using weighted expertise codes allows you to prevent assigning objects to overqualified candidates 
by applying a weight to the skill score. Each expertise code has a defined value, which is its weighting 
factor. The expertise code with the highest defined weighting factor represents the maximum 
weighting factor (Max Weighting Factor). 

The weighting applied to a skill or criteria score is the percentage defined by an expertise code�s 
weighting factor over the maximum weighting factor. For an example, see Table 25 on page 117. 

Table 24. How Assignment Rules are Matched Based on Expertise Code and Comparison Methods

If the Criteria Comparison 
Method Is � The Assignment Rule Passes if the �

Compare to Object Skill�s expertise code is equal to, or higher than, the 
object�s expertise code.

Compare Object to Person Candidate�s expertise code is equal to, or higher than, the 
object�s expertise code.

Compare Object to Organization Organization�s expertise code is equal to, or higher than, 
the object�s expertise code.

Compare to Person Candidate�s expertise code is equal to, or higher than, the 
skill�s expertise code

Compare to Organization Organization�s expertise code is equal to, or higher than, 
the skill�s expertise code.
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Weighted scores are calculated differently based on the comparison method chosen for the 
assignment rule:

■ For the Compare to Person, Compare to Object, and Compare to Organization comparison 
methods, the weighted score is determined as follows:

Score = Criteria Score + Skill Score*(Weighting Factor/Max Weighting Factor)

■ For the Compare Object to Person and Compare Object to Organization comparison methods, 
because neither of these comparison methods can define skill scores, the weighted score is 
determined as follows:

Score = Criteria Score*(Weighting Factor/Max Weighting Factor)

NOTE: When using the Compare Object to Person or the Compare Object to Organization 
comparison method, weighting factors are only applied if the expertise code is defined for both 
the object assignment skill item and the candidate skill item. If the expertise code is not defined 
for both, the weighting factors are excluded.

Assignment Manager applies the weighted skill scores and other scores to find the most suitable 
candidate when a match is made.

Related Topics
�Process of Defining Criteria Values as Skills with Expertise Codes and Weighting Factors� on page 114

�Scenario for Using Assignment Skills� on page 119

�Example of Using Assignment Skills in Assignment Rules� on page 119

Process of Defining Criteria Values as 
Skills with Expertise Codes and 
Weighting Factors 
You define skills in the same manner as you define criteria values. Defining criteria values as skills 
with expertise codes is a preconfigured feature of assignment criteria values and works with 
assignment rules for service objects (or any other object you configure to use skills). By default, 
sales objects do not use skills.

To define criteria values as skills with expertise codes and weighting factors, perform the following 
tasks:

1 (Optional) �Creating Expertise Codes for Skills� on page 115

2 �Adding Criteria Values as Skills to Assignment Rules Using Expertise Codes� on page 116

3 (Optional) �Defining Weighting Factors for Expertise Codes� on page 117

These tasks are one step in �Process of Defining Assignment Rules� on page 86.

NOTE: Criteria and skills need the same Assignment Criteria Attribute enabled for Assignment 
Manager to perform skill comparison. For more information about enabling Assignment Criteria 
Attributes, see �Creating Assignment Criteria Attributes for Assignment Criteria� on page 65.
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Related Topics
�About Assignment Skills, Expertise Codes, and Weighting Factors� on page 112

�Scenario for Using Assignment Skills� on page 119

�Example of Using Assignment Skills in Assignment Rules� on page 119

Creating Expertise Codes for Skills
Expertise codes apply only to skills and are global; after they are defined, assignment criteria share 
the same set of expertise codes. Expertise codes are predefined for the following skill types 
(assignment criteria):

■ Language Code

■ Product

■ Product Line

■ Product Line Wildcard

■ Product Wildcard

The three predefined expertise codes are Novice, Intermediate, and Expert. For most deployments, 
the predefined skills are sufficient, however, you can create new ones. Expertise codes are stored 
in�and can be modified, added to, or deleted from�the Administration - Data screen > List of Values 
view.

To create new expertise codes, use the following procedure.

NOTE: You should perform the procedures in this section only if the default expertise codes�Novice, 
Intermediate, and Expert�do not meet the requirements of your organization.

To create an expertise code

1 Navigate to the Administration - Data screen > List of Values view.

2 In the List of Values list, click New.

3 In the new record, click in the fields to enter the relevant information for the expertise code.

a In the Type field, click the select button, query for EXPERTISE_CD in the Pick Value Type dialog 
box, and then click OK.

b In the Display Value field, type the name of the expertise code as you want it to appear.

c In the Language-Independent Code field, type in the exact value that you entered in Step b.

d In the Language Name field, click the select button to select the appropriate language in the Pick 
Language Name dialog box, and then click OK.

e In the Translate field, click to place a check mark (if not already checked).
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f In the Order field, type a numerical value for the rank of the expertise code.

The numerical value you type in this field determines the rank of the expertise code. Use a 
higher value to apply a greater rank to the expertise code, and a lower value to apply a lesser 
rank.

The new expertise value appears in the List of Values list and also becomes a valid expertise code 
selection in the criteria value drop-down menu when defining skills.

Figure 15 shows an example of creating a Manager expertise code that is ranked higher than the 
default expertise codes.

Adding Criteria Values as Skills to Assignment Rules 
Using Expertise Codes 
To add a criteria value as a skill to an assignment rule using expertise codes, select the desired 
expertise from the Expertise Code field in the Value list applet as shown in Figure 16 on page 117. 
The predefined expertise codes are: Novice, Intermediate, and Expert.

This task is a step in �Process of Defining Criteria Values as Skills with Expertise Codes and Weighting 
Factors� on page 114 as well as a step in �Process of Defining Assignment Rules� on page 86.

To add a skill to an assignment rule using an expertise code

1 Navigate to the Administration - Assignment screen > Assignment Rules List view.

2 In the Assignment Rules list, drill down on the assignment rule for which you want to add a skill, 
and then click the Criteria view tab.

3 In the Criteria list, select New.

4 In the new criteria record, click in the available fields to enter the relevant information.

5 Scroll down to the Values subview, and then click New.

6 In the new values record, click in the available fields to enter the relevant information.

NOTE: The assignment attributes for criteria values that are available differ depending on the 
assignment criterion you select in Step 4. In the example in Figure 16 on page 117, the assignment 
attributes are: Score, Product Line, and Expertise Code.

Figure 15. Example of Creating a New Expertise Code
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Figure 16 on page 117 shows an example of creating a required Product Line Wildcard assignment 
criterion that is compared to candidates. This criterion requires a minimum score of 10 and the 
modem product line skill with an expertise level of intermediate or better.

In this example, only candidates with an Intermediate- or Expert-level expertise qualify for this skill 
and receive 20 points.

If the predefined expertise codes are not sufficient for your needs, you can create new ones. To 
create new expertise codes, see �Creating Expertise Codes for Skills� on page 115.

Defining Weighting Factors for Expertise Codes
Weighting factors for expertise codes apply only to skills and are global; after they are defined, 
assignment criteria share the same set of weighting factors for expertise codes. Weighting factors 
weigh expertise codes by applying a specified percentage to the skill score. Table 25 shows sample 
weighting factors that can be used for the three types of predefined expertise codes.

Figure 16. Example of Adding a Skill with an Expertise Code

Table 25. Sample Weighting Factors for Expertise Codes

Expertise 
Code

Weighting 
Factor Percentage of Skill Score

Novice 2 If skill is matched, adds 40% of score for the skill (or criteria value)

Intermediate 5 If skill is matched, adds 100% of score for the skill (or criteria value)

Expert 3 If skill is matched, adds 60% of score for the skill (or criteria value)
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In this example, candidates with an intermediate expertise for the matched skill are favored over 
other candidates, because they receive 100% of the skill score. This may be desired if your 
organization has many more service representatives with an intermediate expertise than service 
representatives with an expert expertise. In this case, you make sure that service requests that 
require only an intermediate expertise are assigned to service representatives with an intermediate 
expertise.

NOTE: Use weighting factors to adjust relative scoring for expertise; do not define separate criteria 
and scores for different expertise levels.

If you use weighting factors to weigh the expertise codes, candidates with different expertise receive 
different scores. For example, if you use the weighting factors described in Table 25 on page 117 and 
the expertise code defined in Figure 16 on page 117:

■ Candidates who possess an intermediate-level expertise in the modem product skill receive 20 
points and qualify for this criterion.

■ Candidates who possess an expert-level expertise receive 10 points and qualify for this criterion.

■ Candidates who possess a novice-level expertise fail this criteria (because an expertise level of 
intermediate or better is required), and fail the assignment rule (because the criterion is 
required).

■ Candidates who possess an intermediate-level expertise are therefore favored, because they 
receive a higher score.

This task is a step in �Process of Defining Criteria Values as Skills with Expertise Codes and Weighting 
Factors� on page 114.

Weighting factors for expertise codes are stored in�and can be modified, added to, or deleted from�
the Administration - Data screen > List of Values view.

To define weighting factors for expertise codes

1 Navigate to the Administration - Data screen > List of Values view.

2 Display the list of values of type EXPERTISE_CD.

a In the List of Values list, click Query.

b In the Type field, click the select button.

c In the Pick Value Type dialog box, query for EXPERTISE_CD, click Go, and then click OK.

d In the List of Values list, click Go to complete the query.

3 For each of the resulting display values (default values are Novice, Intermediate, and Expert), 
click in the Weighting Factor field and type in a numerical value.

The numerical value you type in this field, relative to the maximum weighting value defined, 
represents the percentage applied to the skill score. 

TIP: If the Weighting Factor field is not visible when the List of Values appear, use the Columns 
Displayed feature to make it visible (right-click, select Columns Displayed, use the arrows to 
move Weighting Factor from Available Columns to Selected Columns, and then click Save).
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Figure 17 shows an example of defining the weighting factors for the default expertise codes using 
the values listed in Table 25 on page 117.

Related Topics
�Assignment Skills, Expertise Codes, and Weighting Factors� on page 30

Scenario for Using Assignment Skills
This scenario provides an example of how Assignment Manager can automatically route an SR 
(service request to the most qualified field service representative. Your company may follow a 
different process according to its business requirements.

A software application company places a call to your Call Center stating they have a malfunctioning 
cable modem. To handle the incoming request, a call center service agent creates an SR, and then 
associates that service request with the Cable Modem PL/12 product. Based on the predefined 
assignment rule, Assignment Manager automatically assigns the SR to the most qualified field service 
representative who has expertise with this cable modem product line.

Example of Using Assignment Skills in 
Assignment Rules
This topic gives one example of using skills to determine who passes an assignment rule. You may 
use this feature differently, depending on your business model.

The following procedure explains how to configure Assignment Manager so that only employees who 
speak Spanish are assigned a service request.

To configure Assignment Manager to assign a service request only to employees 
who speak Spanish

1 Create a service request with Language as the skill and Spanish as the skill item. 

a In the Service Request skill table for the service request, create one record and specify Language 
as the skill. 

b In the child Service Request skill item table, create one record and specify Spanish as the skill 
item.

Figure 17. Example of Defining Weighting Factors
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2 Create an assignment rule that filters employees based on their language skills.

a Create an assignment rule and apply the Service Request assignment object.

b Create a criterion called Language and use the Compare to Person assignment rule comparison 
method.

This criterion, and therefore the rule, passes only employees who have the Spanish language 
skill.

NOTE: The previous example used the Compare to Person comparison method, however, skill 
matching can be used with other comparison methods. For more information about comparison 
methods, see �Assignment Criteria Comparison Methods� on page 98.

Assignment Manager can also do skill matching with expertise codes and can use weighting factors 
to assign weighted scores to different expertise codes. For more information about skill matching 
using expertise codes and weighting factors, see �Process of Defining Criteria Values as Skills with 
Expertise Codes and Weighting Factors� on page 114.

Adding Employees, Positions, and 
Organizations to Assignment Rules 
This topic provides procedures for adding employees, positions, and organizations to assignment 
rules.

This task is a step in �Process of Defining Assignment Rules� on page 86.

Assignment Manager can assign employees, positions, and organizations based on their association 
with their parent organization. For example, only employees or positions associated with a specific 
organization can be assigned to an assignment object even if other employees or positions 
associated with other organizations qualify. Positions assigned to an assignment object can also have 
their associated organizations assigned. This functionality is called multitiered assignment, and you 
must configure the appropriate assignment object before implementing. For information about 
configuring assignment objects for multitiered assignment, see �Configuring Assignment Objects for 
Multitiered Assignment� on page 268.

Alternatively, you can set a default employee, position, or organization for assignment objects. For 
example, if you want records for a given assignment object assigned to a certain employee, you can 
change the Default Employee property on the assignment object using Siebel Tools. For more 
information about the Default Employee, Default Position, and Default Organization properties, see 
Object Types Reference. For more information about setting these properties, see �Configuring 
Assignment Object Properties� on page 51.

NOTE: Assignment Manager does not prevent you from adding employees to an assignment rule that 
performs position assignments. If a particular rule is set for position assignment and the rule has 
employees associated with the assignment rule, Assignment Manager considers only the position 
candidates.
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To add employees to an assignment rule

1 Drill down on the assignment rule for which you want to add employees (Navigate > Site Map > 
Assignment Rules List), and then click the Employee Candidates view tab.

2 In the Employee Candidates list, click New.

3 In the Add Employees dialog box, select the employees to include for this assignment rule, and 
then click OK.

4 In the new employee record, click in the available fields to enter or edit the relevant information.

5 If new candidates are added, make sure you release the assignment rules for the changes to take 
effect. 

For more information about releasing assignment rules, see �Releasing Assignment Rules� on 
page 153.

NOTE: If the All People value is selected in the Person Candidates Source field for the assignment 
rule, all candidates are evaluated even if they are not listed in the Employee Candidates list or the 
Position Candidates list.

Table 26 shows select predefined fields available.

NOTE: For assignment purposes, an employee's organization is the organization corresponding to 
the employee's primary position. For example, if Employee A holds Position A where Position A is in 
the Sales East organization, then Employee A's organization is the Sales East organization.

To add positions to an assignment rule

1 Drill down on the assignment rule for which you want to add positions (Navigate > Site Map > 
Assignment Rules List), and then click the Position Candidates view tab.

2 In the Position Candidates list, click New.

3 In the Add Positions dialog box, select the positions to include for this assignment rule, and then 
click OK.

Table 26. Employee Candidates List Fields

Field Description

Activation Start date of the assignment rule employee.

NOTE: By default, Siebel applications use the Universal Time Coordinated (UTC) 
standard. For more information about UTC, see Global Deployment Guide. 

Expiration End date of the assignment rule employee.

NOTE: By default, Siebel applications use the Universal Time Coordinated (UTC) 
standard. For more information about UTC, see Global Deployment Guide. 

Score An initial score for each employee is permitted in this field to differentiate between 
other employees for potential assignment.
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4 In the new record in the Positions list, click in the available fields to enter or edit the relevant 
information.

5 If new candidates are added, make sure you release the assignment rules for the changes to take 
effect. 

For more information about releasing assignment rules, see �Releasing Assignment Rules� on 
page 153.

NOTE: If the All People value is selected in the Person Candidates Source field for the assignment 
rule, all candidates are evaluated even if they are not listed in the Employee Candidates list or the 
Position Candidates list.

Table 27 shows select predefined fields available for editing.

After you add positions for an assignment rule, only the active employees for each position are 
available. If Assignment Manager assigns the position, employees for the position have visibility to 
the assigned object.

To delete system-assigned positions from individual assignment objects, or to manually assign other 
positions, see the procedure in �Maintaining the Manually Assigned Primary Position� on page 251. You 
can configure Assignment Manager to define additional fields for Positions associated with an 
assignment rule. For more information on defining fields for Positions, see �Configuring Assignment 
Objects to Copy Additional Columns to the Team Table� on page 255.

To add organizations to an assignment rule

1 Drill down on the assignment rule for which you want to add organizations (Navigate > Site Map 
> Assignment Rules List), and then click the Organization Candidates view tab.

2 In the Organization Candidates list, click New.

3 In the Add Organization dialog box, select the organizations to include for this assignment rule, 
and then click OK.

4 In the new record in the Organizations list, click in the available fields to enter or edit the relevant 
information.

Table 27. Positions List Fields

Field Description

Activation Start date of the assignment rule position.

NOTE: By default, Siebel applications use the Universal Time Coordinated (UTC) 
standard. For more information about UTC, see Global Deployment Guide. 

Expiration End date of the assignment rule position.

NOTE: By default, Siebel applications use the Universal Time Coordinated (UTC) 
standard. For more information about UTC, see Global Deployment Guide. 

Score An initial score for each position is permitted in this field to differentiate between 
other positions for potential assignment.
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5 If new candidates are added, make sure you release the assignment rules for the changes to take 
effect. 

For more information about releasing assignment rules, see �Releasing Assignment Rules� on 
page 153.

NOTE: If the All Organizations value is selected in the Organization Candidates Source field for the 
assignment rule, all candidates are evaluated even if they are not listed in the Organization 
Candidates list.

Table 28 shows select predefined fields available for editing.

Choosing a Candidate as the Primary 
Assignee 
Assignment Manager provides the ability to influence a particular candidate to act as a primary 
assignee for a specific assignment rule. You do so by picking an employee, position, or organization 
from the Primary Employee, Primary Position, or Primary Organization pick dialog box in the 
Assignment Rules List list. This primary assignee represents the candidate (employee, position, or 
organization) that is assigned as the primary owner of the assignment object if the candidate passes 
the criteria for that rule.

NOTE: Typically, you choose a primary assignee when creating an assignment rule, however, you can 
add a primary to an existing assignment rule at anytime. But, you must release the rule for the 
change to take effect.

This task is a step in �Process of Defining Assignment Rules� on page 86.

To choose a candidate as the primary assignee

1 Navigate to the Administration - Assignment screen > Assignment Rules List view.

2 In the Assignment Rules List list, select the assignment rule for which you want to assign a 
particular candidate as the primary assignee.

Table 28. Organizations List Fields

Field Description

Activation Start date of the assignment rule organization.

NOTE: By default, Siebel applications use the Universal Time Coordinated (UTC) 
standard. For more information about UTC, see Global Deployment Guide. 

Expiration End date of the assignment rule organization.

NOTE: By default, Siebel applications use the Universal Time Coordinated (UTC) 
standard. For more information about UTC, see Global Deployment Guide. 

Score An initial score for each organization is permitted in this field to differentiate between 
other organizations for potential assignment.
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3 In one of the following fields, click the select button.

■ Primary Employee. If you want to assign a particular employee, query for that employee, 
and then click OK.

■ Primary Position. If you want to assign a particular position, query for that position, and 
then click OK.

■ Primary Organization. If you want to assign a particular organization, query for that 
organization, and then click OK.

TIP: The Primary Employee, Primary Position, and Primary Organization fields may not be 
visible in the initial view; use the Columns Displayed feature to make the fields visible (right-
click, select Columns Displayed, use the arrows to move a field from Available Columns to 
Selected Columns, and then click Save).

Associating Skills with Employees, 
Positions, and Organizations
You use skills to find the best matching candidates to assign to assignment objects. Skills can be 
associated with individual employees, positions, or organizations. During the assignment process, 
Assignment Manager identifies candidates that have the relevant skills for assignment to a particular 
item. For example, a service request requiring an agent who has expertise for a particular product 
is routed to someone who has that product expertise as a part of their skill set.

This task is a step in �Process of Defining Assignment Rules� on page 86.

You enable and configure skills at the criteria level by using Siebel Tools. For more information on 
defining criteria for skills, see �Process of Defining Criteria Values as Skills with Expertise Codes and 
Weighting Factors� on page 114. 

NOTE: Assignment Manager caches employee, position, and organization skills when the Siebel 
Server is started. Every time rules are released, employee, position, and organization skills are 
updated and cached. If you want to automatically refresh employee, position, and organization skills 
at a periodic interval, set the value of Refresh people skills interval (the MaxSkillsAge AsgnSrvr 
component parameter) to the desired interval of update.

To associate skills with an employee

1 Navigate to the Administration - User screen > Employees > Assignment Skills view.

2 In the Employees list, select the employee for whom you want to define skills.

3 In the Assignment skills list, click New to add a new record.

4 In the Skill field, select a skill from the drop-down list.
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5 In the Assignment Skill Items list, click New to add a new record, and then complete the 
necessary fields.

The columns that display in the Employee Skill Items list depend on the skill chosen from the 
drop-down list in the Assignment Skills list.

NOTE: Employees can also track and update their own skill profiles in the User Preferences Profile 
view (Navigate > User Preferences > User Profile > Assignment Skills).

To associate skills with a position

1 Navigate to the Administration - Group > Positions > Assignment Skills view.

2 In the Positions list, select the position for which you want to associate skills. 

3 In the Assignment Skills list, click New.

4 In the Item field, select a skill from the drop-down list.

5 Scroll down to the Position Skill Items list, click New to add a new record, and then complete the 
necessary fields.

NOTE: The columns that display in the Position Skill Items list depend on the skill chosen from 
the drop-down list in the Assignment Skills list.

To associate skills with an organization

1 Navigate to the Administration - Group > Positions > Assignment Skills view.

2 In the Organizations list, select the organization for which you want to associate skills.

3 In the Assignment Skills list, click New.

4 In the Item field, select a skill from the drop-down list.

5 Scroll down to the Organization Skill Items list, click New to add a new record, and then complete 
the necessary fields.

NOTE: The columns that display in the Organization Skill Items list depend on the skill chosen 
from the drop-down list in the Assignment Skills list.

How Assignment Manager Balances 
Workload Among Candidates
Workload distribution is a special criteria type that balances the load between candidates. You create 
workload distribution by adding workload rules in the Assignment Workload view for employees and 
positions, or the Assignment Organization Workload view for organizations. Workload distribution is 
generally used with service assignments. 

Optionally, you can also define your own workload rules using the Workload Distribution Rules view. 
For more information about defining assignment workload distribution rules, see �Creating 
Assignment Workload Distribution Rules� on page 128.
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How Workload Distribution Applies Workload Scores to Candidates 
Workload distribution applies a workload score to candidates based on their current workload. The 
workload score is calculated as follows:

Workload score = Score * (1 � (current workload/maximum workload))

NOTE: The candidate�s current workload excludes the workload of the current object being assigned.

Candidates with a lighter workload receive a higher score than candidates with a heavier workload. 
The workload score is then added to the candidate�s score to generate a total score. Candidates that 
have workloads in excess of the maximum workload are eliminated from the assignment rule. This 
criteria prevents employees from being overloaded. Multiple workload distributions can be used for 
each assignment rule.

NOTE: As with criteria, workload distribution has a Required field, which functions in the same 
manner as it does for regular criteria. 

Figure 18 shows a workload distribution rule that:

■ Adds 100 points to candidates with a workload of 0 items (100* (1-(0/2))

■ Adds 50 points to candidates with a workload of 1 item (100* (1-(1/2))

■ Adds 0 points to candidates with a workload of 2 items (100* (1-(2/2))

■ Eliminates candidates with a workload of more than two items if the workload distribution rule is 
marked as Required

Enabling MLOV Capability for Workload Distribution 
Workload distribution can be enabled for multilingual list of values (MLOV) capabilities with additional 
configuration. MLOV allows you to store workload distribution in a form that can be retrieved and 
displayed in a variety of supported client languages. For more details on this feature, see Configuring 
Siebel Business Applications.

Figure 18. Sample Workload Distribution
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Process of Defining Assignment 
Workload 
There are two methods for defining workload rules�using predefined workload rules or creating your 
own workload-rule definitions. This topic discusses how to use both options.

Assignment Manager provides a set of predefined workload rules that allows you to define workload 
distribution in assignment rules for employees, positions, or organization. 

Table 29 lists the predefined assignment workload rules:

Optionally, you can create your own workload rules. Use the following procedures to define 
assignment workload if you plan to create your own workload distribution rules. 

NOTE: If you plan to use the predefined workload distribution rules, skip to Step 2. 

1 (Optional) �Creating Assignment Workload Distribution Rules� on page 128

2 �Applying Assignment Workload Distribution to Employees, Positions, and Organizations� on 
page 130

Table 29. Predefined Assignment Workload Rules

Workload Rule Name Assignment Object

Critical Service Requests Service Request

Excellent Leads Opportunity

Open Opportunities Opportunity

Total Open Service Requests Service Request
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Creating Assignment Workload Distribution Rules
If you prefer to create you own workload distribution rules, in lieu of using the predefined rules, use 
the following procedure.

NOTE: When creating your own workload rules, keep in mind that performance may be affected if 
Assignment Manager is accessing a nonindex column or retrieving the total number of records. 

This task an optional step in �Process of Defining Assignment Rules� on page 86 and �Process of 
Defining Assignment Workload� on page 127.

To create assignment workload distribution rules

1 Navigate to the Administration - Assignment screen > Workload Distribution Rules view.

NOTE: If you plan to use the predefined workload rules, skip to Step 4.

2 In the Workload Rules list, click New.

3 In the new record, click in the available fields to enter the relevant information for the workload 
rule.

a In the Name field, type a name for the workload rule.

b In the Assignment Object field, select the assignment object of the workload rule. 

NOTE: The workload rule�s assignment object must match the assignment rule�s assignment 
object; otherwise, the assignment workload criteria is excluded or a run-time error occurs 
(dependent on the assignment rule assignment object�s Ignore Extra Attributes run-time 
parameter setting).

4 With the appropriate workload rule selected, in the Workload Conditions view, click New.

5 In the new record, click in the available fields to enter the relevant information for the workload 
conditions.

a In the Field field, select a value to define the workload condition. 

The fields that are available depend on the assignment object selected in Step 3 on page 128.

b In the Comparison field, select a comparison method.

NOTE: When specifying values for the comparison operands (LIKE, NOT LIKE, IN, NOT IN, 
and BETWEEN), the Value field must be in a form that the underlying database expects. For 
more information about operands, see Siebel Developer�s Reference.
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c In the Value field, select a value with which you want to compare the workload condition.

The values that are available depend on the workload condition selected in Step 3 on 
page 128.

TIP: If the drop-down arrow does not appear when you select the Value field, you need to 
enter an appropriate value. For example, if you are creating a workload rule for an 
Opportunity object and using Position Id as the workload condition, you need to enter the 
physical ROW_ID of the positions.

NOTE: If the assignment object selected for the workload criteria is team-based, workload criteria 
using this workload rule should be associated with an assignment rule only if the workload rule object 
has the team table (or owner field) referenced by one of its workflow components.

Figure 19 shows an example of creating a workload rule called Example for the Account assignment 
object. The workload condition requires that the account state equal CA.

Figure 19. Creating Workload Distribution Rules
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Applying Assignment Workload Distribution to 
Employees, Positions, and Organizations
You balance workload among candidates by adding workload distribution rules for employees and 
positions, and organization workload distribution rules for organizations. For example, if your 
business logic includes limits on the maximum amount of work that can be handled at one time, you 
would apply assignment workload to your assignment rules.

The following tasks are one step in �Process of Defining Assignment Workload� on page 127 and 
�Process of Defining Assignment Rules� on page 86.

Applying Workload Distribution to Employees and Positions
Use the following procedure when defining workload distribution for employees or positions.

To apply workload distribution to employees and positions

1 Drill down on the assignment rule for which you want to define workload criteria (Navigate > Site 
Map > Administration - Assignment > Assignment Rules List), and then click the Workload 
Distribution view tab.

2 In the Workload Distribution list, click New.

3 In the new record, click in the available fields and enter the relevant information.

Table 30 shows the available predefined fields.

Table 30. Workload Distribution Fields for Employees and Positions

Field Description Example

Workload 
Distribution Rule

Name of the workload rule to apply to the assignment 
rule.

Total Open Service 
Requests

Assignment Object Type of assignment object related to this workload rule. Service Request

Score Score to apply for this workload rule. For more 
information on workload scores, see �Process of Defining 
Assignment Workload� on page 127.

50

Required Determines whether the workload rule is required for the 
assignment rule. The choices are Always and Never.

Always

Maximum 
Workload

The maximum workload allowed for this workload rule. 
For more information on how this value affects the 
workload score, see �Process of Defining Assignment 
Workload� on page 127.

2
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Figure 20 shows an example of defining a workload distribution rule for employees and positions 
using values specified in Table 30.

Applying Workload Distribution to Organizations
Use the following procedure when defining workload distribution for organizations.

To apply workload distribution to organizations

1 Drill down on the assignment rule for which you want to define workload criteria (Navigate > Site 
Map > Administration - Assignment > Assignment Rules List), and then click the Organization 
Workload Distribution view tab.

2 In the Organization Workload Distribution list, click New.

3 In the new record, click in the available fields and enter the relevant information.

Figure 20. Example of Defining Workload Distribution for Employees and Positions
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Table 31 shows the available predefined fields.

Figure 21 shows an example of adding a workload criteria for organizations using values specified in 
Table 31 on page 132.

Table 31. Workload Distribution Fields for Organizations

Field Description Example

Assignment 
Object

Type of assignment object related to this workload rule. Opportunity

Maximum 
Workload

The maximum workload allowed for this workload rule. For 
more information on how this value affects the workload score, 
see �Process of Defining Assignment Workload� on page 127.

3

Required Determines whether the workload rule is required for the 
assignment rule. The choices are Always and Never.

Always

Score Score to apply for this workload rule. For more information on 
workload scores, see �Process of Defining Assignment Workload� 
on page 127.

10

Workload 
Distribution Rule

Name of the workload rule to apply to the assignment rule. Excellent 
Leads

Figure 21. Example of Defining Workload Distribution for Organizations
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Assignment Methodology and Examples 
for Creating Assignment Rules
It is recommended that you have a good understanding of how Assignment Manager evaluates 
candidates and determines assignments before you begin creating your assignment rules, or 
configure, administer, or use the various assignment features.

Figure 22 provides a high-level flowchart of Assignment Manager behavior. 

This topic explains assignment methodology and provides examples for creating different kinds of 
assignment rules. You may, however, use these features differently, depending on your business 
model. The topics are:

■ �Example of Creating Sales Assignment Rules Based on Territories� on page 137

An example of how a sales organization can strategically assign salespeople based on territories.

■ �Example of Creating Sales Assignment Rules That Combine Criteria� on page 139

An example of how a sales organization can distribute its salespeople in the same geographic 
location based on revenue potential.

Figure 22. Assignment Methodology Flowchart
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■ �Example of Creating Assignment Rules for Service Organizations� on page 141

An example of how to create assignment rules for a service organization.

Assignment Methodology
Siebel Assignment Manager uses the following methodology to assign candidates to assignment 
objects.

1 Assignment Manager finds assignment rules for an object. Assignment Manager finds 
active assignment rules for evaluation for the object being assigned. If there are no active rules 
for the assignment object, default assignees are assigned. In rule group mode, all the active 
rules for the assignment object belonging to the rule group of the request are processed.

NOTE: The Default Employee, Default Position, and Default Organization properties for each 
assignment object are defined in Siebel Tools. For more information about these properties, see 
�Adding Employees, Positions, and Organizations to Assignment Rules� on page 120.

2 Assignment Manager evaluates assignment criteria for the object. After Assignment 
Manager determines the rules for processing, it processes rules in ascending sequence number 
order. For each rule, Assignment Manager first evaluates each criterion with the Compare to 
Object comparison method.

NOTE: If criteria marked as Required do not satisfy the object�s attributes, then Assignment 
Manager stops evaluating the assignment rule. 

3 Assignment Manager determines a list of candidates from each assignment rule. For 
each assignment rule that satisfies Step 2, Assignment Manager determines a list of person and 
organization candidates relevant to the assignment rule, depending on the Person Candidate 
Source and Organization Candidate Source fields on the assignment rule.

■ Static candidates from rule. If the Person Candidate Source is indicated as From Rule, 
then:

❏ If the assignment object uses position-based assignment, the candidate list includes the 
positions registered in the Position Candidates view.

❏ If the assignment object uses employee-based assignment, the candidate list includes 
the employees registered in the Employee Candidates view.

■ All People. If the Person Candidate Source is indicated as All People, the candidate list 
includes all registered employees or positions in the Siebel database.

■ Dynamic candidates. If the Person Candidate Source is the name of a team (such as 
Activity Account Team or Activity Asset Team), Assignment Manager obtains the candidate 
list from the team table related to the object row.

The list of organization candidates for each rule are determined using a similar method.
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4 Assignment Manager evaluates each candidate against assignment rule criteria. 
Assignment Manager evaluates each candidate against the criteria using the selected comparison 
method as described in �Assignment Criteria Comparison Methods� on page 98. Workload 
distribution rules are also processed for each candidate.

NOTE: Candidates fail if they do not match any required criterion and are not evaluated further 
against this rule.

5 Assignment Manager scores each qualified candidate for each assignment rule. 
Assignment Manager scores each candidate for an assignment rule based on the sum of:

■ Assignment rule score of each assignment criterion that is satisfied

■ Each assignment criterion value that is satisfied depending on the inclusion method as 
explained in �Assignment Criteria Inclusion Methods� on page 99

Some assignment criteria values (skills) are weighted by expertise.

❏ To rank expertise codes, Assignment Manager uses the Order field in the List of Values 
view in the Administration - Data screen.

❏ To define expertise weight, Assignment Manager uses the Weighting Factor field in the 
List of Values view in the Administration - Data screen.

■ Score for the candidate

For static candidates, this value is specified in the Employees Candidates view, Position 
Candidates view, or Organization Candidates view. For dynamic candidates, this value is 
specified in the Score Column property in the Dynamic Candidate object.

■ Criterion that is calculated as the prorated score

This is the score based on the current workload of candidates compared to the maximum 
workload allowed.

If the Assignment Rule form has the Check Employee Calendar box selected, Assignment 
Manager uses the availability-based assignment feature to submit employee availability 
information to the Field Service Appointment Booking System (ABS), which reviews qualified 
candidates� calendars and work schedules to see who is available to undertake the 
assignment at the required time. Employees who are not available at the requested time for 
the specified duration are eliminated.

At this point, the score for the assignment rule is calculated from either the highest-scoring 
person candidate or organization candidate depending on the value in the Assignment 
Scoring Mode property for the assignment object. 

6 Assignment Manager applies the assignee filter to scored candidates to generate a list 
of potential assignees. Assignment Manager uses the assignee filters to eliminate candidates 
and determine a final list of assignees. The choices are:

■ All, Above Minimum

■ All, Must Assign

■ One, Best Fit

■ One, Random
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7 Assignment Manager evaluates exclusive assignment rules and determines the primary 
assignment rule. If no exclusive assignment rule exists or none of the exclusive rules passed, 
the assignment rule with the highest score is the primary assignment rule. If all assignment rules 
do not have a score or more than one rule has the same highest score, then the assignment rule 
with the lowest row ID is used to break the tie in the process of finding the primary assignment 
rule. If the AddScores property is set to TRUE, scores for each candidate are merged across rules, 
and the candidate primaries are calculated based on the total scores.

If at least one assignment rule marked as exclusive passes, the exclusive assignment rule with 
the higher score is chosen as the primary rule. Only the assignees in this assignment rule are 
kept and all the assignees from other assignment rules are excluded. 

If no rules passed or more than one exclusive assignment rule yields the same highest score, 
Assignment Manager assigns the object to:

■ The default employee for employee-based assignments

■ The default position for position-based assignments

■ The default organization for organization-based assignments

NOTE: When two or more exclusive assignment rules have the same score and the Keep Man 
Asgn Primary Position assignment property is set to TRUE on the object, then the manually 
assigned primary position is retained and the default position is added to the team as a 
nonprimary.

8 Assignment Manager determines the primary assignees. Assignment Manager determines 
the primary assignees from the primary assignment rule:

■ For objects that use employee-based assignments, set the primary assignee to the primary 
employee selected in the Primary Employee field of the Assignment Rule form applet for the 
primary assignment rule. If the selected primary employee is not an assignee that satisfies 
Step 6 on page 135, or if there is no primary employee specified on the rule, then select the 
highest-scoring employee for the primary assignment rule that satisfies Step 6 on page 135.

■ For objects that use position-based assignment, set the primary assignee to the primary 
position selected in the Primary Position field of the Assignment Rule form applet for the 
primary assignment rule. If the selected primary position is not an assignee that satisfies 
Step 6 on page 135, or if there is no primary position specified on the rule, then select the 
highest-scoring position for the primary assignment rule that satisfies Step 6 on page 135.

■ For objects that use organization-based assignments, set the primary organization to the 
primary organization selected in the Primary Organization field of the Assignment Rule form 
applet for the primary assignment rule. If the selected primary organization is not an 
assignee that satisfies Step 6 on page 135, or if there is no primary organization specified on 
the rule, then select the highest-scoring organization for the primary assignment rule that 
satisfies Step 6 on page 135.

NOTE: The primary employee, position, or organization must pass the minimum score required 
for this assignment rule for assignment as the primary assignee. The only exception is when the 
Assignee Filter is All, Must Assign, in which case the highest-scoring candidate is a potential 
assignee if all candidates fail to meet the minimum score. For more information about assignee 
filters, see �About Some of the Assignment Rule Fields� on page 90.
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9 Assignment Manager filters out certain assignees based on multitiered mode. By 
default, the assignment mode is set to independently assign qualifying people and organizations. 
If you set one of the other assignment modes�Person-Oriented, Organization-Oriented, Person 
and Organization-Oriented�Assignment Manager filters out unwanted, but qualifying, people 
and organizations based on the relationship that exists between them. Assignment Manager 
recalculates the primaries, if necessary; for example, if primaries were filtered out by multitiered 
filtering. See �Configuring Assignment Objects for Multitiered Assignment� on page 268 for further 
information.

10 Assignment Manager generates assignments. Assignment Manager writes assignees to the 
database to finalize the assignment as follows:

■ Writes the primary assignment rule and primary assignees to the object�s primary table.

■ For team-based objects, writes assignees to the object�s team table.

NOTE: For interactive assignments, assignees appear in the appropriate list applet after 
calculation. The candidate that Assignment Manager determines as the primary appears 
highlighted. The user can then choose the candidate or candidates for assignment, or the user 
can override and assign a different primary by selecting a different record.

Related Topics
�About Some of the Assignment Rule Fields� on page 90

�Creating Assignment Rules� on page 94

Example of Creating Sales Assignment Rules Based on 
Territories 
This topic gives one example of how a sales organization can strategically assign salespeople based 
on territories. You may use this feature differently, depending on your business model. 

Your sales organization wants to create four territories based on geographic location. In this case, 
you may want to create four assignment rules: US NW, US NE, US SE, and US SW, as shown in 
Figure 23. Assignment Manager then assigns your salespeople depending on the geographic location 
of the sales opportunity.

NOTE: For detailed instructions on performing each step in the following procedure, see Chapter 6, 
�Assignment Rule Administration.�

Figure 23. Example of Creating Sales Territories

One of the assignment rules 
representing a sales territory (US 
NW) highlighted in the Assignment 
Rules List view.
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To create sales assignment rules based on territories

1 Create assignment rules as sales territories.

In this example, in the Assignment Rule view you create four assignment rules, one for each 
territory as shown in Figure 23.

2 Determine the assignment criteria.

In this example, in the Assignment Criteria view, you define Account State as the criteria for each 
assignment rule, because the assignment rules are based on territories.

3 Define the criteria values.

In this example, in the Assignment Criteria view, you use the states that make up each territory 
as criteria values.

The following figure shows an example of defining a sales territory using assignment criteria and 
values as described in Step 2 and Step 3.

4 Add the Positions.

In the Assignment Positions view, add the sales positions responsible for each territory. As an 
example, you add Division Manager - West and Field Sales Representative to the US NW 
assignment rule.

NOTE: To specify a primary position, you must set the primary at the rule level (in the Primary 
Position field in the Assignment Rule List view) and also assign a specific position within that rule 
(Assignment Rules > Positions).

5 Release the assignment rules.

In the Assignment Rules view, click the Release button. You can then run Batch Assignment to 
assign objects affected by the assignment rules. For more information about running Batch 
Assignment, see �Running Batch Assignment� on page 228.
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After these assignment rules are released, Assignment Manager assigns salespeople based on the 
geographic location of the sales opportunity. For example, a sales opportunity in California is 
assigned to a Western Field Sales Representative.

NOTE: After an account or opportunity has been assigned to a sales team, the list of Territory 
definitions used by Assignment Manager for this item is added to the item record in the Territories 
field. This list cannot be edited in the standard user Account or Opportunity detail views.

For an example of how a sales organization can strategically distribute salespeople by using 
assignment rules based on territories and revenue, see �Example of Creating Sales Assignment Rules 
That Combine Criteria� on page 139.

Assignment Manager Behavior When All Assignment Rules Fail
If no qualifying assignment rules are found, that is, all evaluations fail, then Assignment Manager 
replaces the team and assigns the default position as the primary position. For example, assume you 
run batch assignment on the Account assignment object without specifying an object WHERE clause. 
In this case, Assignment Manager processes all Account records. For each account, if no matching 
assignment rules are found, then Assignment Manager can potentially replace the account team with 
the default position. This can ultimately result in reassignment of all accounts.

Example of Creating Sales Assignment Rules That 
Combine Criteria 
This topic gives one example of how a sales organization can distribute its salespeople in the same 
geographic location based on revenue potential. You may use this feature differently, depending on 
your business model.

You can create territories that use the same geographic location but different revenue potentials. In 
this example, you may want to create two assignment rules: US SW High Revenue and US SW Low 
Revenue as shown in Figure 24. Assignment Manager then assigns your salespeople, depending on 
both the geographic location and the revenue potential of the sales opportunity.

NOTE: For detailed instructions on performing each step in the following procedure, see Chapter 6, 
�Assignment Rule Administration.�

Figure 24. Example of Creating Assignment Rules with Combined Criteria

Two assignment rules, one 
for each territory, created 
for opportunity objects.
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To create sales assignment rules that combine criteria

1 Create assignment rules.

In this example, create two assignment rules, one for each territory, as shown in Figure 24.

2 Determine the assignment criteria.

In this example, select Account State and Revenue as the criteria.

3 Define the criteria values.

In this example, use the states that make up each territory as the Account States criteria values. 
For the Revenue criteria values, select different assignment attributes for each assignment rule:

■ For the US SW High Revenue assignment rule, type 100,001 in the Revenue Low assignment 
attribute.

■ For the US SW Low Revenue assignment rule, type 100,000 in the Revenue High assignment 
attribute.

NOTE: The columns that appear in the Values list applet change dynamically depending on the 
criteria selected in the Criteria list applet.

The following figure shows an example of defining the US SW High Revenue assignment rule as 
described.

4 Add the positions for this assignment rule.

In this example, you add a different sales position for each assignment rule:

■ For the US SW High Revenue assignment rule, add Division Manager - West.

■ For the US SW Low Revenue assignment rule, add Western Field Sales Representative.

The figure shown in Step 3 shows an example of defining the US SW High Revenue assignment 
rule as described.
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5 Release the assignment rules. 

In the Assignment Rules view, click the Release button. You may then run Batch Assignment to 
assign objects affected by the assignment rules. For more information about running Batch 
Assignment, see �Running Batch Assignment� on page 228.

After these assignment rules are released, Assignment Manager assigns salespeople based on 
the geographic location and revenue potential of the sales opportunity. For example, a sales 
opportunity in Nevada with a revenue potential of over $100,000 is assigned to the western 
division manager. However, a sales opportunity in New Mexico with a revenue potential of 
$100,000 or lower is assigned to a western field sales representative.

Example of Creating Assignment Rules for Service 
Organizations
This topic gives one example of how to create assignment rules for a service organization. You may 
use this feature differently, depending on your business model.

Use the following strategy to develop assignment rules for your service organization:

1 Determine the different assignment objects to be assigned.

Service organizations need to assign ownership of a wide variety of tasks. These tasks may 
include service requests, activities, and accounts. In addition, a product development 
organization may need to assign ownership of product defects to engineers. For instance, you 
may decide to assign only service requests and product defects, because the associated activities 
are manually assigned by owners of those objects.

2 Determine if multiple assignment objects are assigned using the same assignment rules.

Multiple assignment objects can be assigned using the same assignment rules. For example, if 
you are assigning accounts and service requests in the same manner, you can use the same 
assignment rules by associating those rules with multiple assignment objects.

3 For each assignment object, determine which of the objects is assigned using the same 
assignment rules.

The Compare to Object comparison method allows you to assign different groups of objects using 
different rules. Typically, complex service environments assign different groups of service 
requests using different rules, such as segmenting the service requests based on service request 
priority.

4 Determine the strategy for each group of objects to be assigned using the same assignment 
rules.

Use the skill criteria to minimize the number of assignment rules. One assignment rule can match 
different candidates to various objects based on the object characteristics and candidate skills. 
To determine optimal assignment, determine the criteria that you want to evaluate for each 
candidate to make sure that the candidate possesses the proper skills to handle the task. This is 
the primary type of criteria you use most frequently for implementing assignments in a customer 
service environment. These criteria are defined using the Compare Object to Person comparison 
method in the Assignment Criteria view.
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5 Define workload rules.

Determine the various methods of calculating workloads for employees in your organization. 
Each workload rule is associated with a specific assignment object. For instance, you can define 
two workload rules to calculate:

■ Open Service Requests for an employee

■ Critical Service Requests submitted through Siebel eService

6 Define assignment rules, assignment criteria, assignment criteria values, and assignment 
workloads.

Using the strategy, rules, and criteria discussed previously, define the assignment rules and the 
corresponding detail using assignment administration views. In defining rules, criteria, values, 
and workloads, you can specify scores for each component. These scores are aggregated in 
determining the total score for each candidate of an assignment rule.

7 Define static and dynamic candidates.

For static candidates, use the assignment rule Employee, Position, or Organization Candidates 
view (or use the All People value in the Person Candidates Source field or the All Organizations 
value in the Organization Candidates Source field) to define eligible employees for assignment. 
For dynamic candidates, choose the appropriate value from the Person Candidates Source field.

You may further restrict or weight employees who have different skills using the Compare to 
Person assignment criteria.

8 Define employee skills.

After the assignment rules and the corresponding details have been defined, a customer service 
manager must update the employee skill information (such as product expertise, language skills, 
and geography). Assignment Manager uses these attributes when evaluating Compare to Person 
and Compare Object to Person assignment criteria.

9 Release assignment rules.

In the Assignment Rules view, click the Release button. You can then run batch assignment to assign 
objects affected by the assignment rules. For more information about running Batch Assignment, see 
�Running Batch Assignment� on page 228.
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Figure 25 shows a sample assignment rule for assigning support representatives to a service request.

The assignment rule shown in Figure 25:

■ Matches any service request:

■ For Pentium III 600 products

■ With a priority of High

■ Uses two criteria with the following values:

■ Product Wildcard. A list of products that include the value CPU Pentium III 600

■ Service Request Priority. A list of service requests whose priority level is High

About Assignment Policies
Siebel applications include predefined assignment policies for each of the predefined assignment 
objects. You should use these predefined assignment policies, however, you can also create new 
assignment policies for dynamic assignment. If you plan to use the predefined assignment policies, 
you must first activate them.

A Workflow Monitor Agent detects when a user changes data related to objects, and each Workflow 
Monitor Agent can monitor one or more assignment policies. You can use a single Workflow Monitor 
Agent to monitor all assignment policies by placing all assignment policies in the same workflow 
group (the predefined assignment policies are defined this way). You can also place the assignment 
policies in separate workflow groups and dedicate Workflow Monitor Agents for each workflow group. 

The Assignment Manager workflow policy actions you can use for an assignment policy are:

■ Assignment Request (In Process). This action assigns rows in its own process and does not use 
the AsgnSrvr server component.

Figure 25. Assignment Rule for a Service Organization
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■ Assignment Request. This action routes the requests to an AsgnSrvr process running in default 
mode. 

If you want to use the rule group feature in dynamic assignment, create a workflow process that 
submits requests to the Assignment Server (AsgnSrvr) server component using a business service.

For more information about Workflow Monitor Agent, see �About Running Dynamic Assignment� on 
page 220 and Siebel Business Process Designer Administration Guide.

Process of Defining Assignment Policies 
for Dynamic Assignment
To create new assignment policies for dynamic assignment, perform the following tasks:

1 �Creating Assignment Policies for Dynamic Assignment� on page 144

2 �Activating Assignment Policies to Enable Dynamic Assignment� on page 146

Creating Assignment Policies for Dynamic Assignment 
Assignment policies are specialized workflow policies used for dynamic assignment. Siebel 
applications include predefined assignment policies for each of the predefined assignment objects. 
You should use these predefined policies for setting up dynamic assignment, however, you can create 
new assignment policies. 

NOTE: If you create a new assignment object for dynamic assignment, you must also create a new 
assignment policy for that object.

The following tasks are one step in �Process of Defining Assignment Rules� on page 86.

Use the following procedures to create new assignment policies for dynamic assignment.

To create an assignment policy for dynamic assignment

1 Navigate to the Administration - Assignment screen > Assignment Policies view.

2 In the Assignment Policies list, click New.

3 In the new assignment policy record, enter the relevant information.
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Table 32 shows the predefined assignment policy fields.

NOTE: By default, every assignment policy has an action. Use the following procedure only if you 
accidentally remove an action or create a new assignment policy. In addition, you should not 
associate customized workflow actions with assignment policies. For more information about 
workflow actions, see Siebel Business Process Designer Administration Guide. 

To create an action for an assignment policy for dynamic assignment

1 With the newly created assignment policy still selected, in the Actions list, click New.

2 In the Assignment Action field, click the drop-down arrow and select Assignment Request (In 
Process).

NOTE: It is recommended that you use the Assignment Request (In Process) workflow policy 
action because the Assignment Request action might cause performance problems. If you do 
choose to use the Assignment Request action, make sure the AsgnSrvr process is available and 
online. 

3 In the Assignment Mode field, click the down-arrow button and select MatchAssign.

4 (Optional) Add a sequence number, if so desired.

Table 32. Assignment Policy Fields

Field Description

Name The name of the assignment policy.

Workflow Object The assignment object to which the assignment policy belongs.

Policy Group The workflow group for the assignment policy. The default for the predefined 
assignment policies is Assignment Group. Any new policies you create for use 
with Assignment Manager should use the Assignment Group policy group. 

It is recommended that you do not change the policy group for assignment 
policies. However, if you find a need to do so, you should regenerate triggers 
after making the change. For more information about regenerating triggers, 
see Siebel Business Process Designer Administration Guide.

CAUTION: Assign a policy group to only one Workflow Monitor Agent. Multiple 
Workflow Monitor Agents running the same policy group cause unpredictable 
completion times and possible multiple actions created for one trigger. For 
more information on Workflow Monitor Agents, see Siebel Business Process 
Designer Administration Guide.

Activation The start date of the assignment policy.

Expiration The end date of the assignment policy.
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Activating Assignment Policies to Enable Dynamic 
Assignment
To enable dynamic assignment for an assignment object, activate the assignment policy for that 
object. 

This task is a step in �Process of Defining Assignment Rules� on page 86.

To activate an assignment policy to enable dynamic assignment

1 Navigate to the Administration - Assignment screen > Assignment Policies view.

2 In the Assignment Policies list, select the assignment policy you want to activate.

3 In the Expiration field, click to either null the existing value or set the value to a later date.

Workflow components process only active assignment policies that have not expired. 

NOTE: After activating an assignment policy, you must generate triggers again for the changes to 
take effect.

Deactivating Assignment Policies to 
Disable Dynamic Assignment
You may find at some point that you no longer need certain assignment rules. When this occurs, you 
can deactivate those assignment rules. To disable dynamic assignment for an assignment object, 
deactivate the assignment policy for that object.

NOTE: Assignment Manager uses the database time to determine whether a rule is active or not.

To deactivate an assignment policy to disable dynamic assignment

1 Navigate to the Administration - Assignment screen > Assignment Policies view.

2 In the Assignment Policies list, select the assignment policy you want to deactivate.

3 In the Expiration field, set the value to a date that has already passed.

Workflow components process only active assignment policies that have not expired; therefore, you 
can deactivate an assignment policy by expiring it.

NOTE: After deactivating an assignment policy, you must generate triggers again for the changes to 
take effect.
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How Assignment Manager Determines 
the Sequence in Which Rules Are 
Evaluated
When you assign sequence numbers to assignment rules, Assignment Manager evaluates those rules 
in ascending order of the sequence numbers. Assignment rule sequencing provides a means for you 
to prioritize the rules that apply to any given assignment object by order of importance, thereby 
limiting the number of rules that Assignment Manager processes for assignment. For example, you 
might want to run Assignment Manager only for your higher priority rules first, and then if those rules 
pass, stop processing additional rules because candidates are already successfully matched.

If none of the rules have a sequence number, or if all of the rules have the same sequence number, 
then Assignment Manager processes all the rules. However, if some of the rules in the group have 
sequence numbers and other rules do not, the rules with no specified sequence number are 
considered to have a sequence number of 0 and are evaluated first. Therefore, it is recommended 
that you give every rule a sequence number if you use sequencing. 

After processing every assignment rule within a sequence number, Assignment Manager checks to 
see if each rule was successfully assigned. When a rule results in successful assignment, Assignment 
Manager processes the rest of the rules having the same sequence number and then stops 
processing. Subsequently, the rules with higher sequence numbers do not get processed.

As shown in Table 33, Assignment Manager identifies the beginning and end of a segment within a 
sequence by the change in sequence number. For example, Assignment Manager first evaluates rules 
with a sequence number of 1, then evaluates rules with a sequence number of 2, and so on. It does 
not matter, however, how rules within a segment are evaluated.

At run time, Assignment Manager evaluates the rules in the first segment (Segment 1) first, and then 
stops to find out whether an assignment has been made. If it has assigned, Assignment Manager 
does not continue. If it has not assigned, then Assignment Manager continues to the next sequence 
(Segment 2).

Table 33. Example of a Rule Sequence

Segment Assignment Rule Sequence #

1 Assign Sales Rep West 1

Assign Sales Rep North 1

Assign Sales Rep East 1

2 Assign Sales Rep West 2

Assign Sales Rep North 2

3 Assign Sales Rep West 3

Assign Sales Rep North 3

Assign Sales Rep East 3
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If Assignment Manager is running in default mode and there are multiple rule groups defined, then 
Assignment Manager evaluates the rules as if they are part of one big group.

For example, if there are two rule groups loaded by the same Assignment Manager server with the 
sequences shown in Table 34.

Then, this is the order Assignment Manager evaluates those rules:

A1
A1
A1
B1
B1
A2
A2
B2
B2
A3
A3
B3
B3
B3

Sequence numbers can be assigned to assignment rules when creating new assignment rules or can 
be added to assignment rules at a later time.

Related Topic
�Adding a Sequence Number to Assignment Rules� on page 149

Table 34. Example Group Rules A and B

Rule Group A Rule Group B

1 1

1 1

1 2

2 2

2 3

3 3

3 3
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Adding a Sequence Number to 
Assignment Rules
This topic explains how to add sequence numbers to assignment rules.

To add a sequence number to an assignment rule

1 Navigate to the Administration - Assignment screen > Assignment Rules List view.

2 In the Assignment Rules List list, select the assignment rule for which you want to define rule 
sequencing.

3 In the Sequence field, enter a sequence number.

Related Topic
�How Assignment Manager Determines the Sequence in Which Rules Are Evaluated� on page 147

How Assignment Manager Uses Server 
Key Maps to Load Rules to a Particular 
Siebel Server 
For each Siebel Server, you use server key maps to define multiple rule groups that you want that 
server to load and process. This allows you to use different servers for different business purposes. 
After you define server key maps in the assignment administration views, each assignment server 
(AsgnSrvr) process looks for the server name in the key mappings during startup and only loads rules 
from those rule groups. The AsgnSrvr also registers the rule group row IDs as keys. When you submit 
a request to a server, you must submit the AsgnKey parameter as a row ID of one of the rule group 
row IDs assigned to that server. 

The server key mapping process uses an internal key-based routing mechanism to route requests to 
a particular server, however, this is done in the background and is not apparent. You can specify 
multiple servers to load the same rule group. In this case, the Siebel Server Request Broker 
component routes requests, based on load balancing metrics, to one of the assignment servers that 
loaded that rule group. 

You can mark certain rule groups for use only with server key maps. These rule groups are not loaded 
by any Assignment Manager component operating in default mode.
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The server key mapping feature is supported only in certain environments when using specific 
functionality as follows:

■ Script or workflow process calling a business service. You can invoke Assignment Manager 
through a business service from within a workflow process, or from a script, using one of the 
following predefined business services:

■ Server Requests business service. Use this generic business service to submit requests 
to a particular component using the server request broker. With this business service, you 
can use the Assignment Manager server mapping feature. If you are using this business 
service to invoke rules based on rule groups, pass the AsgnKey parameter as the input 
parameter, and pass the ReqKey parameter as a request parameter (in the child property set 
for the component). Then, set both the AsgnKey and ReqKey parameters to the rule group 
Id of the relevant rule group.

■ Synchronous Assignment Manager Requests business service. This business service 
has one method available: Assign. This method sends a request to the Assignment Manager 
server component using the AsgnObjName and ObjRowId parameters. All active rules in the 
database are processed. 

Use this business service:

❏ To submit requests to assign a single object row

❏ With the Default Group (when no server key maps are defined)

For more information about business services, see Siebel Business Process Designer Administration 
Guide. For more information about scripting, see Object Types Reference.

■ Interactive assignment. In the default configuration, interactive assignment runs in default 
mode. However, interactive assignment can be customized to use the server key mappings 
feature using the SetAsgnKey InvokeMethod on the business component base class CSSBCBase. 

Using a script, a workflow process, or a business service, you call the InvokeMethod to pass the 
row ID of one of the rule groups as the parameter. The interactive assignment uses this 
parameter as the AsgnKey and ReqKey parameters when submitting requests to the AsgnSrvr 
component. 

You call InvokeMethod only once for one session, but subsequent requests in the same session 
reuse the rule group row ID. However, when the session is logged out or the server is restarted, 
you must call InvokeMethod again to set the AsgnKey parameter. Otherwise, Assignment 
Manager reverts to running in default mode. 

NOTE: When operating Assignment Manager in default mode, rules from rule groups that have 
the Key Based flag checked are not loaded.
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■ Batch assignment and dynamic assignment do not read server key mappings

NOTE: You cannot run Default Mode and Server Key Mappings mode on the same assignment server 
because the two tasks are mutually exclusive functionalities. For example, you cannot use the same 
assignment server to run resource assignment (used for professional service automation and does 
not use rule groups) and credit assignment (used for sales and does use rule groups). You should 
run assignment for each on different servers.

TIP: Siebel Incentive Compensation and Siebel Marketing are specifically designed to use the server 
key maps and rule group features. For more information about each of these Siebel products, see 
Siebel Marketing Installation and Administration Guide.

Related Topics
�Defining Server Key Maps for Assignment Rule Groups� on page 151

Defining Server Key Maps for 
Assignment Rule Groups 
This topic explains how to define server key maps for assignment rule groups. You can at anytime 
change a server key mapping to another rule group or another Siebel Server. 

To define a server key map

1 Navigate to the Administration - Assignment screen > Server Key Mappings view.

2 In the Assignment Server Key Mappings list, click New.

3 In the new record, click in the available fields to enter relevant information.

Table 35 shows the predefined fields.

Table 35. Server Key Map Fields

Field Description

Assignment 
Rule Group

The assignment rule group that you wish to associate with a particular Siebel 
Server running Assignment Manager.

Siebel Server 
Name

The name of the Siebel Server that is running that instance of Assignment 
Manager. Note that you should enter the logical Siebel Server name, not the 
machine name.

For more information about Siebel Servers, see Siebel System Administration 
Guide.
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If you want to exclusively mark certain rule groups for use with server key maps, you can set the 
Key Based flag to true for these rule groups (using the Key Based list column on the assignment Rule 
Groups List view). These rule groups are not loaded by any Assignment Manager component 
operating in default mode. For more information on rule group usage, see �Creating Assignment Rule 
Groups� on page 88.

Related Topics
�How Assignment Manager Uses Server Key Maps to Load Rules to a Particular Siebel Server� on 
page 149

Generating Assignment Reports
Assignment rules are associated with many different elements, such as criteria, employees, 
positions, organization, workload rules, organization workload, activation date, expiration date, and 
so on. Because those elements are organized in different screens in the application, it is rather 
cumbersome to view all information linked to an assignment rule. Assignment reports make it easier 
to inspect assignment rule details.

NOTE: Assignment reports and Reporting Mode are mutually exclusive features.

Assignment Manager provides the ability to output and print the following reports:

■ Assignment Manager Detail

■ Territory Assignment Detail

NOTE: To generate reports, you must be connected to the Siebel Application Server and the Report 
Server must be running. In addition, you need to configure the Siebel Server before generating 
reports. For more information about working with reports, see Siebel Reports Administration Guide.

To generate an assignment report

1 On the toolbar, click the Reports icon.

2 From the popup list, select one of the following:

■ Assignment Manager Detail

■ Territory Assignment Detail

3 (Optional) Print the report.
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Preparing to Release Assignment Rules
Table 36 lists the administrative tasks for preparing for and releasing assignment rules. Perform 
these tasks in the order provided, if they are applicable to your deployment.

Related Topic
�Releasing Assignment Rules� on page 153

Releasing Assignment Rules 
After you define your assignment rules or make any changes to the rules, criteria, values, or 
candidates (employee, position, or organization) for the assignment rules, you must release them to 
instruct Assignment Manager to use these rules. Releasing assignment rules also updates the 
rulecache.dat file. For more information about the rulecache.dat file, see �About Assignment Manager 
Rule Cache Files� on page 237.

NOTE: The following procedure releases all assignment rules simultaneously. Do not release 
assignment rules while associated server tasks are running.

After you have defined your assignment rules, you need to release the rules and possibly perform a 
a few additional administrative tasks. 

Table 36. Tasks for Releasing Assignment Rules

Task UI Tools

1 (Optional) �Defining Server Key Maps for Assignment Rule Groups� on page 151 X

2 (Optional) Set up Assignment Manager for availability-based assignment 

a In Siebel Tools, complete several tasks.

See �Process of Configuring Assignment Objects for Availability-Based 
Assignment� on page 280.

b In the UI, check the Check Employee Calendar field for each assignment rule 
you want to assign by availability. 

X X

3 (Optional) Define load splitter configuration

See �Setting Up Load Splitter Configuration� on page 293.

X

4 �Releasing Assignment Rules� on page 153 X
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To release assignment rules 

1 Navigate to the Administration - Assignment screen > Assignment Rules List view.

2 In the Assignment Rules list, click the Release button.

A confirmation message appears indicating the rules have been released. 

NOTE: You can also update the rule cache by deleting the rule cache files and restarting the Siebel 
Server. Search for *rulecache*.dat in the siebel_server\bin folder.

TIP: If you want to verify the new or modified rules have been applied, check the timestamp of the 
rulecache.dat file or the AsgnSrvr log file. 

When a new Siebel Server is installed�for instance, as part of an upgrade�pending assignment rules 
are released (the rule cache is recreated) on the first startup. It is recommended that you release 
assignment rules after installation so that servers in the deployment recreate the same rule cache. 

Related Topic
�Preparing to Release Assignment Rules� on page 153

About Migrating Assignment Rules
You can use Siebel Enterprise Integration Manager (EIM) or Application Deployment Manager (ADM) 
to migrate assignment rules from one system to another, such as from a test environment to a 
production environment. If you add or change assignment objects, assignment attributes, or 
assignment criteria, you must also migrate the repository to the server production database.

When migrating, Assignment Manager automatically updates existing assignment rules as follows:

■ If All People is selected in the Person Candidates Source field on the assignment rule, then the 
new value in the PERSON_CAND_TYPE column is All People. 

■ If All People is not selected in the Person Candidates Source field on the assignment rule, then 
the new value in the PERSON_CAND_TYPE column is From Rule. 

■ If All Organizations is selected in the Organization Candidates Source field on the assignment 
rule, then the new value in the BU_CAND_TYPE column is All Organizations. 

■ If All Organizations is not selected in the Organization Candidates Source field on the assignment 
rule, then the new value in the BU_CAND_TYPE column is From Rule. 

For more information about migration, see Siebel Enterprise Integration Manager Administration 
Guide and Going Live with Siebel Business Applications.
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Candidates
This chapter describes how to configure and administer dynamic candidate functionality in Siebel 
Assignment Manager. It includes the following topics:

■ �About Dynamic Candidates� on page 155

■ �About Dynamic Candidate Types� on page 157

■ �Examples of Dynamic Candidate Assignment� on page 159

■ �Example of Assigning Dynamic Candidates to the Same Object� on page 162

■ �Process of Defining Dynamic Candidates� on page 163

■ �Configuring Assignment Objects for Dynamic Candidates� on page 164

■ �Configuring Join Specifications for Dynamic Candidate Object Definitions� on page 166

■ �Mapping Columns From Source Tables to Team-Based Criteria� on page 168

■ �Copying Dynamic Candidate Attribute Columns to the Team Table� on page 169

■ �Adding Dynamic Candidate Teams to Assignment Rules� on page 170

About Dynamic Candidates
Dynamic candidates are potential assignees for objects and behave in the same manner as static 
candidates. When processing rules, Assignment Manager determines candidates based on the value 
in the Person Candidates Source or Organization Candidates Source field on the assignment rule. 

For example, if you associate an activity with an asset, and that asset has a team of employees, you 
can configure Assignment Manager to automatically consider this team of employees for the activity 
and have the same employees available as potential candidates for other activities. The employees 
are connected to the activity through the asset and are known as dynamic candidates. The team of 
employees associated with the asset is known as the candidate table because this is the database 
table where the candidates are stored. In this example, the only potential candidates are the 
employees that are associated with the asset that is associated with the activity.

NOTE: Prior to version 7.8, Candidate Table was known as Team Table. The two terms are 
synonymous, that is, the table that contains the dynamic candidates. For example, the 
S_ASSET_EMP table is the candidate table (team table) for the dynamic candidate Activity Asset 
Team. 

By default, the Activity assignment object is preconfigured for two dynamic candidate teams�
Activity: Account Team and Activity: Asset Team. For the Activity Asset Team, Assignment Manager 
dynamically determines the potential activity assignees (candidates) from the dynamic candidate 
configuration, that is, it joins the activity to the asset and retrieves employees associated with that 
activity's asset. The potential candidates are the group of employees for that particular activity 
record. However, the potential candidates can change from activity to activity.
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For example, if you have two activities with different assets and employees as shown in Table 37, the 
resulting potential candidates for assignment are a union of the employees for each activity. In this 
example, the potential candidates are:

■ Activity 1: Employee 1, 2, 3, and 4

■ Activity 2: Employee 1, 2, and 5

Using Siebel Tools, you can configure dynamic candidates for other assignment objects. For more 
information about configuring assignment objects for dynamic candidates, see �Process of Defining 
Dynamic Candidates� on page 163.

Table 37. Example of Two Activities with Different Assets and Employees

Activity/Asset Employee 1 Employee 2 Employee 3 Employee 4 Employee 5

Activity 1 with Asset 1 X X

Activity 1 with Asset 2 X X X

Activity 2 with Asset 1 X X

Activity 2 with Asset 3 X
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About Dynamic Candidate Types
Depending on how an assignment object is configured, the object can be assigned as either single 
owner or multiple owner. Dynamic candidates are also assigned as single owner or multiple owner, 
as shown in Figure 26. 

Figure 26 shows the following relationships:

■ Candidates are of the single-owner type when you can associate only one candidate (employee, 
position, or organization) with an assignment object. 

In this example, one employee is associate with a service request, as shown in the top left of 
Figure 26. For a more detailed example, see the first example in �Examples of Dynamic Candidate 
Assignment� on page 159.

■ Candidates are of the multiple-owner type when you can associate many candidates (employees, 
positions, or organizations) with an assignment object.

In this example, multiple employees are associated with an activity, as shown in the top right of 
Figure 26, and multiple positions are associated to an opportunity, as shown in the bottom half 
of Figure 26.

Figure 26. Example of Single- Versus Multiple-Owner Dynamic Candidate Types
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The main difference between single- versus multiple-owner is that in single-owner situations, 
Assignment Manager can assign only one candidate, whereas in multiple-owner situations, 
Assignment Manager can assign many candidates. For information about which assignment objects 
are restricted to a single assignee and those objects that are capable of incorporating a team of 
assignees, see Table 5 on page 29.

Using Siebel Tools, you configure dynamic candidates by modifying Dynamic Candidate object 
properties. For more information about configuring dynamic candidates, see �Process of Defining 
Dynamic Candidates� on page 163.

In the UI, you define team-based criteria for assignment rules that have dynamic candidates as you 
would any other criteria, that is, you apply a comparison method and define the criteria values. Only 
the Compare to Person or the Compare to Organization comparison methods are supported for team-
based criteria.

However, an assignment rule defined for dynamic candidates does not necessarily need team-based 
criteria. An assignment rule can have any of the following:

■ Static candidates and regular criteria

■ Dynamic candidates and regular criteria

■ Dynamic candidates and team-based criteria

■ Dynamic candidates and a combination of regular and team-based criteria

Scenario for Using Dynamic Candidates with Team-Based Objects
This scenario provides an example of assigning only Sales Team positions to an opportunity related 
to an account. You may use this feature differently, depending on your business model.

A large corporation has just identified a new opportunity for an existing account. The senior VP wants 
to make sure that only members of a specific sales team are assigned to this opportunity. The sales 
team for this account opportunity has the following positions:

:

Position Name Role Primary

VP, Global Services Executive Sponsor

Sales East - Manager Sales Team

Sales Rep 43 Sales Team X
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Examples of Dynamic Candidate 
Assignment
This topic gives two examples of how you might use dynamic candidate assignment. You may use 
this feature differently, depending on your business model. 

Example 1: Dynamic Candidate Assignment for a Service Organization
Generally, in high-value machinery or asset-based service organizations, each asset is typically 
associated one or more field service engineers (FSEs). These preassigned FSEs are often the 
customer�s first contact for service requests, onsite visits for preventive maintenance, break-fix type 
of activities, and so on. In addition, these FSEs are usually ranked as Primary, Secondary, or Tertiary 
based on their seniority, skills, and so on.

This scenario provides an example of a process performed by field service engineers (FSEs) in an 
x-ray manufacturing company. Your company may follow a different process according to its business 
requirements.

During a typical day in a field service organization, a group of FSEs responds to customer phone calls 
and prepares for onsite visits for preventative maintenance and break-fix type of activities. In this 
scenario, a hospital calls for preventative maintenance for their x-ray machine as per warranty 
conditions. 

To handle the incoming request, the service center agent creates a service request, and then creates 
a preventative maintenance activity for that service request. Next, the agent assigns that activity 
(by clicking the Assign button in one of the service request views), and the results window appears 
with the potential assignees for the asset team. The agent can then choose the appropriate candidate 
to complete the assignment process. Typically, FSEs are ranked as primary, secondary, or tertiary 
based on their seniority, skills, and so on, and the agent bases his decision on this ranking.
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Example 2: Dynamic Candidate Assignment Using Skills and Scoring
Table 38 provides sample data for a another example. The numbers at the top of the table correspond 
to the numbered text following the table. Because the resulting list of potential assignees is 
dependent on the assignee filter and other criteria stipulated in the assignment rule, a few resultant 
examples follow the table.

1 The asset has an asset team and each employee in that team has a type. All the employees in 
this team are eligible candidates for the activity. The employees are scored based on their type 
and the following assignment rules:

■ If Organization = Americas, primary score = 100.

■ If Organization = Europe, primary score = 50.

Based on the rules and their type, assume the asset team scores are:

Employee 1 =100
Employee 2 = 75
Employee 3 = 50
Employee 4 = 25
Employee 5 = 0

2 The activity has an account team and each employee in that team has a type. All the employees 
in this team are eligible candidates for this activity. The employees are scored based on their 
type.

The account team scores are:

Employee 3 = 80
Employee 6 = 60
Employee 2 = 30
Employee 4 = 10
Employee 7 = 0

Table 38. Sample Data for Dynamic Candidates Assigned to an Activity

1 2 3 4

Asset Team 
Member Type

Account Team 
Member Type

Service 
Region Skills

Employee 1 Primary Employee 3 Primary Employee 1 ENU

Employee 2 Secondary Employee 6 Secondary Employee 2 FRA

Employee 3 Tertiary Employee 2 Tertiary Employee 3

Employee 4 Tech Support Employee 4 Tech Support Employee 7

Employee 5 Never Send Employee 7 Never Send Employee 8
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3 The activity has a service region, and the service region has employees. All employees are 
eligible candidates for skill matching. You match activity skills and employee skills, but you can 
specify other matching criteria as well.

Employee 1= 100
Employee 2= 150
Employee 3= 75
Employee 7= 200
Employee 8 = 25

4 This step determines the final list of potential candidates for this activity. The following are two 
possible results:

■ Given the AddScores server component parameter is set to True, the list is the union of the 
employees from all three previous lists, and employee scores are added if they exist in more 
than one list. 

The final list of candidates for this activity with their corresponding scores is:

Employee 1=200 (100 + 100)
Employee 2=255 (75 + 30 + 150)
Employee 3=205 (50 + 80 + 75)
Employee 4=35 (25 + 10)
Employee 5=0
Employee 6=60
Employee 7=200 (0 + 200)
Employee 8=25

■ Given the AddScores server component parameter is set to False, the scores are not added, 
so the highest-scoring employee (Employee 7) is selected.

The final list of candidates for this activity with their corresponding scores is:

Employee 1 = 100
Employee 2 = 150
Employee 3 = 80
Employee 3 = 75
Employee 4 = 25
Employee 5 = 0
Employee 6 = 60
Employee 7 = 200
Employee 8 = 25

Additional possible final results for this example include:

■ If the assignment rules uses a One, Best Fit assignee filter, only the highest scoring employee is 
assigned, so Employee 2 is the only eligible candidate for assignment. 

■ If the assignment rule uses an All Above Minimum assignee filter and the minimum score for the 
rule is 200, then Employee 1, 2, and 3 are potential candidates for the assignment.
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Example of Assigning Dynamic 
Candidates to the Same Object
This topic gives one example of configuring Assignment Manager to assign a manager of an existing 
team to an account, contact, or opportunity belonging to one of their subordinates. You may use this 
feature differently, depending on your business model. 

To assign a manager to an account, contact, or opportunity record belonging to one 
of their subordinates

1 Start Siebel Tools.

2 Create a new symbolic string, and then apply this definition to the Display Name property for the 
Account Assignment Object.

a In the Object Explorer, select Symbolic String.

b Choose Edit > New Record to create a new symbolic string record.

For more information about symbolic strings, see Using Siebel Tools.

3 Create a new Dynamic Candidate record.

a In the Object Explorer, expand Workflow Policy Object, then expand Assignment Object, and then 
select Dynamic Candidate.

b Choose Tools > Lock Project (or Alt+L) to lock the project. 

c In the Dynamic Candidates window, choose Edit > New Record to add a new record with the 
following property settings:

❏ Display Name = Reporting Candidate

❏ Team Type = Position

d In the Object Explorer, expand Dynamic Candidate Component, and in the Dynamic Candidate 
Component list, choose Edit > New Record to add a new record with the following property 
settings:

❏ Name= Account Position

❏ Primary = Y

❏ Source Table Name = S_ACCNT_POSTN

❏ Source Column Name = OU_EXT_ID

4 Create another Dynamic Candidate record with the following property settings:

❏ Name = Reporting Position

❏ Candidate Table = TRUE

❏ Source Table Name = S_PARTY_RPT_REL

❏ Source Column Name = PARTY_ID

❏ Target Component Name = Account Position

❏ Target Column Name = POSITION_ID
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❏ Candidate Id = SUB_PARTY_ID

❏ Set the Display Name - String Reference property to the symbolic string you created in 
Step 2 on page 162.

NOTE: After configuration, the display name for the team appears in the Person Candidate 
Source or the Organization Candidate Source list of value (LOV) fields on the assignment rule 
(Administration - Assignment > Assignment Rule List). 

5 Check in the configuration to the server database. 

6 Navigate to the Administration - Assignment screen > Assignment Rule List view and select the 
assignment rule for which you want to apply this configuration.

7 Set the Person Candidates Source field to the dynamic candidate display name that you created 
Step 3 on page 162. 

8 Release the rules.

NOTE: For testing purpose, it is recommended that you run an AsgnBatch server component job to 
verify the assignees.

Process of Defining Dynamic Candidates
If you plan to create new dynamic candidate teams, you must first modify the Dynamic Candidate 
objects before the candidates are available for adding to your assignment rules. The process is 
similar to Workflow Policy Component and Workflow Policy Component Column configuration. Using 
Siebel Tools, you modify the following object types:

■ Dynamic Candidate

■ Dynamic Candidate Component

■ Dynamic Candidate Component Col

Dynamic candidate configuration is a logical definition of the underlying team table, candidate 
column, and related joins to the assignment object. The Dynamic Candidate properties define the 
dynamic candidate name, team type, and so on. The Dynamic Candidate Component properties 
define the table and column names used in the join, and the Dynamic Candidate Component Col 
properties define columns used in the team-based criteria.

The process for defining dynamic candidate is a multi-step process and requires the following tasks. 
These tasks may vary according to your organization�s business practices.

NOTE: If you plan to use only the predefined dynamic candidate teams�Activity Account Team or 
Activity Asset Team�for your assignment rules or you have already created other dynamic candidate 
teams, you can skip the first three configuration steps and proceed directly to Step 5.

1 �Configuring Assignment Objects for Dynamic Candidates� on page 164

2 �Configuring Join Specifications for Dynamic Candidate Object Definitions� on page 166

3 �Mapping Columns From Source Tables to Team-Based Criteria� on page 168

4 (Optional) �Copying Dynamic Candidate Attribute Columns to the Team Table� on page 169

5 �Adding Dynamic Candidate Teams to Assignment Rules� on page 170
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Configuring Assignment Objects for Dynamic 
Candidates
Dynamic candidates are the potential assignable candidates obtained from related business entities 
when assigning an object. The Dynamic Candidate Component object properties define the dynamic 
candidate name, team type, and so on.

Using Siebel Tools, you must first modify the properties of the Dynamic Candidate object type. 

This task is a step in �Process of Defining Dynamic Candidates� on page 163.

Use the following procedure to configure the Dynamic Candidate object type for dynamic candidates.

To configure an assignment object for dynamic candidates

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and in the Workflow Policy Objects 
window, select the object you want to configure.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can enable it in the 
Development Tools Options dialog box (View > Options > Object Explorer).

3 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

4 In the Object Explorer, expand Assignment Object, and then select Dynamic Candidate. 

5 In the Dynamic Candidates window, choose Edit > New Record.

6 In the new record, enter values for the relevant information.
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Table 39 provides descriptions of some of the Dynamic Candidate object properties.

NOTE: As of version 7.8, the following Dynamic Candidate object type properties are no longer used: 
Attribute Id Column, Attribute Table, Object Id Column, Score Column, Team Table, Team Table 
Attribute Id Column, and Team Table Candidate Id Column. However, these properties remain for 
upgrade purposes.

Table 39. Dynamic Candidate Object Properties

Property Description

Name The name of the dynamic candidate team. For example, Activity: Asset 
Team.

Display Name An alternative name to display to the Siebel Client. This property is 
optional. If no display name is provided, then the value in the Name field 
is used.

By default, this is set to NULL.

Display Name - String 
Reference

The display name for this team appearing in the Person Candidate Source 
or the Organization Candidate Source list of value (LOV) fields on the 
assignment rule applet. 

NOTE: You must first create a string reference in the Symbolic String 
object, and then set the Display Name - String Reference to the symbolic 
string you created.

Display Name - String 
Override

This property allows users to enter a display name without entering a 
symbolic string. The value in this property is what is displayed in the UI, 
and it overrides any other display name entries. However, because this 
value has no symbolic string, it is not translatable. For this reason, use 
caution when assigning an override.

Inactive Indicates if the object is active or inactive. 

By default, this value is set to FALSE.

Team Table Attribute Id 
Column

The name of the column in the team table that contains the attribute ID, 
that joins to the Attribute Id column.

Team Table Candidate 
Id Column

The name of the column in the team table that contains the candidate ID, 
the foreign key to the candidate base table.

Team Type Indicates whether or not the candidate team is employee-, organization-, 
or position-based.
Siebel Assignment Manager Administration Guide Version 7.8 165



Working with Dynamic Candidates ■  Process of Defining Dynamic Candidates
Configuring Join Specifications for Dynamic Candidate 
Object Definitions
As of version 7.8, Assignment Manager supports complex joins to relate base table with other related 
entities. The Dynamic Candidate Component object properties define the table and column names 
used when performing a join from the assignment object primary table to the candidate table to 
retrieve the dynamic candidates.

Using the dynamic candidate feature, you can configure Assignment Manager to identify related 
business entities and retrieve potential candidates from these entities. For example, you use the 
dynamic candidate feature when:

■ Assigning a position, such as Executive Sponsor, from the account team to a related child account

■ Assigning account sales representative positions to a child account's opportunity

■ Assigning an activity and you want to evaluate only employees who belong to that activity's 
service region, and if necessary, add more criteria for product skills, and so on.

Because potential assignees for dynamic candidates can be derived from various related business 
entities, you must configure the relationship between these entities.

This task is a step in �Process of Defining Dynamic Candidates� on page 163.

Use the following procedure to configure join specifications for dynamic candidates.

NOTE: Before you can successfully use join specifications for creating dynamic candidate definitions, 
you need to have a thorough understanding of database administration and how to use Siebel Tools. 
You should also familiarize yourself with the basics of the underlying Siebel application architecture. 
For more information on these topics, see Using Siebel Tools and Deployment Planning Guide.

To configure join specifications for dynamic candidates

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and in the Workflow Policy Objects 
window, select the object you want to configure.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can enable it in the 
Development Tools Options dialog box (View > Options > Object Explorer).

3 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

4 In the Object Explorer, expand Assignment Object, and then expand Dynamic Candidate.

5 Expand the Dynamic Candidate object further, and then select Dynamic Candidate Component.

6 In the Dynamic Candidate Component window, choose Edit > New Record.

7 In the new record, enter values for the relevant information.
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Table 40 provides descriptions of some of the Dynamic Candidate Component properties.

NOTE: Each dynamic candidate specified can have only one primary dynamic candidate component.

Table 40. Dynamic Candidate Component Object Properties

Property Description

Additional Join Spec Use this property to specify an additional join.

Candidate Id Column The column in the Team table containing the Id of the candidate 
(employee, position, or organization).

Candidate Table The name of the source table at the last level of a join.

NOTE: Before version 7.8, this property was called Team Table.

Inactive Indicates if the component is active or inactive. 

Name The name of the dynamic candidate component.

Primary When checked, indicates whether the dynamic candidate component 
is the primary for the dynamic candidate selected for the assignment 
object. 

Score Column The column in the Team table containing scores of the candidates.

Source Column Name The column in the source table that relates to another dynamic 
candidate component.

Source Table Name The table that the dynamic candidate component is based on.

Target Column Name The column in the source table that relates to another dynamic 
candidate component.

Target Component Name The target dynamic candidate component that is related to this 
dynamic candidate component.
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Mapping Columns From Source Tables to Team-Based 
Criteria
Using Siebel Tools, you create records in the Dynamic Candidate Component Col object to map 
columns in a source table, at a particular level in the join, to a team-based assignment criterion. You 
do so by specifying the attribute column name and the correct assignment criteria attribute name.

This task is a step in �Process of Defining Dynamic Candidates� on page 163.

Use the following procedure to map columns from source tables to team-based criteria.

To map columns from a source table to team-based criterion

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and in the Workflow Policy Objects 
window, select the object you want to configure.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can enable it in the 
Development Tools Options dialog box (View > Options > Object Explorer).

3 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

4 In the Object Explorer, expand Assignment Object, and then expand Dynamic Candidate.

5 Expand the Dynamic Candidate object further, and navigate to Dynamic Candidate Component 
Col.

6 In the Dynamic Candidates Component Columns window, choose Edit > New Record.

7 In the new record, enter values for the relevant information.

Table 41 provides descriptions of some of the Dynamic Candidate Component Col object properties.

Table 41. Dynamic Candidate Component Col Object Properties

Property Description

Assignment Criteria 
Attribute Name

The name of the assignment criteria attribute.

Assignment Criteria 
Name

The name of the assignment criteria.

NOTE: This property is automatically populated when you select the 
assignment criteria attribute name.

Inactive Indicates if the component is active or inactive. 

Name The name of the dynamic candidate component column.

Parent Name The name of the object definition's parent. This is a system-supplied 
value.
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Copying Dynamic Candidate Attribute Columns to the 
Team Table
Assignment Manager supports copying of dynamic candidate attribute columns and stamping of 
attributes on each candidate obtained through a join on the team table by copying dynamic candidate 
attribute values at any level in an n-level join to the results team table. 

You can create multiple entries to create joins. One of those entries you flag as the candidate table. 
The source table for that record is the team table for that dynamic candidate.

This task is an optional step in �Process of Defining Dynamic Candidates� on page 163.

Use the following procedure to specify the column name in the results table where you want the 
attribute values stamped.

NOTE: You can write results to both reporting or operational tables.

To copy dynamic candidate attribute columns to the team table

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and in the Workflow Policy Objects 
window, select the object you want to configure.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can enable it in the 
Development Tools Options dialog box (View > Options > Object Explorer).

3 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

4 In the Object Explorer, expand Assignment Object, and then expand Dynamic Candidate.

5 Expand the Dynamic Candidate object further, and navigate to Dynamic Candidate Component 
Col.

6 In the Dynamic Candidates Component Columns window, choose Edit > New Record.

7 In the new record, enter values for the relevant information.

Table 42 provides descriptions of some of the Dynamic Candidate Component Col object properties.

Table 42. Dynamic Candidate Component Col Object Properties Used for Stamping Attributes

Property Description

Attribute Column 
Name

The name of the column in the source table.

Copy Column Name The name of the column stamped on the team table when working in 
operational mode.

Reporting Copy 
Column Name

The name of the column stamped on the Name reporting table when 
working in reporting mode.
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Adding Dynamic Candidate Teams to Assignment Rules
You can add dynamic candidates teams (position or employee) or organization dynamic candidate 
teams to assignment rules. You can use either the predefined dynamic candidate teams provided in 
the application or create your own teams using Siebel Tools. 

This task is a step in �Process of Defining Assignment Rules� on page 86.

Use one of the following procedures to add predefined dynamic candidate teams to your assignment 
rules.

NOTE: If you plan to create you own dynamic candidate teams, you must use Siebel Tools to 
configure the teams before implementing the following procedure. For more information about 
configuring dynamic candidate teams, see �Configuring Assignment Objects for Dynamic Candidates� 
on page 164.

To add a person dynamic candidate team to an assignment rule

1 Navigate to the Administration - Assignment screen > Assignment Rules List view.

2 Drill down on the assignment rule for which you want to add a dynamic team.

3 Click the Person Candidates Source drop-down list and choose one of the following:

■ Activity Account Team

■ Activity Asset Team

■ All People

■ From Rule

■ Any team you predefined using Siebel Tools

NOTE: For territory management, you can choose from several other predefined values. For 
more information about these values, see Siebel Territory Management Guide.

You use a similar procedure for adding organization dynamic candidate teams to assignment rules. 
However, there are no predefined organization dynamic teams from which to choose in the seed data; 
you must create your own organization teams.

To add an organization dynamic candidate team to an assignment rule

1 Navigate to the Administration - Assignment screen > Assignment Rules List view.

2 Drill down on the assignment rule for which you want to add a dynamic team.

3 Click the Organization Candidates Source drop-down list and choose one of the following:

■ All Organizations

■ From Rule

■ Any team you predefined using Siebel Tools
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8 Assignment Rule Administration 
for Delegated Assignment
This chapter explains how to delegate assignment rules to others, and how others can inherit and 
further define these delegated rules. The tasks explained in this chapter are for Delegated 
Administrators (DAs), and as such, the procedures are documented using the Administration - 
Delegated Assignment screen and views.

NOTE: Although the procedures in this chapter are written for the Administration - Delegated 
Assignment screen and views, you can also perform many of these same operations using the Rule 
Group Explorer views in the Administration - Assignment screen.

Topics in This Chapter
■ �About Delegated Assignment� on page 172

■ �Scenario for Delegated Assignment� on page 172

■ �Sample Delegated Assignment Process Flowchart� on page 174

■ �About Assignment Rule Group Hierarchy� on page 176

■ �About Setting Up Assignment Rules for Delegation� on page 179

■ �Process of Making an Assignment Rule Inheritable� on page 180

■ �Process of Inheriting and Refining Delegated Assignment Rules� on page 183

■ �Setting Up Assignment Responsibility for Designees� on page 184

■ �Examples for Using Delegated Assignment� on page 185

The topics are organized to present information in a sequence roughly corresponding to the order in 
which you are likely to be concerned with the subjects described when using delegated assignment. 
However, your company may follow a different process according to its business requirements.

CAUTION: Before performing the tasks in this chapter, you should familiarize yourself with the 
assignment administration tasks explained in Chapter 6, �Assignment Rule Administration.� Otherwise, 
you may find the procedures difficult to follow.
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About Delegated Assignment
Delegated assignment provides people (positions) other than the assignment administrator the 
ability to create and manage assignment rules. The top assignment administrator (AA) position can 
delegate rule administration to other positions and partners to route leads, activities, accounts, and 
other objects to employees or positions. These delegates are known DAs. DAs can, in turn, delegate 
assignment rule administration to other DAs. This hierarchical assignment rule inheritance feature is 
well-suited to sales organizations and organizations that work closely with partners.

NOTE: Prior to version 7.7, the assignment administrator was the only person responsible for 
administering assignment rules.

Delegated assignment allows AAs the ability to enforce core business logic using rule inheritance, 
while allowing delegated administrators (DAs) the ability to further refine that logic and specialize 
their assignment rules for their unique circumstances.

However, DAs can only inherit rules from their parent rule group. When inheriting a rule, DAs are 
allowed to choose only from rules in the parent rule group in which the owner of their rule group is 
currently a candidate (employee or position). The logic specified on a rule is enforced on all inherited 
rules by making sure that the rule contains nonremovable and noneditable copies of all criteria from 
the parent rule. DAs can further refine the rule�s logic, by adding new criteria to inherited rules by 
either creating new criteria or by adding and modifying criteria templates. DAs can also delete any 
rule they choose to inherit from the parent rule group. Candidates (employees and positions) of rules 
are not inherited, so users can choose anyone their organization visibility allows as a candidate. 
Workload criteria, organization workload criteria, and organizations are not inherited.

If you plan to use delegated assignment, the top AA position must first prepare the assignment rules 
for inheritance. After a rule is inherited and changes are made to the original rule�such as, adding 
criteria to, expiring, or deleting the rule�those changes are propagated down the hierarchy to all 
rules that were inherited from it.

Scenario for Delegated Assignment 
This scenario gives one example of how you can dynamically assign candidates. You may use this 
feature differently, depending on your business model.

For this scenario, candidates are assigned to an activity based on the information provided in 
Table 43. The numbers at the top of the table correspond to the numbered text following the table.

Table 43. Sample Data for Dynamic Candidates Assigned to an Activity

1 2 3 4

Asset Team 
Member Type

Account Team 
Member Type

Service 
Region Skills

Employee 1 Primary Employee 3 Primary Employee 1 ENU

Employee 2 Secondary Employee 6 Secondary Employee 2 FRA

Employee 3 Tertiary Employee 2 Tertiary Employee 3
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1 The activity has an asset team and each employee in that team has a type. All the employees in 
this team are eligible candidates for the activity. The employees are scored based on their type 
and the following assignment rules:

■ If Organization = Americas, primary score = 100.

■ If Organization = Europe, primary score = 50.

Based on the rules and their type, assume the asset team scores are:

Employee 1 =100
Employee 2 = 75
Employee 3 = 50
Employee 4 = 25
Employee 5 = 0

2 The activity has an account team and each employee in that team has a type. All the employees 
in this team are eligible candidates for this activity. The employees are scored based on their 
type.

The account team scores are:

Employee 3 = 80
Employee 6 = 60
Employee 2 = 30
Employee 4 = 10
Employee 7 = 0

3 The activity has a service region, and the service region has employees. All employees are 
eligible candidates for skill matching. You match activity skills and employee skills, but you can 
specify other matching criteria as well.

Employee 1= 100
Employee 2= 150
Employee 3= 75
Employee 7= 200
Employee 8 = 25

Employee 4 Tech Support Employee 4 Tech Support Employee 7

Employee 5 Never Send Employee 7 Never Send Employee 8

Table 43. Sample Data for Dynamic Candidates Assigned to an Activity

1 2 3 4

Asset Team 
Member Type

Account Team 
Member Type

Service 
Region Skills
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4 This step determines the final list of candidates for this activity. This list is the union of the 
employees from all previous three lists, and employee scores are added if they exist in more than 
one list.

The final list of candidates for this activity with their corresponding scores is:

Employee 1=200 (100 + 100)
Employee 2=255 (75 + 30 + 150)
Employee 3=205 (50 + 80 + 75)
Employee 4=35 (25 + 10)
Employee 5=0
Employee 6=60
Employee 7=200 (0 + 200)
Employee 8=25

All employees with a passing score pass the rule. In this example, if the minimum score for the rule 
is 200, Employee 1, 2, 3, and 7 pass and Employee 2 is set as the primary because that employee 
has the highest score.

Sample Delegated Assignment Process 
Flowchart
Figure 27 provides a sample process flowchart of the delegated assignment feature. Each of the 
process steps are explained in further detail later in this chapter.

Figure 27. Sample Process Flowchart for Delegated Assignment
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Figure 27 shows the following relationships:

1 Amy is the EVP of Sales and is the assignment administrator. Amy must first create root-level 
rule groups, child rule groups, and rules, and add criteria templates and owners of the child rule 
groups to the assignment rules before delegated assignment can be implemented. 

2 Lance and Henry are sales VPs and are delegated administrators (2nd-tier). Lance and Henry 
must first inherit rules in the rule group Amy created for their respective areas, and can then 
further refine and delegate those rules further down the hierarchy.

3 Sarah and Rick are Sales Managers and are delegated administrators (3rd-tier). Sarah and Rick 
inherit the rules created by Lance for their respective areas, and then further refine those rules 
for their sales representatives.

4 Robin and Sam are Partners and are delegated administrators (3rd-tier, similar to Sarah and 
Rick). Robin and Sam inherit the rules created by Henry for their respective areas, and then 
further refine those rules for their sales representatives. 

NOTE: After a rule is inherited in child rule groups and changes are made to the original rule, such 
as adding criteria to, expiring, or even deleting the rule, those changes are propagated down the 
hierarchy to all rules that were inherited from it.
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About Assignment Rule Group Hierarchy
A rule group is a group of categorized assignment rules. You might think of a rule group as similar 
to a territory. The delegated assignment feature provides a hierarchical (tree) distribution of rule 
groups as shown in Figure 28. The logic defined in the rules in rule groups at the top of the hierarchy 
is enforced down the hierarchy, but can be refined.

The following subtopics describe rule group hierarchy in further detail.

The Rule Group Explorer
The Rule Group Explorer is one of the views in the administration screens. The Rule Group Explorer 
(see Figure 28) is a graphical representation of the rule group hierarchy tree and provides a 
convenient way to navigate the entire rule group hierarchy. The relationships between parent and 
child rule groups is a hierarchy.

Figure 28 shows the following relationships:

■ Root-level rule groups

■ Child rule groups and their characteristics:

■ Rule Groups (lists all child rule groups for the current rule group)

■ Rules

■ Designees

■ Inheritable Rules

Figure 28. Sample Rule Group Explorer

Root-Level Rule Groups

Child Rule Groups
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Rules in rule groups at the bottom of a hierarchy are processed first, moving up one level each time 
no rule in the previous level passes. Within each level in the hierarchy, the rules are processed by 
ascending order of sequence number.

Administrators (AAs and DAs) use the Rule Group Explorer to create and maintain rule group 
hierarchies. Assignment Administrators have organization visibility, so they see the rules for their 
specific organization or organizations. Typically, AAs use the Rule Group Explorer views in the 
assignment administration screen but can also use the views in the delegated assignment 
administration screen. Delegated Administrators s must use the My Rule Group Explorer view in the 
delegated assignment screen and can see only rule groups for which they are an owner or designee, 
and the rule groups and rules that appear below (subtree).

DAs can only create a new rule group below one for which they are the owner or designee; this new 
rule group is a child rule group of the original rule. DAs can also create grandchild rule groups, great-
grandchild rule groups, and so on.

Parent and Root-Level Rule Groups
A parent rule group is a rule group that appears directly above another rule group in the hierarchy. 
A root-level rule group is a rule group without a parent. For example, in Figure 29 on page 177, RG 2 
is the parent of RG 4, but RG 2 is not a root-level rule group. Only RG 1 is a root-level rule group�
that is because it is the only rule group in the hierarchy that does not have a parent rule group (and, 
subsequently, is at the top of the hierarchy).

Figure 29 provides a sample rule hierarchy that shows how parent and root rule groups relate to other 
rule groups in the same hierarchy.

Figure 29. Relationships Between Parent and Child Rule Groups in a Hierarchy
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Figure 29 show the following relationships:

■ Rule groups that have no parent are root-level rule groups. There is only one root-level rule 
group for each hierarchy and that root-level rule group appears at the top of the hierarchy (RG1). 

NOTE: Only assignment administrators (not delegated administrators) can create root-level rule 
groups.

■ Rule groups that are parents to no other rule groups (rule groups with no child rule groups) are 
considered leaf rule groups and appear at the bottom of the hierarchy (RG3, RG4, and RG5).

■ Rules at the leaf nodes are processed first by Assignment Manager. If none of those rules, pass 
Assignment Manager processes rules in the set of rule groups above the leaf nodes, and so on, 
until the root-level rule group is processed. This makes certain that if a rule is inherited from one 
rule group to another, the inherited rule is passed first.

NOTE: The Default Rule Group is a root-level rule group (has no parent) as well as a leaf node (has 
no child).

Assignment Owners and Designees
Assignment Manager uses ownership as a means to determine if a particular rule is eligible for 
inheritance by a rule group. Each rule group must have an owner, and a rule group defaults to the 
creator (as owner) when a new rule group is created. 

NOTE: The concept of ownership is an integral part of delegated assignment functionality; however, 
if you do not use delegated assignment, ownership serves no functional role.

Owners can delegate their responsibility to designees with the same rights as an owner. A designee 
is an individual who can view and edit rule groups (and the rules within those rules groups) on behalf 
of an owner. The owner and the designees of a rule group are collectively known as delegated 
administrators (DAs).

Assignment Rule Inheritance
Rule inheritance allows assignment administrators (AAs) to enforce business logic, while allowing 
delegated administrators (DAs) to further refine that logic. In addition, inheritors of rules can refine 
those same rules and specialize them for their unique circumstances.

Criteria templates are special criteria that can be applied to inherited rules. Assignment Manager 
does not process criteria templates until an inheritor of an assignment rule chooses to apply a 
template to the inherited rule.
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To use criteria templates, administrators (AA or DA) must first create criteria templates for 
inheritable rules by checking the Template field in the Criteria list for the criteria they want as 
templates. When an assignment rule is inherited, the inheritor has the option to either apply the 
criteria templates into an actual criterion--by checking the Create From Templates button in the 
Criteria view tab--or to create a new criterion for the inherited rule.

NOTE: Assignment Manager ignores criteria that have the Template field checked on an assignment 
rule until such time as that rule is inherited and the criteria template is applied to the inherited rule. 

TIP: It is recommended that AAs create criteria templates to assist DAs in rule creation. This 
reduces the need for DAs to fully understand the steps required and implications of creating new 
logic.

Rule Group Visibility and Permissions
AAs have visibility only for the rule groups (and the rules within those rule groups) for their specific 
organization (unless given permission to the All Rule Groups Across Organizations view). DAs have 
visibility only to the rule groups for which they are an owner (or designee) and each of their rule 
groups� subtrees. An owner of a particular rule group cannot be the owner (or designee) of a rule group 
lower in the hierarchy (subtree), but can be an owner (or designee) for rule groups in other hierarchies.

TIP: DAs can only inherit rules from a parent rule group and can refine inherited rules to specialize 
them, but cannot remove any of the logic specified in the original rule.

About Setting Up Assignment Rules for 
Delegation
If you plan to use delegated assignment, the top AA position must first prepare the assignment rules 
for inheritance in addition to the tasks presented in Chapter 6, �Assignment Rule Administration.�

The top AA position typically creates rules and rule criteria templates from which all other delegated 
rules and rule criteria are created using the Administration - Assignment views. DAs can then inherit 
these predefined rules and further refine those rules by adding new criteria or apply criteria 
templates criteria using the Administration - Delegated Assignment views. These refined rules can 
again be inherited and modified by other DAs at a lower level in the hierarchy, and so on. At each 
level in the hierarchy, administrators can assign designees to act on their behalf. Designees can view 
and edit rule groups (and the rules within those rules groups) on behalf of an AA or DA. Figure 28 on 
page 176 shows an example of this n-tier hierarchical relationship.
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Process of Making an Assignment Rule 
Inheritable
By associating positions to the inheritance access list for an assignment rule, you make that rule 
inheritable for use by child rule groups (accessible by the rule group�s owners and designees). 
Assignment administrators (AAs and DAs) can make an assignment rule inheritable as long as they 
have access to the rule.

To make assignment rules inheritable, you perform the following tasks:

1 �Creating Child Assignment Rule Groups� on page 180

You must first create a child rule group from a parent rule group, setting the Parent Rule Group 
field to the current rule group.

2 �Adding Owners to the Inheritance Access List� on page 181

After creating the child rule group, you add the owner of the child rule group to the inheritance 
access list for the rule.

NOTE: Unless the owner of a rule group is on the inheritance access list, that owner (and his or 
her designees) cannot inherit a rule.

3 (Optional) �Adding Criteria Templates to Assignment Rules� on page 182

Optionally, you can add criteria templates to an assignment rule. DAs then have the option to 
apply the criteria templates to their inherited rules in lieu of creating new criteria.

Creating Child Assignment Rule Groups
This topic explains how to create a child assignment rule group using the delegated assignment 
administration views.

This task is a step in �Process of Making an Assignment Rule Inheritable� on page 180. 

To create a child rule group

1 From the application-level menu, choose Navigate > Site Map > Administration - Delegated 
Assignment > Rule Group Explorer.

2 In the Rule Group Explorer, expand the rule group folder for which you want to define a child rule 
group, and then click Rule Groups.

3 In the My Rule Group Explorer list, click New.

4 In the new rule group record, click in the available fields to enter relevant information for the 
new group rule.

a In the Name field, type a name for the child rule group.
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b In the Owner Position field, click the select button to query for an owner, and then click OK.

NOTE: You must specify an appropriate position for the owner. A position cannot be owner 
(or designee) for a rule group below one for which that position is already an owner or 
designee.

For field descriptions, see �Creating Assignment Rule Groups� on page 88.

TIP: Activation and expiration dates are modifiable only at the root-level rule group level in the 
hierarchy. All other rule groups under the root-level rule group share the same dates and are 
read only.

Adding Owners to the Inheritance Access List
This topic explains how to add owners to the inheritance access list for an assignment rule using the 
delegated assignment administration views. After owners are added to the inheritance access list of 
an assignment rule, inheritors of that rule can further refine and specialize that rule.

This task is a step in �Process of Making an Assignment Rule Inheritable� on page 180 and �Setting Up 
Assignment Responsibility for Designees� on page 184.

To add an owner to the inheritance access list

1 From the application-level menu, choose Navigate > Site Map > Administration - Delegated 
Assignment > Rule Group Explorer.

2 In the Rule Group Explorer, expand the rule group in which the assignment rule resides, and then 
click Rules.

3 In the My Rule Group Explorer list, drill down on the assignment rule you want to make 
inheritable, and then click the Inheritance Access view tab.

4 In the Inheritance Access List, click Synchronize.

NOTE: This action first deletes anyone from the list who is not an owner of a child rule group 
and then adds back only the owners of the child rule group. To prevent deletion, check the Lock 
During Synchronization checkbox next to a position before clicking Synchronize.

5 Delete any positions from the list that you do not want to inherit rules.

6 Alternatively, you can add a single position:

a In the Inheritance Access List, click New. 

b In the Pick Positions dialog box, query for the position you want to give access, and then click OK.
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Adding Criteria Templates to Assignment Rules
This topic explains how assignment administrators (AAs) can add criteria templates to an assignment 
rule using the delegated administration views. After you create criteria templates, the criteria 
templates are available for use with inherited rules.

NOTE: It is recommended that assignment administrators create criteria templates to assist DAs in 
rule creation. This reduces the need for DAs to fully under the steps required and implications of 
creating new logic.

This task is a step in �Process of Making an Assignment Rule Inheritable� on page 180.

To add criteria templates to an assignment rule

1 From the application-level menu, choose Navigate > Site Map > Administration - Delegated 
Assignment > Rule Group Explorer.

2 In the Rule Group Explorer, select the assignment rule for which you want to add criteria 
templates.

NOTE: Depending on the rule, you may need to navigate down the hierarchy.

3 In the My Rule Group Explorer list, drill down on the assignment rule, and then click the Criteria 
view tab (if not already active).

4 Add a new criterion.

For information about creating new criteria, see �Process of Creating Assignment Criteria for Use 
in Assignment Rules� on page 56.

5 Check the Template checkbox for the new criterion.

The templated criterion is now available for use with inherited rules.

NOTE: Assignment Manager does not process criteria templates until an inheritor chooses to 
apply a template to an assignment rule. When someone inherits from that rule, that person has 
the option to apply a template into an actual criterion (by checking the Create From Templates 
button in the Criteria view tab) instead of creating a new criterion.
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Process of Inheriting and Refining 
Delegated Assignment Rules
To inherit and refine delegated assignment rules, you perform the following tasks:

1 Inherit an assignment rule.

For a procedure, see �Inheriting Delegated Assignment Rules� on page 183.

2 Add criteria to the inherited assignment rule by either creating new criteria or applying criteria 
templates. 

For information about:

■ Creating new criteria, see �Process of Creating Assignment Criteria for Use in Assignment Rules� 
on page 56

■ Applying criteria templates, see �Applying Criteria Templates to Inherited Assignment Rules� on 
page 184

3 Add candidates to the assignment rule.

For information about adding candidates, see �Adding Employees, Positions, and Organizations to 
Assignment Rules� on page 120.

Inheriting Delegated Assignment Rules
This topic explains how to inherit an assignment rule using the delegated assignment administration 
views.

This task is a step in �Process of Inheriting and Refining Delegated Assignment Rules� on page 183.

To inherit a delegated assignment rule

1 From the application-level menu, choose Navigate > Site Map > Administration - Delegated 
Assignment > Rule Group Explorer.

2 In the Rule Group Explorer, expand the rule group for which you want to inherit rules, and then click 
Inheritable Rules.

3 Select one or more rules you want to inherit, and then click Inherit Rules.

The rule (or rules) now appear as rules in the Rule Group Explorer view under Rules. 
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Applying Criteria Templates to Inherited Assignment 
Rules
This topic explains how to apply predefined criteria templates to inherited assignment rules using 
the delegated assignment administration views. 

This task is a step in �Process of Inheriting and Refining Delegated Assignment Rules� on page 183 and 
an optional task in �Process of Making an Assignment Rule Inheritable� on page 180.

To apply criteria templates to an assignment rule

1 From the application-level menu, choose Navigate > Site Map > Administration - Delegated 
Assignment > Rule Group Explorer.

2 In the Rule Group Explorer, expand the rule group in which the assignment rule resides and you 
want to apply criteria templates, and then click Rules.

NOTE: Depending on the rule, you may need to navigate down the hierarchy.

3 In the My Rule Group Explorer list, drill down on the assignment rule for which you want to apply 
criteria templates, and then click Create From Templates.

4 In the Pick Criteria Templates dialog box, select the rule criterion you want, and click OK.

A new criterion is added to the rule.

Setting Up Assignment Responsibility 
for Designees 
This topic explains how to add designees to an assignment rule group using the delegated 
assignment administration views. Use the following procedure if you want to delegate assignment 
responsibility to someone else (a designee).

To add a designee to an assignment rule group

1 From the application-level menu, choose Navigate > Site Map > Administration - Delegated 
Assignment > Rule Group Explorer.

2 In the Rule Group Explorer, expand the rule group for which you want to assign designees, and then 
click Designees.

3 In the My Rule Group Explorer list, click New.

4 In the Pick Positions dialog box, query for the position you want to add to the rule group, and 
then click OK.

For more information about designees, see �Process of Making an Assignment Rule Inheritable� on 
page 180.
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Examples for Using Delegated 
Assignment
This topic provides an example of how delegated assignment might be used. You may use delegated 
assignment differently, depending on your business model. Your company may follow a different 
process according to its business requirements. 

It covers the following topics:

■ �Scenario for Working with Delegated Administrators� on page 185

■ �Delegated Assignment Example 1: Assignment Administrator Tasks� on page 187

■ �Delegated Assignment Example 2: Second-Tier Delegated Administrator Tasks� on page 189

■ �Delegated Assignment Example 3: Third-Tier Delegated Administrator Tasks� on page 190

■ �Delegated Assignment Example 4: Third-Tier Delegated Administrator Tasks for Partners� on 
page 191

Scenario for Working with Delegated Administrators
This scenario is one of the topics for �About Assignment Rule Group Hierarchy� on page 176.

A sales organization for a high tech company wants to create assignment rules that are inheritable 
and configurable by several different levels in the organization. The requirements are:

■ Handle large sales leads internally; handle small sales leads externally using partners

■ Promptly assign sales leads to the most qualified representative 

■ Design complex assignment rules, making use of the delegated assignment inheritance and 
criteria templates features to allow for uncomplicated rule administration by persons at all levels
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In this scenario, the Sales EVP, vice presidents, regional sales managers, partners, and sales 
representatives participate in delegated assignment for one rule group hierarchy as shown in 
Figure 30.

Figure 30 shows the following relationships:

■ Amy, Executive Vice President of Sales, is the assignment administrator (AA)

■ Two vice presidents report to Amy:

■ Lance, VP Direct Sales

■ Henry, VP Channel Sales

Lance and Henry are 2nd-tier delegated administrators

■ Two managers report to Lance:

■ Sarah, Western Regional Manager

■ Rick, Eastern Regional Manager

Sarah and Rick are 3rd-tier delegated administrators (DAs)

■ Two partners report to Henry:

■ Robin, Partner 1

■ Sam, Partner 2

Robin and Sam are also 3rd-tier delegated administrators (DAs)

■ Three western regional sales representatives report to Sarah

■ Three partner sales representatives report to Robin

Figure 30. Sample Delegated Assignment Organization Chart
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Table 44 provides sample responsibilities for each of the positions discussed previously.

Delegated Assignment Example 1: Assignment 
Administrator Tasks
This example is one of the topics for �About Assignment Rule Group Hierarchy� on page 176.

The assignment administrator (AA) makes sure that large leads go to internal sales reps (by way of 
Lance, VP Direct Sales) and small leads go to channel partners (by way of Henry, VP Channel Sales).

Tasks for the assignment administrator

1 Create a root-level rule group.

In this example, Amy organizes her assignment rules into a logical grouping�rules that route 
leads are in one rule group.

For information about how to create a root-level rule group, see �Creating Assignment Rule 
Groups� on page 88.

2 Create a child rule group (or groups) with the root-level rule group as the parent.

In this example, Amy creates two rules groups as follows:

■ Rule Group 1 with Owner = Lance

■ Rule Group 2 with Owner = Henry

This allows Henry and Lance the ability to manage their own lead assignment rules for their 
subordinates. 

For information about how to create a child rule group, see �Creating Child Assignment Rule 
Groups� on page 180.

3 Create an assignment rule (or rules).

a Add a new assignment rule.

Table 44. Sample Positions and Responsibilities for Delegated Assignment Scenario

Position Responsible for �

Executive Vice President 
(EVP) of Sales 

Making sure large leads are handled by internal sales representatives 
and small leads are handled by partner sales representatives.

VP Direct Sales Making sure leads are routed to the right regional manager.

VP Channel Sales Making sure leads are routed to the right partner.

Regional Manager Making sure leads are routed to the best sales representative.

Partner Making sure leads are routed to best partner employee (because the 
high tech company cannot determine which partner employee is best 
suited for the lead).
Siebel Assignment Manager Administration Guide Version 7.8 187



Assignment Rule Administration for Delegated Assignment ■  Examples for Using 
Delegated Assignment
b Assign candidates to the rule.

For information about adding candidates to assignment rules, see �Adding Employees, 
Positions, and Organizations to Assignment Rules� on page 120.

c Add criteria templates to the rule.

NOTE: It is recommended that assignment administrators create criteria templates to assist 
DAs in rule creation. This reduces the need for DAs to fully understand the steps required 
and implications of creating new logic.

For information about adding criteria templates to assignment rules, see �Adding Criteria 
Templates to Assignment Rules� on page 182.

d Add owners of the child rule groups to the inheritance access list for the assignment rule.

After owners are added to the inheritance access list, inheritors of those rules can refine and 
specialize the rules by adding criteria and candidates for their unique circumstances.

For information about adding owners to the inheritance access list for an assignment rule, 
see �Adding Owners to the Inheritance Access List� on page 181.

In this example, create the following assignment rules to route leads to Lance and Henry. 

This makes sure that large leads are managed by internal sales and smaller leads are managed 
by partners.

4 (Optional) Create additional criteria templates.

a Create new criteria for the assignment rule.

b Click the Template flag for each new criteria created.

In this example, use the following criteria. 

This allows Lance and Henry the ability to refine rules with predefined criteria instead of creating 
new criteria.

Task Assignment Rule 1 Assignment Rule 2

Add criteria Leads > $100k Leads < $100k

Assign candidates Lance (VP Direct Sales) Henry (VP Channel Sales)

Add owners to inheritance access list Lance Henry

Add to Rule Assignment Rule 1 Assignment Rule 2

Criteria Template 1 Product Line= Servers

Criteria Template 2 Product Line = PCs

Criteria Template 3 Product = Notebooks State = NY, CT, NJ

Criteria Template 4 Product = Desktops State = WA, CA, OR, NV

Criteria Template 5 Product = Peripherals
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Delegated Assignment Example 2: Second-Tier 
Delegated Administrator Tasks
This example is one of the topics for �About Assignment Rule Group Hierarchy� on page 176.

The second-tier delegated administrators (DAs) make sure that the leads that are more than $100K 
are routed to the correct sales manager based on geography and territories:

■ Leads in the eastern states go to Rick

■ Leads in the western states go to Sarah

Tasks for second-tier delegated administrators

1 In the Rule Group Explorer, select a rule group previously created by the assignment 
administrator.

In this example, Lance selects the rule group for which he is the owner (Rule Group 1).

2 Create a child rule group (or groups) with the current rule group as the parent.

In this example, Lance creates two rules groups as follows:

■ Rule Group 10 with Owner = Rick; Parent Rule Group = Rule Group 1

■ Rule Group 20 with Owner = Sarah; Parent Rule Group = Rule Group 1

This allows Rick and Sarah the ability to manage their own lead assignment rules for their 
subordinates. 

For information about how to create a child rule group, see �Creating Child Assignment Rule 
Groups� on page 180.

3 Inherit assignment rule (or rules).

In this example, Lance inherits Amy�s rule twice so that he can refine each rule to make sure 
leads in the western states go to Sarah and leads in the eastern states go to Rick.

For information about inheriting an assignment rule, see �Inheriting Delegated Assignment Rules� 
on page 183.
Siebel Assignment Manager Administration Guide Version 7.8 189



Assignment Rule Administration for Delegated Assignment ■  Examples for Using 
Delegated Assignment
4 Refine the inherited assignment rule (or rules).

a Apply criteria templates.

See �Applying Criteria Templates to Inherited Assignment Rules� on page 184.

b Add candidates.

See �Adding Employees, Positions, and Organizations to Assignment Rules� on page 120.

In this example, use the following information to refine the assignment rules. 

5 Add owners of the child rule groups to the inheritance access list for each assignment rule.

See �Adding Owners to the Inheritance Access List� on page 181.

After you add Sarah and Rick to the inheritance access list for the appropriate assignment rule, 
Sarah and Rick can inherit the rules and further refine them by adding criteria and specifying 
candidates.

Henry follows the same steps as Lance, except Henry uses different criteria templates to route leads 
based on product line as follows:

■ Leads for PCs go to Robin (employee of Partner 1)

■ Leads for servers go to Sam (employee of Partner 2)

Delegated Assignment Example 3: Third-Tier Delegated 
Administrator Tasks
Sarah and Rick are third-tier delegated administrators in the rule group hierarchy. 

Sarah and Rick follow the same steps as Lance in �Delegated Assignment Example 2: Second-Tier 
Delegated Administrator Tasks� on page 189, except Sarah and Rick:

■ Inherit Lance�s rules (Assignment Rule 10 and 20), and refine those rules so that the leads are 
routed directly to sales representatives.

■ Do not need to create child rule groups (because they assign leads directly to representatives).

Rule Data Assignment Rule 10 Assignment Rule 20

Criteria Leads > $100k1

1. Criteria inherited from the original rule and is read only.

Leads > $100k1

Criteria State = WA, CA, OR, NV2

2. Applied from criteria templates.

State = NY, CT, NJ2

Candidate Sarah Rick
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Delegated Assignment Example 4: Third-Tier Delegated 
Administrator Tasks for Partners
This example is one of the topics for �About Assignment Rule Group Hierarchy� on page 176.

The 2nd-Tier partner delegated administrator makes sure that leads that have been assigned to 
Partner 1 are routed to the best sales representative and that no leads go unassigned.

1 In the Rule Group Explorer, select the rule group previously created by the 2nd-tier delegated 
administrator (Henry, in this example).

In this example, assuming Henry created Assignment Rule 30 for Robin and Assignment Rule 40 
for Sam, Robin selects Rule Group 30. 

2 Inherit the assignment rule (or rules).

In this example, Robin inherits Henry�s rule three times and refines each rule to make sure leads 
are routed to one of Partner 1�s three sales representatives.

For information about inheriting an assignment rule, see �Inheriting Delegated Assignment Rules� 
on page 183.

3 Refine the inherited rule (or rules).

a Apply criteria templates.

See �Applying Criteria Templates to Inherited Assignment Rules� on page 184.

b Add candidates.

See �Adding Employees, Positions, and Organizations to Assignment Rules� on page 120.
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4 Add owners to the inheritance access list for the assignment rule.

See �Adding Owners to the Inheritance Access List� on page 181.

In this example, use the following information: 

Summary for Examples of Working with Delegated 
Administrators
This summary is one of the topics for �About Assignment Rule Group Hierarchy� on page 176.

The following bullet points further summarize the delegated assignment activities as they pertain to 
the examples:

■ The examples describe a four-level assignment model. However, this is no limit to the number of 
levels that the delegated assignment manager feature supports, and there is no limit to the 
number of branches in a level. In these examples, the levels are:

Level 1 = Amy
Level 2 = Lance, Henry
Level 3 = Sarah, Rick, Robin, Sam
Level 4 = West Sales Reps 1,2,3, and Partner 1 Sales Reps 1,2,3

■ Rules group hierarchies are executed from the bottom up. For example, Assignment Manager 
attempts to use Robin�s rules to match a particular lead to a candidate before it tries to use 
Henry�s rules. However, if Robin�s rules fail, Assignment Manager then tries Henry�s rules, and 
assigns the lead to Robin, and so on up the hierarchy.

■ Each rule group owner can assign a designee.

Designess have the same responsibilities as an owner. You may want to delegate your ownership 
to someone else, such as an administrative assistant, to perform the tasks.

■ Each partner should assign one person as the delegated administrator�in these examples, either 
Robin or Sam�and that person should manage the partner�s rule group. This same person should 
receive all leads that are not assigned to the partner�s sales representatives. 

Apply to 
Rule Assignment Rule 30A Assignment Rule 30B Assignment Rule 30C

Criteria Leads > $100k1

1. This criteria is already inherited and is Read Only.

Leads > $100k1 Leads > $100k1

Criteria Product Line = PCs2

2. Applied from criteria templates.

Product Line = PCs1 Product Line = PCs1

Criteria Product = Desktops Product = Notebooks2 Product = Peripherals2

Candidate Partner 1 Sales Rep 1 Partner 1 Sales Rep 2 Partner 1 Sales Rep 3
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■ AAs and DAs can create new criteria (you are not required to use criteria templates). However, 
it is recommended that the AA create criteria templates for the most common criteria to ease the 
learning curve for the DAs.
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9 Running Assignment Manager
This chapter provides preparatory considerations and tasks before running Assignment Manager and 
explains how to run Assignment Manager in several operating modes. It includes the following topics:

■ �Preparing to Run Assignment Manager� on page 196

■ �Checking the State of the Assignment Manager and Server Request Broker Components� on 
page 197

■ �Modifying the Assignment Manager Server Component Parameters� on page 198

■ �Additional AsgnSrvr and BatchAsgn Parameter Information� on page 207

■ �Setting the Log Level of Assignment Manager Events� on page 209

■ �About Server Administration Requirements After Configuration� on page 211

■ �About Server Administration Requirements for Assignment Modes� on page 212

■ �About Running Assignment Manager in Denormalization Mode� on page 214

■ �Running Interactive Assignment� on page 216

■ �About Running Dynamic Assignment� on page 220

■ �Process of Running Dynamic Assignment� on page 221

■ �About Tuning Dynamic Assignment for Performance� on page 226

■ �About Running Batch Assignment� on page 227

■ �Running Batch Assignment� on page 228

■ �About Tuning Batch Assignment for Performance� on page 233

■ �Running Mobile Assignment� on page 234

■ �About Running Assignment Manager in Reporting Mode� on page 235

■ �About Assignment Manager Rule Cache Files� on page 237

■ �About Using External Components to Invoke Assignment Manager� on page 238

■ �About Tuning Assignment Manager for Performance in a DB2 Deployment� on page 239
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Preparing to Run Assignment Manager
Assignment Manager obtains information required for operation from the following sources:

■ The assignment rules and criteria as well as employees, positions, and organizations that are 
read from the rule cache file.

■ The properties of assignment objects and their property values, the list of values for the picklists, 
and assignment criteria, attributes, workflow policy components, workflow policy component 
columns, and other repository information from the database.

■ Input parameters for the server component

NOTE: Assignment Manager uses many Siebel Server resources. It is recommended you monitor the 
Siebel Servers whenever Assignment Manager is invoked, especially if you run multiple instances at 
the same time. For more information about running multiple instances of Assignment Manager, see 
�About Running Multiple Instances of Assignment Manager in Batch Mode� on page 231.

Before running Assignment Manager, you must perform several preparatory tasks. These tasks 
include:

1 Assigning Rules. See �Process of Defining Assignment Rules� on page 86

2 �Updating Your Assignment Manager Deployment with New Configurations� on page 80

3 �Checking the State of the Assignment Manager and Server Request Broker Components� on 
page 197

4 �Modifying the Assignment Manager Server Component Parameters� on page 198

5 �Setting the Log Level of Assignment Manager Events� on page 209

In addition to the preparatory tasks, there are server administration requirements that should be 
considered before running Assignment Manager. For a discussion of these requirements, see the 
following topics:

■ �About Server Administration Requirements After Configuration� on page 211

■ �About Server Administration Requirements for Assignment Modes� on page 212
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Checking the State of the Assignment 
Manager and Server Request Broker 
Components
Before running Assignment Manager, you must first make sure that the Siebel Server can start one 
or more multithreaded assignment servers by checking the Assignment Manager and Server Request 
Broker server components.

To check the state of the Assignment Manager and Server Request Broker 
components

1 Navigate to the Administration - Server Management screen > Servers view.

2 In the Component Groups list, query for the Assignment Manager and Server Request Broker 
components, and check the Server field to verify these components are running on the 
appropriate Siebel Server. 

TIP: If the Server field is not visible, use the Columns Displayed feature to make it visible (right-
click, select Columns Displayed, use the arrows to move Server from Available Columns to 
Selected Columns, and then click Save).

3 In the State field in the Component Groups list, verify the state of each of the following 
components:

■ Assignment Manager component is Online.

■ Server Request Broker component is Running.

NOTE: If these components are not in their required state, check the log file for errors, and then 
make the necessary corrections.
Siebel Assignment Manager Administration Guide Version 7.8 197



Running Assignment Manager ■  Modifying the Assignment Manager Server Component 
Parameters
Modifying the Assignment Manager 
Server Component Parameters
Before running Assignment Manager, you should configure the Assignment Manager (AsgnSrvr) and 
Batch Assignment (BatchAsgn) server components to enhance their performance for your 
implementation by modifying the appropriate parameters.

To modify Assignment Manager server component parameters

1 Navigate to the Administration - Server Configuration screen > Servers > Components view.

2 In the Siebel Servers list, select your server (if more than one server appears) and make sure 
the Assignment Manager component is enabled on that server.

3 In the Components list, select one of the following:

■ Assignment Manager (AsgnSrvr)

■ Batch Assignment (BatchAsgn)

4 Click the Parameters subview (if not already active).

5 In the Parameters list, select the component parameters of interest, and adjust the values as 
required by your implementation to achieve optimal performance.

Table 45 on page 199 provides the parameters used by Assignment Manager that you can change.

6 After you have determined the optimal settings, make sure that the MinMTServers parameter is 
set to a current value greater than 0, and then restart the Siebel Server.

This starts the specified number of Assignment Manager components. For more information 
about the MinMTServers parameter, see �Additional AsgnSrvr and BatchAsgn Parameter 
Information� on page 207. For more information about starting and restarting the Siebel Server, 
see Siebel System Administration Guide. 
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Table 45 lists the server component parameters used by Assignment Manager that you can change. 
Because many of the parameters function in the same manner for both server components, the 
parameters for each component are combined into one table.

Table 45.  Assignment Manager (AsgnSrvr) and Batch Assignment (BatchAsgn) Server Component 
Parameters

Parameter 
Name Parameter Alias

Asgn
Srvr

Batch
Asgn Description

Active 
Employee 
Where Clause

ActiveEmpLOVCode X X Used to exclude inactive employees 
from assignment by specifying an 
SQL WHERE clause.

NOTE: You must set the same values 
for the ActiveEmpLOVCode and 
ActivePosWhereClause parameters 
consistently among the assignment 
server (AsgnSrvr), batch assignment 
(AsgnBatch), and the workflow policy 
program (if used). Otherwise, you 
may encounter unexpected results.

For more information, see the List of 
excluded person ids parameter in 
�Additional AsgnSrvr and BatchAsgn 
Parameter Information� on page 207.

Active Position 
Where Clause

ActivePosWhereClause X X Used to exclude inactive positions 
from assignment by specifying an 
SQL WHERE clause.

NOTE: You must set the same values 
for the ActiveEmpLOVCode and 
ActivePosWhereClause parameters 
consistently among the assignment 
server (AsgnSrvr), batch assignment 
(AsgnBatch), and the workflow policy 
program (if used). Otherwise, you 
may encounter unexpected results.

For more information, see the List of 
excluded person ids parameter in 
�Additional AsgnSrvr and BatchAsgn 
Parameter Information� on page 207.
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Actual 
Assignment Key

ActualAsgnKey X X The key value used when Assignment 
Manager is running in delta reporting 
mode to identify candidates by this 
key value in the actual result table.

For more information about delta 
reporting mode, see �About Running 
Assignment Manager in Reporting 
Mode� on page 235.

Add Scores 
across Rules

AddScores X X If True, scores for the same 
candidate are added across rules.

Default value is False.

See �Configuring Assignment Manager 
to Add Scores Across Rules� on 
page 273.

Allow Duplicate 
Positions

AllowDupPostn X X Allows assignment of duplicate 
positions to the team.

Default value is False.

For more information about this 
parameter, see �Additional AsgnSrvr 
and BatchAsgn Parameter 
Information� on page 207.

Assignment 
History Cache

CacheSize X Indicates the assignment history 
cache size in Kbytes.

Default value = 300.

Assignment Key AsgnKey X X Indicates the rule set used for key-
based routing, that is, the row ID of 
the assignment rule group that is 
associated with the rules you want to 
evaluate. The default value of the 
parameter is All AM Rule Set, in which 
case all active rules are evaluated.

Table 45.  Assignment Manager (AsgnSrvr) and Batch Assignment (BatchAsgn) Server Component 
Parameters

Parameter 
Name Parameter Alias

Asgn
Srvr

Batch
Asgn Description
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Assignment 
Mode

AsgnMode X X Indicates the assignment mode 
(Match, Assign, MatchAssign, 
Denorm, or Cancel).

Default value = MatchAssign.

For more information about 
AsgnMode, see �About Using External 
Components to Invoke Assignment 
Manager� on page 238.

Assignment 
Object Name

AsgnObjName X X Indicates the name of the 
assignment object.

Batch Size BatchSize X X Indicates the number of objects to be 
assigned before committing the 
transaction.

Default value = 100.

Check if 
CandidateActive

CheckIfCandidateActive X X Determines whether Assignment 
Manager checks candidate's 
activation and expiration date during 
evaluation of every rule.

Default value is False.

Check version 
iterations

CheckVerIter X Defines the frequency of time 
Assignment Manager checks whether 
rule version has changed. This also 
represents the time lag the new rules 
take effect after clicking the Release 
button.

Check version from database every N 
iterations. One integer value equals 
ten seconds (minimum value is 1).

Default value = 6.

Copy Candidate 
Specific Data

CopyCandSpecData X X Indicates whether Assignment 
Manager copies attribute values from 
dynamic candidate to the result 
table.

Default value = No.

Table 45.  Assignment Manager (AsgnSrvr) and Batch Assignment (BatchAsgn) Server Component 
Parameters

Parameter 
Name Parameter Alias

Asgn
Srvr

Batch
Asgn Description
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Copy Person 
Specific Data

CopyPersonSpecData X X Indicates whether Assignment 
Manager copies attribute values from 
dynamic candidates to the result 
table. 

Default value = No.

Default Tasks DfltTasks X X Indicates the default number of 
service tasks to start (server-mode 
only). 

NOTE: You must restart the 
component or server for this to take 
effect.

Default value = 0.

Dynamic 
Candidate 
Parameters

DynCandParam X X Semicolon-separated parameter, 
whose value pairs are used to 
substitute the variables in the 
Dynamic Candidate definitions in 
Siebel Tools. 

Format = 
Name of Param1:Value for param1; 
Name of Param2:Value for param2; 
and so on.

NOTE: Before version 7.8, this 
parameter was comma-separated.

Ignore Calendar 
Criteria

IgnoreCalCrit X X Allows a match to be made without 
taking into account calendar 
availability.

Default value = False.

Ignore 
assignment rule 
cache

IgnoreCache X X Indicates whether Assignment 
Manager ignores the assignment rule 
cache and reads from the database.

Default value = False.

Indepedent 
Rule Group 
Cache

IndepRuleGroupCache X If True, the Batch Assignment server 
component maintains a separate 
cache file for this rule group for this 
request.

Default value = True.

Table 45.  Assignment Manager (AsgnSrvr) and Batch Assignment (BatchAsgn) Server Component 
Parameters

Parameter 
Name Parameter Alias

Asgn
Srvr

Batch
Asgn Description
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Key Based 
Enable

KeyBasedEnabled X Enables key-based routing for a 
component that has been predefined 
for that attribute.

Default value = True.

List of excluded 
organization ids

ExcludeOrgList X X Indicates a comma-separated list of 
organization IDs to be excluded from 
assignment.

For more information on excluding 
organization IDs, see �Additional 
AsgnSrvr and BatchAsgn Parameter 
Information� on page 207.

List of excluded 
person ids

ExcludePersonList X X Indicates a comma-separated list of 
employee or positions Ids to be 
excluded from assignment.

For more information on excluding 
person IDs, see �Additional AsgnSrvr 
and BatchAsgn Parameter 
Information� on page 207.

Table 45.  Assignment Manager (AsgnSrvr) and Batch Assignment (BatchAsgn) Server Component 
Parameters

Parameter 
Name Parameter Alias

Asgn
Srvr

Batch
Asgn Description
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Log txn only on 
change

LogTxnChgOnly X X Logs transaction only when the 
assignment has changed (for 
example, when the sales team is 
updated).

By default, this parameter is set to 
TRUE. Setting this parameter to 
FALSE causes Assignment Manager 
to log a transaction in the 
S_DOCK_TXN_TABLE on 
reassignment even when there is no 
change in rules or assignees. 

NOTE: If there is a change in at least 
one of the primaries, or if there is a 
change in at least one of the team 
tables, Assignment Manager updates 
columns (primaries, ASGN_DT, and 
system columns) on the object row. 
However, if there is no net change, 
only the ASGN_DT column is 
updated. 

For information about how this 
parameter works with regard to 
merge conflicts, see Siebel Remote 
and Replication Manager 
Administration Guide.

Maximum MT 
Servers

MaxMTServers X Indicates maximum number of active 
servers for a multithreaded service.

Default value = 1.

Maximum 
Routing Keys

MaxRouteKeys X Indicates the number of keys 
allocated for the routing. Used for 
interactive assignment.

Maximum Tasks MaxTasks X X Indicates maximum number of 
running tasks for a service.

Default value = 20.

Table 45.  Assignment Manager (AsgnSrvr) and Batch Assignment (BatchAsgn) Server Component 
Parameters

Parameter 
Name Parameter Alias

Asgn
Srvr

Batch
Asgn Description
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Minimum MT 
Servers

MinMTServers X Indicates a minimum number of 
active servers for a multithreaded 
service.

Default value = 1.

NOTE: Applies only to the 
Assignment Server and other 
multithreaded request-based 
servers.

Object Row Id ObjectRowId X Indicates the row ID of the object to 
assign.

Object Row Sql 
Statement

ObjRowSqlStmt X X Represents the SQL statement that 
when executed gives the object row 
IDs to be assigned. 

NOTE: You can use this parameter to 
specify the rows to be assigned in lieu 
of the ObjRowId or ObjWhereClause 
parameters.

Object Where 
Clause

ObjWhereClause X X A WHERE clause of the object for use 
with interactive and batch 
assignment.

For more information, see �About 
Using an Object Where Clause to 
Restrict the Number of Records 
Processed� on page 212.

Organization 
Key Value

OrgKeyVal X X Used to stamp rows when assigning 
organizations and UseKeyValue = 
Key Value. 

Person Key 
Value

PersonKeyVal X X Used to stamp rows when assigning 
employees or positions and 
UseKeyValue = Key Value.

Primary 
Organization Id

PrOrganizationId X Indicates the ID of the organization 
to be assigned as the primary.

Primary Person 
Id

PrPersonId X Indicates the ID of the person to be 
assigned as the primary.

Primary Rule Id PrRuleId X Indicates the ID of the rule to be 
assigned as the primary.

Table 45.  Assignment Manager (AsgnSrvr) and Batch Assignment (BatchAsgn) Server Component 
Parameters

Parameter 
Name Parameter Alias

Asgn
Srvr

Batch
Asgn Description
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Refresh people 
skills interval

MaxSkillsAge X Indicates the interval in which people 
skills are refreshed in seconds. 
Setting the value to 0 (zero) disables 
refresh.

Default value = 0.

Regular 
Assignment

RegularAsgn X Indicates whether Assignment 
Manager should perform regular 
assignment.

NOTE: Assignment Manager can also 
run in reporting mode.

Default value = True.

Replace Key 
Values

ReplaceKeyVal X X Indicates whether Assignment 
Manager should look for candidates 
in the team table that have a value 
stamped in the Key column.

These candidates are then compared 
to those that qualify for the rule and 
are removed, updated, or inserted.

This parameter is a comma-
separated string and is dependent on 
what is passed in the UseKeyVal 
parameter. 

Replace Team 
Members

ReplaceTeamMembers X X Allows deletion of team members if 
they no longer qualify.

Reporting Mode RptMode X X Indicates what reporting mode 
Assignment Manager will run. Values 
are: None, Snapshot, and Delta.

Default value = None.

Request Id ReqId X X Assignment Manager generates a 
request ID for each server 
component job. When AsgnMode = 
Match, passing candidates are stored 
in a temporary table with the request 
ID. Then, Assignment Manager uses 
this request ID to find (match) the 
correct entries in the table.

Table 45.  Assignment Manager (AsgnSrvr) and Batch Assignment (BatchAsgn) Server Component 
Parameters

Parameter 
Name Parameter Alias

Asgn
Srvr

Batch
Asgn Description
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Additional AsgnSrvr and BatchAsgn 
Parameter Information
The following subtopics provide further explanation for some of the server component parameters 
used with Assignment Manager and why you might want to use them. The name provided in 
parentheses is the alias for the parameter.

Allow Duplicate Positions (AllowDupPostn) Parameter
You can assign duplicate positions by setting the Allow Duplicate Positions server component 
parameter when you run an assignment request. By default, the Allow Duplicate Positions server 
parameter is set to False. When you set this parameter to True, Assignment Manager attempts to 
insert duplicate positions, that is, positions with the same ID in the team table, given those positions 
do not violate the user key constraints of the table.

Return Property 
Set

ReturnPropSet X If True, Assignment Manager returns 
a hierarchical property set containing 
qualified or assigned candidates.

See �About Using External 
Components to Invoke Assignment 
Manager� on page 238.

Use FOR 
UPDATE

UseForUpdate X X If True, Assignment Manager uses 
the FOR UPDATE SQL clause to lock 
primary table rows so that, during 
evaluation and assignment, no other 
process or user can make changes to 
this row.

Use Key Value UseKeyVal X X Indicates whether Assignment 
Manager uses the Key Value to filter 
and stamp the candidate. Values are: 
None, Rule Group, and Key Value.

Default value = None.

Use Rule 
Minimum Score

UseRuleMinScore X X If True, Assignment Manager filters 
out candidates who do not get at 
least the minimum score on the 
assignment rule.

Default value = False.

Table 45.  Assignment Manager (AsgnSrvr) and Batch Assignment (BatchAsgn) Server Component 
Parameters

Parameter 
Name Parameter Alias

Asgn
Srvr

Batch
Asgn Description
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You must also set the PositionTeamDenorm user property for the assignment object. The 
PositionTeamDenorm assignment object user property specifies which destination columns are part 
of the user key. Assignment Manager checks whether positions with the same ID that pass violate 
the uniqueness of these key columns. If Assignment Manager detects a violation, only the first 
position encountered is inserted into the team table, and the other position is ignored. Otherwise, 
Assignment Manager inserts both positions into the team table.

For example, if there is a violation of the user key when adding positions to the account team, then 
only the first duplicate position encountered is inserted into the S_ACCNT_POSTN table. For an 
example of using the PositionTeamDenorm assignment object user property, see �Example of Copying 
Additional Columns to the Team Table� on page 256.

Check version iterations (CheckVerIter) Parameter
Changing this parameter to a small value, such as 1, reduces the potential for invalid assignment. 
For example, running interactive assignment before Assignment Manager detects that the Release 
button was recently clicked causes assignment based on the previous version of assignment rules. 
By having a small iteration value, Assignment Manager checks for a newer version of assignment 
rules more frequently. Test your deployment with this lower parameter value to make sure it does 
not interfere with any other database activity. 

List of excluded person ids (ExcludePersonList) and List of excluded 
organization ids (ExcludeOrgList) Parameters
You can choose to exclude a specific candidate or candidates, even though you added the candidate 
or candidates to an assignment rule. You do so at run time by specifying the ExcludePersonList or 
the ExcludeOrgList server component parameter as comma-separated lists of candidate Ids from the 
Server Manager command line. Assignment Manager does not evaluate these candidates, and 
because of this, the candidates do not appear in log files even when Match or Assign logging is active.

For example, if an employee has not worked on a service request for several days, and if a request 
is submitted to assign the same service request, Assignment Manager assigns the service request to 
the same person again. That is because, given a set of assignment rules and criteria, Assignment 
Manager assigns the candidate with the highest score to the object row. By specifying the 
ExcludePersonList parameter for a particular run, you can exclude this particular candidate from 
assignment consideration.

In addition, you can choose to exclude certain employees for assignment rule evaluation. For 
example, you might want to exclude inactive employees or employees who are on a leave of absence 
from assignment consideration. You exclude employees using the Active Employee Where Clause 
server parameter (or use ActiveEmpLOVCode from the Server Manager command line) with an SQL 
WHERE clause that is based on any column (or columns) on the S_EMP_PER employee table. For 
example, you could use the EMP_STAT_CD column with the following value to indicate that you want 
only active employees considered for evaluation and assignment:

AND emp.EMP_STAT_CD='Active'

The employees are excluded even if they are explicitly added to an assignment rule as candidates.
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Similarly, you can exclude inactive positions using the Active Position Where Clause component-level 
server parameter (or use ActivePosWhereClause from the Server Manager command line). 

NOTE: If you make changes to either of these parameters, you must release rules for the them to 
take effect.

CAUTION: When specifying the parameters, you must use the emp SQL alias for the S_EMP_PER 
employee table and the pos alias for the S_POSTN position table. This is to differentiate from other 
columns by the same name in other tables that Assignment Manager might use in the same SQL. 
Otherwise, a SQL error (ambiguous reference to a column) may occur.

Maximum MT Servers (MaxMTServers) Parameter
This parameter controls the maximum number of Assignment Manager server processes that are 
running at any time (when MaxMTServers > MinMTServers). Generally, the default value is sufficient 
for most deployments as server processes and Assignment Manager have large resource 
requirements. 

Maximum Tasks (MaxTasks) Parameter
This parameter controls the maximum number of server threads that can run at any time. For 
Assignment Manager, this controls the maximum number of assignments that can be processed 
concurrently. The value of this parameter should be set to the maximum anticipated concurrent 
requests (dependent on your server�s capabilities). 

Minimum MT Servers (MinMTServers) Parameter
This parameter controls the number of Assignment Manager server processes that are started when 
the Siebel servers starts up. If this value is set to zero, Assignment Manager is disabled. It is 
recommended that you use the default value of one, as server processes and Assignment Manager 
have large resource requirements.

Refresh people skills interval Parameter (MaxSkillsAge) Parameter
This parameter controls the interval in which people skills are refreshed in seconds. If you want to 
automatically refresh skills without restarting the Assignment Manager component, set the value of 
the MaxSkillsAge parameter to the desired update interval (the value must be greater than zero 
seconds). Then, when rules are released, Assignment Manager refreshes skills and recreates the 
rulecache.dat file at the periodic interval set.

Setting the Log Level of Assignment 
Manager Events
Before running Assignment Manager, you can set event logs to view results. The Assignment 
Manager, Batch Assignment, and Workflow Monitor Agent server components are configured to use 
events.

NOTE: The Trace Flags and Error Flags parameters are no longer used with Assignment Manager. 
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In addition to the events used for other server components, the Assignment Manager, Batch 
Assignment, and Workflow Monitor Agent server components use specific events to log information 
related to assignments:

■ Assignment Manager Generic (Generic). Generic events specific to Assignment Manager.

■ Loading (Loading). Logging of events that happen during loading.

■ Object Assignment (Assign). Logging of events during the assignment phase.

■ Rules Evaluation (Match). Logging of events during the evaluation phase

■ SQL Parse and Execute. Traces all executed SQL and makes enhances debugging.

There are five levels in each of the events:

■ Level 0: Used for fatal errors

■ Level 1: Used for nonfatal errors and warnings

■ Level 2-4: Used for different levels of logging detail

■ Level 5: Used for detailed debug information

Assignment Manager uses two events for logging information when assigning object rows. For the 
evaluation phase, Assignment Manager uses the Rules Evaluation (Match) event. The following levels 
of information are logged for each level:

■ Level 2 - Object row-level logging

■ Level 3 - Rule-level logging

■ Level 4 - Criterion-level logging

■ Level 5 - Criterion value-level logging

NOTE: As of version 7.7, level 5 is necessary for you to see detailed criteria value-level logging.

For the assignment phase, Assignment Manager uses the Object Assignment (Assign) event. The 
following levels of information are logged for each level:

■ Level 2 - Object row-level logging

■ Level 3 - Passing rules-level logging

■ Level 4 - Passing candidates-level logging

NOTE: You can set the log level of both event types to print a list with combined results. However, 
when assigning too many objects, these settings may create extremely large log files. 

To set the log level of Assignment Manager events

1 Navigate to the Administration - Server Configuration screen > Servers > Components view.

2 In the Components list, select the Assignment Manager, Batch Assignment, or Workflow Monitor 
Agent component, depending on which component you want to set a log level; make sure the 
selected component is running on the correct server.

3 In the Log Level field in the Events list, adjust the values as required by your implementation as 
follows:
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a Select Rules Evaluation; type in 3 if you want to print a list of assignment rules that were 
evaluated

b Select Object Assignment; type in 3 if you want to print a list of evaluated assignment rules that 
passed

For more information on event logs, see System Monitoring and Diagnostics Guide for Siebel 
Business Applications.

About Server Administration 
Requirements After Configuration
After configuring Assignment Manager objects and attributes or altering assignment policies, it is 
often necessary to stop and restart various server tasks and components. Table 46 summarizes the 
required server tasks and components that must be restarted based on the type of configuration 
process. Detailed information on how and when to run these server tasks and components is 
provided in the remainder of this chapter. 

NOTE: If you want to automatically refresh skills without restarting the Assignment Manager 
component, set the value of the Refresh people skills interval (MaxSkillsAge) server component 
parameter to the desired update interval (the value must be greater than zero seconds). Then, when 
rules are released, Assignment Manager refreshes skills and recreates the rulecache.dat file at the 
periodic interval set. 

Table 46. Summary of Server Administration After Configuration

Configuration Process

Restart 
Assignment 
Manager

Regenerate 
Triggers

Restart 
Workflow 
Monitor Agent

Adding or configuring an assignment object, 
assignment attribute, or assignment criteria

Yes Yes Yes

Changing assignment policies Not applicable Yes Yes

Activating or deactivating assignment policies Not applicable Yes Yes
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About Server Administration 
Requirements for Assignment Modes
Assignment Manager requires various functioning server components and tasks based on the 
selected assignment mode. Table 47 summarizes the required server components and tasks that 
must be online or started when selecting a particular mode of assignment. When Mobile Assignment 
is selected, use the information provided for either interactive or batch assignment based on your 
deployment requirements. Detailed information on starting these components and tasks is covered 
in the remainder of this chapter.

Additionally, when using availability-based assignment, make sure the Field Service component 
group and the ApptBook component are online.

About Using an Object Where Clause to 
Restrict the Number of Records 
Processed
The Object WHERE Clause (ObjWhereClause) parameter can be used to restrict which records are 
retrieved and processed. Standard SQL WHERE statements are used for the Object WHERE Clause 
and can include up to 2048 characters when an assignment server job is started using the 
command-line interface. However, when you start an assignment server job from the UI, you can 
only specify up to 100 characters. Also, when using wildcards in the object WHERE clause, make sure 
you use the correct wildcard specific to your database.

Table 47. Summarization of Server Requirements for Assignment Modes

Assignment Mode
Set Assignment 
Manager Online

Start Workflow 
Monitor Agent

Server Request 
Broker Running1 

1. For dynamic and batch assignment, you do not need to start the Server Request Broker when running your tasks using the 
SRVRMGR command-line interface (or an alternate method, such as setting Default Tasks for the server component).

Interactive Mode Yes No Yes

Dynamic Assignment Mode No2 Yes No2 

2. This information is based on the default �Assignment Request (In Process)� seeded action.

Batch Assignment Mode No No No
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The following object WHERE clause examples for the Account assignment object are provided as a 
guideline. Assignment administrators should work with their database administrator to generate 
optimal SQL for their implementation.

As an example, the following conditions for the Account assignment object can apply:

■ Joins are allowed in the Object WHERE Clause. 

An example of a join is as follows:

Object Where Clause = where pr_postn_id in (select row_id from s_postn where name 
= 'Sales Rep') 

■ The Object WHERE Clause assumes the base table is coming from the assignment object 
specified. 

If you start batch assignment specifying the assignment object as Account and the Object WHERE 
Clause is where row_id = '1-232', then batch assignment attempts to assign only the row_id 
= '1-232' from the S_ORG_EXT table.

The following is an example of a batch assignment request using the command-line interface:

start task for component AsgnBatch with AsgnObjName= �Account�, 
AsgnMode=�MatchAssign�, ObjWhereClause=�where name like 'B%'�

This command batch assigns accounts starting with B. 

Optionally, you can use the command-line interface and the Object WHERE Clause to run only a select 
number of assignment rule groups. The following is an example of this:

start task for comp asgnbatch with asgnobjname="Account", objwhereclause="where name 
like 'B%'", asgnkey="12-4DR56"

In this example, 12-4DR56 is the row ID of an assignment rule group, and only those rules belonging 
to this group are evaluated when this parameter is passed in the request.

NOTE: When using the command-line interface, use double quotation marks for the ObjWhereClause 
parameter; otherwise, it is treated as a SRVRMGR command option that changes the case.
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About Running Assignment Manager in 
Denormalization Mode
Assignment Manager provides the ability to denormalize positions and organizations using the 
Contact Denormalization and Product Denormalization features.

Contact Denormalization and Product Denormalization modes do not require assignment rules to 
function. Assignment Manager does not evaluate the Contact object against any assignment rules in 
contact denormalization mode, nor does it evaluate the Product object against any assignment rules 
in product denormalization mode. And, neither mode assigns candidates to these objects. Instead, 
Assignment Manager gets positions from a related entity in these modes. For example, in Contact 
Denormalization mode, Assignment Manager gets a union of positions from related accounts and 
opportunities and assigns it to the contact.

NOTE: Contact Denormalization behavior differs among the various Siebel Industry Applications. 
See the appropriate industry-specific guide to learn more about this behavior.

About Contact Denormalization
You use Contact Denormalization when you want to allow assignees automatic access to detail 
contact information that is associated with an account or opportunity. In Contact Denormalization 
mode, Assignment Manager denormalizes positions from the Accounts and Opportunities team tables 
by copying these positions to the associated contacts in the Contact team table, even if the assignees 
are not assigned to the contacts:

■ Positions from the team table of all accounts associated with the contact to the contact team.

■ Positions from the team table of all Opportunities associated with the contact to the Contact 
team.

NOTE: The Contact Denormalization object is reserved to run Assignment Manager in Contact 
Denormalization mode. Assignment Manager does not evaluate the Contact object against any 
assignment rules in Contact Denormalization mode, and therefore does not assign candidates to 
objects. For this reason, do not create assignment rules for the Contact Denormalization object.

If you want the contact access list to reflect the positions in both the account and opportunity team 
tables, you must associate the contact with an account and then associate the contact with an 
opportunity. If a team member is removed from the account or opportunity�s team table, then the 
position on the associated contact�s access list can also be removed by Contact Denormalization 
(dependent on the properties of the Contact Denormalization assignment object). Similarly, if the 
account team has manually assigned team members and you want the same team members on both 
the contact team and account team, you must run Contact Denormalization after the account 
assignment.

NOTE: Positions marked Indirect by Contact Denormalization in Contact Access list are not dropped 
by contact assignment, that is, contact assignment does not drop the positions that were added by 
Contact Denormalization. 
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Contact Denormalization checks the Lock Assignment column on assignment objects before 
denormalizing. If this flag is checked, Contact Denormalization does not denormalize the contact 
record. For more information about the Lock Assignment feature, see �Setting the Lock Assignment 
Default Value for Activity Assignment Objects� on page 254.

NOTE: Both Account and Contact and Contact and Opportunity have a many-to-many relationship. 
The Account and Contact many-to-many relationship is a feature available as of the version 7.0 
release.

Assignment Manager also assigns a primary position to the contact when running in Contact 
Denormalization mode using the following methodology:

1 If the Set Primary Position property on the assignment object is TRUE (checked) and a primary 
position is not currently selected, then Assignment Manager sets the creator�s primary position 
as the new primary position.

2 If a primary position is not selected for the creator, then Assignment Manager sets the default 
position as the new primary position.

3 If a default position is not defined, then Assignment Manager does not set a primary position.

However, Contact Denormalization does not remove positions marked as the Primary, even if the 
positions no longer exist on an associated account or opportunity (with the Denorm Flag set).

Related Topic
�Activating Contact Denormalization for Dynamic Assignment� on page 216

About Product Denormalization
In product denormalization mode, Assignment Manager denormalizes organizations from the Price 
List table into the Product table by copying these organizations to the products associated with the 
price lists. You should run product denormalization only in batch mode.

NOTE: Product to price list is a many-to-many relationship.

Assignment Manager assigns a primary organization to the product when running in denormalization 
mode using the following methodology:

1 If the Set Primary Organization flag is checked and a primary organization is not currently 
selected, then Assignment Manager sets the creator�s primary organization as the new primary 
organization.

2 If a primary organization is not selected for the creator, then Assignment Manager sets the 
default organization as the new primary organization.

3 If a default organization is not defined, then Assignment Manager does not set a primary 
organization.

NOTE: The Product Denormalization object is reserved to run Assignment Manager in Product 
Denormalization mode. Assignment Manager does not evaluate the Product object against any 
assignment rules in Product Denormalization mode, and therefore does not assign organizations to 
objects. For this reason, do not create assignment rules for the Product Denormalization object. 
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Activating Contact Denormalization for 
Dynamic Assignment
For dynamic assignment, if you want to run Assignment Manager in contact denormalization mode, 
you must activate the Contact Denormalization assignment policy. By default, this policy is inactive.

NOTE: When Assignment Manager runs in contact denormalization mode, it does not evaluate 
assignment rules. Therefore, you do not need to select the Contact Denormalization object for the 
assignment rule to run Assignment Manager in contact denormalization mode.

Use the following procedure to activate contact denormalization for dynamic assignment.

To activate contact denormalization

1 Navigate to the Administration - Assignment screen > Assignment Policies view.

2 In the Assignment Policies list, select Contact Denormalization, and then perform the following:

a In the Group field, click the select button.

b In the Workflow Groups dialog box, select a workflow group (the default is Assignment Group), 
and then click OK.

c In the Expiration field, either clear the existing value or set the value to a later date.

NOTE: If running batch assignment, you do not need to activate this policy.

Running Interactive Assignment
Running Assignment Manager in interactive mode allows end users to make real-time assignments. End 
users can review a list of potential assignees generated by Assignment Manager, then select and confirm, 
or override the assignment from the generated potential candidate list. For example, a call center agent 
might review potential candidates for an activity, then based on the candidates� assignment scores, 
expertise, or workload, assign the best candidate for the job.

The Activity and Service Request assignment objects are predefined to use interactive assignment, 
which allows you to assign employees to activities and service requests in real time. However, you 
can configure other assignment objects to use interactive assignment. For information about how to 
configure assignment objects to use interactive assignment, see �Configuring Assignment Objects for 
Interactive Assignment� on page 53.
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You can run interactive assignment using any of the following:

■ Siebel Developer Web Client

■ Siebel Web Client (also known as zero footprint client)

■ Command-line Server Manager (srvrmgr) program

NOTE: Before running interactive assignment using the Siebel Developer Web Client, it is 
recommended that you verify that the correct parameter settings exist in your Siebel client 
configuration (.cfg) file. The parameters identified in this configuration file specify the location of the 
Siebel Server where Assignment Manager is running and are automatically created during installation 
of the Siebel client. For information about the Siebel client installation process and configuration file, 
see the Siebel Installation Guide for the operating system you are using.

NOTE: Mobile users running Assignment Manager in interactive mode do not make real-time 
assignments, because interactive assignments made by mobile users are not applied to the server 
until they resynchronize.

Requirements
Interactive assignment requires that the:

■ Assignment Manager server component is Online

■ Server Request Broker server component is Running

Running Interactive Assignment from the UI
The Activity and Service Request assignment objects are predefined to use interactive assignment, 
which allows you to assign employees to activities and service requests in real time.

To run interactive assignment from the UI

1 Navigate to either of the following locations:

■ Activities screen > Activity List > All Activities view

■ Service Requests screen > All Service Requests view

2 In the All Service Requests or All Activities list, select an open service request or activity for 
assignment.

3 In the More Info form, click the Menu button and select Assign to start interactive assignment.

For an example, see Figure 4 on page 53.

4 Choose an assignee from the list of best candidates provided by Assignment Manager.
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The Siebel client then:

■ Communicates with the Siebel Assignment Manager on the Siebel Server and creates a list of 
qualified employees for the activity or service request.

■ Displays the list of qualified employees to the Siebel user, sorted by the descending order of 
scores.

■ Sets the activity or service request owner to the employee that is chosen when clicking the Assign 
button.

Example of Running Interactive Assignment for Service 
Requests from the UI
This topic gives one example of running interactive assignment from the user interface (UI). The 
example is applicable for use with the Siebel Developer Web Client as well as the Siebel Web Client. 
You may use this feature differently, depending on your business model. 

To run interactive assignment for a service request

1 Navigate to the Service Requests screen > All Service Requests view.

2 In the Service Requests list, select an open Service Request for assignment.

3 In the More Info form, click the Menu button and select Assign to start interactive assignment.

For an example, see Figure 4 on page 53.

4 Choose an assignee from the list of best candidates provided by Assignment Manager.

The Siebel client:

■ Communicates with the Siebel Assignment Manager on the Siebel Server and creates a list of 
qualified employees for the service request.

■ Displays the list of qualified employees to the Siebel user, sorted by the descending order of 
scores.

■ Sets the service request owner to the employee that you choose.
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About Running Interactive Assignment in Rule Group 
Mode
By default, interactive assignment submits requests to an assignment server that is running in 
default mode. However, you can use the Assignment Manager server component (AsgnSrvr) to run 
interactive assignment in rule group mode�with or without using server key mappings.

Using Server Key Mappings to Run Interactive Assignment 
Use server key mappings when you want to split your rules across different servers. You can explicitly 
define what rule groups to load on what server, and only rules from that particular rule group are 
executed. At the time of the assignment request, you can specify one of the rule groups as the 
Assignment Key parameter (AsgnKey) along with the request.

If you use server key maps, when you click the Assign button, a request is sent to the Assignment 
Manager server component (AsgnSrvr) to evaluate and return the qualified candidates. To submit 
requests to a server that has server key mappings, one of the rule group IDs must pass because the 
AsgnKey parameter must pass. To accomplish this, the SetAsgnKey InvokeMethod is called on the 
CSSBCBase business component base class. Using a script, a workflow process, or a business 
service, this InvokeMethod is called and the row ID of one of the rule groups is passed as the 
parameter. 

After this is complete, interactive assignment uses this parameter as the AsgnKey and ReqKey 
parameters when submitting requests to the AsgnSrvr component. Note that for one session, you 
only need call this InvokeMethod once. Subsequent requests in the same session reuse the rule 
group row ID. However, when the session is logged out or the server is restarted, you must call this 
InvokeMethod again to set the AsgnKey parameter. Otherwise, the assignment server reverts to 
running in default mode. 

Without Using Server Key Mappings to Run Interactive Assignment 
Assignment Manager supports the use of rule group mode even if you do not want to split your rules 
across multiple servers. In this case, you do not create server key mappings. Instead, you submit 
the request a specifying the rule group in the AsgnKey parameter for AsgnSrvr. Even if there are no 
server key mappings, each AsgnSrvr process loads all active rules. AsgnSrvr determines at request 
time whether to execute all rules or only rules from a particular group based on whether or not the 
assignment key is passed.
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About Running Dynamic Assignment
Dynamic assignment is a feature that works transparently as existing records change or new records 
are created. For example, you can set up dynamic assignment to automatically assign a service 
request to an owner when a new record is created or reassign a service request to another owner if 
the service request is updated.

Dynamic assignment is especially useful in a deployment where users and server programs make 
frequent changes to the assignment object records (such as service requests and activities) because 
dynamic assignment can automatically determine the changes and assign the objects to the 
appropriate people and organizations.

The dynamic assignment process uses the underlying database triggers feature. When a record is 
modified, either by a user or by another server process like EAI, workflow, and so on, the database 
trigger (setup by the Generate Triggers server component) captures the changes, and queues the 
assignment request into the S_ESCL_REQ (escalation request) table. The Workflow Monitor Agent 
then polls S_ESCL_REQ periodically and assigns the object by internally invoking Assignment 
Manager within its own process.

NOTE: By default, the Server Request Broker and the Assignment Manager server components are 
not explicitly used in dynamic assignment. 

Requirements
Dynamic assignment requires that: 

■ Triggers are generated using Generate Triggers component 

■ Workflow Monitor Agent is running

■ Assignment policies are set and activated

■ (Optional) If you are using skills, make sure the MaxSkillsAge server component parameter is 
set to a value greater than 0 seconds

NOTE: Dynamic assignment can refresh employee, position, and organization skills from the 
database if changes are made to these items. The MaxSkillsAge program argument, if activated, 
forces Assignment Manager to reload this information. By default, this argument is not set. For 
more information about this parameter, see �Modifying the Assignment Manager Server 
Component Parameters� on page 198.

Workflow Monitor Agent
To run dynamic assignment, a Workflow Monitor Agent task must be running. A Workflow Monitor 
Agent detects when a user changes data related to objects. For more information about Workflow 
Monitor Agent, see Siebel Business Process Designer Administration Guide.
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Generate Triggers
The Generate Triggers server component generates the database triggers used by Workflow Manager 
to detect changes. Generate Triggers reads the Workflow Policy Object and Assignment Object 
definitions in the Siebel repository and generates the appropriate database triggers to monitor 
changes.

Process of Running Dynamic Assignment
You run dynamic assignment only in default mode, which means all active rules are loaded and 
processed. Rule group mode is not supported. 

To set up dynamic assignment, perform the following tasks:

1 (Optional) �Reviewing Triggers for Dynamic Assignment� on page 221

2 Generating Triggers, using either of the following procedures:

■ �Generating Triggers for Dynamic Assignment Using the UI� on page 222

■ �Generating Triggers for Dynamic Assignment Using the Command-Line Interface� on page 224

3 �Starting Workflow Monitor Agent for Dynamic Assignment Using the Command-Line Interface� on 
page 224

Reviewing Triggers for Dynamic Assignment 
The database triggers created by the Generate Triggers server component detect record changes in 
the Siebel database and place an assignment request in the S_ESCL_REQ (escalation request) table 
for the Workflow Monitor Agent to pick up the request and invoke the Assignment Server. However, 
triggers generated for Assignment Manager can reference other database columns not associated 
with assignment rules. 

CAUTION: Make sure triggers are generated only for an assignment policy�s criteria. Large data 
loads can experience performance issues otherwise.

Do not modify the database triggers. However, before generating or applying triggers for dynamic 
assignment, you might want to review the trigger.sql file. It is recommended you work with your 
database administrator to do so.

NOTE: If you discover redundant triggers, you need to deactivate the appropriate assignment 
criteria and assignment attribute using Siebel Tools.

To review triggers for dynamic assignment

1 Use Siebel Tools, or view the trigger.sql file (/Siebel Root/Siebsrvr/trigger.sql), to examine the 
appropriate table columns.

For more information about using Siebel Tools, see Using Siebel Tools.
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2 Disable the inappropriate columns by inactivating the assignment attribute column.

For detailed information, see �Disabling Assignment Attributes� on page 73.

If you inactivate only the assignment attribute column and leave the assignment attribute and 
assignment criteria active, then the assignment criteria appears in the user interface in the 
assignment administration views, which means you can create assignment rules based on that 
criteria. The following is the result of this action based on whether or not the Employee Skill field 
is checked: 

■ If the Employee Skill field is checked, then the assignment criteria is skill-based and, as such, 
should continue to work for assignment rules. For example, the criteria works if you run batch 
assignment because that mode does not rely on triggers.

■ If the Employee Skill field is not checked, then the assignment criteria is object-based, and 
as such, relies on a valid assignment attribute column configuration. If you attempt to create 
assignment rules, you get an error message when the task is run.

3 Drop and regenerate new triggers.

See �Generating Triggers for Dynamic Assignment Using the UI.�

4 Recheck the trigger.sql file, to confirm that the trigger is no longer active. 

NOTE: When dynamic assignment is running, due to the database concurrency feature, some users 
might receive the following error when attempting to modify a record: �The selected record has been 
modified by another user since it was received. Please continue." This can occur because Assignment 
Manager updated the record by assigning it while an user was trying to edit it. In this situation, the 
user�s changes may be lost. The solution is to refresh the query and reenter the changes.

Generating Triggers for Dynamic Assignment Using the 
UI
Use the Generate Triggers server component to generate the database triggers used by Workflow 
Manager to detect changes in the database. 

NOTE: You cannot create custom triggers on the Siebel database. The only supported triggers 
allowed on the Siebel database are those generated during installation or from running the Generate 
Triggers server component. 

For dynamic assignment, you need to run the Generate Triggers server component after:

■ Creating or changing an Assignment Object, Assignment Attribute, or Assignment Criteria object 
type in Siebel Tools

■ Changing assignment policies

■ Installing or upgrading the Siebel Server

TIP: When amending an assignment rule, criteria, or value, or when making changes to assignment 
positions in dynamic mode, you do not have to drop and regenerate database triggers. 
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To generate triggers for dynamic assignment using the UI

1 Navigate to the Administration - Server Management screen > Jobs view.

2 In the Jobs list, click New.

A new record appears with a system-defined ID automatically generated with a status of 
Creating.

3 In the Job Detail subview, enter the relevant information for the new component request record.

a In the Requested Server field, type the name of the Siebel Server for which you want to run 
Generate Triggers.

b In the Request Key field, type in the name of the request key.

c Complete the rest of the fields, if needed.

4 In the Job Parameters list, click New to create a new record for the Privileged User, and enter the 
relevant parameter information.

a In the Name field, click the select button.

b In the Job Parameters dialog box, query for PrivUser, and then click OK.

c In the Value field, type in the privileged user name.

NOTE: If you are using a Microsoft SQL Server database, you need to set the Privileged User 
Password value to the user password with tableowner privileges. Also make sure that the Table 
Owner value is set to dbo.

5 In the Job Parameters list, click New to create a new record for the Privileged User Password, 
and enter the relevant parameter information.

a In the Name field, click the select button.

b In the Job Parameters dialog box, query for PrivUserPass, and then click OK.

c In the Value field, type in the privileged user password.

6 In the My Component Requests form, click the Menu button, and then click Submit request.

For more information generating database triggers, see Siebel Business Process Designer 
Administration Guide. 
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Generating Triggers for Dynamic Assignment Using the 
Command-Line Interface
You can run dynamic assignment using the Server Manager server component from the command-
line interface using the Generate Triggers command and the parameters in Table 48. The 
command-line interface of the Server Manager is the srvrmgr program. For more information on 
using the command-line interface, see Siebel System Administration Guide.

Starting Workflow Monitor Agent for Dynamic 
Assignment Using the Command-Line Interface 
To run dynamic assignment, the Workflow Monitor Agent (the WorkMon server component) needs to 
be running. This server component monitors the S_ESCL_REQ table. Database triggers, when fired 
because of object changes, create records in the S_ESCL_REQ table. The Workflow Monitor Agent 
reads these new records and processes requests for Assignment Manager policies. Affected objects 
are then dynamically assigned. 

NOTE: Dynamic assignment does not log information into S_ESCL_LOG. For more information about 
log files, see System Monitoring and Diagnostics Guide for Siebel Business Applications.

To start Workflow Monitor Agent from the command-line interface

1 Determine the workflow group that you want Workflow Monitor Agent to monitor. 

a Navigate to the Administration - Assignment screen > Assignment Policies view. 

b In the Policy Group field in the Assignment Policies list, choose the workflow group (the default 
group is Assignment Group).

2 Start the srvmgr program. 

For detailed information on this process, see Siebel System Administration Guide. After the 
program starts, the prompt changes to:

srvmgr: server_name>

Table 48. Generate Triggers Command-Line Interface Parameters

Parameter 
Name Display Name Description

Default 
Value

EXEC EXEC Install Triggers to DB directly FALSE

Mode Mode Assignment Server and/or Workflow mode 
(ASGN, WORK, or ALL)

ALL

Remove Remove Remove All Triggers Mode FALSE

TAMode TAMode All Territory or Contact Only mode ALL

TrigFile Trigger File Name Output trigger script file name trigger.sql
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3 At the prompt, enter the following information to start the Workflow Monitor Agent server 
component task; use the Group information gathered from Step 1 (Assignment Group used in 
this example):

start task for component workmon with GroupName=�Assignment Group�

4 Configure other component parameters, if needed.

For more information about other configurable parameters, see Table 49 on page 225.

NOTE: Separate the parameters and their values in the command-line statement with commas.

5 Alternatively, you can configure a Workflow Monitor Agent to start automatically to process 
assignment requests whenever the Siebel Server starts. 

For more information on Workflow Monitor Agent, see Siebel Business Process Designer 
Administration Guide.

This command starts a new task running in the background and returns to the Server Manager 
immediately.

NOTE: It is possible to set up multiple Workflow Monitor Agents for dynamic assignment. For more 
information on setting up multiple Workflow Monitor Agents, see the �Starting Workflow Agent 
Processes Automatically with Siebel Server� topic of Siebel Business Process Designer Administration 
Guide. 

Table 49 shows the Workflow Monitor Agent command-line interface parameters.

Table 49. WorkMon Command-Line Interface Parameters

Parameter Name Alias Description
Default 
Value

Action Interval ActionInterval Do not reexecute actions within specified 
interval in minutes

3600

Cache size of Policy 
violations

CheckLogCacheSz Number of policy violations to store in 
cache

100

Cache size of last user 
information

LastUsrCacheSz Number of last user information items to 
cache

100

Group Name GroupName Group Name

Ignore errors IgnoreError Ignore errors while processing requests False

Mail Server MailServer Name of email server to send notification 
of abnormal termination

Mailing Address MailTo Mail address to review notification of 
abnormal termination

Number of days to 
keep violation 
information

KeepLogDays Number of days worth of violation 
information that should be retained

30
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For detailed information on starting, stopping, and monitoring server tasks, see Siebel System 
Administration Guide. For further information about the Workflow Monitor Agent, see Siebel Business 
Process Designer Administration Guide.

About Tuning Dynamic Assignment for 
Performance 
If users experience slow response time while running Assignment Manager in dynamic mode, you 
can implement one or more of the following to improve dynamic assignment performance:

■ Increase the Requests (Requests per iteration) workflow monitor parameter (the default is set to 
5,000).

■ Decrease the SleepTime workflow monitor parameter (the default is 60 seconds).

■ Increase the ReloadPolicy workflow monitor parameter to a much larger number, for example, 
86,400 seconds (the default is 600 seconds).

■ Distribute each assignment policy into its individual group and then invoke several Workflow 
Monitor Agents concurrently (one on each Siebel Server, if available).

Number of seconds to 
retry

GenReqRetry Number of seconds to retry sending a 
Generic Request message

120

Processes the batch 
Policies

BatchMode Process the batch policies False

Reload Policy ReloadPolicy Reload Policy Interval in seconds 600

Request delete size DeleteSize Request delete size 500

Requests per iteration Requests Requests per iteration 5000

Sleep Time SleepTime Time to sleep between iterations (in 
seconds)�that is, the frequency of time 
the Workflow Monitor Agent polls the 
S_ESCL_REQ table (escalation request 
table) and assigns rows.

For example, if SleepTime is set to 60 
seconds, the Workflow Monitor Agent 
polls the S_ESCL_REQ table, then wait 
60 seconds before it polls it again.

60

Use Action Agent ActionAgent Use Action Agent False

Table 49. WorkMon Command-Line Interface Parameters

Parameter Name Alias Description
Default 
Value
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About Running Batch Assignment 
Use batch assignment to assign multiple records of an object in a single batch. Typically, you want 
to run batch jobs periodically when you anticipate the least amount of database activity (such as 
daily or weekly after-hours).

Batch assignment runs only in rule group mode. At the time of the assignment request, you specify 
one of the rule groups as the Assignment Key parameter for the AsgnBatch server component job 
along with the request. You identify the records for batch assignment using an SQL WHERE clause. 
This WHERE clause is usually based on columns in the base table of the assignment object. For 
example, an example of a WHERE clause is:

WHERE OWNER_EMP_ID = NULL

You can use this clause to identify all service requests that are not as yet assigned to a owner.

You can have a batch assignment task load only a particular group of rules into memory by specifying 
the row ID of the rule group in the Assignment Key parameter when you start the task. If no rule 
group is specified for this parameter, the batch task loads all rules in the Default Rule Group into 
memory. If no rule groups have been defined in the application, then all active rules in the database 
load.

Reason to Not to Run Batch Assignment with Dynamic Assignment
For performance reasons, do not run dynamic assignment when running batch assignment. If you 
run both batch assignment and dynamic assignment in your environment, the batch assignment can 
activate dynamic assignment due to triggers created in the database required to run dynamic 
assignment. Before running batch assignment, you should deactivate all assignment policies and 
drop related triggers to prevent dynamic assignment from processing modified rules, objects, and 
candidates. After completing batch assignment, you can reactivate the assignment policies and 
reenable batch assignment.

Related Topic
�Running Batch Assignment� on page 228
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Running Batch Assignment 
Batch assignment executes Assignment Manager in batch mode. In batch mode, Assignment 
Manager can take an Object WHERE Clause and other appropriate parameters that determine 
candidates for chosen objects

You typically use batch assignment for importing new records from a legacy system or when an 
assignment rule changes, such as when a sales representative no longer manages a specific ZIP 
CODE. 

When You Must Run Batch Assignment
You must run Assignment Manager in batch mode if you change nonobject data that can affect 
assignments. Such situations occur whenever you:

■ Modify assignment rules and want these changes to affect existing objects. You modify 
assignment rules when you:

■ Add or remove employees, positions, or organizations

■ Add, remove, or update assignment criteria or criteria values

■ Associate a rule with a different rule group or change the rule sequence number

■ Change scores

■ Change activation and expiration dates

■ Change exclusive mode

■ Modify the list of employees, positions, or organizations and you want these changes to affect 
existing objects.

■ Change the Assignment Manager configuration in Siebel Tools and you want your changes to 
affect existing objects. You change the Assignment Manager configuration when you:

■ Change Assignment Attribute definitions

■ Change Assignment Criteria definitions

■ Change Assignment Object definitions

■ Change Workflow Policy Object definitions

■ Use EIM (Enterprise Integration Manager) to perform initial loads (if you do not run Generate 
Triggers to create the appropriate triggers).

NOTE: When using EIM to load assignment rules, make sure the column ASGN_TYPE_CD 
includes a value. If it is left NULL, which is permissible in EIM, the rules are loaded but 
Assignment Manager fails. 
Siebel Assignment Manager Administration Guide Version 7.8228 



Running Assignment Manager ■  Running Batch Assignment
■ Feel that existing assignments may not be accurate. Assignment Manager does not change 
assignments if the existing assignments are correct.

NOTE: When batch mode is run on correct assignments, although there are no changes to the 
team or primary, an update of the record occurs. This situation can disturb other workflow 
policies relying on various record fields. For example, a workflow policy relying on PR_POSTN_ID 
field to trigger an action does not work properly if this field is updated from a new batch 
assignment. If your deployment uses SQL Server, this note does not apply. 

You can configure the Batch Assignment server component for your implementation by adjusting the 
appropriate parameters. Table 45 on page 199 lists the batch server component parameters used by 
Assignment Manager that you can change.

Use the following procedure to run batch assignment.

CAUTION: For performance reasons, do not run batch assignment while running dynamic 
assignment. This is because batch assignment can activate dynamic assignment with adverse effect 
due to triggers created in the database required to run dynamic assignment. For more information, 
see �About Running Batch Assignment� on page 227.

To run batch assignment 

1 Navigate to the Administration - Server Management screen > Jobs view.

2 In the Jobs list, click New.

A new record appears with a system-defined ID automatically populated with a status of 
Creating.

3 In the new record, enter the relevant information for the new job.

a In the Component/Job field, select Batch Assignment.

b In the Requested Server field, type the name of the server on which you want to run this batch 
request.

c (Optional) If you want to run a specific rule group for this batch, type the row ID of the 
assignment rule group for which you want rules processed for the AsgnKey parameter. 

d Complete the rest of the fields for the new record, if needed.

4 In the Job Parameters list, click New to create a new record, and enter relevant information for 
the assignment object that you want to assign as part of this batch request.

a In Name field, click the select button.

b In the Job Parameters dialog box, select Assignment Object Name, and then click OK.

c In the Value field, enter the name of the assignment object for the parameter.

Use the exact name found in Siebel Tools, such as Service Request or Order (Sales Credit 
Assignment). 

NOTE: Because batch assignment cannot run more than one assignment object per batch, you 
should run batch assignment on only one assignment object for each batch.

5 While still in the Job Parameters list, click New to create a new record so that Assignment 
Manager uses the Object WHERE clause to limit the number of rows processed at one time.
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a In Name field, click the select button.

b In the Job Parameters dialog box, query for ObjWhereClause, click Go, and then click OK.

c In the Value field, enter a WHERE clause to select the object instance that you want to process; 
the WHERE clause can include up to 100 characters.

For example, to select object instances beginning with ibm, type:

WHERE name like �ibm%� 

NOTE: If you leave the value field blank, all object instances are selected. However, it is 
strongly recommended that you limit the number of rows that Assignment Manager 
processes to make sure that sufficient rollback space is available.

For more information about using the Object WHERE clause, see �Setting the Log Level of 
Assignment Manager Events� on page 209.

6 (Optional) If you want to enable Contact Denormalization for batch assignment, add two more 
component job parameter records with values from the following table.

7 (Optional) If you want to save changes to the database during batch processing, add another 
component request parameter as follows:

a In Name field, click the select button.

b In the Job Parameters dialog box, query for Batch Size, and then click Go.

c In the Value field, enter the number of objects to assign before committing each batch.

8 In the Job Detail form, click the menu button and choose Start Job.

NOTE: You should monitor the performance of batch assignment and increase or decrease the 
number of running tasks to obtain optimal performance.

Related Topics
�About Running Batch Assignment� on page 227

�Running Batch Assignment Using the Command-Line Interface� on page 231

�About Running Multiple Instances of Assignment Manager in Batch Mode� on page 231

Parameter Name Value

Assignment Object Name Contact Denormalization

Assignment Mode Denorm
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Running Batch Assignment Using the Command-Line 
Interface
You can run batch assignment from the command-line interface using the AsgnBatch command and 
the designated parameters in Table 45 on page 199. The command-line interface of the Server 
Manager is the srvrmgr program. For more information on using the command-line interface, see 
Siebel System Administration Guide.

You can have a batch assignment task load only a particular group of rules into memory by specifying 
two job parameters in the request:

■ Use Key Value = <Rule Group>

■ Actual Assignment Key = <Rule Group Id>

For example, the following command tells Assignment Manager to only look at or modify candidates 
on the team whose rule group id is 1-34XD4 and runs only those rules that are a part of that rule 
group.

start task for comp asgnbatch with asgnobjname="Activity", usekeyvalue = "Rule 
Group", ActualAsgnKey = "1-34XD4"

Related Topics
�About Running Batch Assignment� on page 227

�Running Batch Assignment� on page 228

�About Running Multiple Instances of Assignment Manager in Batch Mode� on page 231

About Running Multiple Instances of Assignment 
Manager in Batch Mode
When there are many objects that need to be assigned, you can run multiple instances of Assignment 
Manager in batch mode to improve performance. First, develop a strategy for specifying multiple 
batches using the Object Where Clause parameter in the Batch Assignment component. Then, start 
multiple instances of batch assignment specifying the appropriate Object Where Clause for each 
instance.
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For example, you can run one instance of batch assignment for accounts that changed today and a 
different instance of batch assignment for accounts that changed yesterday. Use the Object Where 
Clause parameter to specify the following:

■ For the batch that processes accounts changed today: 

Object Where Clause: WHERE LAST_UPD = SYSDATE

■ For the batch that processes accounts changed yesterday:

Object Where Clause: WHERE LAST_UPD = SYSDATE - 1

NOTE: These examples us a nonindexed field�LAST_UPD. It is recommended, however, that you use 
indexed fields for object WHERE clause statements. Also, use the appropriate database datetime 
functions to determine the current date and time depending on the database you are using. This 
example uses SYSDATE, which is specific to Oracle database datetime functions. 

To process mutually exclusive sets of records when running multiple instances of Assignment 
Manager simultaneously for the same assignment object, you should specify an Object Where Clause 
for each assignment task. You can also distribute the tasks on multiple Siebel Servers to enhance 
performance. 

When Not to Run Multiple, Simultaneous Batch Jobs
There are several instances where you should not run multiple, simultaneous batch jobs:

■ If multiple Assignment batches are executed for the same object, then the results can potentially 
vary and may not be as desired

■ If the batch jobs update rows on the same table or tables

■ If one batch job updates records in a table or tables used by another batch job as input

■ If the batch jobs use workload criteria to assign the same object

NOTE: If multiple assignment batches are executed for the same object using workload criteria, 
the results can potentially vary and may not be as desired.

Examples of when you should not run multiple simultaneous batch jobs include:

■ Contact and Contact Denormalization because the same tables are updated

■ Account and Contact Denormalization because Contact Denormalization uses Account team as 
input

■ Opportunity and Contact Denormalization because Contact Denormalization uses Opportunity 
team as input

Related Topics
�About Running Batch Assignment� on page 227

�Running Batch Assignment� on page 228

�Running Batch Assignment Using the Command-Line Interface� on page 231
Siebel Assignment Manager Administration Guide Version 7.8232 



Running Assignment Manager ■  About Tuning Batch Assignment for Performance
About Tuning Batch Assignment for 
Performance
If users experience slow response time while running Assignment Manager in batch mode, review 
the settings on virus software installed on the applicable server. Implement one or more of the 
following settings to improve batch assignment performance:

■ Virus scan only program files.

■ Exclude all outbound files from virus scanning.

■ Exclude the RDBMS directory where all msb files are located from virus scanning.

Make sure to run a full virus scan on all files during the weekend or off-peak time if the preceding 
settings were used.

You can also implement one or more of the following to boost batch performance in batch mode:

■ Increase the BatchSize parameter, for example, set the batch size to 500 (the default is set to 
100).

This increases the number of records that are processed within a transaction before a commit 
occurs, resulting in less resources used and faster assignment.

NOTE: Only set large batch sizes when there are no or very few users on the system.

■ Create multiple instances of batch assignment (using WHERE clause statements). See �About 
Running Multiple Instances of Assignment Manager in Batch Mode� on page 231.

■ Select a good filter.

Carefully choosing a filter reduces the time it takes to retrieve Object records.

NOTE: Use indexed field or fields for comparison in the object WHERE clause, such as Name for 
Account and Opportunity, or Last Name for Contacts.
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■ Use better logic.

For example, if you want to run Account Assignment based on account name, you can create 
multiple batches so that the first batch starts with names beginning with the letter C through K, 
the second batch starts with the letter L through R, and so on. 

Consider the following logic:

Object Where Clause: WHERE NAME > �B� AND NAME < �L�

Although this causes the database to retrieve account records with names starting with the letter 
C through K, the WHERE clause is specified in such a manner that if accounts starting with the 
letter M through Z are encountered, they are passed on the first round because the values are 
> B. They are then eliminated in the second round (< �L�) by the database. These records are not 
needed in the batch because there is a cap of account names less than L.

It is better logic to use:

Object Where Clause: WHERE NAME < �L� AND NAME >�B�

By switching the order of the conditions, the extra parsing required by the database in the second 
round is eliminated because most of the names start with a letter greater than B.

Running Mobile Assignment 
Use Mobile Assignment to reassign people based on changes uploaded by mobile clients. Assignment 
Manager assigns objects after a mobile client synchronizes with the Siebel Server and uploads 
assignment requests or any changes to objects and assignment rules. Depending on the 
configuration of Generate Triggers, the Workflow Monitor detects these changes and activates 
Assignment Manager to dynamically reassign affected objects.

NOTE: If a disconnected client sends an assignment request to the Siebel Server while running 
Mobile Assignment, the request is sent as an asynchronous request. Because of this, the request 
does not override the Keep Manual Assign property.

To run mobile assignment

1 Be sure that you have run the Generate Triggers server component. 

For instructions, see �Generating Triggers for Dynamic Assignment Using the UI� on page 222. 

2 Start the Workflow Monitor Agent. 

For instructions, see �Starting Workflow Monitor Agent for Dynamic Assignment Using the 
Command-Line Interface� on page 224.

NOTE: If running interactive assignment, make sure the Server Request Broker server component 
is running. For instructions on checking the status of a server component, see Siebel System 
Administration Guide.
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About Running Assignment Manager in 
Reporting Mode 
Reporting mode provides the assignment administrator the ability to perform trial assignments and 
what-if analysis. When running Assignment Manager in reporting mode, assignments are written into 
results tables, known as reporting tables, rather than into the actual database tables. This allows the 
administrator the opportunity to preview possible assignment before actual assignments are made.

You can run Assignment Manager in reporting mode either from the UI or using the Siebel Server 
Manager command-line interface, known as the srvrmgr program. In either mode, you initiate a 
reporting mode request using either the Assignment Server (AsgnSrvr) or the Batch Assignment 
(BatchAsgn) server component. You pass the Reporting Mode (RptMode) parameter, specifying one 
of the following values: 

■ Snapshot. Reporting is turned on. Assignment Manager performs assignment validations and 
writes resulting candidates to the reporting team tables.

■ Delta. Reporting is turned on. Assignment Manager performs assignments, compares existing 
assignment team table and writes the results to the reporting team tables. 

For example, the following command tells Assignment Manager to read from and write to only the 
reporting tables where the reporting team tables store a snapshot of the results:

start task for comp asgnsrvr with asgnobjname="Opportunity", objwhereclause="where 
name='James Opty'",rptmode = "Snapshot"

NOTE: By default, reporting is turned off. That is, when the Regular Assignment server component 
parameter is set to False, no assignment takes place. However, irrespective of whether reporting is 
turned on or off, Assignment Manager can write evaluation results to actual assignment tables.

Using Siebel Tools, you specify key columns through properties on the assignment object. 
Assignment Manager reads these key columns to differentiate between candidates. Assignment 
Manager stamps these key values; that is, Assignment Manager sets the key value for each record, 
to keep track of what employees, positions, or organizations are added in a specific assignment 
execution.

Then, when submitting an assignment request, you can pass one of the following values for 
stamping:

■ Person Key Value (PersonKeyVal) for employees and positions

■ Organization Key Value (OrgKeyVal) for organizations

For example, the following command tells Assignment Manager to execute in reporting delta mode 
where it merges the team from this run to the current team in the regular tables, and then writes 
the results to the reporting table. However, it only executes the rule against the Account 1 account, 
updates or changes positions who have the key value 12-RG2, and stamps all new positions with the 
value 12-RG2.

start task for comp asgnsrvr with asgnobjname=�Account�, objwhereclause=�where NAME like 

�Account 1��,UseKeyVal=�Key Value�, PersonKeyVal=�12-RG2�, RptMode=�Delta
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The Key Column in the S_ACCNT_POSTN results table holds either the rule group ID or a key value 
to distinguish candidates. You use the UseKeyValue parameter to indicate whether Assignment 
Manager uses the key value to filter and stamp candidates and what the key value should be. The 
choices are:

■ Rule Group. Assignment Manager automatically using the rule group from which a particular 
candidate passes and stamps that rule group ID on the key column you defined.

■ Key Value. User supplies either a Person Key Value (for employees and positions), or an 
Organization Key Value (for organizations) along with the request, then Assignment Manager 
stamps that value.

For example, assume you run AsgnSrvr with rule group 1 (RG1), and the result is that Position 1 is 
added to Account1. Next, you run rule group 2 (RG2) and Position 2 is added to Account1. If you do 
not want a second AsgnSrvr run to touch or change anything from the first run, you run AsgnSrvr 
with the UseKeyValue server component parameter set to either Rule Group or Key Value.

■ If UseKeyValue = Rule Group, Assignment Manager saves the rule group ID in the Key Column 
property in the Assignment Object Extension object. In addition, Assignment Manager does not 
delete any positions who's key column value does not match the rule group ID. 

■ If UseKeyValue = Key Value, you need to also pass along another parameter as well�either 
PersonKeyVal or OrgKeyVal. 

In this case, because you are working with account positions, Assignment Manager passes the 
PersonKeyVal parameter. 

When you run AsgnSrvr again, you might run the following command:

start task for comp asgnsrvr with asgnobjname=�Account�, objwhereclause=�where NAME like 
� Account 1��,UseKeyVal=�Key Value�, PersonKeyVal=�12-RG2�, RptMode=�Delta� 

Later on, if you make changes to RG2 and want to run another assignment request, you can use the 
same command. Only the positions on the account team with a key value of 12-RG2 change.

For more information on using the command-line interface, see Siebel System Administration Guide.

Related Topic
�Configuring Assignment Manager to Use Reporting Tables and Columns� on page 265
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About Assignment Manager Rule Cache 
Files 
The rule cache file contains the most recent copy of assignment rule, criteria, candidates, skills, and 
skill items information before the last time assignment rules were released. A cache file is recreated 
every time assignment rules are released or when skills have expired.

Depending on the mode in which you run Assignment Manager, the following cache files are used:

■ rulecache.dat

This file contains information about all active rules in the database. When running Assignment 
Manager in default mode, this file is used by each of the three assignment operation modes�
interactive, batch, and dynamic assignment.

■ rulecache_SERVERNAME.dat 

This file (where SERVERNAME is the name of the Siebel Server) contains information about the 
rules in the rule groups assigned to a particular Siebel Server and is used when server key 
mappings are defined.

■ batchrulecache_RULEGROUPID.dat

When batch assignment runs in rule group mode, you can specify whether it uses the default 
mode cache file (rulecache.dat) or a separate cache file by way of the Independent Rule Group 
Cache server parameter. 

■ If you set this parameter value to FALSE, it uses the default mode cache file (see 
rulecache.dat previously described in this topic). 

■ If you set this parameter to TRUE, it creates a separate cache file, 
batchrulecache_RULEGROUPID.dat (where RULEGROUPID is the Assignment Key parameter 
you passed along with the request). 

There can be multiple cache files of this type because you can use batch assignment in rule group 
mode for different rule groups. This rule group cache file is a smaller file, therefore providing 
better performance than the default mode cache file. The performance is better because the 
batchrulecache_RULEGROUPID.dat file only has information about some rules for some rule 
groups while the rulecache.dat file has information about all active rules for all rule groups. 

NOTE: The default value of the Independent Rule Group Cache parameter is set to TRUE because 
this setting gives better performance. Thus, if batch assignment is running in default mode (that is, 
the Assignment Key parameter is not supplied), then the value of this parameter is excluded.
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About Using External Components to 
Invoke Assignment Manager 
You can make assignments by invoking Assignment Manager from within a Siebel workflow process, 
business service, or Siebel script interface. 

Assignment Manager provides the ability of sharing inputs and outputs (supports rerouting of 
objects) with an external component. Assignment Manager can return qualified or assigned 
candidates along with their scores in the form of a hierarchical property set. A property set is a set 
of name-value pairs that are used by various Siebel components to pass information back and forth 
between them. 

This feature is particularly useful in a workflow process. For example, a business service step in a 
workflow process might call on Assignment Manager (with the assignment mode set to Match) to 
evaluate potential candidates and return the set of qualified candidates in a property set along with 
their scores. Then, the workflow process can�based on other business logic�decide the set of 
candidates that are assigned. 

NOTE: Before version 7.7, Assignment Manager could only write qualified or assigned candidates to 
the database.

Assignment Manager integration behavior is controlled by the ReturnPropSet server parameter 
(ReturnPropSet). Table 50 lists the conditions for which Assignment Manager returns a property set 
or writes the results to the database.

Table 50. ReturnPropSet Server Parameter Behavior

AsgnMode Writes to Database Returns Property Set

Synchronous:

Match

If ReturnPropSet is FALSE, writes to database No property set returned

If ReturnPropSet is TRUE, does not write to 
database

Qualified candidates 
returned

Assign Writes to database No property set returned

MatchAssign Writes to database If ReturnPropSet is TRUE

Asynchronous Writes to database No property set returned
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DB2 Deployment
Figure 31 illustrates the structure of the output property set that Assignment Manager returns from 
a synchronous request, given the input parameter AsgnMode = Match or MatchAssign.

About Tuning Assignment Manager for 
Performance in a DB2 Deployment
If you are using DB2, for performance reasons, you should periodically execute the REORG and 
update statistics utilities against all applicable tables for the assignment objects that you use. For 
example, to enhance Assignment Manager performance before running batch or dynamic assignment 
for contact territory realignment (assuming you are using the preconfigured Contact assignment 
object), you should execute REORG and update statistics against the related tables, such as the 
S_CON_TERR and S_POSTN_CON tables. 

For the Account assignment object, consider evaluating the S_ORG_TERR and S_ACCNT_POST 
tables; and for the Opportunity assignment object, consider evaluating the S_OPTY_TERR and 
S_OPTY_POSTN tables; and so on. For applicable tables for other assignment objects�planned or in 
use�view the assignment object properties for those objects using Siebel Tools. 

For more information about the REORG and update statistics utilities, see Implementing Siebel 
Business Applications on DB2 UDB for z/OS and the Siebel Installation Guide for the operating system 
you are using.

Figure 31. Example of Output Property Set Structure Returned from a Synchronous Request
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10 Advanced Assignment Manager 
Configuration
This chapter discusses advanced configuration techniques for Siebel Assignment Manager. 

NOTE: Do not attempt to perform procedures in this chapter until you are well versed in basic 
assignment manager configuration and assignment rule creation. This chapter is intended for users 
already familiar with Assignment Manager basic features and who require further information on 
refining their Assignment Manager deployment.

This chapter includes the following topics:

■ �About Performing Advanced Assignment Manager Configuration Tasks� on page 242

■ �Creating Assignment Objects� on page 243

■ �Creating New Skills� on page 244

■ �Example of Using Skill Tables� on page 244

■ �Assigning Objects Based on the Primary Address� on page 245

■ �Assigning Child Accounts Based on Parent�s Primary Address� on page 246

■ �Reassigning Accounts to a Different Primary Position� on page 248

■ �Routing of Assignments to Mobile Users� on page 250

■ �Maintaining the Manually Assigned Primary Position� on page 251

■ �Stopping Assignment of the Default Organization� on page 252

■ �Stopping Assignment of Organizations for Accounts� on page 253

■ �Setting the Lock Assignment Default Value for Activity Assignment Objects� on page 254

■ �Configuring Assignment Objects to Copy Additional Columns to the Team Table� on page 255

■ �Process of Configuring Assignment Objects for Team Scoring� on page 257

■ �Extending an Object�s Base Table for Team Scoring� on page 258

■ �Configuring Assignment Objects for Team Scoring� on page 258

■ �Example of Configuring the Opportunity Assignment Object for Team Scoring� on page 259

■ �Configuring Assignment Manager to Use Reporting Tables and Columns� on page 265

■ �Configuring Assignment Objects for Multitiered Assignment� on page 268

■ �Scenarios for Using Multitiered Assignment with Sales Assignment Rules� on page 270

■ �Configuring Assignment Manager to Add Scores Across Rules� on page 273
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About Performing Advanced Assignment 
Manager Configuration Tasks
Assignment Manager allows the creation of very advanced assignment configurations. The following 
lists the various configuration tasks you may need to know or perform before creating your 
assignment rules. The list is presented in no particular order, and some may not be applicable for 
your needs.

■ �Creating Assignment Objects� on page 243

■ �Creating New Skills� on page 244

■ �Example of Using Skill Tables� on page 244

■ �Assigning Objects Based on the Primary Address� on page 245

■ �Assigning Child Accounts Based on Parent�s Primary Address� on page 246

■ �Reassigning Accounts to a Different Primary Position� on page 248

■ �Routing of Assignments to Mobile Users� on page 250

■ �Maintaining the Manually Assigned Primary Position� on page 251

■ �Stopping Assignment of the Default Organization� on page 252

■ �Stopping Assignment of Organizations for Accounts� on page 253

■ �Setting the Lock Assignment Default Value for Activity Assignment Objects� on page 254

■ �Configuring Assignment Objects to Copy Additional Columns to the Team Table� on page 255

■ �Process of Configuring Assignment Objects for Team Scoring� on page 257

■ �Extending an Object�s Base Table for Team Scoring� on page 258

■ �Configuring Assignment Objects for Team Scoring� on page 258

■ �About Configuring Assignment Manager to Copy Columns� on page 261

■ �Configuring Assignment Objects to Copy Columns� on page 262

■ �Configuring Assignment Manager to Use Reporting Tables and Columns� on page 265

■ �Configuring Assignment Objects for Multitiered Assignment� on page 268

Requirements for Completing Advanced Assignment Manager Configuration
Before beginning any advanced configuration procedures, you should have background knowledge in 
the Siebel software architecture, Siebel Tools, and Siebel Workflow Manager. Consult the following 
documentation for this information: 

■ Going Live with Siebel Business Applications

■ Using Siebel Tools

■ Configuring Siebel Business Applications

■ Siebel Business Process Designer Administration Guide
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Creating Assignment Objects
Using Siebel Tools, you can create new assignment objects by adding an assignment object to a 
workflow policy object. However, adding assignment objects can require the addition of skills or other 
tables and columns. Because of the complexity of this requirement, it is recommended that you 
contact Technical Support if you need to create new assignment objects.

CAUTION: It is recommended that you contact Siebel Technical Support for assignment object 
creation. If you create your own assignment objects, you run the risk of Assignment Manager 
assigning incorrect assignments.

To create an assignment object

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and select Assignment Object.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can enable it by selecting 
View > Options > Object Explorer in the Development Tools Options dialog box.

3 In the Workflow Policy Objects window, select the workflow policy object type for which you want 
to add the new assignment object.

4 Select the Assignment Objects window and choose Edit > New Record.

5 Configure the assignment object by setting values in the appropriate fields for each property. 

For a list of assignment object properties and their default values, see Object Types Reference.

6 If you are running dynamic assignment, activate an assignment policy for the assignment object.

For more information on dynamic assignment, see �Process of Defining Assignment Policies for 
Dynamic Assignment� on page 144.

7 Update your deployment with the new configurations. 

For instructions, see �Updating Your Assignment Manager Deployment with New Configurations� on 
page 80.
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Creating New Skills
Skills are assignment criteria values attributed to specific assignment rules, objects, employees, 
positions, and organizations. Assignment Manager uses skills to match assignment rules, objects, 
employees, positions, and organizations.

The Siebel application provides several predefined skills, however, you can create new skills using 
Siebel Tools. This section explains how to view the predefined skills and create new skills.

For most deployments, the predefined skills are sufficient. However, you can create new skills using 
Siebel Tools. The following procedure explains how to create a new skill that can be used in any Siebel 
application. 

To create a new skill

1 Create an assignment attribute.

2 Create an assignment criterion. 

You must check the Employee Skill field because you are configuring the criterion as a skill.

3 Add the assignment attribute created in Step 1 as a child object to the assignment criterion 
created in Step 2.

For more information on creating assignment attributes, assignment criteria, and assignment criteria 
attributes, see �Process of Creating Assignment Criteria for Use in Assignment Rules� on page 56. 

NOTE: To perform assignments based on skills, further configuration is required using Siebel Tools. 
For more information about configuring criteria as skills, see �Process of Defining Criteria Values as 
Skills with Expertise Codes and Weighting Factors� on page 114.

Example of Using Skill Tables
The skill and skill item tables are child and grandchild tables, respectively, of the object used to store 
skills, and skill items for assignment objects that are not stored as columns in the parent table itself. 
The employee skill table is used to store skills possessed by employees, such as languages spoken, 
product expertise, and so on. For example, for an employee who speaks English and Spanish, there 
is one record in the employee skill table that specifies the skill name as Language. There are also 
two records in the child employee skill item table that correspond to this skill record: one record for 
English, and another record for Spanish. For more information on how to assign skills to candidate 
objects, see �Scenarios for Using Assignment Manager� on page 41.
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For example, the following procedure explains how to configure Assignment Manager so that only 
employees who speak Spanish are assigned a service request.

To configure Assignment Manager to assign a service request only to employees 
who speak Spanish

1 Create a service request with Language as the skill and Spanish as the skill item. 

a In the Service Request skill table for the service request, create one record and specify Language 
as the skill. 

b In the child Service Request skill item table, create one record and specify Spanish as the skill 
item.

For more information about how to perform this step, see �Process of Defining Criteria Values as 
Skills with Expertise Codes and Weighting Factors� on page 114.

2 Create an assignment rule that filters employees based on their language skills.

a Create an assignment rule and apply the Service Request assignment object.

b Create a criterion called Language and use the Compare to Person assignment rule comparison 
method.

This criterion, and therefore the rule, passes only employees who have the Spanish language 
skill.

NOTE: You can also perform skill matching with other comparison methods. For more information 
about the comparison methods, see �Assignment Criteria Comparison Methods� on page 98.

Assignment Manager can also perform skill matching with expertise codes and can use weighting 
factors to assign weighted scores to different expertise codes. For more information on these topics, 
see �About Assignment Skills, Expertise Codes, and Weighting Factors� on page 112.

Assigning Objects Based on the Primary 
Address
An assignment rule with address criteria, by default, passes objects (Account, Contact, and 
Opportunities, for example) based on any one of the multiple addresses associated with the objects. 
However, Assignment Manager is configurable to assign based on only the primary address. This 
configuration is completed through Siebel Tools in the following procedure. The Account assignment 
object is used in this example.

NOTE: For Siebel Life Sciences, Assignment Manager can populate the Primary Address field for the 
system-assigned positions for the contacts on the intersection table (S_POSTN_CON).

To assign objects based on the primary address

1 Start Siebel Tools.

2 Select the assignment object.

a In the Object Explorer, expand Workflow Policy Object.
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b In the Workflow Policy Objects list, select Account.

3 Select the workflow policy component to change the Source Column and Target Column fields.

a In the Object Explorer, select Workflow Policy Component.

b In the Workflow Policy Component window, select Account Address.

c Change Source Column Name to ROW_ID (from OU_ID).

d Change Target Column Name to PR_ADDR_ID (from ROW_ID).

4 Repeat Step 2 and Step 3 for the Contact and Opportunity assignment objects.

5 Check in the projects to the server.

For more information about checking in projects, see Using Siebel Tools.

6 If using dynamic assignment or workflow policies, drop and regenerate triggers by running the 
Generate Triggers server component.

See �Generating Triggers for Dynamic Assignment Using the UI� on page 222 or �Generating Triggers 
for Dynamic Assignment Using the Command-Line Interface� on page 224 for more information on 
stopping and restarting this server component. Alternatively, see Siebel System Administration 
Guide.

Assigning Child Accounts Based on 
Parent�s Primary Address
A common business requirement involves the configuration of Assignment Manager to assign child 
accounts based on the primary account�s address. This configuration is completed through Siebel 
Tools using the following procedure.

To assign child account objects based on the parent�s primary address

1 In the Object Explorer, select the Workflow Policy object, and click the Account record.

2 Expand the Workflow Policy object in the Object Explorer, and select the Workflow Policy 
Components object.

3 Create two new workflow policy components, Parent Account and Parent Account Address, with 
the following properties:

4 While the new Parent Account Address record is selected, expand the Workflow Policy Component 
object, and click the Workflow Policy Component Column object. 

Name: Parent Account Parent Account Address

Source Table Name: S_ORG_EXT S_ADDR_ORG

Source Column Name: ROW_ID ROW_ID

Target Component Name: Account Parent Account

Target Column Name: PAR_OU_ID PR_ADDR_ID
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5 Create a new record with the following properties:

6 In the Object Explorer, select the Assignment Attributes object, and create a new record with the 
following properties:

7 While the new assignment attribute Parent Account State is selected, expand the Assignment 
Attributes object, and click the Assignment Attributes Column object. 

8 Create a new record with the following properties:

9 In the Object Explorer, select the Assignment Criteria object and create a new record with the 
following properties:

10 While the new assignment criteria Parent Account State is selected, expand the Assignment 
Criteria object and click the Assignment Criteria Attribute object; create a new record with the 
following properties:

After the configurations are complete, the project must be checked into the server, and various 
server administration procedures must be run. To update your deployment with these new 
configurations, see �Updating Your Assignment Manager Deployment with New Configurations� on 
page 80.

For more information on compiling projects, see Using Siebel Tools. For information on distributing 
the siebel.srf file, see Siebel Anywhere Administration Guide.

Alias Parent Account State

Data Type: Varchar

Pick List: PickList State

Pick Field: Value

Assignment Object Account

Workflow Object: Account

Workflow Component: Parent Account Address

Workflow Component Column: Parent Account State

Sequence: 1

Display Name Parent Account State

Use Expertise FALSE

Assignment 
Attribute:

Parent Account State

Store Column: 1

Display Sequence: 1

Display Name: Parent Account State
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An assignment rule can now be created that assigns child accounts based on the parent�s primary 
address.

NOTE: Make sure the child account has a value in the PAR_OU_ID column pointing to a parent 
account that has the primary address.

Reassigning Accounts to a Different 
Primary Position
To reassign Account assignment objects to another position, use the following procedure. This 
procedure provides an example of mapping the PR_POSTN_ID column of the Account�s base table 
(S_ORG_EXT) to a new assignment attribute named Account Primary Position. Configuration in 
Siebel Tools is required for this process.

NOTE: The following procedure can be employed anytime you want to use a base table column as 
an assignment attribute.

To reassign accounts to a different position

1 Start Siebel Tools.

2 In the Object Explorer, select the Workflow Column object and create a new record with the 
following properties:

■ Name: Account Primary Position Id

■ Table: S_ORG_EXT

■ Column: PR_POSTN_ID

3 Select Workflow Policy Object > Account > Workflow Policy Component > Account record; drill 
down to the Workflow Policy Component Column and add a new record called Account Primary 
Position Id.

4 In the Object Explorer, select Assignment Attribute and create a new record called Account 
Primary Position; drill down to Assignment Attribute Column and add a new record with the 
following properties:

■ Name: Account: Account Primary Position Id

■ Assignment Object: Account

■ Workflow Policy Object: Account

■ Workflow Component: Account

■ Workflow Policy Component Column: Account Primary Position Id

■ Sequence: 1
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5 In the Object Explorer, select Assignment Criteria and create a new record called Account Primary 
Position; drill down to the Assignment Criteria Attribute and create a new record called Account 
Primary Position Id with the following properties:

■ Name: Account Primary Position Id

■ Assignment Attribute: Account Primary Position Id

■ Store Column: 1

■ Display Sequence: 1

■ Display Name: Id

6 Check in the project to the server, compile changes to the siebel.srf file, and distribute it to your 
users.

a Choose Tools > Compile.

b In the Object Compiler dialog box, select the Assignment project.

c Select the Siebel client repository file (default is siebel.srf file) located in the Objects 
subdirectory within the Siebel client root directory.

d Click Compile.

7 In the updated Client, create a new assignment rule based on the assignment object Account; 
add a new criterion for this rule, and select the Account Primary Position; under the values 
applet, select the ROW_ID of the position you want to reassign.

8 Navigate to the Positions view of this new Assignment Rule; select the new position that is to 
replace the previous position.

9 Release assignment rules by clicking Release in the Assignment Rules view.

10 Run a Batch Assignment against a test account that includes the old position; use the following 
parameters:

■ Object: Account

■ Object WHERE clause: WHERE ROW_ID=�<your_value>� 

11 Confirm that the test account is reassigned and then run a Batch Assignment to reassign the 
other accounts to the new position; use the following parameters:

■ Object: Account

■ Object WHERE clause: WHERE PR_POSTN_ID=�<your_value>�

Thoroughly test this assignment rule before applying it to your production environment. After 
your Accounts have been reassigned, it is recommended that you expire this rule.

12 Depending on your situation, run Contact Denormalization to update the contact access list.

For information about running Assignment Manager in denormalization mode, see �About Running 
Assignment Manager in Denormalization Mode� on page 214.

13 To set up Position in the Values applet as a picklist, select the appropriate picklist and applet 
when configuring the Workflow Column and Assignment Criteria Attribute for the Account Position 
Id. 
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Routing of Assignments to Mobile Users
The component parameter LogTxnChgOnly controls whether transactions with no change to 
Assignment primary or team members are routed to mobile or remote users. This parameter has a 
default setting of TRUE for Batch Assignment, Interactive Assignment (Assignment Manager), and 
implicitly Dynamic Assignment (Workflow Monitor Agent). As a result, transactions with no change 
to Assignment primary or teams are not routed to mobile users. To change the LogTxnChgOnly 
parameter for dynamic assignment, use the following steps. This procedure requires configuration in 
Siebel Tools.

To route assignments to mobiles users by changing the LogTxnChgOnly parameter

1 Stop the Workflow Monitor Agent processing the assignment policies.

2 Start Siebel Tools (see Configuring Siebel Business Applications for more information on proper 
Siebel Tools configuration procedures).

3 In the Object Explorer, select the Workflow Policy Program, and then select Assignment Request 
(In Process).

4 Drill down to Workflow Policy Program Arguments in the Object Explorer, and select the 
LogTxnChgOnly parameter.

5 Change the value to TRUE or FALSE.

If TRUE, transactions with no change to the assignment primary or teams are not routed to 
mobile users.

6 Check in the project to the server.

7 Restart the Workflow Monitor Agent. 

NOTE: You do not need to recompile the .srf file.
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Maintaining the Manually Assigned 
Primary Position
Assignment Manager maintains an object's manually assigned primary position when the Keep 
Manual Primary Position property in Siebel Tools for the object is set to TRUE. Assignment Manager 
identifies the manually assigned primary position when the PR_REP_MANL_FLG field = Y on the 
object. By default, the PR_REP_MANL_FLG value is set to N, which indicates the candidate is not a 
manually added primary.

When the primary is updated in the UI, the PR_REP_MANL_FLG flag is updated to Y. For this position 
to be recognized as the manually assigned primary by Assignment Manager, the Primary Assignment 
Manual flag, that is, PR_REP_MAN_FLG should be manually set in order to make that position the 
manually assigned primary.

To maintain the object�s primary position

1 Start your Siebel application. 

2 Navigate to the Administration - Data screen.

TIP: If this screen is not visible, check your responsibility.

3 Navigate to the Opportunity (or other assignment object) screen.

4 Query for and select the item of interest.

5 Click the Sales Team select button to launch the Team Members dialog box.

6 Click the Primary check box of another position in the list; then reselect the Primary check box 
of the original position and click OK.

This process changes the system PR_REP_MANL_FLG value to Y and updates PR_REP_SYS_FLG 
to N. 

This procedure can also be used to add positions to the object or delete system-assigned positions 
from the object. 
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Stopping Assignment of the Default 
Organization
If you want to override the assignment of all organizations to an assignment object, you must 
remove the assignment property Org Primary Column from a selected assignment object. The default 
value is set to BU_ID. After this value is set to null, Assignment Manager does not assign any 
organization to the assignment object. The following procedure details this configuration. The 
account assignment object is used as an example.

To stop assignment of the default organization to Account object

1 Start Siebel Tools, and select the appropriate project.

2 In the Object Explorer, expand Workflow Policy Object.

3 Select Assignment Object.

4 Select the Account Record.

5 In the Properties Window, find the property called Org Primary Column.

6 Delete the value for this property. (The default value is BU_ID.)

After the assignment object is modified, various server administration procedures must be run to 
make sure your configurations are recognized by Assignment Manager.

■ If you are using Batch Assignment, start a new task.

■ If you are using Dynamic Assignment, stop and restart the Workflow Monitor Agent. 

■ If you are using Interactive Assignment, stop and restart the Assignment Manager Server 
Component.

NOTE: It is not necessary to recompile the .srf file when configuring an assignment object to stop 
assignment of the default organization. 
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Stopping Assignment of Organizations 
for Accounts
If you do not want Assignment Manager to reassign the organizations that you have setup for an 
account, you must change the default values for the Account assignment object properties in Siebel 
Tools. 

To stop reassignment of organizations for accounts

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object.

3 In the Workflow Policy Object list, select Account.

4 In the Object Explorer, click Assignment Object.

5 In the Assignment Objects list, set the following values:

■ Default Organization = <blank> 

■ Org Primary Column = <blank>

■ Org Table = <blank>

■ Set Primary Org = FALSE

NOTE: Where <blank> is a null value.

After these values are set, Assignment Manager does not reassign any organizations for 
accounts.

6 Run various server administration tasks.

For instructions, see Step 2 and Step 3 of the procedure in �Updating Your Assignment Manager 
Deployment with New Configurations� on page 80.

NOTE: It is not necessary to recompile the .srf file. However, you should check-in the changes 
to the server database.
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Setting the Lock Assignment Default 
Value for Activity Assignment Objects
Assignment objects contain a lock assignment feature that, when activated by checking the Lock 
Assignment column on the object's list applet in Siebel Tools, prevents Assignment Manager from 
assigning or reassigning a position or candidate to that object. You can use this feature to exclude 
an object (such as Account or Opportunity object) from being reassigned by Assignment Manager. 
By setting the column defined in the Exclude Column for the assignment object, Assignment Manager 
excludes (ignores) the object for assignment.

The Lock Assignment parameter for activity objects is, by default, set to TRUE. This setting does not 
allow Assignment Manager to assign these objects. Therefore, Assignment Manager does not assign 
activity records. However, the Field Service Activity object is the one exception and is, by default, 
available for assignment (the Lock Assignment parameter is set to FALSE). Other activity objects 
must have the Lock Assignment parameter set to FALSE or null for assignment to occur. (The lock 
assignment feature for activity records in the Siebel application, except for Field Service activity 
records, defaults to �Y�.) This behavior is due to a setting in the Post Default Value property for the 
Action business component's Assignment Excluded field (Business Component > Field > Assignment 
Excluded). The value in the property is:

Expr: "If ([Class] = LookupValue(""FS_ACTIVITY_CLASS"", ""Field Engineer Activity"") OR 
[Class] = LookupValue (""FS_ACTIVITY_CLASS"", ""Repair Activity"") OR [Class] = 
LookupValue(""FS_ACTIVITY_CLASS"", ""Preventive Maintenance""), ""N"", ""Y"")"

Using Siebel Tools, you can implement assignment of all types of activities by setting the default 
value of the Assignment Excluded field to FALSE at the business component level.

The following procedure explains how to set the Lock Assignment default value so that Assignment 
Manager assigns activity objects. A similar procedure can be used for other assignment objects.

To set the lock assignment default value to assign activity objects

1 Start Siebel Tools.

2 In the Object Explorer, expand the Business Component object.

3 In the Business Components list, select Action.

4 In the Object Explorer, click Field. 

5 In the Fields list, select Assignment Excluded, and change the Post Default Value field to N.

6 Check-in the changes to the server.

For more information about checking in changes, see Using Siebel Tools.

7 Recompile the .srf file.

For more information about recompiling the .srf file, see �Updating Your Assignment Manager 
Deployment with New Configurations� on page 80.
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8 Make sure that all Siebel clients that create activity records have the new .srf file by copying the 
newly compiled .srf file to the:

❏ Siebel client's object\<language> directory for the Siebel Developer Web Client, where 
<language> is the appropriate language code, such as ENU for American English

❏ Siebel Server�s objects\<language> directory for mobile clients, where <language> is 
the appropriate language code, such as ENU for American English.

NOTE: This step applies only to the mobile client or the Developer Web Client.

Assignment Manager now assigns activity records based on the defined assignment rules.

Configuring Assignment Objects to Copy 
Additional Columns to the Team Table
When an item, such as an account or opportunity, is assigned to a team of people, the team field 
(the actual name of the field varies depending on the view) for that record shows a list of the people 
assigned to that item. This list of names is known as the team table for the given record. When 
making assignments, Assignment Manager passes information about the team members to the team 
table, such as the name of the person, that person�s position and user ID, and so on. This section 
explains how to configure assignment objects to add additional information about team members to 
the team table.

Using Siebel Tools, you configure assignment objects to copy additional columns to the team table. 
Use the PositionTeamDenormN user property (where N is any number) to copy additional columns 
from the S_ASGN_GRP_POSTN assignment rule position candidate table to the team table.

To configure an assignment object to copy additional columns to the team table

1 Start Siebel Tools.

2 Select the assignment object for which you want to copy additional columns to the team table.

a In the Object Explorer, expand Workflow Policy Object.

b In the Workflow Policy Object window, select the object.

c In the Object Explorer, expand Assignment Object, and then select Assignment User Prop.

3 In the Assignment User Properties window, choose Edit > New Record to define user properties 
for the assignment object.

a In the Name field, type a name for the property starting with PositionTeamDenorm followed by 
a digit (for example, PositionTeamDenorm1, PositionTeamDenorm2). 

b In the Value field, use the following syntax to enter values:

SrcCol,DestCol,UserKeyBool,DefaultValue
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Table 51 provides descriptions for each field these values.

At runtime, Assignment Manager copies the user property values to the team table. 

Example of Copying Additional Columns 
to the Team Table
The following procedure gives one example of copying additional columns to the team table. In this 
example, you copy data from the S_ASGN_GRP_POSTN rule group position table to the 
S_ORD_CRDT_ASGN team table of the Order (Sales Credit Assignment) assignment object.

You may use this feature differently, depending on your business model.

Table 51. User Property Values for Copying Additional Columns to the Team Table

Value Description

SrcCol The name of the source column in the assignment rule group position table whose 
value is copied to the destination column of the team table. There are 7 Boolean 
columns, 19 string columns, 7 number columns, and 3 date columns available for 
copying.

DestCol The name of the destination column in the team table where the values are copied. 
The destination column must be one of the user data columns in the team table of 
the assignment object.

UserKeyBool If this flag is set to Y (True), indicates the respective destination column is part of 
the user key of the team table. Without this flag specified, duplicate positions 
cannot be inserted in the team table. For more information about duplicate 
positions, see the description for the AllowDupPostn server component parameter 
in �Additional AsgnSrvr and BatchAsgn Parameter Information� on page 207.

DefaultValue Specifies the values that are inserted in the destination columns if default position 
is assigned. In this case, you cannot specify the values to be copied in the 
ASGN_GRP_POSTN table.

NOTE: This value is optional if the default position is not specified. That is, if the 
value for a position is NULL, the default value is set to NULL as well.
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To configure the Order assignment object to copy the S_ORD_CRDT_ASGN column 
to the S_ASGN_GRP_POSTN team table

1 Start Siebel Tools.

2 Select the Order assignment object, which is the object for which you want to copy additional 
columns to the team table.

a In the Object Explorer, expand Workflow Policy Object.

b In the Workflow Policy Object window, select Order.

c In the Object Explorer, expand Assignment Object, and then select Assignment User Prop.

3 In the Assignment User Properties window, choose Edit > New Record to define user properties 
for the assignment object.

a In the Name field, type a name for the property starting with PositionTeamDenorm followed by 
a digit (for example, PositionTeamDenorm1, PositionTeamDenorm2). 

b In the Value field, use the following syntax to enter values (for value descriptions, see Table 51 
on page 256):

SrcCol,DestCol,UserKeyBool,DefaultValue

For this example, SrcCol copies values come from the S_ASGN_GRP_POSTN table. The 
following table shows some of the valid user properties for the Order (Sales Credit 
Assignment) assignment object:

Process of Configuring Assignment 
Objects for Team Scoring 
You can configure Assignment Manager to save candidates� scores to the team table for those 
candidates who are assigned to an assignment object. These scores can be then used by other Siebel 
applications or exposed through the user interface.

To configure an assignment object for team scoring, perform the following tasks:

1 �Extending an Object�s Base Table for Team Scoring� on page 258 

2 �Configuring Assignment Objects for Team Scoring� on page 258

Name Value

PositionTeamDenorm1 DATE1,START_DT,N

PositionTeamDenorm2 CHAR2,SLS_TERR_ID,Y

PositionTeamDenorm3 CHAR1,CRDT_RULE_ID,N

PositionTeamDenorm5 CHAR3,FROM_BTM_NODE_FLG,N

PositionTeamDenorm6 NUM2,ROLLUP_PCT,N

PositionTeamDenorm8 CHAR5,ROLLUP_FRMLA,N

PositionTeamDenorm21 BOOL5,QTA_RLP_ACNTED_FLG,N
Siebel Assignment Manager Administration Guide Version 7.8 257



Advanced Assignment Manager Configuration ■  Process of Configuring Assignment 
Objects for Team Scoring
Extending an Object�s Base Table for Team Scoring
Before configuring an assignment object for team scoring, make sure the object has the necessary 
columns in its database table. 

This task is a step in �Process of Configuring Assignment Objects for Team Scoring� on page 257. 

NOTE: You must review the sections on extension tables and columns in Configuring Siebel Business 
Applications before completing this procedure.

To extend an object�s base table for team scoring

1 Start Siebel Tools.

2 In the Object Explorer, expand the Table object, and then query for the table you want to 
configure.

3 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

4 In the Object Explorer, select Column.

5 In the Columns window, choose Edit > New Record to add new records.

For more information about adding new column records, see Using Siebel Tools.

6 Select each new record and click the Apply button.

7 Enter the appropriate value for tableowner password.

The table is now extended.

NOTE: There are specific considerations depending on the platform you are using. For more 
information about this, see the note in Step 7 on page 282 of the procedure in �Extending an 
Assignment Object�s Base Table for Availability-Based Assignment.�

After the necessary base table columns are in place, you can configure the assignment object for 
team scoring.

Configuring Assignment Objects for Team Scoring
After extending an assignment object�s base table for team scoring (see �Extending an Object�s Base 
Table for Team Scoring� on page 258), you can then configure the assignment object.

This task is a step in �Process of Configuring Assignment Objects for Team Scoring� on page 257. 

To configure an assignment object for team scoring

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and select the object you want to 
configure.
Siebel Assignment Manager Administration Guide Version 7.8258 



Advanced Assignment Manager Configuration ■  Example of Configuring the Opportunity
Assignment Object for Team Scoring
3 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

4 In the Object Explorer, select Assignment Object.

5 In the Assignment Objects window, set values for the properties in the following table.

For information on modifying the appropriate components that expose the scoring information to the 
user interface, see Configuring Siebel Business Applications.

Example of Configuring the Opportunity 
Assignment Object for Team Scoring
This topic gives one example of configuring the Opportunity assignment object for team scoring. You 
may use this feature differently, depending on your business model. Use the following procedures to 
extend the Opportunity assignment object for team scoring.

To extend the Opportunity object�s base table for team scoring

1 Start Siebel Tools.

2 In the Object Explorer, expand the Table object, and then query for the S_OPTY table.

3 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

4 In the Object Explorer, select Column.

Column Value

Employee Team Score 
Column

The table column that references a Number column in the assignment 
object�s employee team table.

Org Team Score 
Column

The table column that references a Number column in the assignment 
object�s organization team table.

Position Team Score 
Column

The table column that references a Number column in the assignment 
object�s position team table.
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5 In the Columns window, add the records shown in the following table.

NOTE: The values and records shown are examples and can be modified, as appropriate, for your 
deployment.

6 Select each new record and click the Apply button.

7 In the Apply Schema dialog box, enter the appropriate value for database user password, and 
click Apply.

The S_OPTY table is now extended with the following columns: X_POS_SCORE and 
X_ORG_SCORE.

To configure the Opportunity assignment object for team scoring

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and select the Opportunity object.

3 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

4 In the Object Explorer, select Assignment Object.

5 In the Assignment Objects window, set values for the properties in the following table.

Record 1 Record 2

Name X_POS_SCORE X_ORG_SCORE

Cascade Clear Ignore Ignore

Physical Type Data(Public) Data(Public)

Precision 22 22

Scale 7 7

Text Length 22 22

Txn Log Code TRUE TRUE

Column Value

Employee Team Score Column The name of the column that stores the score for each 
member of an employee team.

Org Team Score Column The name of the column that stores the score for each 
member of an organization team.

Position Team Score Column The name of the column that stores the score for each 
member of a position.
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About Configuring Assignment Manager 
to Copy Columns
Assignment Manager allows you to copy position- and employee-specific columnar data so that you 
can replace one position or employee with another and have the position or employee data stay 
intact. For example, you might have a sales representative who has been working on an account or 
contact for several days but find you need another person to take on that work. To enable this 
feature, you must first configure an assignment object�s user properties so that Assignment Manager 
can find the lists of columns in the position or employee team tables. Then, you submit a component 
job request so that Assignment Manager retains the position- or employee-specific data in the team 
table for the new person. During assignment processing, the data from one position (or employee) 
is copied to the extension columns for the new position (or employee) before deleting the original 
position (or employee).

NOTE: Prior to version 7.8, Assignment Manager could only delete a record for a position that no 
longer qualified without copying any data.

The logic that Assignment Manager uses to copy position- or employee-specific data is as follows:

1 Checks to see if the position or employee already exists in the account team.

■ If yes, do nothing

■ If no, skip to Step 2

2 Searches to find:

■ Any positions with position-specific data for the same rule group (or list of rule groups when 
merging sales forces) on the team.

or

■ Any employees with employee-specific data for the same rule group on the team.

3 If: 

■ No, do nothing

■ If yes, then:

❏ Find the position that has the latest updated position-specific data and copy that 
position's data and assign it to the new position

or

❏ Find the employee that has the lasted updated employee-specific data and copy that 
employee�s data and assign it to the new employee
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Process of Configuring Assignment 
Manager to Copy Columns
By default, the TM Account assignment object is configured to copy columnar position or employee 
data. However, you can make this feature available for other assignment objects by configuring user 
properties using Siebel Tools, then initiating a server component job to process the information.

To copy columns for positions or employees, perform the following tasks:

1 �Configuring Assignment Objects to Copy Columns� on page 262

2 �Copying Columns Using the UI� on page 264

or

�Copying Columns Using the Command-Line Interface� on page 265

Configuring Assignment Objects to Copy Columns
Using Siebel Tools, you can configure assignment objects to copy position-specific or employee-
specific data. Typically, you configure sales objects to copy position-specific data and you configure 
service objects to copy employee specific data.

This task is one step in �Process of Configuring Assignment Manager to Copy Columns� on page 262.

By default, the TM Account assignment object is predefined to copy position-specific data. Figure 32 
shows the TM Account assignment object configured to copy only a single column�ROLE_CD.

Figure 32. The TM Account Assignment Object Configured to Copy Position-Specific Data
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Use the following procedure to add either the Position Specific Columns or Employee Specific 
Columns user property to an assignment object for which you want to enable copying of data.

To configure an assignment object to copy position- or employee-specific data

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and then query for the object you want 
to configure.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can enable it by selecting 
View > Options > Object Explorer in the Development Tools Options dialog box.

3 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

4 In the Object Explorer, expand Assignment Object, and then select Assignment User Prop.

5 In the Assignment User Properties window, choose Edit > New Record.

6 In the new record, enter values for the relevant information.

■ In the Name field, type either Position Specific Columns or Employee Specific Columns.

■ In the Parent Name field, type the name of the parent object.

■ In the Value field, type the names of the columns you want copied.

For example, if you want to copy multiple columns, type: ROLE_CD, ROW_ID.

■ In the Inactive field, click the drop-down arrow, and select FALSE.

After the assignment object is modified, you must run various server administration procedures to 
make sure your configurations are recognized by Assignment Manager.

■ If you are using Batch Assignment, start a new task.

■ If you are using Dynamic Assignment, stop and restart the Workflow Monitor Agent. 

■ If you are using Interactive Assignment, stop and restart the Assignment Manager Server 
Component.

After the assignment object is configured, you can then instruct Assignment Manager to copy 
position- or employee-specific data using the UI or by submitting a server component job from the 
command-line interface.
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Copying Columns Using the UI
You can set up Assignment Manager to copy columnar position or employee data using the UI or by 
submitting a server component job from the command-line interface. This topic explains how to copy 
columns using the UI.

This task is one step in �Process of Configuring Assignment Manager to Copy Columns� on page 262.

Prerequisites
The following procedure assumes the Position Specific Columns and Employee Specific Columns 
properties are preconfigured for the assignment object and the Copy Candidate Specific Data 
(CopyCandSpecData) server component parameter is set to Yes. For information on how to configure 
these properties and parameter, see �Configuring Assignment Object Properties� on page 51 and 
�Modifying the Assignment Manager Server Component Parameters� on page 198, respectively.

To copy columns using the UI

1 Navigate to the Administration - Server Management screen > Jobs view.

2 In the Jobs list, click New.

A new record appears with a system-defined ID automatically generated with a status of 
Creating.

3 In the Requested Server field n the Job Detail subview, type the name of the Siebel Server on 
which you want to run the copy columns feature.

NOTE: Assignment Manager copies position- or employee-specific data only if the Use Key Value 
server component parameter value is set to either Rule Group or None. If None, position-specific data 
is copied from any position in the ACCNT_POSTN table that was updated last, given every position 
in the team is for the same business reason.

TIP: When merging sales forces in production mode, Assignment Manager takes into account the 
list of key values, that is, Assignment Manager gets the latest updated position in all the rule groups 
in the Replace Key Values list with position-specific data.
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Copying Columns Using the Command-Line Interface
After configuring an assignment object to copy columns, Assignment Manager can copy columnar 
position- and employee-specific data by initiating a server component job from the command-line 
interface using the AsgnSrvr command and the parameters described in Table 45 on page 199. The 
command-line interface of the Server Manager is the srvrmgr program. 

This task is one step in �Process of Configuring Assignment Manager to Copy Columns� on page 262.

For more information on using the command-line interface, see Siebel System Administration Guide.

To copy columns using the command-line interface
■ From the command-line interface, submit an assignment request using the CopyCandSpecData 

server component parameter to instruct Assignment Manager to retain the position- or 
employee-specific data in the team table. 

For example:

start task for comp asgnbatch with asgnobjname="Account", objwhereclause="where 
row_id='88-1FC68'", CopyCandSpecData = "Y"

or

start task for comp asgnsrvr with asgnobjname="Account", objwhereclause="where 
row_id='88-1FC68'", CopyCandSpecData = "Y"

Configuring Assignment Manager to Use 
Reporting Tables and Columns
Assignment Manager provides a special set of tables to which you can write assignment results for 
what-if analysis. These tables are known as reporting tables, and the environment in which you work 
with these tables is known as the reporting environment. When you work in the reporting 
environment, you work in reporting mode. By default, reporting mode is turned off; Assignment 
Manager does not write to the reporting tables. Using Siebel Tools, you can configure Assignment 
Manager to use reporting tables and columns (in lieu of actual assignment tables) by defining 
Assignment Object and Assignment Object Extension object properties.

NOTE: You can retrieve Reporting mode table data by using native database utilities, such as 
SQL*Plus, Query Analyzer, and so on. You should not modify or delete this data. Rather, assignment 
administrators should use the Reporting tables to preview the temporary reporting results before 
executing Assignment Manager in actual production tables.

About Reporting Tables
You can think of the reporting tables as temporary draft tables that allow you to preview the results 
of Assignment Manager processing to see the changes that are going to be made before committing 
those changes to the actual database. Reporting allows you to run Assignment Manager multiple 
times without impacting current assignment. Assignment Manager can write to the reporting tables 
independently of whether results are written to actual assignment tables or not.
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The reporting tables are especially useful when you want to filter and operate on a subset of 
candidates.

About Reporting Mode
When merging records in reporting mode, Assignment Manager runs in one of the following modes:

■ Snapshot mode. Assignment Manager reads from and writes to the reporting team tables only. 

This is similar to running in production mode except that the result tables are different. 
Assignment Manager stores the results tables in the Assignment Object Extension object in 
Siebel Tools. In snapshot mode, the reporting team tables store a snapshot of the results.

■ Delta mode. Assignment Manager reads from the current actual assignments but writes to the 
reporting team tables.

In delta mode, Assignment Manager stores the delta as compared with current actual 
assignments to the reporting tables. Assignment Manager also stores the delta information about 
whether a particular candidate was added or dropped as compared with the same account or 
contact in actual assignments. You can later use this information to run reports.

NOTE: The values in the Assignment Object Extension object properties determine what columns 
are used to determine which candidates were added or dropped, which tables to use for 
reporting, which column to use as the key column, and which columns to use as the position, 
employee, or organization column.

Reporting mode is supported in default mode, that is, when Assignment Manager operates on one 
rule group at a time. 

To configure an assignment object to use reporting tables and columns

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and in the Workflow Policy Objects list, 
query for the object for which you want to enable reporting tables and columns.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can enable it by selecting 
View > Options > Object Explorer in the Development Tools Options dialog box.

3 Lock the project for the object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

4 In the Object Explorer, select Assignment Object Extension.

5 In the Assignment Object Extensions list, choose Edit > New Record, and then click in the 
available fields to enter relevant information.
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Table 52 shows some of the properties of the Assignment Object Extension object type. 

Table 52. Properties of Assignment Object Extension

Property Description

Name The name of the assignment object extension. This name should always 
match the assignment object name.

Inactive Indicates if the object extension is active or inactive. 

By default, this is set to FALSE.

Position Reporting 
Table

The name of the position reporting intersection table. If the assignment 
object can be assigned to multiple positions, this intersection table stores 
the set of position IDs that are assigned to the assignment object IDs.

Position Reporting 
Column

The name of the column in the position reporting intersection table that 
points to rows in the S_POSTN position table.

Required if Position Table property is non-NULL.

Position Reporting 
Insertion Column

This column marks the positions that are added to the team. Applicable in 
both snapshot and delta reporting modes.

Position Reporting 
Deletion Column

This column marks the positions that are removed from the team. Applicable 
in both snapshot and delta reporting modes.

Position Reporting 
Key Column

Stores the key values of the positions assigned to the team at runtime. 

NOTE: The UseKeyValue server component parameter must also be set to 
True. 

Employee Reporting 
Table

The name of the employee reporting intersection table. If the assignment 
object can be assigned to multiple employees, this intersection table stores 
the set of employee IDs that are assigned to the assignment object IDs.

Employee Reporting 
Column

The name of the employee reporting intersection table that points to rows 
in the S_POSTN position table.

Required if Employee Table property is non-NULL.

Employee Reporting 
Insertion Column

This column marks the employees that are added to the team. Applicable in 
both snapshot and delta reporting modes.

Employee Reporting 
Deletion Column

This column marks the employees that are removed from the team. 
Applicable in both snapshot and delta reporting modes.

Employee Reporting 
Key Column

Stores the key values of the employees assigned to the team at runtime. 

NOTE: The UseKeyValue server component parameter must also be set to 
True. 

Org Reporting Table The name of the organization reporting intersection table. If the assignment 
object can be assigned to multiple organizations, this intersection table 
stores the set of organization IDs that are assigned to the assignment object 
IDs.
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Configuring Assignment Objects for 
Multitiered Assignment
By default, Assignment Manager independently matches people and organizations to assignment 
objects. Activating Assignment Manager to use multitiered assignment, however, allows assignments 
based on the relationship between a person and their organization or an organization and its people. 

NOTE: Without multitiered assignment�or appropriate assignment rules�it is possible for 
Assignment Manager to assign an unrelated organization or person to an assignment object.

Org Reporting 
Column

The name of the organization reporting intersection table that points to rows 
in the S_POSTN position table.

Required if Organization Table property is non-NULL.

Org Reporting 
Insertion Column

This column marks the organizations that are added to the team. Applicable 
in both snapshot and delta reporting modes.

Org Reporting 
Deletion Column

This column marks the organizations that are removed from the team. 
Applicable in both snapshot and delta reporting modes.

Org Reporting Key 
Column

Stores the key values of the organizations assigned to the team at runtime. 

NOTE: The UseKeyValue server component parameter must also be set to 
True. 

Table 52. Properties of Assignment Object Extension

Property Description
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Table 53 shows the multitiered assignment modes. 

NOTE: Use caution when the Organization and Person-Oriented mode is used with assignment rules 
that use the One, Best Fit assignee filter because inconsistencies can occur. The One, Best Fit 
assignee filter assigns only the highest-scoring position or organization. If the highest-scoring 
position does not have a qualifying organization, or if the highest-scoring organization does not have 
a qualifying position, the object remains unassigned, even if a lower-scoring position and its related 
organization both qualify for the assignment rule.

This logical assignment feature is well-suited to sales organizations.

You use Siebel Tools to activate multitiered assignment by setting the Assignment Mode property for 
an assignment object.

NOTE: You should not configure multitiered assignment to assign people and corresponding 
organizations when running interactive assignment. This is because when using interactive 
assignment, you manually choose assignees and only the person or the organization candidates are 
shown, not both.

To configure an assignment object for multitiered assignment

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and in the Workflow Policy Objects list, 
query for the assignment object for which you want to enable mutitiered assignment.

TIP: If Workflow Policy Object is not visible in the Object Explorer, you can enable it by selecting 
View > Options > Object Explorer in the Development Tools Options dialog box.

3 In the Object Explorer, select Assignment Object.

4 Lock the project for the assignment object by choosing Tools > Lock Project (or Alt+L).

The pencil icon appears in the W field to indicate the project for the object is locked.

Table 53. Multitiered Assignment Modes

Multitier Mode Description

Independent Assigns people and organizations that qualify, regardless of whether 
they are related or not.

Person-Oriented Assigns people that qualify, then assigns only qualified organizations 
that the assigned people belong to. 

Organization-Oriented Assigns organizations that qualify, then assigns qualified people from 
those organizations. 

Organization and 
Person-Oriented

Identifies qualified people and organizations, then assigns only those 
that have both a qualified person and related qualified organization.
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5 For the assignment object, change the Assignment Mode property to the multitiered assignment 
mode operation of interest.

Choices are: 

■ Independent

■ Org & Person-oriented

■ Organization-oriented

■ Person-oriented

Related Topics
�Scenarios for Using Multitiered Assignment with Sales Assignment Rules� on page 270

Scenarios for Using Multitiered 
Assignment with Sales Assignment 
Rules
This topic gives one example of how multitiered assignment may be used with sales assignment 
rules. You may use multitiered assignment differently, depending on your business model. 

Multitiered assignment is a logical assignment feature that considers the relationships between 
people and organizations before assigning an object, which makes this feature well-suited to sales 
organizations. To activate multitiered assignment, you must first use Siebel Tools to configure 
assignment objects. Then, after assignment objects are configured, multitiered assignment can 
function in various modes. 

The following scenarios show how multitiered assignment functions in various modes. Each scenario 
is based on the same sales opportunity and the same assignment rules.

Independent Assignment. If multitiered assignment is disabled, Assignment Manager assigns the 
object independently, resulting in the following scenario:

■ All people and organizations not matching assignment rule criteria are filtered out.

■ For each person that matches, assign that person to the object.

■ For each organization that matches, assign that organization to the object.
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■ The European and Asian sales representatives independently are assigned to the same 
opportunity as well as the Europe and North America organizations, as shown in the following 
table:

Person-Oriented Assignment. If multitiered assignment is set to person-oriented mode the 
following situation occurs:

■ All organizations and people not matching assignment rule criteria are filtered out.

■ For each person that matches, assign that person to the object.

■ Evaluate organization candidates for the assigned people�s organizations. If the organization 
matches, assign that organization to the object.

■ The European and Asian sales representatives are assigned, but only the Europe organization is 
assigned, as shown in the following table:

Organization-Oriented Assignment. If multitiered assignment is set to organization-oriented 
mode the following situation occurs:

■ All organizations and people not matching the assignment rule criteria are filtered out.

■ For each organization that matches, assign it to the object. 

■ Evaluate each person candidate for the assigned organization�s people. If a person matches, 
assign that person to the object.

Person Match Organization Match
Assigned 
Person

Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North American Sales 
Representative

N North America Y North America

Asian Sales 
Representative

Y Asia N Asian Sales 
Representative

Person Match Organization Match
Assigned 
Person

Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North American Sales 
Representative

N North America Y

Asian Sales 
Representative

Y Asia N Asian Sales 
Representative
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■ The Europe and North America organization are assigned, but only the �European Sales 
Representative� is assigned, as shown in the following table:

Organization and Person-Oriented Assignment. If multitiered assignment is set to organization 
and person-oriented mode, the following situation occurs:

■ All organizations and people not matching the assignment rule criteria are filtered out.

■ For people and organizations that satisfy the assignment rule criteria, assign only those that have 
both a corresponding organization and person that meet the criteria (similar to a logical AND 
statement).

■ Only the European sales representative and the Europe organization are assigned, as shown in 
the following table:

Related Topics
�Configuring Assignment Objects for Multitiered Assignment� on page 268

Person Match Organization Match
Assigned 
Person

Assigned 
Organization

European Sales 
Representative

Y Europe Y European 
Sales 
Representative

Europe

North American Sales 
Representative

N North America Y North America

Asian Sales 
Representative

Y Asia N

Person Match Organization Match
Assigned 
Person

Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North American Sales 
Representative

N North America Y

Asian Sales 
Representative

Y Asia N
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Configuring Assignment Manager to Add 
Scores Across Rules
You can configure Assignment Manager so that the same candidate (employee, position, or 
organization) can qualify from different assignment rules with different scores. By default, 
Assignment Manager treats passing candidates from different rules as if they were different 
candidates. However, it is possible for Assignment Manager to merge (add) the scores for the same 
candidate across rules and take the total score in the calculation of the primaries.

How you configure Assignment Manager to add scores across rules differs for each operating mode. 
You specify the Add scores across rules (AddScores) server component parameter to determine 
Assignment Manager scoring behavior by way of the:

■ AsgnSrvr component for interactive assignment

■ AsgnBatch component for batch assignment

■ Assignment Request (In Process) workflow policy program for dynamic assignment

The following subtopics describe configuration for each mode in detail.

NOTE: The AddScores parameter is applicable to static and dynamic candidates, but only if no rules 
are marked as exclusive. That is because you explicitly define the rule from which you want the 
primaries to come for exclusive rules.

Adding Scores Across Rules for Interactive Assignment
If you set the AddScores component parameter to TRUE, all requests sent to AsgnSrvr add scores 
for the candidates. However, when interactive assignment is used, the <Assign> menu method by 
default sets AddScores to FALSE, and subsequently passes AddScores = FALSE to the AsgnSrvr task. 
To override this behavior so that interactive assignment passes AddScores = TRUE for the 
assignment, you need to add a user property to the respective business component on which 
interactive assignment is running. 

Alternatively, for requests sent to AsgnSrvr using a script or the Server Request business service, 
you can pass AddScores = TRUE as an input parameter to the AsgnSrvr task.

To configure Assignment Manager to add scores across rules for interactive 
assignment

1 Start Siebel Tools.

2 Configure the Action business component to add scores across rules.

a In the Object Explorer, expand Business Component.

b In the Business Components list, select Action.

c Choose Tools > Lock Project (or Alt+L) to lock the project. 
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d In the Object Explorer, click Business Component User Prop, and add a new record with the 
following information:

❏ Name = AddScores

❏ Value = TRUE

3 Compile the .srf file.

4 Copy the .srf file to the Siebel client\objects\<language> directory, where language is the 
appropriate language code, such as ENU for American English.

5 Copy the .srf file to the Siebel server\objects\<language> directory, where language is the 
appropriate language code, such as ENU for American English.

This allows control of AddScores = TRUE for interactive assignment based on the object being 
assigned.

Adding Scores Across Rules for Batch Assignment 
If you set the AddScores component parameter to TRUE, all tasks for batch assignment add the 
scores across rules for the candidates. Alternatively, you can also set Add Scores across Rules = 
TRUE at the task-level when starting a batch assignment task. For more information about running 
batch assignment, see �Running Batch Assignment� on page 228.

Adding Scores Across Rules for Dynamic Assignment
To add scores across rules for dynamic assignment, you must set the Add Scores program argument 
to TRUE for the Assignment Request (In Process) workflow policy program.

To configure Assignment Manager to add scores across rules for dynamic 
assignment

1 Start Siebel Tools.

2 Configure the Assignment Request (In Process) workflow policy program to add scores across 
rules.

a In the Object Explorer, expand Workflow Policy Program.

b In the Workflow Policy Programs list, select Assignment Request (In Process).

c Choose Tools > Lock Project (or Alt+L) to lock the project. 

d In the Object Explorer, click Workflow Policy Program Arg, select AddScores, and change the 
Default Value to TRUE. 

3 Check in the changes to the server.
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How the AddScores Server Component Parameter Affects Primaries
By default, if an assignment rule has a primary employee, primary position, or primary organization 
set and one of these people pass, they are assigned as the primary if that rule passes and is the 
highest scoring rule for that object. However, if the AddScores server component parameter is set to 
True, the primaries are ignored because the AddScores parameter overrides the primaries on the 
rule. The AddScores parameter assigns the highest scoring employee, position, or organization 
across all the rules that pass for that object and has more weight than the primaries.

For example, assume you have two rules�Rule 1 and Rule 2�that pass for a specific Account Z. Each 
rule has two positions that qualify with scores as shown the following table:

If the AddScores parameter is not applied (set to False), position B is the highest-scoring position 
with a score of 120 and becomes the primary. However, if the AddScores parameter is applied (set 
to True), then position A with a score of 150 is the highest-scoring position and becomes the primary.

Position A Score Position B Score

Rule 1 100 120

Rule 2 50 20

Total Score 150 140
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11 Availability-Based Assignment
This chapter describes how to make availability-based assignments in Siebel Assignment Manager. 
It includes the following topics:

■ �About Availability-Based Assignment� on page 277

■ �About Assigning Employees to Assignment Rules Based on Availability� on page 278

■ �How Assignment Manager Creates Activities for Employees During Availability-Based Assignment� 
on page 279

■ �Process of Configuring Assignment Objects for Availability-Based Assignment� on page 280

■ �Extending an Assignment Object�s Base Table for Availability-Based Assignment� on page 281

■ �Configuring Assignment Object Properties for Availability-Based Assignment� on page 282

■ �Configuring Assignment Object User Properties for Availability-Based Assignment� on page 284

■ �Example of Configuring the Service Request Assignment Object for Availability-Based Assignment� 
on page 286

About Availability-Based Assignment
Assignment Manager has the ability to assign employees based on their calendar availability and can 
find out whether candidates are working at the required time�and whether their calendar is free or 
not�before assigning an item to a candidate or team. This feature is used on employee-based 
assignment objects only, and requires the installation of the Field Service option as it depends on a 
Field Service component, the Appointment Booking System (ABS), to check employee availability. It 
is, however, not limited to use in the Field Service application and can be used in any application that 
has employee-based objects. In general, this feature is meant for use with employee-based objects 
that have an associated time duration, such as Activities and Service Requests.

To use this feature, certain properties of the assignment object require configuration in Siebel Tools. 
The Activity object is, by default, partially preconfigured for use with availability assignment; the 
Service Request object, however, is not. Both objects require configuration in Siebel Tools to activate 
availability-based assignment. See �Process of Configuring Assignment Objects for Availability-Based 
Assignment� on page 280 for further information on these procedures. Assignment Manager can also 
be configured to create an Activity in the calendar of the candidate assigned to the object.

After an object is configured for availability-based assignment, an assignment rule activates this 
feature by means of a check box on the Assignment Rule detail applet. You can further customize 
Assignment Manager for availability-based assignment, by configuring assignment object user 
properties.

Related Topic
�About Assigning Employees to Assignment Rules Based on Availability� on page 278
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About Assigning Employees to 
Assignment Rules Based on Availability 
You can create assignment rules for employee-based objects using availability-based assignment, 
which allows Assignment Manager to check an employee�s calendar and to consider the employee�s 
availability when determining assignment eligibility. Assignment objects must be preconfigured 
before using the assignment availability criteria feature. 

When an assignment object is configured for availability, a user specifies the following three times 
for the assignment object:

■ Early Start Time. (Optional) The earliest time the assignment object can be scheduled 
(specified in the Calendar Early Start Time Column property of the assignment object).

If this time is specified, Assignment Manager looks for an available slot for the specified duration 
in the employees' schedules with the starting time anywhere between the Early Start Time and 
the Start Time. If this time is not specified, it defaults to the Must Start Time which means that 
Assignment Manager looks for an available slot for the specified duration starting exactly at the 
start time.

■ Latest Start Time. The latest time the assignment object can be started (specified in the 
Calendar Start Time Column property of the assignment object).

■ Duration. The time in minutes required to finish the assignment object�s task (specified in the 
Calendar Duration Column property of the assignment object).

Each of these times is accessed by Assignment Manager when determining the availability of an 
employee. Assignment Manager then uses the availability information like other criteria when 
evaluating employees for the assignment object. 

NOTE: If the Calendar Early Start Time Column is not defined, but the Calendar Start Time Column 
is defined, the Appointment Booking System (ABS) checks to see whether employees are available 
or not at the exact Calendar Start Time. If both columns are defined, ABS checks to see whether 
employees are available or not during the period from Calendar Early Start Time Column to Calendar 
Start Time Column. For more information about ABS, see Siebel Field Service Guide. 

Assignment Manager can also be configured to add an activity to the calendar of the employee who 
is assigned the assignment object. For example, if a service request is created with times indicating 
a service duration of four hours, Assignment Manager evaluates the object�s times and employees� 
schedules, and selects only employees who are available for the four hours indicated by the service 
object. Assignment Manager then selects the highest-scoring employee available and creates an 
activity for the employee (given the object is configured to assign activities). Employees can manually 
insert activities into their calendar to block assignments during specific periods. Similarly, an 
employee can delete activities created by the original assignment so further assignments can be made.

Assignment Manager functions for both single employees and teams. If an object is assigned to a 
team, every employee within the team is assigned an activity for the duration of the assignment 
(given the object is configured to assign activities). Assignment Manager can assign activities for the 
same object at different times based on the calendars of individual team members. A calendar 
activity, however, cannot be split up across multiple dates and times.

When administrators define a new rule, selecting the Check Employee Calendar box activates the 
assignment availability criteria.
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Related Topics
�About Assigning Employees to Assignment Rules Based on Availability� on page 278

�How Assignment Manager Creates Activities for Employees During Availability-Based Assignment� on 
page 279

How Assignment Manager Creates 
Activities for Employees During 
Availability-Based Assignment 
If an assignment rule has the Check Employee Calendar flag checked, availability for each employee 
is evaluated before assignment. If the Calendar Create Activity property is also set for the 
assignment object, make sure that an activity exists in the employee's calendar for that duration to 
block the schedule. Figure 33 shows a high-level flowchart of this process.

Assignment Manager evaluates whether the Check Employee Calendar flag is checked (calendar 
rules) or not (noncalendar rules) and processes the rules differently based on this indication. If 
Assignment Manager is assigning activities, and if only one employee passes and that employee is 
from a calendar rule, the original activity is reused and the employee is added to the owners list for 
that activity. This action blocks the employee�s schedule. If more than one employee passes, 
separate activities are created for each employee. In this case, the parent activity of all these 
additional activities is set to the original activity to make sure that all are related to each other.

Figure 33. High-Level Flowchart of Availability-Based Assignment
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If Assignment Manager is not assigning activities, separate activities are created for each employee 
who passes and blocks their schedules.

Related Topic
�Process of Configuring Assignment Objects for Availability-Based Assignment� on page 280

Process of Configuring Assignment 
Objects for Availability-Based 
Assignment
When you configure assignment objects for availability-based assignment, Assignment Manager can 
review an employee�s calendar as a criterion for assignment. If the employee�s calendar has no 
activities booked at the time required by the object, and has a sufficient time period available for the 
object�s duration, the employee qualifies for assignment.

Requirements
Before configuring the assignment object, make sure the following information is satisfied:

■ The Field Service component group is enabled.

For more information on the Field Service component group, see Siebel System Administration 
Guide.

■ A mapping of the server to the Field Service components and region exists.

For more information on Field Service components and regions, see Siebel Field Service Guide.

■ Employees are associated with service regions.

For more information on Field Service regions, see Siebel Field Service Guide.

■ The object that you are configuring for assignment availability has the necessary columns in its 
database table. 

For more information on configuring for availability, see �Extending an Assignment Object�s Base 
Table for Availability-Based Assignment� on page 281.

By default, the Activity assignment object has the required columns in its database table for Start 
Time and Duration; however, one column must be extended if the Early Start Time property is 
desired. All other assignment objects must have their base tables extended if you want them enabled 
for availability-based assignment. 

To configure assignment objects for availability-based assignment, you need to perform the following 
tasks:

1 �Extending an Assignment Object�s Base Table for Availability-Based Assignment� on page 281

2 �Configuring Assignment Object Properties for Availability-Based Assignment� on page 282
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3 �Configuring Assignment Object User Properties for Availability-Based Assignment� on page 284

NOTE: It is recommended that you review the sections on extension tables and columns in 
Configuring Siebel Business Applications before completing this process.

Extending an Assignment Object�s Base Table for 
Availability-Based Assignment 
Using Siebel Tools, you extend an assignment object�s base table for availability-based assignment 
by performing the following tasks.

This task is a step in �Process of Configuring Assignment Objects for Availability-Based Assignment� on 
page 280.

To extend an assignment object�s base table for availability-based assignment

1 Start Siebel Tools.

2 In the Object Explorer, expand the Table object, and then select Column.

3 In the Tables window, query for the appropriate table.

For example, if you are extending the Service Request assignment object, query for the 
S_SRV_REQ table.

4 With the table selected, choose Tools > Lock Project (or Alt+L) to lock the project.

5 In the Columns list, choose Edit > Add New Record to add the records as described in the 
following table.

6 In the Table column window and after you have created the new records you need, click Apply.

This sends the new columns to the appropriate tables in the database.

Record 1
(Required)

Record 2
(Required)

Record 3 
(Optional)

Name X_DURN_MIN X_START_TIME X_EARLY_START_TIME

Physical Type Number UTC Date Time UTC Date Time

Length 22 7 7

Precision 22

Scale 7

LOV Type APPOINTMENT_DURATION

Cascade Mode Ignore Ignore Ignore

TxnLog Code TRUE TRUE TRUE
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7 Complete the fields in the Apply Schema dialog box.

a In the Tables field, click the select button, and choose one of the following:

❏ All

❏ Current Query

❏ Current Row

b In the Table owner password field, enter the appropriate value.

c Click Apply.

The base table is now extended with the following three columns: X_DURN_MIN, 
X_EARLY_START_TIME, and X_START_TIME.

NOTE: If using DB2 390 database, you must create a storage control file to accommodate the 
table space. You provide the location of the control file in the Apply Schema dialog box 
accordingly. You must create the storage control file from the siebsrvr/bin directory and the 
bufferpool size should be either 16k or 32k. If the Siebel Server is running on the UNIX platform, 
then the storage control file generation is command driven. If the Siebel Server is running on the 
Windows platform, then you generate the storage control file using the UI. 

With the appropriate columns in place, use can now configure availability criteria for the assignment 
object. 

Configuring Assignment Object Properties for 
Availability-Based Assignment
Using Siebel Tools, you configure an assignment object for availability-based assignment by setting 
the assignment object property and user property values and exposing some of those values in the 
user interface.

This task is a step in �Process of Configuring Assignment Objects for Availability-Based Assignment� on 
page 280.

To configure an assignment object for availability-based assignment 

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object and select the assignment object.

3 With the object selected, choose Tools > Lock Project (or Alt+L) to lock the project.

4 In the Assignment Objects list, set the property values as shown in Table 54.

5 After the properties are configured for the assignment object, they must be made visible to the 
end user by adding them to the appropriate business component and applets. 

For information on how to make the properties visible to the end user, see Using Siebel Tools. 
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6 Configure certain assignment user properties to come from either the object row itself or through 
constants.

For a procedure on how to do this, see �Configuring Assignment Object User Properties for 
Availability-Based Assignment� on page 284.

Table 54 shows the assignment object property values you set for availability-based assignment.

If a value is not specified in the Calendar Start Time Column property for an assignment object, 
Assignment Manager does not check calendars when assigning that object, even if the Check 
Employee Calendar flag is checked on the assignment rule. Instead, Assignment Manager assigns all 
candidates who meet the criteria for the rule. For example, if you don't specify the Start Date or Due 
Date for an activity, Assignment Manager does not check calendars when assigning this activity, even 
if the assignment rule has the Check Employee Calendar flag checked. Instead, Assignment Manager 
assigns all candidates who meet the criteria for the rule.

Table 54. Assignment Object Property Settings for Availability-Based Assignment

Property1

1. Properties are specified as one value string for that property.

Description

Calendar Activity 
Additional Fields

(Optional) When this property is specified, Assignment Manager sets the field 
value to the row ID of the assignment object when it creates the activity. 
Assignment Manager also sets the additional fields to the specified field 
values. For example, for the Service Request object, you can specify the 
following fields: Activity SR Id, Type, To Do.

Calendar Early 
Start Time Column

(Optional) The table column that references the early start time of the object. 
For example, X_EARLY_START_TIME.

Calendar Start 
Time Column

The table column that references the start time of the object. For example, 
X_START_TIME.

Calendar Duration 
Column

The table column that references the duration of the object. For example, 
X_DURATION.

Calendar Create 
Activity

(Optional) Check this column if you want an activity created for the assigned 
employee.

TRUE = Activity is created in employee�s calendar
FALSE =Activity is not created in employee�s calendar 

Note: You must configure this property if you plan to use the Appointment 
Booking System to detect conflicts. For more information about the 
Appointment Booking System, see �About Availability-Based Assignment� on 
page 277 in this guide and Siebel Field Service Guide.
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Configuring Assignment Object User Properties for 
Availability-Based Assignment 
Using Siebel Tools, you configure the values of the Activity Type, Activity Priority, and Breakable Flag 
user properties for an assignment object to come from either the object row itself or through 
constants. 

This task is a step in �Process of Configuring Assignment Objects for Availability-Based Assignment� on 
page 280.

To configure assignment object user properties for availability-based assignment

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object and select the assignment object.

3 With the object selected, choose Tools > Lock Project (or Alt+L) to lock the project.

4 In the Assignment Objects list, choose Edit > New Record to add the property values as shown 
in Table 55.

5 After the user properties are configured for the assignment object, they must be made visible to 
the end user by adding them to the appropriate business component and applets.

NOTE: Configure the views and applets with Start Time and Duration fields, such as is the case 
with Activity.

For information on how to make the properties visible to the end user, see Using Siebel Tools. 
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Table 55 shows the assignment object user property values you set for availability-based assignment.

NOTE: A column user property takes precedence over the corresponding value user property. For 
example, if you define a Breakable Flag Column user property and a Breakable Flag Value user 
property, the Breakable Flag Column user property takes precedence. As an alternate method, you 
can configure the Calendar Activity Additional Fields property on the assignment object to specify 
the values of certain fields. Assignment Manager assigns in this order: column user property, then 
value user property, and then Calendar Activity Additional Fields property.

Table 55. Assignment Object User Property Settings for Availability-Based Assignment

Property Description

Breakable Flag 
Column

The name of the column in the assignment object primary table that stores the 
value of the Breakable Flag property. When this property is defined and the 
Check Employee Calendar flag is checked on the assignment rule, Assignment 
Manager queries for the Breakable Flag Column column when it retrieves data 
from the object row and passes this value to the Appointment Booking System 
(ABS) when evaluating employee availability. 

For example, you can create a user property for the Activity assignment object 
with name=Breakable Flag Column and value=ALLOW_BREAK_FLG.

Breakable Flag 
Value

The constant value that is passed to the ABS for the Breakable Flag field in 
availability-based assignment. For example, you can create a user property for 
the Service Request assignment object with name=Breakable Flag Value and 
value=TRUE.

Activity Priority 
Column

The name of the column in the assignment object primary table that stores the 
value of the Activity Priority. When this property is defined and the Check 
Employee Calendar flag is checked on the assignment rule, Assignment 
Manager queries for the Activity Priority Column column when it retrieves data 
from the object row and passes this value to ABS when evaluating employee 
availability. 

For example, you can create a user property for the Activity assignment object, 
with name=Activity Priority Column and value=ALLOW_BREAK_FLG.

Activity Priority 
Value

The constant value that is passed to the ABS for the Activity Priority field in 
availability-based assignment. For example, you can create a user property for 
the Service Request assignment object with name=Activity Priority Value and 
value=TRUE.
Siebel Assignment Manager Administration Guide Version 7.8 285



Availability-Based Assignment ■  Example of Configuring the Service Request Assignment 
Object for Availability-Based Assignment
Example of Configuring the Service 
Request Assignment Object for 
Availability-Based Assignment 
This topic gives one example of creating an assignment rule that evaluates a service request object 
and assigns the object to the highest-scoring employee based on the employee�s skill level and 
availability. You may use this feature differently, depending on your business model.

The service request object�which is often associated with a job, a finite time period, and a specific 
owner�is an example of an object that can be assigned using Assignment Manager�s availability-
based assignment feature.

To use the availability assignment feature, certain setup procedures must be performed in the Field 
Service application before creating the assignment rule. For more information about this feature and 
its requirements, see �About Availability-Based Assignment� on page 277. Several configurations must 
also be made to the assignment object before using the availability feature. See �Process of 
Configuring Assignment Objects for Availability-Based Assignment� on page 280.

Requirements
The following procedures assumes that a service region (California Service Region), employees (West 
Coast Service Representative and West Coast Service Manager), and a product (Pentium III Desktop) 
are already defined. 

For information about defining service regions, see Siebel Field Service Guide.

Activity Type 
Column

The name of the column in the assignment object primary table that stores the 
value of the Activity Type. When this property is defined and the Check 
Employee Calendar flag is checked on the assignment rule, Assignment 
Manager queries for this column when it retrieves data from the object row and 
passes this value to the ABS when evaluating employee availability. 

For example, you can create an Activity assignment object with name=Activity 
Type Column and value=ALLOW_BREAK_FLG.

Activity Type 
Value

The constant value that is passed to the ABS for the Activity Type field in 
availability-based assignment. For example, you can create a Service Request 
assignment object with name=Activity Type Value and value=TRUE.

Table 55. Assignment Object User Property Settings for Availability-Based Assignment

Property Description
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To set up the Field Service application for availability assignment

1 Verify a schedule exists with valid hours by navigating to the All Schedules view (Administration 
- Service > Schedules). 

For this example, select the 12x5 Support schedule in the Schedules List, and click the Schedule 
Hours view tab. Make sure the hours listed are valid. The following figure shows this view.

2 Set up a Service Region.

Navigate to the Administration - Scheduling screen Service Regions view. For this example, select 
the California Service Region. In the Schedule field, select 12x5 Support.

3 Set up the parameter set for the Service Region.

With California Service Region selected, navigate to the Parameters Sets view (in the Scheduling 
Administration screen). For this example, select the West Coast Parameters used by the 
California Service Region and click the Parameters tab. Update the following parameter records:

■ ABS Days to Start = 0 

■ ABS Days to End = 20

■ ABS Logging Level= 4

4 Set up server key mappings by navigating to the Server Key Mappings view in the Scheduling 
Administration screen. 

For this example, create a new record and save it with the following field values:

■ Server = Siebel Server

■ Process # = 0

■ Service Region = California Service Region

■ Component = ApptBook
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5 Associate employees to the service region by navigating to Administration - User > Employees.

For this example, select the West Coast Service Representative and the West Coast Service 
Manager and click the Field Service Details tab. Edit the Schedule and Service Region fields with 
12x5 Support and California Service Region, respectively.

NOTE: If service regions are modified or deleted, you must release assignment rules to update the 
rulecache.dat file.

After the Field Service application is configured, create the assignment rule that uses the assignment 
availability feature.

To create a field service assignment rule

1 Create the assignment rule by navigating to the Administration - Assignment screen > 
Assignment Rules List view.

a In the Assignment Rules List, choose Edit > New Record.

b In the new record, enter the following settings: 

❏ Name = West Coast Service 

❏ Assignment object = Service Request

❏ Assignee filter = One, Best Fit 

c Click on the Check Employee Calendar checkbox to enable the rule for availability-based 
assignment. 

2 Determine assignment criteria.

Navigate to the Criteria view tab and create Product criteria for the assignment rule. For this 
example, service representatives are evaluated with the Compare Object to Person based on an 
employee�s product knowledge.

3 Determine assignment criteria values.

Navigate to the Values view and create a new record with Pentium III desktop.

4 Define employees for the assignment rule.

Navigate to the Assignment Employee view and add the West Coast Service Representative and 
the West Coast Service Manager to the assignment rule.

5 Release the assignment rule.

When a service request is created with attributes that match both West Coast service 
representatives, Siebel Assignment Manager, through the Field Service Appointment Booking System 
(ABS), assigns the employee who has available time in his or her calendar and work schedule. 
Optionally, the ABS can create an activity in the assigned employee�s calendar. For more information 
about ABS, see Siebel Field Service Guide.
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Figure 34 shows the assignment rule described in the previous procedure. 

Related Topic
�Process of Configuring Assignment Objects for Availability-Based Assignment� on page 280

Figure 34. A Field Service Assignment Rule with the Check Employee Calendar Field Activated
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12 Assignment Load Splitter 
Configuration
This chapter describes Siebel Assignment Manager load splitter configuration. It includes the 
following topics:

■ �How Load Splitter Configuration Works� on page 292

■ �Scenarios for Load Splitter Configuration� on page 293

■ �Setting Up Load Splitter Configuration� on page 293

■ �Examples for Administering the Load Splitter� on page 295

■ �Load Splitter Operating Modes� on page 296

■ �Distribute Data Method� on page 297
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How Load Splitter Configuration Works
Using load splitter configuration, you can run multiple application servers concurrently within the 
Siebel Enterprise as shown in Figure 35. This behavior can enhance assignment throughput by 
reducing the amount of time required to complete assignment requests.

Figure 35 shows that when a batch request is submitted, the Load Splitter divides the objects into 
multiple assignment requests across multiple machines. Assignment Manager then executes 
according to the predefined load splitter configurations and outputs to the database server.

Load splitter configuration is especially useful for batch assignment or when you need to reassign 
large amounts of data, launch new product lines, change territory coverage or routing definitions, 
and so on. This feature is a great tool for processing major reassignments because load splitter 
configuration can automatically determine the load and share it evenly across multiple servers.

Load splitter configuration works in two modes�write mode and read mode�depending on where it 
finds the object row IDs to process. For more information about these modes, see �Distribute Data 
Method� on page 297.

NOTE: You can use Load Splitter Configuration in both Production and Reporting modes.

Figure 35. High-Level Process Flow for Load Splitter Configuration
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Scenarios for Load Splitter Configuration
This topic provides scenarios for how you might use load splitter configuration and how you can use 
threshold and batch size to manage your tasks. You may use this feature differently, depending on your 
business model.

You can use load splitter configuration when you perform:

■ Bulk import of accounts, contacts, or other data from a legacy system or data feeds

A software company periodically imports several thousands of accounts, contacts, and other data (for 
example, assets, products, and so on) from a legacy system. The company uses load splitter 
configuration to make sure this newly imported information has correct visibility to the right people 
using the Siebel application. In this case, the assignment administrator is spared the responsibility 
of load balancing because load splitter configuration automatically identifies how to distribute the 
imported data evenly among the available application servers.

■ Periodic assignment rule changes

A consumer goods company periodically makes changes to assignment rules. The company uses load 
splitter configuration to make sure all accounts and contacts are reassigned in optimal time. In this 
case, the assignment administrator is spared the time-consuming responsibility of planning and 
determining what resources are available for the realignment.

Setting Up Load Splitter Configuration
Load splitter configuration provides Assignment Manager the ability to balance job load when 
processing object rows. The Assignment Administrator (AA) specifies a list of servers, the number of 
tasks each of those servers can run, and the priority for each server for a given configuration.

Use the following procedure to set up load splitter configuration for your needs.

NOTE: Make sure the Assignment Manager server component is enabled on all the specified servers. 
For more information about checking the status of this component, see �Checking the State of the 
Assignment Manager and Server Request Broker Components� on page 197.

To set up load splitter configuration

1 From the application-level menu, navigate to the Assignment - Administration screen > Load 
Splitter Configuration view.

2 In the Load Splitter Configuration list, click New to add a new record.

NOTE: Notice the Configuration ID field automatically populates.

3 In the new record, enter values for the relevant information.

a In the Name field, type the name of the configuration.

b In the Threshold field, click the calculator button to enter a number.
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c In the Minimum Batch Size field, click the calculator button to enter a positive number. 

4 In the Server Configuration list, click New to add a new record.

a In the Priority field, click the calculator button to enter a number.

b In the Server Name field, enter the name of the Siebel Server. 

c In the Number of Tasks field, click the calculator button to enter a positive number.

Field Description

Threshold Identifies the maximum number after which the splitting will occur

Minimum Batch 
Size

This field determines the minimum number of rows processed within 
a single task.

Field Description

Priority Determines which server should be picked up first for processing over others. 
The priority is determined in ascending order, that is, 1 is a higher priority 
than 2. For example, if you have dedicated Assignment Manager servers that 
require a higher priority than another server running EIM. In this case, you 
would set a higher priority for the Assignment Manager servers than the EIM 
server.

NOTE: It is recommended that you set your first priority number fairly high, 
such as 100 and provide sufficient gaps between priority numbers. This is 
helpful when new servers are added for processing load splitting tasks. It 
keeps you from having to reset your entire priority arrangement. For example, 
if you start with two servers, you could set one priority at 100, and the other 
at 200. Then, when you need to add an additional third server, you can set 
that priority to 150.

Number of 
Tasks

Determines the number of tasks that can be executed on that particular 
server.
Siebel Assignment Manager Administration Guide Version 7.8294 



Assignment Load Splitter Configuration ■  Examples for Administering the Load Splitter
Figure 36 shows a sample Align configuration that uses two servers�Server A and Server B�to 
process multiple tasks. In this configuration, Server A has a higher priority than Server B.

Examples for Administering the Load 
Splitter
The following three examples show how the Assignment Administrator might use threshold, batch 
size, and load splitter configuration to split a batch request into multiple, manageable tasks. You may 
use this feature differently, depending on your business model.

Example 1: Load Splitter Less Than Threshold
In this example, the load splitter receives 900 ROW_IDS for the account assignment object. Because 
this is less than the threshold, which is 1000, no load splitting occurs. All rows are passed to the 
server with the lowest priority number. 

Example 2: Load Splitter Using Minimum Batch Size
In this example, the load splitter receives 1001 ROW_IDs for the account assignment object, which 
is greater than the threshold of 1000. The total number of tasks is 10, and minimum batch size is 
500. Load Splitter tries to split the rows into even tasks. The default calculation for batch size 
calculates 1001/10, or ~100 rows as the batch size. Due to the ramp-up time for different server 
components, this processing is actually more inefficient than just running two separates batches of 
500 and 501 ROW_IDs. Therefore, Load Splitter takes the minimum batch size of 500 into account 
and splits the rows into two tasks of 500 and 501.

Figure 36. Example of Load Splitter Configuration
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Example 3: Load Splitter When Batch Size is Greater Than Minimum 
Batch Size
In this example, the load splitter receives 6023 ROW_IDs for the account assignment object. 
Because this is greater than the threshold of 1000, Load Splitter tries to split the rows into batches. 
The default calculation for batch size calculates 6023/10, or ~600 rows as the batch size. Because 
this is greater than the minimum batch size of 500, Load Splitter splits the rows into 8 tasks of 600 
and one task of 623.

Load Splitter Operating Modes
Load splitter configuration uses the Configuration ID parameter to query against the configuration 
and configuration server business components and gets the threshold, minimum batch size, list of 
servers, the server task number, and the maximum number of tasks. However, if certain conditions 
exist, load splitter configuration passes all the objects as one batch onto the server component. 
Those conditions are:

■ If there is no configuration data

■ If configuration is incorrect

■ If the server cannot be found 

There are two operating modes for load splitter configuration�write mode and read mode�
depending on where load splitter configuration finds the object row IDs to process. Write mode writes 
to the S_ASGN_LB_DATA table, whereas read mode expects the data to already be loaded into the 
table.

Write Mode. By default, load splitter configuration runs in write mode. This mode takes a property 
set of WHERE clauses�one for each object type�and inserts the rows into the S_ASGN_LB_DATA 
table, then groups the object row IDs into several tasks and passes them to Assignment Manager. 

In write mode, the Load Splitter Business Service takes two inputs�object to be assigned and search 
specification (in SQL format)� to identify the records that need to be assigned. Based on the Load 
Splitter Configuration parameters, the Load Splitter engine splits the data, computes the resources 
available, and then distributes the assignment load among the configured Siebel Application Servers.

Read Mode. Load splitter configuration runs in read mode based on a request ID. If the Mode input 
argument is Read, then load splitter configuration separates the object rows into separate tasks and 
submits a request to a server component job to the appropriate server or servers.

In this mode, the assignment administrator (AA) determines the records that need to be assigned in 
the S_ASGN_LB_DATA staging table, and then invokes Load Splitter in read mode. The Load Splitter 
business service bypasses the identifying phase and reads the predetermined set of records that 
need to be assigned. Based on Load Splitter Configuration parameters, the Load Splitter engine 
computes the resources available (similar to write mode), and then distributes the assignment load 
among the configured Siebel Application Servers.

For information about invoking the Load Splitter, see �Distribute Data Method� on page 297.
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Distribute Data Method
The Distribute Data business service method is part of the Load Splitter Service business service that 
allows you to configure Assignment Manger to run multiple application servers concurrently within 
the Siebel Enterprise. This method consists of a complex hierarchical input property set.

Arguments

Usage
The input for load splitter configuration comes from any service that intends to use it, such as Target 
Object Selector (TOS), a business service, and so on. Load splitter configuration splits the objects 
that need processing into separate batches and submits those batches to a target process, such as 
Assignment Manager.

Argument Description

Configuration Id The load splitter uses the configuration ID to get the configuration for 
the servers, threshold, minimum batch size, list of servers to run on, 
and so on.

Mode Determines whether Load Balancer runs in Write or Read mode. Read 
mode is the default.

Object Types A property set that identifies the types of objects in a run and a child 
property set which contains a WHERE clause and the table name of 
each object type. For example:

Object Type = Contact

WHERE Clause = Specialty LIKE Cardiology 

TableName = S_PARTY

Request Id Identifies the rows in the S_ASGN_LB_DATA table for a specific 
assignment request.

Server Component Identifies the server component�AsgnSrvr or AsgnBatch�that the 
load splitter uses to pass the object rows for subsequent processing. 
This parameter also contains a child property set that has the input 
arguments used by a particular server component. For example:

AsgnSrvr can take in the following input arguments: AsgnKey, Copy-
postn-specific data, and so on.

Server Component 
Parameters

The property set that contains all the parameters for the specified 
server component.

Set Server Component 
Object Type Parameter

Indicates which server component parameter to populate with the 
object type.

Set Server Component 
SQL Parameter

Indicates which server component parameter to populate with the load 
balanced SQL statement.
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Invoked From
You can invoke Load Splitter using a workflow process, business service, scripting, and so on. 

Example
The following is sample code for invoking load splitter configuration using a business service and 
AsgnSrvr.

function LoadSplitterCreateInputs()

{

var psInputArgs;
var psOutputArgs;
var psObjTypes;
var psSrvrCompParams;
var pService;

psInputArgs = TheApplication().NewPropertySet();
psInputArgs.SetProperty ("Request Id", "LoadSplitterTest");
psInputArgs.SetProperty ("Configuration Id", "42-4VPGT");
psInputArgs.SetProperty ("Mode", "Write");
psInputArgs.SetProperty ("Server Component", "AsgnSrvr");
psInputArgs.SetProperty ("Set Server Component Object Type Parameter", 
"AsgnObjName");
psInputArgs.SetProperty ("Set Server Component SQL Parameter", "ObjRowSqlStmt");

psObjTypes = TheApplication().NewPropertySet();
psObjTypes.SetType ("Object Type");
psObjTypes.SetValue ("Account");
psObjTypes.SetProperty("SQL", "SELECT ROW_ID FROM SIEBEL.S_ORG_EXT WHERE NAME 
LIKE 'K%TEST%'");
psInputArgs.AddChild (psObjTypes);

psObjTypes = TheApplication().NewPropertySet();
psObjTypes.SetType ("Object Type");
psObjTypes.SetValue ("Opportunity");
psObjTypes.SetProperty ("SQL", "SELECT ROW_ID FROM SIEBEL.S_OPTY WHERE NAME LIKE 
'K%TEST%'");
psInputArgs.AddChild (psObjTypes);

psSrvrCompParams = TheApplication().NewPropertySet();
psSrvrCompParams.SetType ("Server Component Parameters");

psInputArgs.AddChild (psSrvrCompParams);

psOutputArgs = TheApplication().NewPropertySet();

pService = TheApplication().GetService("Load Splitter Service");
pService.InvokeMethod ("DistributeData", psInputArgs, psOutputArgs);

}
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A Troubleshooting: Assignment 
Manager Error Messages
This appendix explains how to view Assignment Manager error messages using Siebel Tools and 
provides a description for many of the error messages.

Topics in This Appendix
■ �Viewing Assignment Manager Error Messages� on page 299

■ �Assignment Manager Error Messages� on page 299

Viewing Assignment Manager Error 
Messages
Using Siebel Tools, you can view Assignment Manager error message descriptions and suggested 
resolutions. You must be connected to the server database to retrieve this information.

To view Assignment Manager error messages

1 Start Siebel Tools and connect to the server.

2 From the Screen Menu, select System Administration submenu > Strings view. 

3 Enter a query using the Message Key column with *ASG* OR ERR_ASG*.

The Assignment Manager error messages appear.

4 (Optional) Sort by error message number. 

Assignment Manager Error Messages
Table 56 lists some of the error codes, the message text, and a description of each error that 
Assignment Manager may generate during processing. For each error, Assignment Manager writes 
this information to the Assignment Manager log file (if you specified that one be used).
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Table 56 provides some of the Assignment Manager error codes.

NOTE: When dynamic assignment is running, some users may receive the following error when 
attempting to modify a record: �The selected record has been modified by another user since 
it was received. Please continue.� This may occur because Assignment Manager updated the 
record by assigning it while the user was trying to edit it. In this situation, the user�s changes may 
be lost. The solution is to refresh the query and reenter the user�s changes. 

Table 56. Assignment Manager Error Codes

Error Code Error Text1 Resolution2

ERR_ASG_ALREADY_ASSIGNED Assigned this object %1 
(more recently than 
requested %2).

This is just information.

ERR_ASG_ASSIGN_REPLY Selected %3 rules, 
%5 organizations, and %4 
people for %1 (%2).

This is just information.

ERR_ASG_BASSIGN_REPLY Assigned %1 rows for %2. This is just information.

ERR_ASG_LOADING_OBJECT Unable to load assignment 
object %1.

The configuration of the 
assignment object is not 
correct. Use Siebel Tools to 
check the configuration of the 
assignment object.

ERR_ASG_BDENORM_REPLY Denormalized %1 rows for 
%2.

This is just information.

ERR_ASG_CANNOT_ASSIGN_
LOCKED_ROW 

Cannot assign this item 
because it is in a locked state. 
(Object Name = %1, Object 
Row Id = %2.)

If you want to assign this 
object, please uncheck the 
Lock Assignment field for the 
object being assigned. 
Otherwise, this is just 
information.

ERR_ASG_DENORM_REPLY Denormalized %1 rows for 
%2.

This is just information.

ERR_ASG_DUP_CONFLICT Unable to update row (%1) 
because updated values 
violate unique index with an 
existing row (%2).

Check the data on your team 
table on the object row_ID 
where it failed.

ERR_ASG_INVALID_BU_
DFLT_NAME

Default organization %1 for 
assignment object %2 is not 
found in the organizations 
table. Please check that 
Default Organization - %1 is 
a valid organization.

Use Siebel Tools to set the 
Default Organization 
parameter for the assignment 
object to a valid organization in 
the database.
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ERR_ASG_INVALID_EMP_
DFLT_NAME 

Default employee %1 for 
assignment object %2 is not 
found in the employees table.

Use Siebel Tools to set the 
Default Employee parameter 
for the assignment object to a 
valid employee in the 
database.

ERR_ASG_INVALID_POSTN_
DFLT_NAME 

Default position %1 for 
assignment object %2 is not 
found in the positions table.

Use Siebel Tools to set the 
Default Position parameter for 
the assignment object to a 
valid position in the database.

ERR_ASG_INVALID_STORE_
COL_NUM

Assignment criteria attribute 
%1 has an invalid store 
column.

Check the Store Column value 
for your assignment criteria 
attribute and make sure it lies 
between 1 
and 4.

ERR_ASG_INVALID_WF_
LINK_COL

Assignment attribute column 
(%1) references invalid 
workflow component column 
(%2).

Check the Workflow Policy 
Component Column property of 
the assignment attribute 
column, and make sure it 
points to a valid and active 
workflow policy component 
column.

ERR_ASG_ITEM_ATTR_HAS_
NO_ATTR

Assignment Criteria %1, 
Assignment Criteria Attribute 
%2 has no attribute defined. 
Verify in Siebel Tools that the 
Assignment Criteria %1 has 
an assignment criteria 
attribute defined and active. 
Recompile the server 
repository file to apply 
changes made on assignment 
criteria configuration if 
necessary.

ERR_ASG_ITEM_ATTR_HAS_
NO_ITEM

Item(%2) not found for item 
attribute (%1). Please make 
sure that the item(%2) is 
active.

Make sure that the Parent 
Assignment Item Type of the 
Assignment Criteria 
Attribute(%1), points to a valid 
and active assignment criteria.

Table 56. Assignment Manager Error Codes

Error Code Error Text1 Resolution2
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ERR_ASG_ITEM_NOT_
FOUND

Assignment Criteria %1 has 
an invalid assignment 
attribute. Please check the 
assignment criteria 
configuration on Siebel Tools 
using the Validate tool, and 
note that it is a requirement 
to recompile the server SRF 
after adding or deleting 
assignment criteria records.

ERR_ASG_LOADING_GROUP Unable to load assignment 
rule %1 from the database. 
Please check the assignment 
rule definitions to make sure 
that all the required 
information is correct and 
press the Release button to 
recreate the rule cache data 
file.

ERR_ASG_LOADING_OBJECT Unable to load assignment 
object %1." 

Check the configuration of the 
assignment object.

ERR_ASG_LOV_VALUE_NOT_
FOUND

No LOV value found for 
Type [%1], Value [%2].

Make sure expertise values for 
skills are valid, belonging to 
LOV type EXPERTISE_CD 
(defined through Application 
Administration screens).

ERR_ASG_MATCHASSIGN_
REPLY

Qualified and selected %3 
rules, %5 organizations, and 
%4 people for %1 (%2).

This is just information.

ERR_ASG_MATCH_REPLY Qualified %3 rules, %5 
organizations, and %4 people 
for %1 (%2).

This is just information.

ERR_ASG_NO_OBJ_COL_FOUND Assignment object %1 has no 
columns.

Table 56. Assignment Manager Error Codes

Error Code Error Text1 Resolution2
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ERR_ASG_NOT_EMP_POSTN Employee or Position not 
specified for assignment 
object %1.

If person-based assignment, 
make sure that at least one of 
the four properties (Position 
Table, Position Primary 
Column, Employee Table, 
Employee Primary Column) for 
assignment object %1 has a 
valid non-null value. If 
organization-based 
assignment, make sure that at 
least one of the two properties 
(Org Table, Org Primary 
Column) for assignment object 
%1 has a valid non-null value.

ERR_ASG_NO_WF_COLS_
IN_ATTR

Assignment attribute %1 has 
no workflow columns.

ERR_ASG_NO_WF_OBJECT No workflow object available 
for assign object = %1.

Make sure that the Parent 
Workflow Object property of 
the Assignment Object % 
points to a valid workflow 
object.

ERR_ASG_OBJECT_NOT_FOUND Assignment object %1 is not 
registered in the Siebel 
repository. Please make sure 
that %1 is a valid assignment 
object name and the value 
you input is identical to what 
you see in the application. 
Please review the Assignment 
Manager documentation for 
details on the required 
parameters before running an 
Assignment Manager task.

ERR_ASG_PERSON_OBJECT_
NUM_ATTR_MISMATCH

Number of attributes do not 
match with assignment object 
for person object %1.

ERR_ASG_PR_TBL_ROW_
NOT_FOUND 

RowId [%1] in table [%2] not 
found.

Make sure that request 
submitted is for a valid Row Id 
in table (%2).

ERR_ASG_UPDATE_FAILED Unable to update row %1 
(%2).

Check the log file for database 
related error, and correct the 
error.

Table 56. Assignment Manager Error Codes

Error Code Error Text1 Resolution2
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ERR_ASG_PARSING_VALUE Unable to parse criteria value 
%1.

ERR_ASGN_KEY_NO_MATCH Assignment Key %1 does not 
match the Request Key.

Make sure that the AsgnKey 
parameter is set to the Row Id 
of one of the assignment 
groups mapped to the server.

1. The error text that appears in Table 56 is generic. However, for most errors, Assignment Manager generates more specific 
information about the exact cause of the error. Both the generic and the specific error messages appear in the Server Process Log; 
while only the specific error message appears in the Assignment Manager log file.

2. If the Resolution column is blank, this means either the error code is no longer applicable or the text of the error code is informative 
enough not to warrant a separate explanation for resolution.

Table 56. Assignment Manager Error Codes

Error Code Error Text1 Resolution2
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ActionAgent parameter, about 226
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about 199
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assignment default value 254
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SRVRMGR utility 200
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SRVRMGR utility 200
administrative tasks
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skills, associating with an employee 124

All, Above Minimum method, about 91
All, Must Assign method, about 91
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SRVRMGR utility 200
applet classes in interactive 

assignment 54
AsgnBatch command

batch assignment mode, running from (about 
and parameters) 231

AsgnKey parameter
SRVRMGR utility 200

AsgnMode parameter
SRVRMGR utility 201

AsgnObjName parameter
SRVRMGR utility 201

Assign option, configuration example 53
Assignee Filter type, table of 135
assignee, determining primary 136

Assignment Attribute Column object type
configuring 61
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Assignment Attribute object type
overview 58
properties (table) 59

assignment attributes
column-based vs. skill-based 56
configuring assignment attributes 57
creating 58
definition 58
disabling 73, 111
mapping workflow components 69, 71
multilingual list of values (MLOV), configuring 

for 60
multiple attributes, about basing on 

columns 58
overview 56
triggers, generating 58
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assignment methodology, role in 133
assignment rules without criteria, role 

of 99
attribute object definition, about 58
combining rules, developing 140
configuration warning 56
configuring, about 63
configuring, creating 63
creating 104
creating, example of 64
creation process overview 56
expertise codes, role of 112
inclusion methods (table) 99
mapping workflow components 68, 71
multiple assignment attributes, about basing 

on columns 58
nonrequired assignment criteria 103
object definition properties 65
object definition properties, about 64
primary address, assignments based 

on 245
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queries, creating 105
required assignment criteria 102
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example 103
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seed assignment criteria, removing 111
values, comparison method 108

assignment criteria attributes
configuring 65
creating 66
list columns, relation to 65
object properties (table) 66

assignment criteria values
creating, example 110
sorting and storage 109
wildcard characters as literals 109
wildcard characters, about 109

Assignment Manager
Assignment Manager component, 

modifying 198
child accounts, parent primary address 

example 111
component configuration, overview 58
component parameters, configuring, 

importance of 199
components, starting 198
configuration concepts 64
contact denormalization 214
customizing, about 22
customizing, tasks 23
data sources 196
event log configuration 209
parameters, configurable (table) 198
post-configuration tasks 80, 211
running multiple instances 231
Server Request Broker components, 

checking 197, 217
trace and error flags, about using 209

Assignment Manager, modes
batch assignment mode, running in 228
dynamic assignment mode 220
interactive assignment mode 216
mobile assignment mode, running in 234

assignment methodology, assigning 
candidates 133

assignment modes
dynamic assignment mode, running in 

overview 220
dynamic assignment, disabling and 

enabling 146
independent assignment 270
interactive assignment mode, running in 

overview 216
mobile mode, running in 234
organization and person-oriented assignment, 

about 272
organization-oriented assignment, if 

multitiered assignment is set 271
person-oriented assignment, if multitiered 

assignment is set 271
assignment object base table, extending for 

availability-based assignment 281
assignment object modes

batch assignment mode, multiple record 
assignments 230

batch mode assignment, overview 228
assignment object object types, about 46
assignment object properties

See also configuration; configuration, 
advanced

assignment object types
hierarchy and relationships 48

assignment objects
assigning multiple records 230
assignment attributes, mapping to 61
assignment rules, about developing 39
configuration overview 51
default organization, suppressing assignment 

of 252
expertise codes 112
interactive assignment, configuring 53
interactive assignment, overview 53
matching requirement for workload 

rules 128
no-criteria rule 104
position and employee-based assignments, 

creating 51
positional visibility, about 122
predefined assignment rules, definition 

requirement 83
predefined definitions, list of 46
primary address criteria 245
primary position, maintaining 251
reassigning positions, example 248
role in defining assignment criteria 63
team table, configuring to copy additional 

columns to 255
team-based criteria 129
wildcard characters, use of 109
workflow policy object, adding to 243
workflow policy objects, relation to 51

assignment objects, availability-based 
assignment

about configuring for 280
configuration example 282
configuring for 281
visibility 282, 284

assignment policies
activating 146
batch assignment mode deactivation 

requirements 227
contact denormalization, activating 216
deactivating 146
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dynamic assignment mode and predefined 
assignment policies 146

workflow groups, role of 146
Workflow Monitor Agent, role of 146

Assignment Results BusComp user 
property 55

assignment rule fields
overview 90

assignment rule groups
assignment rules, sequencing 147
creating 88
key-based routing 149
overview 26

assignment rules
See also territories
assignment methodology, role in 133
assignment object configuration 

overview 51
availability-based rules, overview 278
combining criteria, developing rules 140
complex rule, example 111
creating 94
definition requirement 83
developing, about 39
emails, as activities 31
employees, about visibility for assigned 

object 122
employees, adding to (procedure) 121
Enterprise Integration Manager, loading 

with 228
migrating, about 154
multiple criteria, about creating rules that 

combine 139
multitiered assignment mode, using with sales 

assignment rules 270
multitiered assignment, about 269
no-criteria rule 104
organizations, adding to 122
process overview 21
releasing 153
required assignment criteria 102
rule cache, recreating 154
scoring formula 135
sequence, defining 149
sequences of rules, evaluating 147
sequences of rules, examples 147
without criteria, role of 99

assignment scoring
overview 101
team member scores 102

assignment strategy
assignment rules, about developing 39
assignment skill, associating with an 

organization 125

sales organizations, assignment in 41
skills, associating with a position 125
skills, associating with an employee 124

Assignment Type business component, user 
property 54

attributes, about defining assignment 
criteria and using 63

availability-based assignment
assignment objects, configuring 282
assignment objects, visibility 282, 284
assignment rules, overview 278
availability criteria, activating 278
overview 277

B
batch assignment mode

about 32
assignment rules without criteria 99
command line, running from (about and 

parameters) 231
interaction with dynamic assignment 

mode 227
mobile users, routing assignments to 250
multiple instances, running 231
Object WHERE Clause, using when starting 

server task 213
overview 228
performance tuning 231, 233
record updating, inadvertent 229
running 229
SRVRMGR utility, running from (about and 

parameters) 231
wildcards, using in SQL statements 212

BatchMode parameter, about 226
BatchSize parameter

performance considerations 233
SRVRMGR utility 201

business components
interactive assignment 54

C
cache size, LastUsrCacheSx parameter, 

about 225
CacheSize parameter

SRVRMGR utility 200
candidates

assignment methodology 133
evaluation methods, about 99
organizations, about and example 28
positions, about and example 27
potential assignees list 135
teams, about and example 28

Check Calendar box, about using 278
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Check version iterations parameter, 
about 201

CheckIfCandidateActive parameter
SRVRMGR utility 201

CheckLogCacheSz parameter, about 225
CheckVerIter parameter

SRVRMGR utility 201
child accounts

PAR_OU_ID column, about value point 
to 248

parent�s primary address, assigning based 
on 246

primary parent address 111
classes, confirming for interactive 

assignment 54
column-based assignment attributes, 

about 56
Compare Object to Organization

comparison method, about 99
Compare Object to Person

comparison method, about 98
expertise codes, use of 112

Compare to Object
comparison method, about 98
criteria values, about using 108
criteria values, assignment criteria 108
expertise codes, use of 112

Compare to Organization
comparison method, about 99
criteria values, about using 108

Compare to Person
comparison method, about 98
criteria values, about using 108
criteria values, assignment criteria 108
expertise codes, use of 112

configuration
See also configuration, advanced
Assign option, using to invoke Interactive 

Assignment 53
Assignment Manager post-configuration 

tasks 80, 211
availability-based assignment, extending 

Service Request�s base table 
for 281

availability-based assignment, 
overview 280

event logs, about and types of 209
event logs, setting log level 210
interactive assignment, configuring for an 

assignment object 53
interactive assignment, overview 53
Siebel Developer Web Client, parameters for 

interactive assignment mode 
(table) 217

configuration, advanced
See also configuration
activity assignment objects, setting the lock 

assignment value 254
assignment objects, configuring to copy 

additional columns 255
assignments, routing to mobile users 250
child account, assigning based on parent�s 

primary address 246
default organization, stopping assignment 

of 252
organization, stopping assignment for 

accounts 253
primary address, assigning objects based 

on 245
primary position, maintaining manually 

assigned 251
primary position, resigning accounts 248

contact denormalization
activating 216
assignment operation mode, about 214

CopyCandSpecData parameter
SRVRMGR utility 201

CopyPersonSpecData parameter
SRVRMGR utility 202

Criteria list column, using to configure 
assignment criteria 63

criteria values
configuration warning 44
criteria value scores, calculation of 108
duplicate criteria values 109
methods used 108

CSSBCBase, about configuring for interactive 
assignment 54

D
data visibility, about controlling visibility 

between organizations 28
database triggers, about generating 221
Default Employee, Position, Organization, 

modifying 52
default organization, suppressing 

assignment of 252
Default Tasks parameter, about 202
delegated assignment

about 172
DeleteSize parameter, about 226
denormalization, about using Contact 

Denormalization mode 214
DfltTasks parameter

SRVRMGR utility 202
dynamic assignment mode

See also Workflow Monitor Agent
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about 32
assignment objects, enabling and disabling 

for 146
database changes, refreshing display 220
GenTrig command-line interface command, 

running using 224
interaction with batch assignment 

mode 227
mobile users, routing transactions to 250
performance tuning 226
running in overview 220
triggers, generating 222

dynamic candidates
about 155

DynCandParam parameter
SRVRMGR utility 202

E
email activity assignment, email and 

assignment rules 31
email and assignment rules, email activity 

assignment 31
employee-based assignment objects, 

about 277
employees

assignment rules, adding to 
(procedure) 121

availability-based assignment rules, 
overview 278

availability-based assignment, about 277
multitiered assignment, about and 

example 120
position and employee-based assignments, 

creating 51
skills, associating with 124
visibility, about for assigned object 122
workload criteria definition example 131
workload criteria, defining 130

Enterprise Integration Manager (EIM), 
loading assignment rules 228

error flags, about using 209
error messages

IgnoreError parameter, about 225
event logs

about configuring and types of 209
log level, setting 210

Exclude method
assignment criteria inclusion method, 

about 101
ExcludeOrgList parameter

SRVRMGR utility 203
ExcludePersonList parameter

SRVRMGR utility 203

EXEC parameter
about 224

expertise codes
creating, example 116
overview 112
predefined expertise codes, about 115
weighting factors example 119
weighting factors, about applying to 113
weighting factors, defining 118

Expertise list column, about 65

F
field service

assignment rules, creating 288

G
Generate Triggers server component, 

about 221
Generate Triggers, running 222
GenReqRetry parameter, about 226
GenTrig command-line interface command, 

using 224
GroupName parameter, about 225

I
IgnoreCache parameter

SRVRMGR utility 202
IgnoreCalCrit parameter

SRVRMGR utility 202
IgnoreError parameter, about 225
Include All Matching method

assignment criteria inclusion method, 
about 101

Include All method, assignment criteria 
inclusion method, about 100

Include method
assignment criteria inclusion method, 

about 100
criteria values, about using 108

inclusion-exclusion assignment criteria 
table 99

independent assignment mode, and 
multitiered assignment 
disabled 270

IndepRuleGroupCache parameter
SRVRMGR utility 202

interactive assignment
about running in rule group mode 219
SRVRMGR utility, running from (about and 

parameters) 217
UI, running from (about and 

parameters) 217
interactive assignment mode
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about 33
applet classes, allowable 54
assignment objects, configuring for 53
business components, restrictions on 54
configuring 53
running in overview 216
service requests, running for example 218
Siebel Developer Web Client, running 

Assignment Manager in 217
Siebel Developer Web Client, server 

component requirements 217

K
KeepLogDays parameter, about 225
key-based routing, about and use of 149
KeyBasedEnabled parameter

SRVRMGR utility 203

L
language

code criteria example 25
LastUsrCacheSz parameter, about 225
list columns, relation to assignment criteria 

attributes 65
lock assignment

activity assignment objects, setting 254
log level, setting 210
LogTxnChgOnly parameter

mobile users, routing assignments to 250
SRVRMGR utility 204

M
MailServer parameter, about 225
MailTo parameter, about 225
Maximum MT Servers parameter, 

about 204
Maximum Tasks parameter, about 204
MaxMTServers parameter

SRVRMGR utility 204
MaxRoutKeys parameter

SRVRMGR utility 204
MaxSkillsAge parameter

SRVRMGR utility 206
MaxTasks parameter

SRVRMGR utility 204
migrating assignment rules, about 154
Minimum MT Servers parameter, 

about 205
MinMTServers parameter

SRVRMGR utility 205
MinMTServers parameter, about 

setting 198
MLOV

See multilingual list of values (MLOV)
mobile assignment mode

about 34
mobile users, routing transactions to 250
running in 234

Mode parameter
about 224

multilingual list of values (MLOV)
assignment attributes. configuring for 60
workload criteria, about 126

multitiered assignment
See also multitiered assignment mode
employees, adding example 120

multitiered assignment mode
See also multitiered assignment
independent assignment 270
organization and person-oriented assignment, 

about 272
organization-oriented assignment, if 

multitiered assignment is set 271
overview 270
person-oriented assignment, if multitiered 

assignment is set 271
multitiered assignment objects

about 269

N
nonrequired assignment criteria

about using 103

O
object types

field value and property relationships, 
diagram 49

Object WHERE Clause
creating 212
performance considerations 234
role of 213
running multiple Assignment Manager 

instances 231
ObjectRowId parameter

SRVRMGR utility 205
ObjRowSqlStmt parameter

SRVRMGR utility 205
ObjWhereClause parameter

SRVRMGR utility 205
One, Best Fit, assignment rule, about 91
One, Random, assignment rule, about 91
opportunities

territories, role of 85
territory definition list, modifying 139

Org Primary column, using to stop 
assignment 252
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organization and person-oriented 
assignment mode, and multitiered 
assignment 272
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and multitiered assignment 271
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assignment rule, adding organizations 

to 122
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default organization, suppressing 

assignment 252
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person-oriented assignment mode, and 
multitiered assignment 271

picklists
assignment attribute, specializing in 58
Criteria list column, about using 63

position object
examples 248

positions
described 27
indirect positions 214
position and employee-based assignments, 

creating 51
predefined objects, using 27
primary position, determining 215
skills, setting up 125
visibility for assigned object 122
workload criteria definition example 131
workload criteria, defining 130

post-configuration tasks, server 
administration requirements 80, 

211
predefined objects

sales objects, use of 27
Price List table, organization 

denormalization 215
primary address

assigning child accounts based on 111
assignment based on 245

primary position
determining 215
different position, reassigning accounts 

to 248
manually assigned primary position, 

maintaining 251
Product Defect Priority criteria value 110
Product Denormalization

mode, about and using 215
products, associating to organizations and 

price lists 215
properties

Default Employee, Position, Organization 
properties, modifying 52

PrOrganizationId parameter
SRVRMGR utility 205

PrPersonId parameter
SRVRMGR utility 205

PrRuleId parameter
SRVRMGR utility 205

Q
queries, assignment criteria 105

R
RegularAsgn parameter

SRVRMGR utility 206
ReloadPolicy parameter, about 226
Remove parameter

about 224
ReplaceKeyVal parameter

SRVRMGR utility 206
ReplaceTeamMembers parameter

SRVRMGR utility 206
repository

repository file, compiling 81
ReqId parameter

SRVRMGR utility 206
Requests parameter, about 226
ReturnPropSet parameter

SRVRMGR utility 207
RptMode parameter

SRVRMGR utility 206
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rulecache.dat file
assignment rules, releasing 153

S
sales organizations

assignment in 41
multiple criteria, about creating rules that 

combine 139
multitiered assignment rules, using with sales 

assignment rules 270
position candidates, use of 27
team candidates, about 28
territory definition list, modifying 139
territory-based assignment rules, 

creating 138
territory-based assignment rules, 

developing 140
territory-based assignment rules, 

example 137
sales team

See teams
Score list column, about 65
scoring

assignment scoring 101
formula for assignment rules 135
sequences of rules, evaluating 147
sequences of rules, examples 147
team member scores 102
without criteria, role of 99

security, about controlling an organization 
security 28

seed assignment criteria, removing 111
server administration

Assignment Manager post-configuration 
tasks 80, 211

dynamic mode requirements 220
interactive assignment mode, server 

component requirements 217
server key maps

about and used of 149
new server key map, defining 151

Server Request Broker components
checking 197
interactive mode, checking server 

components 217
Service Request base table, extending for 

availability-based assignment 281
Service Request object

configuring for interactive assignment 53
service requests

interactive assignment mode, running 
for 218

Siebel Dedicated Web Client

Assignment Manager, running in interactive 
mode 217

service requests, running interactive 
assignment mode in 218

Siebel Server, concurrent components, 
number of 198

Siebel Web Client
service requests, running interactive 

assignment mode in 218
skill-based assignment attributes, 

about 56
skills

See also expertise codes
Assignment Manager, assigning a service 

request example 119, 245
creating with expertise codes, 

example 117
employee skills, associating with 124
new skill, creating 244
organization skills, associating with 125
position skills, setting up 125
predefined skills, viewing 244
skill table, using 119, 244
weighted expertise codes, defining 118

SleepTime parameter, about 226
SmartScript, role in interactive 

assignment 53
.srf file, compiling instructions for 81
SRVRMGR utility

batch assignment mode, running from (about 
and parameters) 231

dynamic assignment mode, using to 
run 224

T
TAMode parameter

about 224
teams

availability-based assignment rules, 
overview 278

availability-based assignment, about 277
described and example 28
team member assignment scores 102
team table, configuring assignment objects to 

copy additional columns to 255
territories

See also assignment rules
criteria, about creating rules that combine 

criteria 139
location and revenue-based, example 139
multitiered assignment, using with sales 

assignment rules 270
organization and person-oriented assignment, 
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about 272
realignment, impact of 41
role in opportunity and account 

distribution 85
sales assignment rules, creating based on 

territories 137
sales assignment rules, creating that combine 

criteria 139
territory definition list, modifying 139
territory-based assignment rules, 

creating 138
views being phased out 85

territory assignment criteria, example of 
creating 109

territory assignment rules
creating 154

trace flags, about using 209
TrigFile parameter

about 224
triggers

assignment attributes 58
custom triggers, about creating 222
Generate Triggers, running 222
reviewing 221

tuning
batch assignment mode, performance tuning 

in 231, 233
dynamic assignment mode, performance 

tuning in 226

U
Use Expertise property, about setting 65
UseForUpdate parameter

SRVRMGR utility 207
UseKeyVal parameter

SRVRMGR utility 207
user properties

assignment criteria attributes (table) 66
Assignment Results BusComp, about showing 

additional properties 55
UseRuleMinScore parameter

SRVRMGR utility 207

V
Values list

about and example 58
list column set, creation of 65

visibility, organizations, role of 28

W
weighting factors

example 119
expertise codes, about applying to 113

wildcard characters
batch assignment mode SQL 

statements 212
criteria value, using with 109

Workflow Monitor Agent
assignment policies, role in 146
role of 220
running 224
workflow groups, role of 146

workflow policy components
assignment attribute, mapping to 69, 71
assignment criteria, mapping to 68, 71
creating 68, 70
record updating, inadvertent 229

workflow policy objects
assignment objects, adding 243
assignment objects, relation to 51

workload criteria
employees and positions example 131
employees and positions, defining for 130
multilingual list of values (MLOV) 126
organizations, defining for 131
predefined fields (table) 130
predefined rules 127
team-based criteria 129

workload rules
assignment object matching 

requirement 128
creating example of 129

workload score
formula 135
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